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What is Cloud Assembly

You use vRealize Automation Cloud Assembly to connect to your public and private cloud
providers so that you can deploy machines, applications, and services that you create to those
resources. You and your teams develop cloud-templates-as-code in an environment that supports
an iterative workflow, from development to testing to production. At provisioning time, you can
deploy across a range of cloud vendors. The service is a managed VMware SaaS and NaaS-based
framework.

An overview of Cloud Assembly includes the following basic functions.

m  The Resources tab shows the current status of your provisioned, discovered, onboarded, and
other resources. You can access resource details and day 2 actions that you use to manage
your resources.

m  The Design tab is your development home. You use the canvas and the YAML editor to
develop and then deploy your machines and applications.

m  The Infrastructure tab is where you add and organize your cloud vendor resources and users.
This tab also provides information about deployed cloud templates.

m  The Extensibility tab is where you can extend and automate your application life cycles. You
can subscribe to events that are used to trigger extensibility actions or vRealize Orchestrator
workflows.

= An Alerts tab provides notifications regarding capacity, performance, and availability for your
infrastructure resources. You must have a configured integration with vRealize Operations
Manager to see and use the alerts.

m  The Tenant Management tab shows the different tenants that you configured if you are a
service provider and enables you allocate or de-allocate virtual private zones.
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This chapter includes the following topics:

m  How does Cloud Assembly work

How does Cloud Assembly work

Cloud Assembly is a cloud template development and deployment service. You and your teams
use the service to deploy machines, applications, and services to your cloud vendor resources.

As a Cloud Assembly administrator, generally referred to as a cloud administrator, you set up the
provisioning infrastructure and create the projects that group users and resources.

m  Add your cloud vendor accounts. See Adding cloud accounts to Cloud Assembly.

m  Determine which regions or datastores are the cloud zones that you want your developers
deploying to. See Learn more about Cloud Assembly cloud zones.

m Create policies that define the cloud zones. See Chapter 4 Building your Cloud Assembly
resource infrastructure.

m Create projects that group the developers with the cloud zones. See Using Cloud Assembly
project tags and custom properties .
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As a cloud template developer, you are a member of one or more projects. You create and deploy

templates to the cloud zones associated with one of your projects.

Develop cloud templates for projects by using the design canvas. See Getting started with
Cloud Assembly designs.

Deploy your cloud templates to project cloud zones based on policies and constraints.

Manage your deployments, including deleting unused applications. See Managing Cloud
Assembly deployments.

Welcome to Cloud Assembly. If you want an example of how to define the infrastructure, and then
create and deploy a cloud template, see Tutorial: Setting up and testing multi-cloud infrastructure
and deployments in Cloud Assembly.
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Cloud Assembly Tutorials

The tutorials show you how to perform common tasks that help you become proficient with Cloud
Assembly.

As you begin, a reminder that in addition to the steps in the tutorials, there is additional
information in this guide. Links are provided to relevant topics.

Accessing user assistance

Equally important, user assistance is provided throughout the application. The user assistance
helps you understand features and provides information that helps you make decisions about how
to populate text boxes. The external documentation provides greater depth, code samples, and
use cases.
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This chapter includes the following topics:

m  Tutorial: Deploying a virtual machine in Cloud Assembly

m  Tutorial: Setting up and testing vSphere infrastructure and deployments in Cloud Assembly

m  Tutorial: Configuring Cloud Assembly to provision a production workload

m  Tutorial: Using tags in Cloud Assembly to manage vSphere resources

m  Tutorial: Adding a Cloud Assembly cloud template to the Service Broker catalog with a custom

request form

m  Tutorial: Onboarding and managing vSphere resources in vRealize Automation

m  Tutorial: Setting up and testing multi-cloud infrastructure and deployments in Cloud Assembly

m  Tutorial: Configuring VMware Cloud on AWS for vRealize Automation

VMware, Inc.
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m  Tutorial: Configuring a provider-specific external IPAM integration for vRealize Automation

Tutorial: Deploying a virtual machine in Cloud Assembly

As a Cloud Assembly Administrator, you can deploy a simple virtual machine that does not require
that you know how to create a cloud template. If you are new to Cloud Assembly this tutorial
guides you through the set up process, creating the virtual machine, and shows you where to
manage the deployed machine.

This method is an easy way to quickly deploy a machine based on image templates, sizing flavors,
storage, and networks defined by the cloud provider. It is a quick test of your cloud account and
projects.

You can create a virtual machine for any of the following cloud services providers.
= Amazon Web Services

m  Google Cloud Platform

= Microsoft Azure

m  vCenter Server

= VMware Cloud on AWS

The Google Cloud Platform is the example in this tutorial.

Before you begin

m  Verify that you have the Cloud Assembly Administrator role. See Organization and service user
roles in vRealize Automation. If you do not have this user role, you do not even see the option
create a new VM.

Step 1: Add a cloud account

The cloud accounts provide the credentials that Cloud Assembly uses to connect to the cloud
provider.

1 Select Infrastructure > Connections > Cloud Accounts.

2 Click Add Cloud Account and select the account type.
You can access the configuration details using the following links.
m  Create an Amazon Web Services cloud account in vRealize Automation
m Create a Google Cloud Platform cloud account in vRealize Automation
m  Create a Microsoft Azure cloud account in vRealize Automation
m Create a vCenter cloud account in vRealize Automation

m  Create a VMware Cloud on AWS cloud account in vRealize Automation

VMware, Inc. 13
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After you add the cloud account, Cloud Assembly collects resource information from the target
cloud provider account that you later use to deploy a virtual machine.

Step 2: Create a project

The project associates the users and the cloud account cloud zones.

In this tutorial, the project name is Create VM Project. This project is a demonstration project that
includes cloud zones for all the supported platforms.

1
2

Select Infrastructure > Administration > Projects.

Click New Project.

Enter a name.

In this tutorial, the name is Create VM Project.

If you want other to use this project, click the Users tab and add any users to the project.

Click the Provisioning tab and click Add Zone to add at least one cloud zone for the cloud
accounts that you are deploying to.

Remember, this is a demonstration project that includes a cloud zone for each support cloud
vendor platform.

& Create VM Project

Summary Users Provisioning Kubernetes Provisioning ntegrations
Zones
Specify the zones that can be used when users provision deployments in this project. ()
ADD ZONE ¥
Name Status Description Priority 4 | Instances Memory Limit {MB) CPU Limit Storage Limit (GB) Capability Tags
) dsadsa-vsphere / SDDC-Datacenter - 0 Unlimited Unlimited Unlimited Unlimited

0 Unlimited Unlimited Unlimited Unlimited

AWS / af-south-1 - 0 Unlirmited Unlimited Unlimited Unlimited

(& veB5 / Datacenter - 0 Unlirmited Unlimited Unlimited Unlimited

0 Unlirmited Unlimited Unlimited Unlimited

6 Click Create.

Step 3: Create and deploy a virtual machine

Select Resources > Resources > Virtual Machines, and then click New VM.
Configure the required settings on the General page of the wizard and click Next.

This tutorial uses Google Cloud Platform as the cloud account where you want to deploy the
virtual machine.

VMware, Inc. 14
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v (O General Location and basic information

Select the project, cloud zone, and other basic information for your virtual machine.

Name ¢ Google Cloud Create VM
Enter a name for your machine. A suffix or naming policy may also be
appiied during provisioning
Project * O Create WM Project
Select a project with access to your desired cloud zone
Cloud zone * Q yingzhi-GCP / us-gast]
Select the cloud Zone Where you Want to provision this machine
Tags

Tags are added to the machine when provisioned

NEXT CANCEL

Remember that these values are samples only. Your values must be specific to your
environment.

Table 2-1. Sample values for the first wizard page

Setting Sample Value

Name Google Cloud Create VM
Project Create VM Project

Cloud zone

yingzhi-GCP/us-east1

3 Select the image and flavor that are used to create the virtual machine.

The available values are collected from the target cloud zone. The image is the operating
system and the flavor is the defined size options. Some target provider types require you to
specify the CPU and memory. This target requires you to select from the defined options.

~ (@ Image and flavor Image and flavor size

Image @

Image * Q, backports-debian-7-wheezy-v20131127

Flaver @

Flavor * Q

fl-micro

&2-highgpu-1g

E a2-highgpu-29

a2-highgpu-4g
3 Storage a2-highgpu-8g

i ni-ultramem-40
4. Networking
ni-ultramem-80
ni-ultramem-160
mi-ultramem-40
mi-ultramem-80

ml-ultramem-160

4  Click Next.

To deploy only the machine, click Create. For this tutorial, click Next to add the optional
storage and network for this virtual machine.
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5 To add a new disk, click Add hard disk and enter a Name and Size.

v (O Storage Storage and hard disks
Configure storage for this virtual machine.
Hard Disk 1 X
° New disk Existing disk

Name * Craate-vm-new-gisk-1

Size © 4 GB

Type
Encrypted
Persistent

6 Click Next.

7 To add a network adapter, click Add network adapter.

8 Select from the search results.

I > @ General Location and basic information
I > @ Image and flavor Image and flavor size
I > (@ Storage Storage and hard disks

v 4 Networking Network and IP assignment

Configure networking for your virtual machine

Network Adapter 1 X

Network * Q default
(O Advanced

+ADD NETWORK ADAPTER

CREATE CANCEL

9 Click Create.

Your view switches to the Deployments page so that you can monitor the progress of the
deployment.

Step 4: Manage the new virtual machine as a deployment

When the deployment process is completed successfully, you can begin managing the
deployment.

For more about managing your deployments, see Managing Cloud Assembly deployments.

For a list of all possible day 2 actions on all resource types, see What actions can | run on Cloud
Assembly deployments.

1 Select Resources > Deployments and locate your virtual machine.
In this tutorial, the deployment name is Google Cloud Create VM.

2 Torun an allowed deployment-level action on the deployment from this view, click the vertical
ellipsis and select the action.
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Deployments Q ® =]
Name Address Qwner Project Status Expires on Price
> H & acp_811d09ff-efel-4dad-3049-5be08ab62¢ .. @vmware.com Create VM Project Never
> @ el Cloud Create VM_6f6d0315-ddc8-4. Bvmware.com Create VM Project Never
> C! Soeeane @vmware com cmbu-08-project Never
Change Owner
> Change Project 1e-f792-43d5-885d-2b45= @vmware.com Create VM Project Never
Delete
> Edit Deployment -South @vmware.com Sales Never
Edit Tags
b Power Off @vm Sales Never

3 To learn more about the deployment, including the topology, click the deployment name.

Notice that the topology of this deployment is simple. More complex deployments also provide
the complete topology that might include machines, load balancers, network connections, and
other components.

You can also view the deployment history, which is a log of all the actions on the deployment
components, and run allowed machine-level actions.

&> Google Cloud Create VM_6f6d0315-ddc8-4f5d.. AcTIONS v | 2

Noldescrption Qwner Expires on Never
cnugent@vmware.com Last updated Dec 3, 2021, 2:55:10 PM
Requestor Created on Dec 3, 2021, 2:52:57 PM
Project

A e
Create VM Project Add Disk
HIDE SUMMARY # Create Snapshot

Delete
Topology History Power Off
Q Av i dm o Bx 0o o » Resize
v Google Cloud Qreat Resiza Boot Diske i chjws'
v General
Resource name mem-20211203215331-

Account /Region £} yin

qzhi-GCP/us-eastl

Status > On

Address 34.74168.22

Compute host us-eastl-b

£ Gooale Cloud
~ Storage

Capacity

Name (GB) Type Encrypted
4 HDI ue
1 HDI ue

Step 5: Manage the new virtual machine as a resource

In addition to managing the virtual machine as a deployment, you can also manage it along
with the other resources. Resources can include deployed, discovered, and onboarded virtual
machines, storage volumes, and network and security resources.

VMware, Inc. 17
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Discovered resources are those that are collected from the cloud instance. You can manage
discovered resources with a limited set of day 2 actions, such as power on and power off. For
more information about working with discovered resources, see How do | work with discovered

resources in Cloud Assembly.

Onboarded resources are discovered resources that you brought under full management. They
can be managed with the more robust day 2 action options. For more information about how to
onboard discovered resources, see What are onboarding plans in Cloud Assembly.

As you work with this deployed machine, it is eligible for more day 2 actions. The availability of the
actions depends on the state of the machine and what day 2 actions you have permission to run.

1
2

Select Resources > Resources > Virtual Machines.

Locate the machine.

Virtual Machines <

NEW VM

Name

% ! @ vm-administrator-VLDX..

% : vm-administrator-NECE...

% t € mcm-20211203215331-0.

Deployment

Google Cloud Create VM_6f...

VM State

» On

»On

»On

Account / Region

(@ https/cmbu-wOl-ve08.eng.vmware.com / wOl-veO8-.

(@ hitps:/cmbu-wOT-ve08.eng.vmuw

O yingzhi-GCP / us-eastl

com / wOl-vcO8-.

Address

192167 211142

347416822

Project

Create VM Proj...

Origin Tags

O Discovered

O Discoverad

<& Deployed

To run an allowed machine-level action on the machine from this view, click the vertical ellipsis

and select the action.

Virtual Machines <

Name

» | 1 @ vm-administrator-VLDX..

7 ! @ vm-administrator-N6CE.

> © mcm-2021203215331-0.
Add Disk

; Create Snapshot o
Delete

b Power Off 328
Resize

” Resize Boot Disk UM
Resize Disk

» Update Tags vz

Deployment

Google Cloud Create VM_6t

VM State

> On

»On

» On

»On

» On

» On

»On

Account / Region

[ nttps://cmbu-w01-vc08.eng v

(@ https/embu-wO1l-veO8.eng.vi

O yingzhi-GCP / us-east!

[ https/cmbu-wG1-vc08 eng v

(& https/embu-w01-veO8.eng.vi

(3 hitps://cmbu-wO1-ve08.eng.vmwar

3 hitps://cmbu-w01-vcO8.eng. vmwar

MWar

mware.c

mwar

MWar

.com /

com / wi

com / wi

com / wi

com /

WOVE08-..

£ WOl-ve08-..

01-ve0s-.

01-ve08-...

01-ve08-

WOlve0s-.

Address

192167 211142

347416822

To review the machine resource details, click the machine name.

Project

Create VM Pro]

Origin

Tags

& Discovered

& Discovered

@ Deployed

& Discavered

& Discovered

&) Discovered

& Discovered

The useful details in this example include the storage, network, and custom properties.
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Virtual Machines o)

Name

@) mem-20211203215331-000020 X

t @ vm-acministrator-VLDX..

VM State » On
Address 34.74168.22
Account / region ) yingzhi-GCP / us-east
t @ vm-administrator-7COL.
Origin & Deployed
@ vm-administrator-Q628
Deployment Google Cloud Create VM_66d0315-ddc8-415d-9e1e-563¢f49a836d
vm-acministrator-88JM..
@ vm-administrator-BE. Tags
t @B vm-administrator-7RGZ Volumes
@ vm-acministrator-BON Name C= U=
B vm-administrator-2M3. create-y 598563851 4GB HDD

! @ vm-administrator-8SKX mem-20211203215331-000020 1068 HDD
Networks
Name Address Assignment Type
default 10142.0.56 dynamic
ministrator-757X. Custom Properties
Name Value
! @ Load-Balancer-NSX-Uni
resourceld 3b43b1a6-105c-4d68-8562-184d545d07a0
f @ e2e-a8n-mcm345178-18.. :_overlapping_migrated true

p a-7354-4dc2-afd5-718755917230

: @ mcm-20211203165342-

-b

us-e

» | 1 1 Load-Balancer-NSX-Uni. environmentName Google Cloud Platform
@ TinvWin7-LinkedClone- v providerld 1393403671 083
120/ 3555 > d /resources/compute/3b43b1a6-105¢c-4d68-8562-1840545d07a0

Tutorial: Setting up and testing vSphere infrastructure and
deployments in Cloud Assembly

If you are new to vRealize Automation or only need a refresher course, this tutorial guides you
through the Cloud Assembly configuration process. You add cloud vSphere account endpoints,
define the infrastructure, add users to projects, and then design and deploy a workload by using
VMware Cloud Templates based on vSphere resource types, learning the process along the way.

Although this tutorial is just the beginning, you are on the path to delivering self-service
automation and iterative development that works across multiple public and private clouds. This
tutorial focuses on VMware vCenter Server and NSX-T. After you finish this workflow, you can
apply what you've learned to add more types of cloud accounts and deliver more sophisticated
cloud templates.

As you work your way through the steps, we provide data examples. Replace the examples with
values that work in your environment.

You perform all the steps in this tutorial in Cloud Assembly.

This configuration process is the foundation of your Cloud Assembly development experience. As
you build your infrastructure and mature your cloud template development skills, you will repeat
and expand on this workflow.

What to do first

m  Verify that you have the Cloud Assembly Administrator role. See Organization and service user
roles in vRealize Automation.
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If you have not used the VMware vCenter Server or the VMware Cloud Foundation Quickstart
wizards in the vRealize Automation console, you can do so now.

These wizard-driven workflows include most but not all of the configuration in this tutorial.

This tutorial is a hands-on experience that adds to your understanding of how to put together
a working infrastructure and deploy a workload.

See How do | set up Cloud Assembly in the Getting Started guide.

If you have not yet used the guided setup that is available in Cloud Assembly, you can do it
now. The guided setup takes you through most but not all of the procedures that you do in this
tutorial. To open the guided setup, click Guided Setup on the right side of the tab bar.

Ensure that you have vCenter Server and NSX credentials. For more information about the
permissions that the credentials must have, see Credentials required for working with cloud
accounts in vRealize Automation. If you plan to add additional users to projects, verify that
they are members of the Cloud Assembly service.

Step 1. Add the vCenter Server and NSX cloud accounts

The cloud accounts provide the credentials that vRealize Automation uses to connect to vCenter
Server and the associated NSX server.

1

Add the vCenter Server cloud account.

The vCenter Server cloud account provides the vCenter credentials that Cloud Assembly uses
to discover resources and deploy cloud templates.

For additional information about vCenter Server cloud accounts, see Create a vCenter cloud
account in vRealize Automation.

a Select Infrastructure > Connections > Cloud Accounts.
b Click Add Cloud Account and select vCenter.

¢ Enter the values.

VMware, Inc. 20
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&% New Cloud Account

MName *

Description

vCenter Server Credentials

vCenter IP address / FQDN *
Username *

Password *

Configuration

Allow provisioning to these

datacenters *

NSX cloud account

Capabilities
Capability tags

ADD CANCEL

vCenter Server Account

e

sc2vc05.cmbulocal

mgmt@cmbulocal

|@ Credentials validated successfuly by

wld01-DC

Create a cloud zone for the selected datacenters

Q) Search for cloud accounts

©

Remember that these values are only examples. Your values will be specific to your

environment.

Setting
Name

vCenter IP address / FQDN

Username and Password

Sample Value

vCenter Server Account

your-dev-vcenter.company.com

vCenterCredentials@yourCompany.com

d To verify the credentials, click Validate.

e To Allow provisioning to these datacenters, select one or more data centers.

f  Skip the NSX cloud account. We'll configure that later, linking the vCenter Server account
to the NSX cloud account.

g Click Add.

2 Add an associated NSX cloud account.

The NSX-T cloud account provides the NSX-T credentials that Cloud Assembly uses to
discover network resources and deploy networks with cloud templates.
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For more information about NSX-T cloud accounts, see Create a vCenter cloud account in
vRealize Automation.

a Select Infrastructure > Connections > Cloud Accounts.
b Click Add Cloud Account and select either NSX-T or NSX-V. This tutorial uses NSX-T.

c Enter the values.
& New Cloud Account

Name * NSX-T Account

Description

NSX-T Credentials

NSX-T IP address / FGDN * sc2vc05-vip-nsx-mamt.cmbulocal (6]

Username * mgmt@cmbulocal

Password * = sesem

NSX mode Policy @
| Credentials validated successfully o

Associations

vCenter cloud accounts + ADD
|:| Mame + Status Identifier Type
[0 (@ vCenter Server Account &) OK sc2vel vCente
Capabilities

Capability tags Enter capability tags

These values are only examples. Your values will be specific to your environment.

S]

Setting Sample Value

Name NSX-T Account

vCenter IP address / FQDN your-dev-NSX-vcenter.company.com
Username and Password NSXCredentials@yourCompany.com
NSX mode Don't know what to select?

Here's a great opportunity to use the in-product help.

Click the information icon to the right of field. Notice
that the field-level help includes information that can
help you configure the option.

In this example, select Policy.

d To verify the credentials, click Validate.

e To associate the vCenter cloud account you created in the previous step, click Add and
then select the vCenter Account.
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This vCenter cloud account association ensures network security.

f  Onthe NSX cloud account page, click Add.

Step 2: Define the cloud zone compute resources

The cloud zones are groups of compute resources in an account/region that are then made
available to projects. The project members deploy cloud templates by using the resources in
the assigned cloud zones. If you want to have more granular control over where project cloud
templates are deployed, you can create multiple cloud zones with different compute resources.

Account/regions are how cloud vendors tie resources to isolated regions or datastores. The
account indicates the cloud account type and the region indicates the region or datastore. vCenter
Server uses datastores and the provisioning resources are the selected clusters and resource
pools.

For this tutorial, you must ensure that the cloud zones include the resources that support the goals
of the project development team, and your budget and management requirements.

For more information about cloud zones, see Learn more about Cloud Assembly cloud zones.
1 Select Infrastructure > Configure > Cloud Zones.

2 Click the cloud zone that was added for your vCenter Server instance and enter the values.
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@\ vCenter Account Cloud Zone

Summary Compute Projects

A cloud zone defines a set of compute resources that can be used for provisioning.

Account / region * (& vCenter Account / wid01-DC

MName * vCenter Account Cloud Zone

Description

Placement policy * DEFAULT - @D
Folder Q) Select folder @
Capabilities

apability tags are effectively applied to all compute resources in this cloud zene, but only in the context of this cloud zone.

Capability tags Enter capability tags

e

SAVE CANCEL

Setting

Account / region

Name

Description

Policy

Sample Value

vCenter Account / data center name

vCenter Server Cloud Zone

This value cannot be changed after you create it. If you
want to configure a different data center for a different
vCenter Server, you must create a new cloud zone
where you can select the account/region.

All vCenter Server compute resources for development.

Default

Don't forget to consult the help if you have questions
about a field value.

Remember that all values are only examples. Your zone specifics will be specific to your

environment.

3 Click the Compute tab and verify that the compute resources are all present.

If you need to exclude one, switch to Manually select compute and add only the ones you

want to include in the cloud zone.
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@\ vCenter Account Cloud Zone
Summary Compute Projects
All compute resources listed apply to this cloud zone. Use the filter to add or remove resources from the list.

Include all compute

GJ

Include all compute

Account / Region Type Tags
Manually select compute

u] vCenter A Supervisor Cluster
Dynamically include compute by tags
TOOT-CIUOT7 DEvETOpIETTT @ vC int / wido1-DC Resource Pool
widO1-cluQ1 / Production [ v ccount / wid01-DC Resource Pool
wldO1-clu01 / Training-Org _;l Resource Pool
_edge-widclu- L‘] Vi Resource Pool
Pool_ffaldb18-82b5-4261-b546-
19

SAVE CANCEL

4 Click Save.

5 Repeat the process for any additional cloud zones, but you must ensure unique zone names.

Step 3: Configure the possible resources that are available for the
account/region

You added the account/region to the cloud zone. Now you define the possible machine sizes
(flavor mappings), image mappings, network profiles, and storage profiles for the cloud account.
The mapping and profile definitions are evaluated for a match when you deploy a cloud template,
ensuring that the workload includes the appropriate machine size (flavor), image, networks, and
storage.

1 Configure the flavor mappings for the account/regions.

Flavors are sometimes referred to as t-shirt sizing. Depending on how your cloud template is
configured, the applied flavor mapping determines the number of CPUs and memory.

For more information about flavor mappings, see Learn more about flavor mappings in
VvRealize Automation.

a Select Infrastructure > Configure > Flavor Mappings.

b Click New Flavor Mapping and enter values that define small, medium, and large
machines.

Remember, these are sample values. You must select relevant account/regions and define
the sizing.
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Iﬁ small oetete

Allows you to define flavors by name in a cloud-agnostic way. @)
Flavor name * small
Configuration * Account / Region Value
Q, (3 vCenter Account / wid01-DC 2 1 GB [-1+]
Setting Sample Value
Flavor name small
Account/region vCenter Account / data center
CPU value 2
Memory value 1GB

¢ Click Create.

d To create additional sizes, configure medium and large flavor mappings for the account/

region.
Setting Sample Value
Flavor name medium
Account/region vCenter Account / Datacenter
CPU value 4
Memory value 2 GB
Flavor name large
Account/region vCenter Account / Datacenter
CPU value 8
Memory value 4 GB

2 Configure the image mappings for the account/regions.

The images are the operating system for machines in the cloud template. When you are
working with vCenter Server images, you select vCenter templates.

For more information about image mappings, see Learn more about image mappings in
vRealize Automation.

a Select Infrastructure > Configure > Image Mappings.
b Click New Image Mapping and search for the images for the account/region.

Remember, these are sample values. You must select relevant images that were
discovered in your account/region.
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Eé} centos beLete

Allows you to define images or machine templates by name in a cloud-agnostic w.

Image name * centos

ay. @

Configuration * Account / Region

O, (3 vCenter Account / widt

Image

Q, centos7

Constraints Cloud Configuration

Example: license:nons: (@) + ADD [-1+]

Setting

Image name
Account/region

Image

¢ Click Create.

Sample Value

centos

vCenter Account

centos?7

d Repeat the process to create additional image mappings. For example, an ubuntu
mapping for the account/region.

3 Configure network profiles.

Network profiles define the networks and network settings that are available for an account/
region. The profiles must support the target deployment environments.

This task provides the minimum configuration information for success. If you want more
information about network profiles, start with Learn more about network profiles in vRealize

Automation .

a Select Infrastructure > Configure > Network Profile.

b Click New Network Profile and create a profile for the vCenter Account / Datacenter

account/region.
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¢ Network Profile  oeiee

——

Summary Networks Network Policies Load Balancers Security Groups

A network profile defines a group of networks and network settings used when machines are provisioned.

Account / region [ vCenter Account / wid01-DC
Name * Network Profile
Description Metworks for development teams.
2

Capabilities

Capability tags listed here are matched to constraint tags in the cloud template.

Capability tags E @®
Setting Sample Value
Account/region vCenter Account / Datacenter
Name Network Profile
Description Networks for development teams.

¢ Click the Networks tab and click Add Network.

O Network Profile
Summary Networks Network Policies Load Balancers Security Groups
Networks listed here are used when provisioning to existing, on-demand, or public networks. (@)

O Name 4+ T Account/Region Zone Vo R T cor V| S v || B T origin Tags T

DevProject--004 @ :?PX'T/| cv; Z 192168.1.64/27 - - <® Deployed
o Thamt cmb ocal
(m] ® !§2(-T'I s 172.16.1.64/28 - - & Discovered
o Mamt ezt cal
O NSX-T overlay-fz- 10.244.00/28 - - & Discovered external_idE.

5 ® nccount SC2VCO5-Vip-nsx-
2772-43 a- mgmt cmbu local
&ddc05635996-
vmware-system-

d Select the NSX networks that you want to make available for the application development
team.

In this example, we had an NSX-T network named DevProject-004.

e Click the Network Policies tab and create a policy.
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¢33 New Network Profile

alation policy

Metwork Resources

T -0 logical ruter

Edge clustes 0 eene-wiaorl

Setting Sample Value
Isolation policy None

Tier-0 logical router Tier-O-router
Edge cluster EdgeCluster

f  Click Create.
4  Configure storage profiles.

Storage profiles define the disks for an account/region. The profiles must support the target
deployment environments.

If you want more information about storage profiles, see with Learn more about storage
profiles in vRealize Automation .

a Select Infrastructure > Configure > Storage Profile.

b Click New Storage Profile and create a profile for the vCenter Server/Datacenter account/
region.

Unless specified in the table, keep the default values.
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& Storage Profile

Account / region
Name *

Description

Disk type *
Storage policy
Datastore f cluster
Provisioning type
Shares

Limit IOPS

Disk mode

Capability tags

Setting

Account/region

Name

Datastore/cluster

&) vCenter Account / wid01-DC

Storage Profile

© Standard disk () First class disk (FCD} @

Datastore default

Q) wid01-sc2vc05-wid01-cludl-vsanO1

Unspecified

Unspecified

)

Dependent

S}

[C] Supports encryption (D)

Preferred storage for this region (D

]

Preferred storage for this region

¢ Click Create.

Step 4: Create a project

Sample Value

vCenter Account / Datacenter

Storage Profile

Selected a datastore with sufficient capacity and that
is accessible to all the hosts.

Select the check box.

This is where you really begin thinking about the project goals.

m  What users need access to the compute resources so that they can create and deploy an
application cloud template? For more information about what the different project roles can
see and do, see Organization and service user roles in vRealize Automation.

= Will the members of the project be creating applications that go from development to

production? What are the necessary resources?

= What cloud zones do they need? What priority and limits should be placed on each zone for

the project?

For this tutorial, we are going to support the Development team as they create and extend an

in-house software application.
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This task provides the minimum configuration information for success. If you want more
information about projects, start with Learn more about Cloud Assembly projects.

1 Select Infrastructure > Administration > Projects.
2 Click New Project and enter the name Development Project.
3 Click the Users tab, and then click Add Users.

You are not required to add users at the time. But if you want other users to work with cloud
templates, they must be a member of the project.

4  Enter email addresses to add users as project members or administrators, depending on what
permissions you want each individual to have.

Add Users

Users EE @

Assign role & Alex Orlander - alex

CANCEL

5 Click Provisioning and click Add Zones > Cloud Zone.
6 Add the cloud zones that the users can deploy to.

You can also set resource limits for the cloud zone in the project. In the future, you can set
different limits for other projects.

Add Cloud Zone X
Add a cloud zone that can be used by this project.
Cloud zone * Q, vCenter Server Account / wid01-DC
Provisioning priority 1 @
Instances limit 5 6]
Memory limit (MB) o @
cPU mit o [6)
Storage limit (GB) o @

=3
Project Cloud Zone Setting Sample Value
Cloud Zone vCenter Account Cloud Zone
Provisioning priority 1
Instance limit 5

7 Add any additional cloud zones to the project.

8 Click Create.
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9 To verify that the project was added to the cloud zone, select Infrastructure > Configure >
Cloud Zones and open the vCenter Account Zone cloud Zone card so that you can examine
the Projects tab. You should see the Development Project.

Step 5: Design and deploy a basic cloud template

You design and deploy the cloud template to ensure that your infrastructure is properly
configured to support the template. Later you can build on the template as you create an
application that meets your project needs.

The best way to build a cloud template is component-by-component, verifying that it deploys
between each change. This tutorial starts with a simple machine and then iteratively adds more
resources.

The examples in this procedure use the YAML code editor. It is an easier way of providing you with
code snippets. However, if you prefer a use dialog box-driven user interface, click Inputs.

There is so much more that you can do with cloud templates than is provided in this tutorial. If you
want more information, start with Chapter 6 Designing your Cloud Assembly deployments.

This tutorial uses vSphere and NSX resource types. These resource types can be deployed only
on vCenter Server cloud account endpoints. You can also use the cloud agnostic resource types to
create cloud templates that can be deployed on any endpoint. For an example of how to configure
the infrastructure and design the template for any endpoint, see Tutorial: Setting up and testing
multi-cloud infrastructure and deployments in Cloud Assembly.

For a video that illustrates the basic steps in this procedure, see How to design and deploy a
basic cloud template.

1 Select Design > Cloud Templates.
2 Select New From > Blank Canvas.

3 Enter the Name Development Template, select the Project Development Project, and
click Create.

4 Add a vSphere machine to the design canvas, test, and deploy.
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Development Template SETTINGS  VERSION HISTORY  ACTIONS v

« S & @ @ [ ®  Code  Properties  Inputs

1 formatVersion: 1

@) Supervisor Namespz «
~ vSphere

& Machine

ubuntu =che

g . 8 FLavor:
@ Network .

v NSX

B2 Gateway

- Cloud_vSpher.. }
o Load Balancer & _vspl :

@ Network
v AWS

B Instance

a From the resource type pane, drag a vSphere Machine to the canvas.

Notice that the Code pane shows the YAML for the machine, with and empty value for
image and predefined CPU and memory properties. You are going to make this template
able so support flexible sizing.

b To select an image value, put your pointer between the single quotes for image and select
centos from the list of images that you configured.

Remember, these are sample values. If you did not configure a centos image, select an
image that you did configure.

c Create a line below the image property and enter or select flavor, then select the small
from the list.

d Delete cpuCount and totalMemory.

Your YAML should look similar to this example.

formatVersion: 1
inputs: {}
resources:

Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:

image: centos

flavor: small

e Click Test.

Test allows you to validate the syntax and placement of your cloud template. A successful
test does not mean that you can deploy the template without errors.
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&
X

Test Result for Development Template

(" Successful )
This simulation only tests syntax, placement and basic validity

(1infe ) & Provisioning Diagram

~ Cloud_vSphere_Machine_1 @

LINE 4

If the test fails, click Provisioning Diagram and look for the failure points. For more
information about using the diagram to troubleshoot, see Test a basic cloud template.

Click Deploy.
Enter Deployment Name as DevTemplate - machine and click Deploy.

You can track the progress of the deployment on the DevTemplate deployment details
page or on the Deployments page. Select Resources > Deployments.

If the deployment fails, you can troubleshoot the problem and revise your template. See
What can | do if a Cloud Assembly deployment fails.

A successful deployment looks similar to this example on the Deployments page.

Topology History

D), Search resources A . gom ;{o = & @ 0. »
Cloud_vSphere_Machine_1 acTions~
v  General
Resource name DevProject—030
@ Cloud_vSpher Account / Region (5] vCenter Account/widO1-DC
Status > On

5 Version the template and add a network.

Versioning a cloud template is required to make it available in the Service Broker catalog, but
it is useful to have a good version to revert to during development.

a

b

Open the template in the design canvas.

Click Version, enter a Description similar to Simple deployable machine, and click
Create.

From the resource type pane, drag an NSX Network resource type to the canvas.
Connect the machine to the network.

Click the small circle on the machine component and drag the connection to the network.
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y. @ Cloud_vSpher..

&) Cloud_NSX_

Notice that the YAML now looks similar to this example.

formatVersion: 1
inputs: {}
resources:

Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:

image: centos
flavor: small
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
attachedDisks: []

Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:

networkType: existing

e Click Test to validate the template.
f  Click Deploy.
g Enter the name DevTemplate - machine - network and click Deploy.
h  Track the progress and review the successful deployment.
6 Version the template and add data disk.
a Open the template in the design canvas.
b Version the template.

Enter Machine with existing network as the description.

c From the resource type pane, drag an vSphere Disk resource type to the canvas.

d Connect the disk to the machine.

D Cloud_vSpher.. : ¢——= @ Cloud_vSpher... :

) Cloud_NSX_N.. }
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Notice that the YAML now looks similar to this example.

formatVersion: 1
inputs: {}
resources:
Cloud_vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 1
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: small
networks:
- network: 'S$S{resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: '${resource.Cloud vSphere Disk 1.id}'
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: existing

e Test the template.
f  Deploy the template using the name DevTemplate - machine - network - storage.
g Track the progress and review the successful deployment.
h  Version the template.
Enter Machine with existing network and storage disk as the description.

This final version ensures that you can add a working template to the Service Catalog.

Tutorial results

You completed the workflow that configured Cloud Assembly as a working system. You are now
familiar with the following concepts.

m  Cloud accounts are the credentials that connect Cloud Assembly to your cloud vendor
endpoints.

m  Cloud zones are the selected compute resources in account/regions that you then assign to
different projects based on the project needs and your goals for managing costs.

m Infrastructure resources are definitions of resources associated with account/regions that are
used in cloud templates.

m  Projects are how you give your users access to the cloud zones based on the project's
application development goals.

m  Cloud templates are the definitions of your application workloads that you iteratively develop
and deploy.
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This tutorial is the foundation of your Cloud Assembly development experience. You can use this
process to build your infrastructure and mature your cloud template development skills.

Tutorial: Configuring Cloud Assembly to provision a
production workload

As a cloud administrator, you want to automate the deployment process for a project so that when
the cloud template designers are creating and deploying templates, Cloud Assembly does the
work for you. For example, the workloads are deployed with a particular custom machine naming
pattern, the machines are added to a specific Active Directory organizational unit, and specific
DNS and IP ranges are used.

By automating the process for the project deployments, you can more easily manage multiple
projects across various data centers and cloud environments.

You are not required to complete all of the tasks provided here. You can mix and match any of
these tasks, depending on your management goals.

Before you begin

This tutorial requires you to have your infrastructure configured and to have successfully deployed
a cloud template with a machine and a network. Verify that the following are already configured
on your system.

m  You successfully performed all of the steps specified in the infrastructure tutorial. See Tutorial:
Setting up and testing vSphere infrastructure and deployments in Cloud Assembly.

m  You have the Cloud Assembly Administrator role. See Organization and service user roles in
VRealize Automation.

Customize the machine names

The goal of this task is to ensure that the deployed machines for the Development project are
named based on the costcenter for the project, the resource type selected at deployment time,
and incremented numbers to ensure uniqueness. For example, DevProject-centos-021.

You can adapt this example to your naming requirements.

For more about projects, see Chapter 5 Adding and managing Cloud Assembly projects.

For a video that illustrates this custom naming example, see How to create a custom naming
template for deployments.

1 Select Infrastructure > Projects.
2 Select an existing project or create a new one.
For this tutorial, the project name is Development Project.

3 Click Create.
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4 On the Projects page, click the project name on the tile so that you can configure the project.

5 Click the Users tab and add the users who are members of this project.

6 Click the Provisioning tab.

a Inthe Zones section, click Add Zone and add the possible cloud zones where the
workloads are deployed for this project.
b Inthe Custom Properties section, add a custom property with the name costCenter and
the value DevProject.
Define custom properties Name Value Encrypted
costCenter DevProject [-T+]
Custom Naming
Specify the naming template to be used for machines, networks, security groups and disks provisioned in this project.
Template s{resuur:e.mstcrenrtrer}r-?{resu;r;(e.instajledﬂf?js(it}::: CD
¢ Inthe Custom Naming section, add the following naming template.
S{resource.costCenter}-${resource.installedOS}-S {###}
The ${resource.installed0S} is based on the operating system selected when you deploy
the cloud template.
7 Click Save.

8 Update the cloud template with an input value for the operating system type.

Input values are the direct way that you can customize the deployment request form for users
and simplify your development process. By creating input values, you can use a single cloud
template to deploy workloads with different configurations. For example, size or operating
system.

This example uses the Development Template from a previous tutorial. See Step 5: Design and
deploy a basic cloud template.

a

b

Select Design and open the Development Template.
In the Code pane, update the YAML with the following changes.
m Inthe Inputs section, add installedOS.

In the next step you can see that installedos input is also used to specify the image.
When you add the strings in the enum section, the values, in this example they are
centos and ubuntu, must match the image names that you defined in Infrastructure >
Configure > Image Mappings. For example, if your image mapping name is CentOS
rather than centos, you should use CentOS in the inputs section.

inputs:
installedOS:
type: string

VMware, Inc. 38



Using and Managing vRealize Automation Cloud Assembly

title: 0OS Type
description: Select the operating system.
enum:

- centos

- ubuntu

m  Inthe cloud vSphere Machine 1 section, update the image to an installedOS input
parameter (${input.installed0s}) and add an installedOS custom property with the
same input parameter.

resources:
Cloud vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 1
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: ${input.installedOS}
installedOS: ${input.installedOS}
flavor: small
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}"'
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:

networkType: existing

c Click Deploy and enter the name Custom name deployment test.

d Click Next.
e Select the centos operating system from the drop-down menu.
Deploy Development Te... Deployment Inputs

1 Deployment Type
Operating system *

2 Deployment Inputs

CANCEL PREVIOUS DEPLOY

f  Click Deploy.

9 Track the progress and review the successful deployment.
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The machine name in this example is DevProject-centos-026. Just a reminder, this example is

based on the tutorial referenced at the beginning of this task.

Topology History

Search resources A 238 55{0

@ Cloud_NSX_N.

Create Active Directory machine records

ESERRCRIO]

»

Cloud_vSphere_Machine_1 acTions ~

D Cloud_vSpher... @ Cloud_vSpher...

v General

Resource name DevProject-centos-040

Account / Region ‘_ijeﬁter
Account/wldQ1-DC

Status [>0On

Address

When you provision a workload, you can create machine records in Active Directory. By

configuring Cloud Assembly to perform this task automatically for a project deployments, you
have lightened your own workload as the cloud administrator.

1 Add an Active Directory integration.

a Select Infrastructure > Connections > Integrations.

These steps cover the basic Active Directory configuration that is related to this AD

machine records tutorial. For more about the Active Directory integration, see How do

| create an Active Directory integration in Cloud Assembly.

b Click Add Integration and click and click Active Directory.

«
Image Mappings -
Network Profiles
Storage Profiles
Pricing Cards
Terraform Versions
Tags
£ Resources v
Compute
Networks
Security
Storage
Machines
Volumes
Kubernetes
Activity v
Requests
Events Log

& Connections v

c Enter the name that you are using for this integration.

d Enter the LDAP host / IP and the associated credentials.

e Enter the Base DN

VMware, Inc.

¢# Active Directory Integration

summary Projects

Status
@ oK

@D Activate integration (@)

Name * Active Directory Integration

Description

Active Directory Credentials

LDAP host / IP Idap://cmbu-sc2dc-01.cmbu.local:389

Running environment embedded-ABX-onprem

Username cmbuhadministrator
Password
Base DN * ou=AppDev,dc=cmbu,dc=local

(@ validate credentials before

making changes

VPPV VVVVVVVVVVVVVVVVVVVVVVVVVVVV VYV VVVVVVEVVVVV VIV VPPV VvV
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2
3

In this tutorial the example is ou=AppDev,dc=cmbu,dc=1local. AppDev is the parent OU
for the computer OU that you will add for the project.

f  Click Add.
Add the project to the integration.
In the Active Directory integration, click the Projects tab and click Add Project.

Add Projects

Select a project and the OU it will be mapped to by adding its relative DN. The effective DN is created by appending the
RDN to the integration base DN (dc=cmbu,dc=local).

Project * Q, App development

Relative DN * ou=AppDev-Computers| @
Overrides * (P Allow cloud template to override relative DN path @
Ignores * (P Allow cloud template to skip adding machines to Active Directory (D)

Constraints
The policy is applied only when at least one of the following criteria is matched

Tags Enter tags @

Matching zones

CANCEL m

a Select the App Development project.
b Enter the relative DNs. For example, OU=AppDev-Computers.
¢ Leave the Overrides and Ignores switches turned off.

This procedure is focused on automating the process for a project. It is not about
customizations that you can do in templates.

d Click Add.
To save your changes to the integration, click Save.

Deploy a cloud template for the project and verify that the machine added to the correct
Active Directory OU.

Set your network DNS and internal IP range

Add or update a network profile to include your DNS servers and internal IP ranges.

You must have already created a cloud account for vSphere, NSX-V, or NSX-T. See Tutorial:
Setting up and testing vSphere infrastructure and deployments in Cloud Assembly or Adding
cloud accounts to Cloud Assembly.

1
2

Select Infrastructure > Configure > Network Profiles.
Select an existing profile or create one.
On the Summary tab, select an Account/region and enter a name.

For this tutorial, the network profile name is Network Profile.

VMware, Inc. 41



Using and Managing vRealize Automation Cloud Assembly

4  Add networks.
a Click the Networks tab.
b Click Add Network.
¢ Add one or more NSX or vSphere networks.
d Click Add.
5 Configure the DNS servers.

a Inthe networks list on the Networks tab, click the network name.

sSummary Networks Network Policies Load Balancers Securi-

Networks listed here are used when provisioning to existing, on-demand, or L.

ADD NETWORK

= Named | | Account/ Zone Network T oo
Region Domain
[ ]| DevProject NSX-T overlay-tz- 192.168.1.64
--004 @ Accoun sc2vc05- 127
t Vip-nsx-
mgmt.cmb
ulocal

b Enter the DNS server IP addresses you want this network to use.

DevProject--004

J DNS Servers
DNS servers 192168122

192168.1.23 ‘ Use a comma separated list or new lines.

DNS search companylecal @
domains

c Click Save.
6 Specify the IP range for the network.

a Inthe networks list, select the check box next to the network name.
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O Network Profile  oetere

Summary Networks Network Policies Load Balancers

Networks listed here are used when provisioning to existing, on-demand, or public networks. @

| + ADD NETWORK £ TAG ¥ MANAGE IP RWES | . REMOVE
S
C T z T Network T
Name + Account / Region Zone Domain
(1 External- @ NS%T overlay-tz-
mcm1343745- Account sC2vc05-vip-
148168716643 nex-
mgmt.cmbulo
cal
] Nsx- @ NSX-T overlay-tz-
memi376447- Account sc2ve05-vip-
151082888186 nsx-
mgmt.cmbulo
cal
a NSX- G VST overiay-tz-
mcm39835- Account sc2vc05-vip-
146434698964 NSx-
mgmt.cmbie o
cal
B m

b Click Manage IP Ranges.

¢ Inthe Manage IP Ranges dialog box, click New IP Range.

New IP Range

Network *

Source

Name *

Description

CIDR

Start IP address *

End IP address *

d Enter a name.

VMware, Inc.

© Internal () External

DevProject Range

Secunty Groups

cIDR i

17216.12.64/28

192.168.100.32/
28

192.168.1.0/27

192.168.100.32/28

192.168.100.34|

192.168.100.46

2
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For example, DevProject Range.

e To define the range, enter the Start IP address and End IP address.
f  Click Add.
g Add additional ranges or click Close.

Add the cloud zone containing the associated network account/region that you configured to

your Development project.

Deploy a cloud template for the project and verify that the machine is provisioned within the

specified IP range.

Tutorial: Using tags in Cloud Assembly to manage vSphere
resources

Tags are powerful metadata that you can associate with resources and include in templates. You
can use tags in a variety of management scenarios, including workload placement and resource

labeling.

Quick introduction to tags

This section is a simple introduction to tags as they apply to the provided steps. For more
in-depth information about tags, see How do | use tags to manage Cloud Assembly resources

and deployments.

Capability and constraint tags

You can use of tags to control deployments based on resource capabilities. For example,
as a cloud administrator you want the iteratively developed cloud templates to deploy to
a development-specific resource pool and the production worthy templates to deploy to a
different resource pool.

m  Capability tags are added to resources, defining their capabilities.

m  Constraint tags are used in cloud templates, defining what resources you want the
deployed resources to consume.

Label tags

To manage resources, you can add tags as object labels or descriptions. The management

possibilities include better resources searching results, differentiating between similar objects,

annotating objects with custom information, providing information to third-party systems,
creating security grouping membership criteria, ensuring consistency across linked SDDC
domains.
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Before you begin

m  Review the resources and cloud template defined in Tutorial: Setting up and testing vSphere
infrastructure and deployments in Cloud Assembly. The sample values used in that tutorial are
used here.

Using tags to manage Workload placement

This simple example uses development and production environment tags to demonstrate how

to use capability and constraint tags. First, you add capability tags on vCenter Server resource
pool compute resources, and then you include the tags in the cloud template. The cloud template
example demonstrates how to use inputs to let the deploying user select whether to deploy it to a
development or to a production resource pool.

For an example of how to use the same tags to define placement in a multi-cloud environment,
see Tutorial: Setting up and testing multi-cloud infrastructure and deployments in Cloud Assembly.

1 Add capability tags to resource pools.
a Select Infrastructure > Resources > Compute.

b Open the cloud zone and click Compute.

«

Terratorm Versions N Compute ==y
Tags il @C
& Resources e (] Name Account / Region Type Tags
Compute [J 1017615227 [ vCenter Account / widO1-DC  Host
Networks [ widot-cuot [ vCenter Account / wid0l-DC  Supervisor Cluster
Security -
(J  widOl-clu01 / Development [ vCenter Account/ wid01-DC  Resource Pool
Storage: -
(] widoi-cluot / Production [ vCenter Account/ wid01-DC  Resource Pool
Machines
(J  widOt-clu01 / Training-Org [ vCenter Account/ wid01-DC  Resource Pool

Volumes
(]  wldot-cluot / VCF-edge_edge-widclu-01_ResourcePool_ffal4bi8-8205-4261-b546- [ vCenter Account / wid0l-DC  Resource Poal
Kubernetes aefg6aldn2d9

¢ Locate and click the resource pool that you want to deploy development workloads to.

This tutorial uses the following sample values. Remember that these values are only
examples. Your values will be specific to your environment.

Sample resource pool Sample tag
widO1-cluO1/ Development env:dev
widO1-clu01/ Production env:prod

d Add the tag env.dev and click Save.
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1 widO1-cluO1/ Development

Account / region (5] vCenter Account / widO1-DC
Name widO1-clud1 / Development
Type VM_HOST

Tags envidev X Enter a new tag

SAVE CANCEL

e Repeat the process for the resource pool that you want to deploy production workloads to
and add the env:prod tag.

2 Verify that the capability tags were added to the resource pools in your cloud zone.

a Select Infrastructure > Configure > Cloud Zones.
b Open the cloud zone associated with the project and click Compute.

In this example, the cloud zone is vCenter Account Cloud Zone and the tags were added to
the two resource pools, widO1-cluO1/ Development and wid0O1-cluO1/ Production.

&«

. @A vCenter Account Cloud Zone ocee

& Administration ~

summary Compute Projects
Projects —

Users and Groups All compute resources listed apply to this cloud zone. Use the filter to add or remove resources from the list

Custom Roles
Include all compute v @
& Configure ~
Cloud Zones Name Account / Region Type Tags
Virtual Private Zones 10.176152.27 [ vCenter Account / wid01-DC Host
Kubernetes Zones wid01-clud1 [ vCenter Account / widO1-DC Supervisor Cluster
Flavor Mappings wid01-cludt / Development (& vCenter Account / wid01-DC Resource Pool envdev
Image Mappings
wid01-clud1 / Production [ vCenter Account / wid01-DC Resource Pool envprod
Network Profiles
widO1-cluQ1 / Training-Org [ vCenter Account / wid01-DC Resource Pool
Storage Profiles
wid01-clu01 / VCF-edge_edge-widclu- ) vCenter Account / widO1-DC Resource Pool
Pricing Cards 01_ResourcePool_ffalabig-82b5-4261- &

i re
b546-aef86aldb2d
Terraform Versions

3 Add constraint tags to the cloud template.
Constraint tags are used to limit where the template is deployed.
a Select Design > Cloud Templates and then open your template.
In this tutorial, the template name is Development Template.

b Review the YAML for the template in the Code pane.
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This YAML is the starting point for this tutorial.

formatVersion: 1
inputs: {}
resources:
Cloud _vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: medium
networks:
- network: 'S${resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: '${resource.Cloud vSphere Disk 1.id}'
Cloud_vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 5
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: existing

c Add the constraint tag to the Cloud_vSphere__Machine_1 resource using $

{input.placement} as a variable.

resources:
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: medium
constraints:
- tag: '${input.placement}’
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}'

d Define the placement variable in the Inputs section.

inputs:
placement:
type: string
enum:
- env:dev
- env:prod
default: env:dev
title: Select Placement for Deployment
description: Target Environment
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e Verify that the final YAML looks similar to the following example.

formatVersion: 1
inputs:
placement:
type: string
enum:
- 'env:dev'
- 'env:prod'
default: 'env:dev'
title: Select Placement for Deployment
description: Target Environment
resources:
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: small
constraints:
- tag: '${input.placement}’'
networks:
- network: 'S$S{resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: '${resource.Cloud vSphere Disk 1.id}'
Cloud_vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 5
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: existing

f To try out the tag variable against the available resources, click Test and then select

env:dev.
Testing Development Template X
Select Placement for env.dev W @
Deployment

CANCEL TEST

Repeat the test using env:prod. When both tests are successful, confirm that the template

works by deploying it.
4  Deploy the template to test the workload placement.
a Inthe cloud template designer, click Deploy.

b Enter Deployment Tag Dev as the Deployment Name and click Next.
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c Select env:dev in the Select Placement for Deployment drop-down menu and click
Deploy.

5 Verify that the template deployed the resources to the selected resource pool.
a Select Resources > Deployments and locate the Deployment Tag Dev deployment.
b Open the deployment details and click Topology.
c Click the vSphere machine and expand the machine information in the right pane.

d Inthe General section, locate Compute host and verify that the value matches the
resource pool that matches your env:dev tag.

In this example, the value is wid01-c1u01l / Development, illustrating that the workload was
deployed to correct resource pool based on the selected constraint tag.

Cloud_vSphere_Machine_1 acTions~

v General

& Cloud_NSX_N.

Resource name Cloud_vSphere_Machine_1-
mcm1013-162768195453

Account / Region _.] wCer Server
Account/wid01-DC
B cloud_vspher . ¢ [ Cloud_vspher
Status > ©On
Address

Compute host widO1-clud1 / Development

3

e Repeat the deployment process, this time select env:prod.

Adding tags as labels that you can use in vCenter Server and NSX-T
You can add tags to deployments that you can then use to manage resources.

In this example, you add tags to identify the MySQL machine and network. You also add a tag to
identify the web network. Due to how tags work on existing networks compared to on-demand
networks, you have two choices.

m [f you use the existing network profile that you used in the previous section, the NGINX:web
tag is not added to existing objects in NSX-T. So you can ignore the verification steps
regarding this tag in NSX-T.

m |f you create an on-demand network profile, you can update the network in the YAML to use
the routed/on-demand network. The on-demand network is used in this example so that we
can demonstrate the NGINX:web tag on the new object in NSX-T.

The following YAML is from the previous example except that it uses a routed on-demand
networkType. It includes the constraint tags.

This tutorial uses the following sample values. Remember that these values are only examples.
Your values will be specific to your environment.

formatVersion: 1
inputs:

placement:
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type: string
enum:
- 'env:dev'
- 'env:prod'
default: 'env:dev'
title: Select Placement for Deployment
description: Target Environment
resources:
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: small
constraints:
- tag: 'S${input.placement}’'
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}"'
Cloud vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 5
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: routed
constraints:

- tag: 'net:od'

1 Select Design > Cloud Templates and then open your template.

2 Inthe Cloud_vSphere_Machine_ properties, add the following tag.

tags:
- key: db
value: mysqgl

3 Add VM NIC tags.

tags:
- key: db
value: mysqgl

4  Add NSX logical switch/segment tags.

tags:
- key: NGINX

value: web
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5 Verify that the YAML looks similar to the following example.

formatVersion: 1
inputs:
placement:
type: string
enum:
- 'env:dev'
- 'env:prod'
default: 'env:dev'
title: Select Placement for Deployment
description: Target Environment
resources:
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: centos
flavor: small
constraints:
- tag: '${input.placement}'
tags:
- key: db
value: mysql
networks:
- network: 'S${resource.Cloud NSX Network 1.id}'
tags:
- key: db
value: mysql
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}'
Cloud_vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 5
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: routed
constraints:
- tag: 'net:od'
tags:
- key: NGINX
value: web

6 Deploy the template.
This example uses the name Development template w tags.

7 To verify the tags in the deployment, open the deployment and click the Topology tab.

a Click the machine in the topology.

b Expand the General section for the machine and locate the Tags label.

The tag value is db:mysql.
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c Expend the Network section and locate the network Tags column.

The tag value is db:mysql.

<8<> Development template w tags ¢ (Sestesucessul) sctions~ |

No description Owner fritz Expires on Never
Reguestor fritz Last updated Mar 8, 2021, 4:31:01PM
Project Development Project Created on Mar 8, 2021, 40914 PM

Cloud Template ~ Development Template &

HIDE SUMMARY A
Topology  History

Q, Search.resources

BHL@ *

|
>
£

4]

M

Cloud_vSphere_Machine_1 acTions~

@ Cloud_NSX_N v General
Resource name Cloud_vSphere_Machine_1-mcm1019-163638575175
G Cloud_vSpher >—+ {1 Cloud_vSpher Account / Region [ vCenter Server Account/wid01-DC
Status [>0On
Address
Compute host widO1-clu01 / Development
Tags do-mysal
> Storage

~  Network

Assignment Security

Index Mame Address  Type Groups Tags
Q DevProject- dynamic db:mysq
-004 -
q » ?> Custom properties

d Click the network in the topology and expand the General section to locate the Tag label.

The tag value is NGINX:web.

Topology  History

i #owm = & ae »
Cloud_NSX_Network_1 acmions
v General
Q;")(m NSX,
B coue_vspher. == @ Cloud_vSpher.

Custom properties

8 To verify the tags in vCenter Server, log in to the vCenter Server instance where this workload
was deployed.

a Locate the virtual machine and locate the Tags pane.
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vm vSphere Client Menu W

O, mysal

che-mcm485-158781591794

1444-160619868924
46-160619933367

em1007-1627660067.

m987-162759191026
mO05-162761722865

chine_2-005634

{5 DB-mcmia3

£ DB-mcmi336542-147536514030

0846519800

147466008039

¢ Cloud_vSphere_Machine_1-mcm1294-163799945783 i

Summary Monitor
-

Configure

Resource pool @ Development

Networks i Cloud_NSX
Storage B wido1-sc2vc05-widor
Tags
Assigned Tag Category
mysa b mys
Assign.

Permissions

Networks
[ VCIES K CITBUIoTaT

Description

Snapshots

vSphere HA
Failure
Host fallure
Proactive HA
Host Isolatien

Permanent Dev.

with All Paths Down

Guest not heartbeating

@ © ACTIONS v

Updates

No items to display

Response
v/ Restart VMs
© Dissoled

v Power off and restart

v Power off and resi

v Power off and restart

v Reset VMs

9 To verify the tags in NSX-T, log in to the NSX-T instance where this network is configured.
a Click Policy in the upper right corner.
b To locate the db:mysql tag associated with the NIC, search for mysql.
¢ Click Logical Ports and locate the deployed vSphere machine.

d Click the number in the Tags column.

The Scope and Tag are db and mysql respectively.

Home Networking Security nventory Plan & Troubleshoot System
Q. mysq| @ Bt x
@ ENTITES
A ual Machines Logical Ports Segment Po Tier-1 Gateway Lap ervice Entrie egmel ervice >
Name Resource Tags Last
Type Modified

Time.

> 5278f751-4687-1016-5a8f-e4434b931410/ My SGL-McM483-158447207 7 75.vmx @a2071736-e672-407d-bddb-3642bf97 0fc Logical o
Ports
(" Manager )

> 9a92fc5f-daBb-04bc-34fc-e4434] MySQL-mcm487-158781611315.vmx@cd00af3a-6cae-434{-8827-8468786 Logical o]
Ports

(m

> 9a3e4660-0889-6354-di4a-e4434b931410/Cloud_vSphere_Machine_i-mcm1019-16363857517@a2b71736-ee7e-407d-bd4b-a6420797e0fc Logcal : 2021/03/¢
Ports &, 0430
<M
5 33254960-4662-5020-83ef-24434b932080/Cloud_vSphera_Machine_1-mcmi294-16379994578@cd00af3a-6cas-434f-8827-8468786609d8 Seope Tas
ab mysq .
1 1-40f4

e To locate the NGINX:web tag associated with segment, search for the network.
In this example, the network name is Cloud NSX Network 1-mcml292-163799928607.
f  Locate the Segments row and click the number in the tags column.

The Scope and Tag are NGINX and web respectively.
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Home Networking Security nventory Plan & Troubleshoot System

Q. nginx Bt | %
) ENTITIES
< es Logical Port Segment Ports Tier-1 Gateways L4 Port Service Entries Segments Services Firewall F >

Name Resource Type Tags Last Modified Time Status Alarms
> NSX-mcm433-160593335982 Segments - 2021/02/M 1016 4 Success o]
- X
> NSX-mcm430-160592760432 Segments . Scope Tag P Success C o

db mysq;

Tutorial: Adding a Cloud Assembly cloud template to the
Service Broker catalog with a custom request form

During the iterative development of your cloud templates or when you have a final template,

you can make the templates available to consumers in the Service Broker self-service catalog. To
further enhance the user experience, you can create a custom request form. The customized form
is more powerful than the simple template input options.

What to do first

m  Verify that you have the infrastructure that supports the your template. If you do not, start with
Tutorial: Setting up and testing vSphere infrastructure and deployments in Cloud Assembly
and continue with the other tutorials.

m  Verify that you tagged some resource pools as env:dev and env:prod. For more information,
see Tutorial: Using tags in Cloud Assembly to manage vSphere resources.

m  Ensure that you have a deployable cloud template, similar to the one below. This tutorial starts
with the following template.

formatVersion: 1
inputs:
installedOS:
type: string
title: Operating System
description: Select the operating system.
enum:
- centos
- ubuntu
placement:
type: string
enum:
- 'env:dev'
- 'env:prod'
default: 'env:dev'
title: Select Placement for Deployment
description: Target Environment
resources:

Cloud vSphere Disk 1:
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type: Cloud.vSphere.Disk
properties:
capacityGb: 1
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: '${input.installedOS}"
installedOS: '${input.installedOS}"'
flavor: small
constraints:
- tag: 'S${input.placement}'
tags:
- key: db
value: mysqgl
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
tags:
- key: db
value: mysqgl
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}"'
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: existing
tags:
- key: NGINX

value: web

Step 1: Add inputs to the cloud template

In addition to the existing OS type input, this procedure updates the placement input and adds a
size input. When you customize the request form in Service Broker, these are the three fields on
the request form that are customized.

1 In Cloud Assembly, select Design > Cloud Template and create or open the template provided
above.

The sample template is used to explain the different options and includes sample values.
Adapt it to your environment.

2 Add the size variable and define the sizes in the Inputs section.

a Inthe Cloud_vSphere_Machine_1 section, add a variable to the fl1avor property.
flavor: '${input.size}"

b Inthe Inputs section, add a user input name size so that the user can select the size of the
deployment. This is sometimes referred to as the t-shirt size that you defined for the cloud

zones.

size:
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type: string
title: Deployment size
description: Select the the deployment t-shirt size.
enum:
- small
- medium

- large

3 Update placement inputs with a descriptive term rather than the tag strings.

These constraint tags will be matched with the capability tags that you added in Tutorial: Using

tags in Cloud Assembly to manage vSphere resources.

a Inthe Inputs section, add a user input named placement so that the user can select

development or production as the deployment placement.

This example uses the oneof attribute, which allows you to present a natural language
label while still submitting strings that the deployment process requires. For example, the

env:dev and env:prod tags.

placement:
type: string
oneOf:
- title: Development
const: 'env:dev'
- title: Production
const: 'env:prod'
default: 'env:dev'
title: Select Deployment Placement

description: Target Environment

4 Review the full YAML to ensure that it looks similar to the following example.

formatVersion: 1
inputs:
installedOS:
type: string
title: Operating system
description: Select the operating system.
enum:
- centos
- ubuntu
placement:
type: string
oneOf:
- title: Development
const: 'env:dev'
- title: Production
const: 'env:prod'
default: 'env:dev'
title: Select Deployment Placement
description: Target Environment

size:
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type: string
title: Deployment size
description: Select the the deployment t-shirt size.
enum:
- small
- medium
- large
resources:
Cloud vSphere Disk 1:
type: Cloud.vSphere.Disk
properties:
capacityGb: 1
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: '${input.installedOS}"
installedOS: '${input.installedOS}"
flavor: '${input.size}'
constraints:
- tag: 'S${input.placement}’'
tags:
- key: db
value: mysqgl
networks:
- network: 'S{resource.Cloud NSX Network 1.id}'
tags:
- key: db
value: mysqgl
attachedDisks:
- source: 'S{resource.Cloud vSphere Disk 1.id}'
Cloud NSX Network 1:
type: Cloud.NSX.Network
properties:
networkType: existing
tags:
- key: NGINX

value: web

5 Click Deploy, verify that the second page of the request looks similar to the following example,
and then you can verify that the deployment is in the selected development of production
resource pool after deployment.

Deploy Development Te... Deployment Inputs

1 Deployment Type
Operating system * centos

2 Deployment Inputs

Select Deployment Development

Placement

Deployment size *

CANCEL PREVIOUS DEPLOY
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Step 2: Version and release the cloud template

When you have a deployable template, you can now make it available in the Service Broker
catalog for other uses to deploy. To make the cloud template discoverable so that you can add it
to the catalog, you must release it. In this procedure we will version it, to capture a snapshot of the
template, and then release the template.

1 Select Design > Cloud Template and open the template in the design canvas.

2 Click Version and enter a description.

Creating Version X
Version * 7
Last Veersion: 6
Description Placement inputs added
and tested
A
Change Log
A
Release Release this version to the catalog

CANCEL CREATE

3 Select the Release check box and click Create.

Releasing the cloud template does not automatically add it to Service Broker. Releasing it
makes is discoverable so the you can add it to the catalog.

Step 3: Add the cloud template to the Service Broker catalog

You can use the Service Broker catalog to provide cloud templates to other consumers in your
organization where they don't need to have any awareness of how to create a template. The
catalog allows them to deploy the template.

Before you can add the template as a catalog item, you must import it into Service Broker. You
can only import released cloud templates.

1 To open Service Broker from Cloud Assembly, click the applications menu in the upper right
corner.
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> Code Stream

@f Orchestrator

Service Broker “

2 Click Service Broker.
3  Import the cloud template.
a In Service Broker, select Content and Policies > Content Sources.
b Click New and then select VMware Cloud Templates.
¢ Enter a Name.
In this tutorial, enter Cloud Assembly DevProject.
d For the Project, select the Development Project that you created in Cloud Assembly.
e Click Validate.
The system must indicate that it found at least one item.
f  When validated, click Create and Import.
Cloud Assembly DevProject is added to the list as a content source.
4 Make the cloud template available in the catalog.
a Select Content and Policies > Content Sharing.
b Inthe Project drop-down list, select Development Project.
¢ Click Add Items and then select
d Inthe Share Items dialog box, select Cloud Assembly DevProject and click Save.
5 To verify that the Development Template was added to the catalog, click Catalog.
6 Click Request on the Development Template card.

Notice that the inputs that you saw on the cloud template are provided here. The next step is
to customize the request form.
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New Request

@QDevelopment Template  wversion 8 ~

Project * Development Project

Deployment Name *

* P

Operating system

Select Deployment Development

Placement

Deployment size *

Step 4: Create a custom form for the template

The goal for this custom form is to provide a form where the user selects the operating system
and placement based on the env:dev or env:prod tags. Then the env:dev option allows the user to
select small or medium, large is not an option. However, if the user selects env:prod, there is not
option to select large, the size is hidden from the user but is included in the request.

1 To create a custom form in Service Broker, select Content and Policies > Content.

2 Click the vertical ellipsis to the left of the Development Template entry and click Customize
form.

3 Customize the input option.

a Inthe canvas, click fields in the canvas and configure the Properties as specified in the
following table.
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Canvas field name Appearance
Operating system Label and type
m  Label = Operating
system
Select Deployment
Placement
Deployment Size Visibility

m  Value source =
Conditional value

m  Setvalue = Yes if
Select Deployment
Placement Equals
env:dev

Values

Value options

m  Value options =
Constant

m Value source
= centos|
CentOS, ubuntu|
Ubuntu

This example uses

the value options to
customize the all lower
case operating system
names with the preferred
OS name.

Value options

m  Value options =
Constant

B Value source =
env:dev|
Development,env:pro

d|Production

Default value

m  Value source =
Conditional value

B Setvalue = large
if Select Deployment
Equals env:prod

Value options

m  Value options =
Constant

m  Value source
= small]|

Small, medium|Medium

Notice that the value
source does not include
large. Large is excluded
because it is only
available for Production
and is the required
value. The large value is
included in deployment
request without a user-
initiated action.

b To turn on the form in the catalog, click Enable.

¢ Click Save.

4 To ensure the correct results by submitting at least a Development Small and a Production

request, test the form in the catalog.

VMware, Inc.

61



Using and Managing vRealize Automation Cloud Assembly

Use following examples to verify the results.

a Test the Development Small request form by providing a name, Test small in this example,

and selecting CentOS, Development, and Small for the options.

New Request

@QDevelopmemt Template  wversion 8 ~

Project * Development Project

Deployment Name * Test small

Operating system * CentOS @
Select Deployment Development (‘;)
Placement

Deployment size * Small (&D)

b To verify the Development Small deployment, Select Resources > Deployments and click

the Test small deployment.

¢ Onthe Topology tab, click the Cloud_vSphere_Machine, and then locate the Custom

Properties section in the right pane.

A few of the values to review include cpuCount = 2 and flavor = small.

&> Test small » actions+ | @

No description owner Expires on Never
fritz Last updated May 21, 2021, 5:14:56 PM
Requestor Created on May 21, 2021, 4:52:38 PM
fritz
Project

Development Project
Cloud Template  Development Template, version: &
X

HIDE SUMMARY 7

Topology History

Q AV R EBEE DL @ Q ¥
costCenter
& Cloud_NSX_N .|. cpuCount
datastoreName
D Cloud_vSpher ._ endpointld
flavor

image

DevProject

2
wid01-sc2vc05-wid01-clul
d827e01c-df9e-4c80-9fld
small

centos ‘

d Test the Production request form by entering a name, Test large in this example, and

select CentOS and Production for the options.

Remember, you configured the form to neither display nor require the user to select the

size.
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New Request

@QDevelopment Template  Version 3 ~

; =
Project Development Project
Deployment Name * Test large

i ® ™
Operating System Centos @

Select Deployment

=)
L

Production

Placement

e To verify the Production deployment, select Resources > Deployments and click the Test
large deployment.

f  Onthe Topology tab, click the Cloud_vSphere_Machine, and then locate the Custom
Properties section in the right pane.

A few of the values to review include cpuCount = 8 and flavor = large.

&> test large 2 acrions+ | C

No description owner Expires on Never
fritz Last updated May 21, 2021, 5:14:56 PM
Requestor Created on May 21, 2021, 4:53:05 PM
fritz
Project

Development Project
Cloud Template = Development Template, version: 6
X

HIDE SUMMARY #

Topology History

Q rvldmE AL @ ?
costCenter DevProject
cpuCount 8
C Cloue NS T datastoreName widQ1-sc2vc05-widO1-clul
endpointld d827e01c-df9e-4c80-9fid
D Cloud_vSpher... 9 @ Cloud_vSpher. flavor arge
mage centos
mageld centos?

Step 5: Control the cloud template versions in the catalog

In most cases, you want to make only the latest cloud templates available in the Service Broker
catalog. The following procedure supports iterative development, where you release a version of
template and add it to the catalog, but now you improved the template and want to replace the
current version with the newer version.
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In step 2, you versioned and released a template, so you are familiar with the process. In step
3, you added it to the catalog. The procedure ties the two steps together as you do iterative
development and update the catalog with the latest version.

You do have the option to make multiple versions available in the catalog.

1 In Cloud Assembly, version the template that you now want to make available in the catalog.

a

b

Select Design > Cloud Template and open the template in the design canvas.
Click Version History.

Locate the version that you want to add to the catalog and click Version.
Enter a Description, select the Release check box, and click Create.

At this point, you have the option to keep the old version in the catalog. If you want
multiple versions, ignore the next step where you Unrelease a version.

To make only one version of the template available in the catalog, review the version
history list and click Unrelease on every version that you don't want in the catalog.

2 To update the Service Broker catalog with the latest version, and to replace any old version,
you must collect the new version.

a

b

d

In Service Broker, select Content and Policies > Content Sources.

Click the Cloud Assembly DevProject content source that is used in this tutorial.
Click Validate.

You should see a message that an item is found.

Click Save and Import.

3 Verify that the catalog displays the needed versions or no versions.

a
b

C

In Service Broker, click Catalog.
Locate the catalog item and click Request.

At the top of the request form, click the Version and verify the version or versions.

The following screenshot shows 8.

New Request

@QDevelopment Template  version 8 ~

8

Project * Development Proj
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Tutorial: Onboarding and managing vSphere resources in
vRealize Automation

As a cloud administrator who has recently added a new cloud account, you want to begin
managing some of the vCenter Server workloads using Cloud Assembly and Service Broker. This
tutorial guides you through the onboarding process and how to set up a few of the management
options for your existing vSphere workloads.

The sample management tasks include adding the resources to a project, creating and applying
an approval policy in Service Broker, and running a few day 2 actions on the resources to
demonstrate the life cycle management tools and to trigger the approval policy.

This tutorial assumes that although you might be relatively new to Cloud Assembly, you have
configured new vSphere cloud account. When you add the cloud account, Cloud Assembly
discovers the currently unmanaged resources on your vSphere instance.

What to do first

m  Add your new vCenter Server account. For additional instructions, see Create a vCenter cloud
account in vRealize Automation.

m  Verify that your user account has at least Cloud Assembly Administrator and Service Broker
Administrator service roles. See What are the vRealize Automation user roles.

m  To properly test the approval policy from the perspective of one of your users, verify that you
have a user account that has only the following user roles. In this tutorial, the user is named
Sylvia.

m  Organization Member
m  Cloud Assembly User
m  Service Broker User

For more information about user roles, see What are the vRealize Automation user roles.

Step 1: Verify that Cloud Assembly discovered the resources

When you add a vCenter Server account, Cloud Assembly discovers the resources on the vCenter
Server instance. You can verify that the machines that you want to begin managing are available to
onboard.

1 In Cloud Assembly, select Resources > Resources > Virtual Machines.
2 Inthe grid, review the Origin and Account/Region.

The Discovered origin type indicates that the machine is discovered on your vSphere instance
rather than deployed by vRealize Automation or already onboarded.

In this example, the Account/Region is vCenter Account / wld01-DC.
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Virtual Machines v Q ®
Name Status ::;’O”n"” Address Project Owner Creation Time Origin Tags
DevProject- > On N/A Jul 26, 2021 ~, Discovere

-116 229115 PM b

DevProject- [>on N/A Onboarding fritz Jul 26, 2021 & Deployed ( dbmysql )
centos-010 Project 229118 PM

DevProject- [>on N/A Jul 26, 2021 .~ Discovere

centos-012 2:29:18 PM - d

DevProject- > On N/A h Jul 26, 2021 ~ Discovere | (“apmysal )
centos-013 229115 PM “d —
DevProject- > On N/A Onboarding sylvia Jul 26, 2021, @ Deployed ( db:mysql )
centos-016 Project 2915 PM —

Step 2: Create a target project

Create a project that you can assign the onboarded machines to. To manage the resources, they
must be part of a project that includes the source cloud zone on which they were originally
deployed.

To test this tutorial, you must have another user who is not an administrator. In this step, as an
administrator, you add Sylvia as the project member.

For more information about projects, see Chapter 5 Adding and managing Cloud Assembly
projects.

1 In Cloud Assembly, select Infrastructure > Projects > .
2 Onthe Projects page, click New Project.
3 Enter the project Name.
In this tutorial, the project name is Onboarding Project.
4 Click the Users tab.
a Click Add Users and add at least one user as at least a project member.
In this tutorial, you add Sylvia.
b Click Add.
5 Click Provisioning.
a Click Add Zone.
b Click Cloud Zone.
c Select the account/region you identified in Step 1.

In this tutorial, the sample value is vCenter Account / wldO1-DC.
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23 New Project

Summar Users Provisioning Kubernetes Provisioning
Zones

Specify the zones that can be used when users provision deployments in this project. @

ADD ZONE +

Name 1 | Status Description Priority Instances Memory Limit (MB)

(5] vCenter Account / wid01-DC - 0 Unlimited Unlimited

Specify the placement policy that will be applied when selecting a cloud zone for provisioning

Placement policy DEFAULT @

d Click Add.

6 Click Create.

Step 3: Create and run an onboarding plan

CPU Limit Storage Limit (GBy | _2P2bility
Tags

Unlimited Unlimited

As a cloud administrator, you onboard discovered machines from your vSphere instance so that

you can apply governance and manage the resources with day 2 actions.

For more information about onboarding plans, see What are onboarding plans in Cloud Assembly.

1 In Cloud Assembly, select Infrastructure > Onboarding, and then click New Onboarding Plan.

2 Enter the onboarding information.

Setting Sample Value

Plan name wldO1-DC Onboarding Plan
Cloud account vCenter Account

Default project Onboarding Project

3 Click Create.

4  Add the machines that you want to onboard.

Do not run the onboarding plan until you complete all of the following steps.

a

b

Click Machines, and then click Add Machines.

Select the machines that you want to include in the plan, and then click OK.

For this tutorial, only two machines are selected.

In the Create Deployments dialog box, select Create plan deployments for each machine,

and then click Create.

You select this option when you want the machines as individual deployments so that you

can manage them as individual resources.

The selected machines are added to the list.
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wldO1-DC Onboarding Plan =

Summary Machines Deployments

Machines listed here are onboarded when the plan runs.

ADD MACHINES ®cC
Name Status Power Address Deployment ey Tags
properties
> %e'wprc]e:t-centas-c @ Pending [>0On Deployment-5e3ac Inherited ( db-mysql )
> gj'wpmjezt-centns-z @ Pending [>oOon Deployment-50507 Inherited (" domysal )

5 Rename the deployments.
a Click Deployments on the onboarding page.
b To change the generated deployment name, select a deployment and click Rename.
¢ Enter the new name, and then click Save.
For example, Onboarded machine 1.
d Repeat as needed.
6 Assign an owner to the deployments.

If you do not assign an owner, you become the owner. The owner must be a member of the
target project.

This tutorial assigns all the deployments to the same owner. Optionally, you can assign
different deployments to different owners.

a Select all the deployments and click Edit Owner.
b Select the owner and click Save.

Review the deployment name and owner changes in the grid.

widO1-DC Onboarding Plan

Summary Machines Deployments

These deployments will be created or updated when the plan runs. By default each added machine is placed in its own Cloud Assembly deployment.

Deployment Name Status Create Cloud Template Owner Components
> Onboarded deployment 1 @ sylvia 1
> Onboarded deployment 2 @ sylvia 1

2 deployments

RUN CANCEL
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7  Click Run.

After you run the onboarding plan, you cannot modify the name or assign owners. If you add
more machines to the plan, you can modify the name or the owner.

8 Review the resources that you onboarded as deployments.
a Select Resources > Deployments.

b To locate deployments, you can search by deployment name, project, or owner.

Dep‘oymeﬁts 20 Items of 26 7 (o] @ Sort: Created on (descending) BB C
Name Address Owner Project Status Expires on Price
> £ Onboarded machine 1 sylvia Onboarding Project Never
v &> Onboarded machine 2 sylvia Onboarding Project Never
: & DevProject-centos-016 »On
Resize -
> Resize Boot Disk fritz onboard project 2 Never
Resize Disk
> fritz Onboarding Project (D Onboard — Failed Never
Shutdown
b Suspend fritz Onboarding Project Never
Unregister
> Update Tags fritz Onboarding Project Never
> ; h fritz Onboarding Project Never

Now that you have brought machines into vRealize Automation, you can begin managing them.

Step 4: Resize a deployment

Perform this step as a cloud administrator and familiarize yourself with how day 2 actions work.
The changes that you can make to deployments are referred to as day 2 actions. Using day 2
actions are the first step in managing your resources.

For this tutorial, you think that the CPU count on a machine is too high, and you want to decrease

the consumed CPUs. This procedure assumes that you are running the resize action on a vSphere

machine that is powered on. It also assumes that you do not have any day 2 policies that prohibit a
user from running this action.

The available actions depend on the resource type, the resource state, and the day 2 policies.
For more information about day 2 actions, see What actions can | run on Cloud Assembly
deployments.

1 In Cloud Assembly, select Resources > Deployments, and then locate your onboarded
deployments.

You can use the search or filter options.

2 Expand the deployment using the arrow on the left, and then click the vertical ellipsis on the
machine name and click Resize.
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Deployments e

>

Mame

& Onboarded machine 1

& Hard disk 2

Address

DevProject-centos-019

reset

Resize

Resize Boot Disk
Resize Disk
Shutdown
Suspend
Unregister
Update Tags

o} @ Sort: Created on (descending)
Owner Project Status Expires on Price
sylvia Onboarding Project Never
»On
sylvia Onboarding Project Never
fritz onboard project 2 MNever
fritz Onboarding Project O Onboard — Failed MNever
fritz ©Onboarding Project Never
fritz Onboarding Project Never

3 Inthe Resize dialog box, decrease the CPU count to 4 and click Submit.

The suggested value is an example, change the CPU count to a value that works in your

environment.

The action runs on the machine.

4 To verify that the CPU count is changed, open the deployment and check the cpuCount

custom property for the machine.

5 You can also verify the count in vCenter Server.

vm vSphere Client Menu v

b B8 @9

i DevProject-centos-019

% DevProject-centos-204

{5 DevProject-centes-210

(5§ DevProject-centos-226
(% DevProject
(g DevProject
g DevProje
g DevProje
{p DevProject-ubuntu-212

-centos-910
centos-916

centos-922

centos-936

% DevProject-ubuntu-214
{5 DevProject-ubuntu-939
{5 DevProject-ubuntu-951

A diasi-n12

sSummary

VM Hardware

CPU
Memory
Hard disk 1 (of 2)

Network adapter 1

CD/DVD drive 1

Monitor

& DevProject-centos-019 ¥ B D ACTIONS

Configure Permissions Datastores Netwol

4 CPU(s), O MHz used
4 GB, 1 GB memory active

48 GB | Thin Provision
wid01-sc2vc05-widO1-clu0i-vsandl

Cloud_NSX_Network_1-mcm1292-
163799928607 (connected) | 00:50:56:be:5¢c:69

Disconnected -
Disconnected g,

Step 5: Applying approval policies

As a cloud administrator, you can apply governance in vRealize Automation to limit what the users
can do or to require them to have approval before they do it. This tutorial shows you how to apply

approval policies to the resize action so that your users cannot reconfigure a machine, perhaps

catastrophically, without your approval or the approval of another administrator.

The policies are created in Service Broker. However, the policies apply to the relevant requests in

Cloud Assembly and Service Broker.

As an approver, you must respond to the approval request in Service Broker.

1 In Service Broker, select Content and Policies > Policies > Definitions, and then click New

Policy.
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2 Click Approval Policy.

3 Configure the approval policy.

Resize Approval Policy

Approval palckes contral wha must

Type

Mame *

Descrigticn

Criteria

Approwal type *

Agprower mode

Approwers ¢

Aurooexpiry dedsicn *

Aurc Expiry trigger ¢

D User based Fiobe bass:
[ A

=

The following table includes sample values that illustrate how to create the policy.

Setting
Name

Scope

Approval type

Approver mode

Approvers

Auto expiry decision

VMware, Inc.

Sample value
Resize Approval Policy

Select Project, and then select Onboarding Project.
The approval policy is triggered when a user who is a
member of the project runs a Resize day 2 action.
User based

This value allows you to name the approvers.

Any

If you have multiple approvers, the approval request can
be resolved by at least one approver.

Add yourself as an approver.

Reject

By rejecting an unreviewed request, you reduce the risk
of making a machine either unusable or over resourced.
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Setting Sample value
Auto expiry trigger 1
Actions Select the resize action that triggers the approval policy.

1 Enter machine.resize in the Search.

2 Click Select multiple in the search results drop-down
list.

3 Select Cloud.vSphere.Machine.Resize.

For this tutorial, which is based on vSphere, you
select the vSphere.Machine action. If you want the
action policy to apply to other resource types, you
can add the other Machine.Resize actions.

Step 6: Request a resize request as a user

In this step you log in to Service Broker as an Organization member and Service Broker user and
run a resize day 2 request. The request creates an approval request. The user can also perform the
same steps in Cloud Assembly.

In the step after this one, you log in as the user who you assigned as an approver in Step 5 and
approve the request.

1 Log in to Service Broker as a user.
In this tutorial, the user is Sylvia.
2 Select Resources > Deployments and locate Onboarded machine 1.

This deployment is the one where you ran the resize action on the machine in Step 4, changing
the number of CPUs from 8 to 4. If you used a different value, modify the machine in a way
that you want to test.

3 Run the Resize action on the machine, increasing the CPU count to 6.
4 Notice that the request is waiting for an approval.

To see the pending status, hover over the information icon in the grid or open the deployment
and review the History tab.

Dep|oyments AT Q, @ Sort: Created on (descending) =-2]
Name Address Owner Project Status Expires on Price
v @: Cnboarded ma. sylvia Onboarding P. o Newver
B Hard disk 2
fii DevProject-c..

Resize — Approval Pending

(O / 2 Tasks)

> > Onboarded ma sylvia Onboarding P...

5 As auser, the change the Sylvia requested does not proceed until it is approved.
6 Log out of Service Broker as the user.

In Step 7 you log in as the assigned approver and respond to the request.
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Step 7: Respond to an approval request

When a request requires an approval, and you are the approver, you receive in email message.
For this tutorial, we are not waiting for the message. Instead, the process guides you through
directly to responding to approval requests using the Service Broker Approvals tab.

1 Log into Service Broker as the user you assigned as the approver in Step 5.
In this tutorial, the approver is Fritz.
2 Select Resources > Deployments and locate Onboarded machine 1.

The status is the grid looks the same as it did for Sylvia.

Dep|oyments A4 Q, @ Sort: Created on (descending) 28
Name Address Owner Project Status Expires on Price
v : & Onboarded ma. sylvia Onboarding P.. @ Never

B Hard disk 2

@ DevProject-c
Resize — Approval Pending

(O / 2 Tasks)

> : <3: Onboarded ma sylvia Onboarding P...

3 Click the Approvals tab.

Notice that you have an approval request pending.

Catalog Deployments Content & Policies nfrastructure Approvals
Ap pro\/a| Requests Q Sort by: Expires on (ascending) Filter by: Pending for me @
Coﬁ Onboarded machine 1 ((Pending ) Expires on Jul 30, 2021, 2:44:17 PM Action: Cloud.vSphere.Machine.Resize ACTIONS v
by sylvia Created on: Jul 29, 2021, 2:44:17 PM
nboarding Project Policy details: Resize Approval Policy
4 To view the request details, click the deployment name.

Onboarded machine 1 (Geone) ©

Requestor sylvia Action Cloud.vSphere.Machine.Resize Created on Jul 29, 2021, 2:44:17 PM

Project Onboarding Project Deployment Onboarded machine 1 Auto decision Reject on Jul 30, 2021, 2:44:17 PM

Policy Details Resource Details nput Details

Policy name Approval mode Status Approvers

Resize Approval Policy ANY_OF (“Pending ) fritz

5 Click Approve, provide a comment, if needed, and click Approve.

6 Return to the Deployments page to see that the Sylvia's resize action is now in progress.
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Q @ Sort: Created on (descending) 88

Deployments

Name Address Owner Project Status Expires on Price
~ : @3 Onboarded ma... sylvia Onboarding P_.. (1] MNever
& Hard disk 2

@ DevProject-c.. I
Resize — In Progress

(1/ 2 Tasks)

> : & Onboarded ma sylvia Onboarding P.
7 When the resize action is completed, you can verify the number of CPUs in the deployment
details and in the vSphere Client.

This tutorial guided you through the process of bringing the machines into vRealize Automation so
that you can begin managing the life cycle of the resource.

Tutorial: Setting up and testing multi-cloud infrastructure
and deployments in Cloud Assembly

This end-to-end Cloud Assembly tutorial shows how you might deploy in a multiple-cloud setting.
You deploy the same cloud template to more than one provider, in this case AWS and Microsoft
Azure.

In this example, the application is a WordPress site. Look at the sequential setup to understand
the process that brings the entire design to completion.

Remember that the names and values you see are only examples. You won't be able to use them
letter-by-letter in your own environment.

To fit your own cloud infrastructure and deployment needs, consider where you would make your
own substitutions for the example values.

Part 1: Configure the example Cloud Assembly infrastructure

First, configure the resources where Cloud Assembly engineering users can later develop, test,
and put the application into production.

The infrastructure includes cloud targets, and definitions around the available machines, networks,
and storage that the WordPress site will need.
Prerequisites

Log in to Cloud Assembly as a Cloud Assembly Administrator.

1. Add cloud accounts

In this step, the cloud administrator adds two cloud accounts. The example project expects to do
development and testing work on AWS, and go to production on Azure.

1  Go to Infrastructure > Connections > Cloud Accounts.

2 Click Add Cloud Account, select Amazon Web Services, and enter values.
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Setting

Access key ID
Secret access key
Name

Description

Sample Value

R5SDR3PXVV2ZW8B7YNSM

SZXAINXU4UHNAQITE156S

OurCo-AWS

WordPress

Remember that all values are only examples. Your account specifics will vary.

3 To verify credentials, click Validate.

4 Click Add.

5 Edit the newly added account Configuration, and allow provisioning to us-east-1 and us-

west-2 regions.

6 Click Add Cloud Account, select Microsoft Azure, and enter values.

Setting

Subscription ID

Tenant ID

Client application ID

Client application secret key
Name

Description

7 To verify credentials, click Validate.

(0]

Click Add.

O

2. Add cloud zones

Sample Value

ef2avpf-dfdv-zxluguili-g4h0-i8ep2jwp4c9arbfe
dso9wv3-4zgc-5nrcy5h3m-4skf-nnovp40wfxsro22r
bg22409-3ptp-mbhicaa05-q511-uflyjr2sttyik6bs
7ugxi57-0Owtn-kymgfowcj-t217-e52e4nu5figdpmdd
OurCo-Azure

WordPress

Edit the newly added account Configuration, and allow provisioning to the East US region.

In this example step, the cloud administrator adds three cloud zones, one each for development,

testing, and production.

1 Go to Infrastructure > Configure > Cloud Zones.

2 Click New Cloud Zone, and enter values for the development environment.

Cloud Zone Setting

Account / region
Name

Description

VMware, Inc.

Sample Value

OurCo-AWS/us-east-1

OurCo-AWS-US-East

WordPress
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Cloud Zone Setting

Placement policy

Capability tags

Sample Value

Default

env:dev

Remember that all values are only examples. Your zone specifics will vary.

3 Click Compute, and verify that the zones you expect are there.

4  Click Create.

5 Repeat the process twice, with values for the test and production environments.

Cloud Zone Setting

Account / region
Name
Description
Placement policy

Capability tags

Cloud Zone Setting

Account / region
Name
Description
Placement policy

Capability tags

3. Add flavor mappings

Sample Value

OurCo-AWS/us-west-2

OurCo-AWS-US-West

WordPress

Default

env:test

Sample Value

OurCo-Azure/East US

OurCo-Azure-East-US

WordPress

Default

env:prod

In this example step, the cloud administrator adds flavor mappings to account for capacity needs

that might vary depending on deployment.

Flavor mapping accounts for different size machine deployments and is informally referred to as

T-shirt sizing.

1 Go to Infrastructure > Configure > Flavor Mappings. Each cloud zone needs to allow for

small, medium, and large flavors.

2 Click New Flavor Mapping, and enter values for the development cloud zone.
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Setting

Flavor name
Account/region
Value

Account/region

Value

Account/region

Value

Sample Value

small
OurCo-AWS/us-east-1
t2.micro

OurCo-AWS/us-west-2

t2.micro

OurCo-Azure/East US
Standard_AO

Remember that all values are only examples. Your flavors will vary.

3 Click Create.

4 Repeat the process twice, with values for medium and large flavors.

Setting

Flavor name
Account/region
Value

Account/region

Value

Account/region

Value

Setting

Flavor name
Account/region
Value

Account/region

Value

Account/region

Value

4. Add image mappings

In this example step, the cloud administrator adds an image mapping for Ubuntu, the host for the
WordPress server and its MySQL database server.

Sample Value
medium
OurCo-AWS/us-east-1
t2.medium

OurCo-AWS/us-west-2

t2.medium

OurCo-Azure/East US
Standard_A3

Sample Value

large
OurCo-AWS/us-east-1
t2.large

OurCo-AWS/us-west-2
t2.large

OurCo-Azure/East US
Standard_A7

Plan for the operating system by adding image mappings. Each cloud zone needs a Ubuntu image

mapping.

1 Go to Infrastructure > Configure > Image Mappings.

2 Click New Image Mapping, and enter values for Ubuntu servers.
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Setting

Image name
Account/region
Value

Account/region

Value

Account/region

Value

Sample Value

ubuntu

OurCo-AWS/us-east-1
ubuntu-16.04-server-cloudimg-amde4

OurCo-AWS/us-west-2

ubuntu-16.04-server-cloudimg-amd64

OurCo-Azure/East US
azul-zulu-ubuntu-1604-923eng

Remember that all values are only examples. Your images will vary.

3 Click Create.

5. Add network profiles

In this example step, the cloud administrator adds a network profile to each cloud zone.

In each profile, the administrator adds a network for the WordPress machines, and a second
network that will sit on the other side of an eventual load balancer. The second network will be the

one that users eventually connect to.

1  Go to Infrastructure > Configure > Network Profiles.

2 Click New Network Profile, and create a profile for the development cloud zone.

Network Profile Setting

Account / region
Name

Description

3 Click Networks, and click Add Network.

4 Select wpnet, appnet-public, and click Add.

Sample Value

OurCo-AWS/us-east-1

devnets

WordPress

Remember that all values are only examples. Your network names will vary.

5 Click Create.

This Wordpress example does not require that you specify network policy or network security

settings.

6 Repeat the process twice, to create a network profile for the Wordpress example test and
production cloud zones. In each case, add the wpnet and appnet-public networks.
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Network Profile Setting

Account / region
Name

Description

Network Profile Setting

Account / region
Name

Description

6. Add storage profiles

Sample Value

OurCo-AWS/us-west-2

testnets

WordPress

Value

OurCo-Azure/East US

prodnets

WordPress

In this example step, the cloud administrator adds a storage profile to each cloud zone.

The administrator places fast storage at the production zone and general storage at development

and test.

1 Go to Infrastructure > Configure > Storage Profiles.

2 Click New Storage Profile, and create a profile for the development cloud zone.

Additional fields appear after you select the account/region.

Storage Profile Setting

Account / region
Name
Description
Device type
Volume type

Capability tags

Remember that all values are only examples.

3 Click Create.

Sample Value

OurCo-AWS/us-east-1

OurCo-AWS-US-East-Disk

WordPress

EBS

General Purpose SSD

storage:general

4 Repeat the process to create a profile for the test cloud zone.

Storage Profile Setting

Account / region

Name

Description
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Sample Value

OurCo-AWS/us-west-2

OurCo-AWS-US-West-Disk

WordPress
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Storage Profile Setting

Device type
Volume type

Capability tags

Sample Value

EBS

General Purpose SSD

storage:general

5 Repeat the process to create a profile for the production cloud zone, which has different

settings because it is an Azure zone.
Storage Profile Setting
Account / region
Name
Description
Storage type
Disk type
OS disk caching
Data disk caching

Capability tags

What to do next

Sample Value

OurCo-Azure/East US

OurCo-Azure-East-US-Disk

WordPress

Managed disks

Premium LRS

Read only

Read only

storage:fast

Create a project to identify users, and to define provisioning settings. See Part 2: Create the

example Cloud Assembly project.

Part 2: Create the example Cloud Assembly project

The example Cloud Assembly project enables the users who can provision, and configures how

much provisioning is possible.

Projects define the user and provisioning settings.

m  Users and their role level of permission

m  Priority for deployments as they are being provisioned to a cloud zone

. Maximum number of deployment instances per cloud zone

Procedure

1 Go to Infrastructure > Administration > Projects.

2 Click New Project, and enter the name WordPress.

3 Click Users, and click Add Users.
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4 Add email addresses and roles for the users.

To successfully add a user, a VMware Cloud Services administrator must have enabled access
to Cloud Assembly for the user.

Remember that addresses shown here are only examples.
m  chris.ladd@ourco.com, Member
m  kerry.mott@ourco.com, Member
m  pat.tubb@ourco.com, Administrator
5 Click Provisioning, and click Add Cloud Zone.

6 Add the cloud zones that the users can deploy to.

Project Cloud Zone Setting Sample Value

Cloud zone OurCo-AWS-US-East

Provisioning priority 1

Instances limit 5

Cloud zone OurCo-AWS-US-West
Provisioning priority 1

Instances limit 5

Cloud zone OurCo-Azure-East-US
Provisioning priority 0]

Instances limit 1

7 Click Create.
8 Go to Infrastructure > Configure > Cloud Zones, and open a zone that you created earlier.
9 Click Projects, and verify that WordPress is a project that is allowed to provision to the zone.

10 Check the other zones that you created.

What to do next

Create a basic cloud template.

Part 3: Design and deploy the example Cloud Assembly template

Next, you define the example application—the WordPress site—in the form of a generic cloud
template. The template can be deployed to different cloud vendors without needing to change its
design.

The example consists of a WordPress application server, MySQL database server, and supporting
resources. The template starts with a few resources, and then grows as you modify them and add
more resources.
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Here are the values from Part 1: Configure the example Cloud Assembly infrastructure, the
infrastructure that was set by a cloud administrator:

= Two cloud accounts, AWS and Azure.
m  Three cloud zone environments:
m  Development—OurCo-AWS-US-East
m  Test—OurCo-AWS-US-West
m  Production—OurCo-Azure-East-US
m  Flavor mappings with small, medium, and large compute resources for each zone.
= Image mappings for Ubuntu configured in each zone.
m  Network profiles with internal and external subnets for each zone.

m  Storage on which to deploy; general storage for the development and test zone, and fast
storage for the production zone.

m  The example project includes all three cloud zone environments plus the users who can create
designs.

Prerequisites

To follow along, you must be familiar with your own infrastructure values. This example uses AWS
for development and test, and Azure for production. When creating your own cloud template,
substitute your own values, typically set by your cloud administrator.

Procedure

1 Create a basic cloud template
In this Cloud Assembly design example, you start with a cloud template that contains only
minimal WordPress resources, such as having only one application server.

2 Test a basic cloud template
During design, you often build a cloud template by starting with the essentials, then
deploying and testing as the template grows. This example demonstrates some of the in-
progress testing built into Cloud Assembly.

3 Expand a cloud template
After you create and test the basic Cloud Assembly template for the example application,
you expand it into a multiple tier application that is deployable to development, test, and
eventually production.

Create a basic cloud template

In this Cloud Assembly design example, you start with a cloud template that contains only minimal
WordPress resources, such as having only one application server.

Cloud Assembly is an infrastructure-as-code tool. You drag resources to the design canvas to get
started. Then, you complete the details using the code editor to the right of the canvas.
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The code editor allows you to type, cut, and paste code directly. If you're uncomfortable editing
code, you can select a resource in the canvas, click the code editor Properties tab, and enter
values there. Values that you enter appear in the code as if you had typed them directly.

Procedure

1

A W

6

Go to Design > Cloud Templates and click New from > Blank canvas.
Name the cloud template Wordpress-BP.
Select the WordPress project, and click Create.

From the resources on the left of the cloud template design page, drag two cloud agnostic
machines onto the canvas.

The machines serve as WordPress application server (WebTier) and MySQL database server
(DBTier).

On the right, edit the machine YAML code to add names, images, flavors, and constraint tags:

resources:
WebTier:
type: Cloud.Machine
properties:
name: wordpress
image: ubuntu
flavor: small
constraints:
- tag: env:dev
DBTier:
type: Cloud.Machine
properties:
name: mysql
image: ubuntu
flavor: small
constraints:

- tag: env:dev

Drag a cloud agnostic network to the canvas, and edit its code:

WP-Network-Private:
type: Cloud.Network
properties:
name: WP-Network-Private

networkType: existing

Connect the machines to the network:

In the canvas, hover over the network block, click and hold the bubble where the line touches
the block, drag to a machine block, and release.

When you create the connection lines, note that network code is automatically added to the
machines in the editor.
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e) (—) =, @\ @\ |47‘ » A Code Properties Inputs
1 formatVersion: 1
2 inputs:
3
a-
5
6~
7 name: wordpress
E image: ubuntu
9 flavor: small
10~ constraints:
1 - teg: envidev’
12+ networ!
13 - network: 'S{resource["WP-Network-Private”].
13-
15 Cloud.Machine
16~ rties:
17 name: mysql
R WebTier : 6P DBTier : 18 image: ubuntu
19 flavor: small
20+ constraints:
21 - teg: envidev’
2+ networ!
23 rk: *${resource["WP-Network-Private”].
24~ k-Private:
25 Cloud . Network
& WP-Network-P_ : 26+ rties:
- 27 name: WP-Network-Private
28 networkType: existing
29

8 Add user input prompting.

idy

idy

In some places, the example infrastructure was set up for multiple options. For example:

m  Cloud zone environments for development, test, and production

m  Flavor mappings for small, medium, and large machines
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You might set a specific option directly in the cloud template, but a better approach is to let
the user select the option at template deployment time. Prompting for user input lets you
create one template that can be deployed many ways, instead of having many hard-coded
templates.

a Create an inputs section in the code so that users can select machine size and target
environment at deployment time. Define the selectable values:

inputs:
env:
type: string
enum:
- env:dev
- env:prod
- env:test
default: env:dev
title: Environment
description: Target Environment
size:
type: string
enum:
- small
- medium
- large
description: Size of Nodes

title: Tier Machine Size

b Inthe resources section of the code, add ${input.input-name} code to prompt for the
user selection:

resources:
WebTier:
type: Cloud.Machine
properties:
name: wordpress
image: ubuntu
flavor: '${input.size}'
constraints:
- tag: '${input.env}'
networks:
- network: '${resource["WP-Network-Private"].id}"
DBTier:
type: Cloud.Machine
properties:
name: mysql
image: ubuntu
flavor: '${input.size}'
constraints:
- tag: '${input.env}'
networks:
- network: '${resource["WP-Network-Private"].id}"

WP-Network-Private:
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type: Cloud.Network
properties:
name: WP-Network-Private

networkType: existing

9 Finally, enhance the webTier and DBTier code using the following examples. The wp-Network-

Private code does not need additional changes.

Note that the enhancements include login access to the database server and deployment-time
cloudConfig initialization scripts.
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Component Example
Additional
DBTier Inputs username:

type: string

minLength: 4

maxLength: 20

pattern: '[a-z]+'

title: Database Username

description: Database Username
userpassword:

type: string

pattern: '[a-z0-9A-Z@#S]+"'

encrypted: true

title: Database Password

description: Database Password

DBTier
Resource DBTier:
type: Cloud.Machine
properties:

name: mysqgl

image: ubuntu

flavor: 'S${input.size}'

constraints:
- tag: '${input.env}'

networks:
- network: '${resource["WP-Network-Private"].id}'

assignPublicIpAddress: true

remoteAccess:
authentication: usernamePassword
username: '${input.username}’
password: 'S${input.userpassword}"'

cloudConfig: |
#cloud-config
repo update: true
repo_upgrade: all
packages:
- mysgl-server
runcmd:
- sed -e '/bind-address/ s/"#*/#/' -i /etc/mysqgl/mysqgl.conf.d/

mysgld.cnf
- service mysgl restart
- mysgl -e "CREATE USER 'root'@'S$' IDENTIFIED BY
'mysglpassword';"

- mysgl -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'s';"
- mysgl -e "FLUSH PRIVILEGES;"

attachedDisks: []

WebTier
Resource WebTier:
type: Cloud.Machine
properties:
name: wordpress
image: ubuntu

flavor: '${input.size}'
constraints:
- tag: '${input.env}'
networks:
- network: 'S${resource["WP-Network-Private"].id}'
assignPublicIpAddress: true
cloudConfig: |
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Component

Example

#cloud-config

repo_update: true

repo_upgrade: all

packages:

- apache?2

- php

- php-mysqgl

- libapache2-mod-php

- mysgl-client

- gcc

- make

- autoconf

- libc-dev

- pkg-config

- libmcrypt-dev

- php-pear

- php-dev

runcmd:

- mkdir -p /var/www/html/mywordpresssite && cd /var/www/html
&& wget https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/

latest.tar.gz -C /var/www/html/mywordpresssite --strip-components 1

- 1=0; while [ $i -le 10 ]; do mysgl --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysqglpassword -e "SHOW STATUS;" &&
break || sleep 15; i=$((i+1)); done

- mysgl -u root -pmysglpassword -h ${DBTier.networks[0].address}
-e "create database wordpress blog;"

- mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/
html/mywordpresssite/wp-config.php

- pecl channel-update pecl.php.net

- pecl update-channels

- pecl install mcrypt

- sed -1 -e

s/"define( 'DB_NAME', 'database name here' );"/"define( 'DB NAME',
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB_USER', 'username here' );"/"define( 'DB_USER',
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i

-e s/"define( 'DB_PASSWORD', 'password here' );"/"define( 'DB_PASSWORD',
'mysglpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB HOST', 'localhost' );"/"define( 'DB HOST',
'$S{DBTier.networks[0].address}' );"/ /var/www/html/mywordpresssite/wp-
config.php

- sed -1 '9501 extension=mcrypt.so' /etc/php/7.4/apache2/php.ini
- service apache2 reload

Example: Completed basic cloud template code example

formatVersion: 1

inputs:
env:
type:
enum:

string

- env:dev

- env:prod

- env:test

default:

title:

env:dev

Environment

description:

size:

type:
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enum:
- small
- medium
- large
description: Size of Nodes
title: Tier Machine Size
username:
type:
minLength: 4
20

'[a-z]+!'

string

maxLength:
pattern:
title: Database Username
description: Database Username
userpassword:
type:
pattern:

string

'[a-z0-9A-Z@#S$]+"
encrypted:
title:

true
Database Password
description: Database Password
resources:
WebTier:
type:
properties:

Cloud.Machine
name: wordpress
image: ubuntu
flavor: '${input.size}'
constraints:

- tag: '${input.env}'
networks:

- network: '${resource["WP-Network-Private"].id}"
assignPublicIpAddress: true

cloudConfig: |

#cloud-config

repo_update: true

repo_upgrade: all

packages:

- apache?2

- php

- php-mysqgl

- libapache2-mod-php

- mysgl-client

- gcc

- make

- autoconf

- libc-dev

- pkg-config

- libmcrypt-dev

- php-pear

- php-dev

runcmd:

- mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/
mywordpresssite --strip-components 1
while [ $i -le 10 ];

- i=0; do mysgl --connect-timeout=3 -h $

{DBTier.networks[0] .address}
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' && break

sleep 15;
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i=$((i+1)); done

- mysgl -u root -pmysglpassword -h ${DBTier.networks[0].address} -e "create database
wordpress_blog;"

- mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/mywordpresssite/
wp-config.php

- pecl channel-update pecl.php.net

- pecl update-channels

- pecl install mcrypt

- sed -i -e s/"define( 'DB NAME', 'database name here' );"/"define( 'DB NAME',
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB USER', 'username here' );"/"define( 'DB USER',
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i
-e s/"define( 'DB_PASSWORD', 'password here' );"/"define( 'DB PASSWORD',
'mysglpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB HOST', 'localhost' );"/"define( 'DB_HOST', '$
{DBTier.networks[0].address}"' );"/ /var/www/html/mywordpresssite/wp-config.php

- sed -1 '9501 extension=mcrypt.so' /etc/php/7.4/apache2/php.ini
- service apache2 reload
DBTier:
type: Cloud.Machine
properties:
name: mysql
image: ubuntu
flavor: '${input.size}'
constraints:
- tag: '${input.env}'
networks:
- network: '${resource["WP-Network-Private"].id}"
assignPublicIpAddress: true
remoteAccess:
authentication: usernamePassword
username: '${input.username}"’
password: '${input.userpassword}"'
cloudConfig: |
#cloud-config
repo_update: true
repo_upgrade: all
packages:
- mysgl-server
runcmd:
- sed -e '/bind-address/ s/"#*/#/' -i /etc/mysqgl/mysqgl.conf.d/mysqgld.cnf
- service mysgl restart
- mysgl -e "CREATE USER 'root'@'$' IDENTIFIED BY 'mysglpassword';"
- mysgl -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'S';"
- mysgl -e "FLUSH PRIVILEGES;"
attachedDisks: []
WP-Network-Private:
type: Cloud.Network
properties:
name: WP-Network-Private

networkType: existing

What to do next

Test the cloud template by checking the syntax and deploying it.
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Test a basic cloud template

During design, you often build a cloud template by starting with the essentials, then deploying and
testing as the template grows. This example demonstrates some of the in-progress testing built
into Cloud Assembly.

To be certain that a deployment works the way that you want, you might test and deploy the cloud
template several times. Gradually, you add more resources, retest, and redeploy along the way.

Prerequisites

Create the basic cloud template. See Create a basic cloud template.

Procedure
1 Click Cloud Templates, and open the WordPress-BP cloud template.
The basic cloud template appears, in the design canvas and code editor.
2 To check template syntax, placement, and basic validity, click Test at the lower left.

3 Enter input values, and click Test.

Testing Basic X

Environment env-dev @

Tier Machine small @
Size *

Database ouradmin
Username *

Database = seeeeees
Password *

CANCEL TEST

The test is only a simulation and does not actually deploy virtual machines or other resources.

& Test Result for Basic X

This simulation only tests syntax, placement and basic validity
£ Provisioning Diagram

v WP-Network-Private @

LINE 96

v DBTier &)

LINE 69

~ WebTier @
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The test includes a link to a Provisioning Diagram, where you can inspect the simulated
deployment flow and see what occurred. The simulation exposes potential issues, such as not
having any resource capabilities defined that match hard constraints in the cloud template. In
the example error that follows, a cloud zone of capability tag env:dev wasn't found anywhere

in the defined infrastructure.

Request Details exporr
NETWORK ALLOCATION ] )

@ Request: mysal

Error: No pl;

reguirements. See if suitable pl

l

exist for the current project and they have

w

n

@

=]

T

@

o
Reguest type Allocation
Flavor small
Image ubuntu

Constraints (" env.devhard )

ent exists that satisfies all of the request

ents and cloud =1

en properly

/

A successful simulation doesn't guarantee that you can deploy the template without errors.

o ua »

~N

Select Create a new deployment.

Enter input values, and click Deploy.

After the template passes the simulation, click Deploy at the lower left.

Name the deployment WordPress for OurCo and click Next.

8 To verify that the template successfully deployed, look under Resources > Deployments.

If a deployment fails, click its name, and click the History tab to see messages that can help

you troubleshoot.

Timestamp Status
Sep 8, 2020, 1. CREATE_IN_PROGRESS

Sep §, 2020, 1. CREATE_FINISHED

Sep 8, 2020, 1. CREATE_IN_PROGRESS

Sep 8, 2020, 1. CREATE_FIMNISHED

Sep §, 2020, 1. CREATE_IN_PROGRESS

Resource type
& Cloud.Machine

& Cloud.Machine

( Cloud.Machine

@ Cloud.Network

@ Cloud.Network

Resource name

WebTier

DETier

DETier

WP-Network-Private

WP-Network-Private

Some history entries might have the Provisioning Diagram link at the far right. The diagram
is similar to the simulated one, where you inspect the flow chart of Cloud Assembly decision

points in the provisioning process.
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More flow charts are available under Infrastructure > Activity > Requests.
9 To verify that the application is working, open the WordPress start page in a browser.
a Wait for the WordPress servers to be fully created and initialized.
It might take 30 minutes or more for initialization, depending on the environment.

b To locate the site FQDN or IP address, go to Resources > Deployments > Topology.
¢ Onthe canvas, click the WebTier, and find the IP address in the panel on the right.

d Enter the IP address as part of the full URL to the WordPress start page.
In this example, the full URL is:
http://{/P-address}/mywordpresssite
or
http://{/P-address}/mywordpresssite/wp-admin/install.php

10 After inspecting WordPress in a browser, if the application needs more work, make template
changes and redeploy using the Update an existing deployment option.

11 Consider versioning the cloud template. You can revert to a working version if a change
causes deployment to fail.

a On the cloud template design page, click Version.
b On the Creating Version page, enter Wp-1.0.
Do not enter spaces in version names.

¢ Click Create.

To review or revert to a version, on the design page, click the Version History tab.

12 With a basic deployment now possible, try your first deployment-time enhancement by
increasing CPU and memory on the application and database servers.

Update to a medium node size for both. Using the same template, select medium at
deployment time, redeploy, and verify the application again.

What to do next

Expand the cloud template into a production-worthy application by adding even more resources.

Expand a cloud template

After you create and test the basic Cloud Assembly template for the example application, you
expand it into a multiple tier application that is deployable to development, test, and eventually
production.

To expand the cloud template, you add the following enhancements.

= An option to cluster application servers for increased capacity

VMware, Inc. 93



Using and Managing vRealize Automation Cloud Assembly

m A public-facing network and load balancer in front of the application servers

m A backup server with archive storage

Prerequisites

Create the basic cloud template and test it. See Create a basic cloud template and Test a basic
cloud template.

Procedure
1 Click Cloud Templates, and open the WordPress-BP cloud template.
The basic template appears, in the design canvas and code editor.
2 Make additions and changes, using the code example and figure for guidance.

You use the GUI to drag new resources to the canvas, such as the load balancer, and then
finish the configuration in the code editor.

a Add a count input prompt to make the WordPress application server into a cluster.
b Add a cloud agnostic load balancer.
¢ Connect the load balancer to the WordPress application server cluster.
d Add a cloud agnostic backup machine.
e Connect the backup machine to the private/internal network.
f  Add a cloud agnostic public/external network.
g Connect the load balancer to the public network.
h Add a cloud agnostic storage volume for use as an archive disk.
i Connect the archive disk to the backup machine.
j  Add an input prompt for the archive disk speed.
3 Deploy, test, and make changes in the same way that you did for the basic cloud template.

You can update existing deployments, or even deploy new instances so that you can compare
deployments.

The goal is to reach a solid, repeatable template that can be used for production deployments.

& DETier : & WebTier

[g ArchiveDisk
-

) > - &g LoadBalancer % E_‘] backup N = =
[‘B'inpu[slolager,'... 'j

(" slinputenv} ) (" $linputenv} ) -

) WP-Network-P__ = e

& WP-Network-P... |
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Example: Completed expanded cloud template code example

formatVersion: 1
inputs:
env:
type: string
enum:
- env:dev
- env:prod
- env:test
default: env:dev
title: Environment
description: Target Environment
size:
type: string
enum:
- small
- medium
- large
description: Size of Nodes
title: Tier Machine Size
username:
type: string
minLength: 4
maxLength: 20
pattern: '[a-z]+'
title: Database Username
description: Database Username
userpassword:
type: string
pattern: '[a-z0-9A-Z@#S]+"'
encrypted: true
title: Database Password
description: Database Password
count:
type: integer
default: 2
maximum: 5
minimum: 2
title: WordPress Cluster Size
description: WordPress Cluster Size (Number of Nodes)
storagetype:
type: string
enum:
- storage:general
- storage:fast
description: Archive Storage Disk Type
title: Archive Disk Type
resources:
WebTier:
type: Cloud.Machine

properties:
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name: wordpress
image: ubuntu
flavor: '${input.size}'
count: '${input.count}’
constraints:
- tag: '${input.env}'
networks:
- network: '${resource["WP-Network-Private"].id}"
assignPublicIpAddress: true
cloudConfig: |
#cloud-config
repo_update: true
repo_upgrade: all
packages:
- apache?2
- php
- php-mysqgl
- libapache2-mod-php
- mysgl-client
- gcc
- make
- autoconf
- libc-dev
- pkg-config
- libmcrypt-dev
- php-pear
- php-dev
runcmd:
- mkdir -p /var/www/html/mywordpresssite && cd /var/www/html && wget
https://wordpress.org/latest.tar.gz && tar -xzf /var/www/html/latest.tar.gz -C /var/www/html/

mywordpresssite --strip-components 1

- 1=0; while [ $i -le 10 ]; do mysgl --connect-timeout=3 -h $
{DBTier.networks[0].address} -u root -pmysglpassword -e "SHOW STATUS;" && break || sleep 15;
i=$((i+1)); done

- mysgl -u root -pmysglpassword -h ${DBTier.networks[0].address} -e "create database
wordpress_blog;"

- mv /var/www/html/mywordpresssite/wp-config-sample.php /var/www/html/mywordpresssite/
wp-config.php

- pecl channel-update pecl.php.net

- pecl update-channels

- pecl install mcrypt

- sed -i -e s/"define( 'DB NAME', 'database name here' );"/"define( 'DB NAME',
'wordpress_blog' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB USER', 'username here' );"/"define( 'DB USER',
'root' );"/ /var/www/html/mywordpresssite/wp-config.php && sed -i
-e s/"define( 'DB_PASSWORD', 'password here' );"/"define( 'DB PASSWORD',
'mysglpassword' );"/ /var/www/html/mywordpresssite/wp-config.php && sed
-i -e s/"define( 'DB HOST', 'localhost' );"/"define( 'DB_HOST', '$
{DBTier.networks[0].address}"' );"/ /var/www/html/mywordpresssite/wp-config.php

- sed -1 '9501 extension=mcrypt.so' /etc/php/7.4/apache2/php.ini
- service apache2 reload
DBTier:
type: Cloud.Machine
properties:

name: mysqgl
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image: ubuntu
flavor: '${input.size}'
constraints:
- tag: '${input.env}'
networks:
- network: '${resource["WP-Network-Private"].id}"
assignPublicIpAddress: true
remoteAccess:
authentication: usernamePassword
username: '${input.username}’
password: '${input.userpassword}"'
cloudConfig: |
#cloud-config
repo_update: true
repo_upgrade: all
packages:
- mysqgl-server
runcmd:
- sed -e '/bind-address/ s/"#*/#/' -i /etc/mysqgl/mysqgl.conf.d/mysqgld.cnf
- service mysgl restart
- mysgl -e "CREATE USER 'root'@'$' IDENTIFIED BY 'mysglpassword';"
- mysgl -e "GRANT ALL PRIVILEGES ON *.* TO 'root'@'S';"
- mysgl -e "FLUSH PRIVILEGES;"
attachedDisks: []
LoadBalancer:
type: Cloud.LoadBalancer
properties:
name: myapp-lb
network: '${resource["WP-Network-Public"].id}"

instances:
- '${WebTier.id}"'
routes:
- protocol: HTTP
port: '80'

instanceProtocol: HTTP
instancePort: '80'
healthCheckConfiguration:
protocol: HTTP
port: '80'
urlPath: /mywordpresssite/wp-admin/install.php
intervalSeconds: 6
timeoutSeconds: 5
unhealthyThreshold: 2
healthyThreshold: 2
internetFacing: true
WP-Network-Private:
type: Cloud.Network
properties:
name: WP-Network-Private
networkType: existing
WP-Network-Public:
type: Cloud.Network
properties:
name: WP-Network-Public
networkType: public
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backup:
type: Cloud.Machine
properties:
name: backup
flavor: '${input.size}'
image: ubuntu
networks:
- network: '${resource["WP-Network-Private"].id}'
attachedDisks:
- source: '${resource.ArchiveDisk.id}"'
ArchiveDisk:
type: Cloud.Volume
properties:
name: ArchiveDisk
capacityGb: 5
constraints:
- tag: '${input.storagetype}'

What to do next

Define your own infrastructure and create your own cloud templates.

See Chapter 4 Building your Cloud Assembly resource infrastructure and Chapter 6 Designing
your Cloud Assembly deployments.

Tutorial: Configuring VMware Cloud on AWS for vRealize
Automation

This vRealize Automation tutorial illustrates the process of defining resource infrastructure and
cloud template settings for deployment to a VMware Cloud on AWS environment.

The procedure requires that a cloud administrator has already configured your organization’s
VMware Cloud on AWS SDDC data center as described in Deploying and Managing a Software-
Defined Data Centerin the VMware Cloud on AWS Getting Started documentation.

Look at the sequential setup to understand the process for configuring your environment for
VMware Cloud on AWS. Remember that the values you see are only use case examples. Think
about where you would make your own substitutions, or extrapolate from the example values, in
order to fit your own cloud infrastructure and deployment needs.

For related information, see this How to Configure VMware Cloud on AWS for Cloud
Assembly video.

Procedure

1 Configure a basic VMware Cloud on AWS workflow in vRealize Automation

This use case shows the process of defining resource infrastructure and a corresponding
cloud template for deployment to a VMware Cloud on AWS environment.
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2 Configure an isolated network in VMware Cloud on AWS workflow in vRealize Automation

In this procedure, you add an isolated network for your VMware Cloud on AWS deployment
in vRealize Automation.

Configure a basic VMware Cloud on AWS workflow in vRealize
Automation

This use case shows the process of defining resource infrastructure and a corresponding cloud
template for deployment to a VMware Cloud on AWS environment.

In this procedure, you configure infrastructure that supports cloud template deployment to
resources in your existing VMware Cloud on AWS environment.

Prerequisites

Before you can create and configure a VMware Cloud on AWS cloud account in Cloud
Assembly, you must be part of an organization in an existing VMware Cloud on AWS SDDC
environment. For information about configuring the VMware Cloud on AWS service, see
VMware Cloud on AWS Documentation.

To facilitate the needed connection between your existing VMware Cloud on AWS host SDDC
in vCenter and a VMware Cloud on AWS cloud account in Cloud Assembly, you must provide
a network connection, and add firewall rules, by using a VPN or similar networking means.
See Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud
accounts in vRealize Automation .

Procedure

Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud
accounts in vRealize Automation

When using VMware Cloud on AWS cloud accounts in your vRealize Automation
environment, you must create a network connection and configure rules to support
communication between your SDDC in vCenter and VMware Cloud on AWS cloud accounts in
vRealize Automation.

Create a VMware Cloud on AWS cloud account in vRealize Automation within a sample
workflow

In this step, you create a VMware Cloud on AWS cloud account in vRealize Automation.

Create a cloud zone for VMware Cloud on AWS deployments in vRealize Automation

In this step, you create a cloud zone to specify a compute resource that the CloudAdmin user
can access when working with VMware Cloud on AWS in vRealize Automation.

Configure network and storage profiles for VMware Cloud on AWS deployments in vRealize
Automation

In this step, you configure a network profile and a storage profile to specify resources that are
available to a VMware Cloud on AWS CloudAdmin user in vRealize Automation.
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Create a project to support VMware Cloud on AWS deployments in vRealize Automation

In this step, you define a vRealize Automation project that can be used to control which
resources are available for VMware Cloud on AWS deployments.

Define a vCenter machine resource in a cloud template design to support VMware Cloud on
AWS deployment in vRealize Automation

In this step, you drag a vCenter machine resource onto the design canvas and add settings
for a VMware Cloud on AWS deployment in vRealize Automation.

Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on
AWS cloud accounts in vRealize Automation

When using VMware Cloud on AWS cloud accounts in your vRealize Automation environment,
you must create a network connection and configure rules to support communication between
your SDDC in vCenter and VMware Cloud on AWS cloud accounts in vRealize Automation.

Configure needed connections and rules to support SDDC communication.

To facilitate the needed connection between your existing VMware Cloud on AWS host SDDC in
vCenter and a VMware Cloud on AWS cloud account in vRealize Automation, you must provide a
network connection between the two elements by using a VPN or similar networking means.

1

Configure a VPN connection over the public Internet or AWS Direct connect.

See information about configuring VPN connectivity to the on-premises data center, as well
as configuring AWS Direct Connect for VMware Cloud on AWS, in VMware Cloud on AWS
Networking and Security at VMware Cloud on AWS Documentation.

Verify that the vCenter Server FQDN is resolvable at a private IP address on the management
network.

See information about setting the vCenter Server FQDN resolution address in VMware Cloud
on AWS Networking and Security at VMware Cloud on AWS Documentation.

Configure needed firewall rules.

You must configure management gateway firewall rules in the SDDC's VMware Cloud on AWS
console to support communication. The rules must be in the Management Gateway firewall
rules section. Create the firewall rules by using options on the Networking & Security tab in
the SDDC console.

m  Limit network traffic to ESXi for HTTPS (TCP 443) services to the discovered IP address of
the vRealize Automation appliance/server or vRealize Automation load balancer VIP.

m  Limit network traffic to vCenter for ICMP (All ICMP), SSO (TCP 7444), and HTTPS (TCP
443) services to the discovered IP address of the vRealize Automation appliance/server or
VRealize Automation load balancer VIP.

m  Limit network traffic to the NSX-T Manager for HTTPS (TCP 443) services to the discovered
IP address of the vRealize Automation appliance/server or vRealize Automation load
balancer VIP.
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The required firewall rules are summarized in the following table.

Table 2-2. Required Management Gateway Firewall Rules Summary

Name

vCenter

vCenter ping

NSX Manager

On pemises to ESXi ping

On Premises to ESXi
remote console and
provisioning

On-premises to SDDC VM

SDDC VM to on premises

Source

CIDR block of on-premises
data center

Any
CIDR block of on-premises

data center

CIDR block of on-premises
data center

CIDR block of on-premises
data center

CIDR block of on-premises
data center

CIDR block of SDDC
logical network

Destination

vCenter

vCenter

NSX Manager

ESXi Management Only

ESXi Management Only

CIDR block of SDDC
logical network

CIDR block of on-premises
data center

Service

Any (All Traffic)

ICMP (All ICMP)

Any (All Traffic)

ICMP (All ICMP)

TCP 902

Any (All Traffic)

Any (All Traffic)

For related information, see VMware Cloud on AWS Networking and Security and VMware
Cloud on AWS Operations Guide at VMware Cloud on AWS Documentation.

After you have configured required gateway access and firewall rules, you can continue with the
process of creating a VMware Cloud on AWS cloud account. See Create a VMware Cloud on AWS
cloud account in vRealize Automation within a sample workflow.

Create a VMware Cloud on AWS cloud account in vRealize Automation within a
sample workflow

In this step, you create a VMware Cloud on AWS cloud account in vRealize Automation.

For related information, see VMware Cloud on AWS documentation.

Prerequisites

This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter and that you
have enabled HTTPS access on port 443. See Credentials required for working with cloud
accounts in vRealize Automation.

This procedure assumes that you have the cloud administrator user role. See What are the
VRealize Automation user roles.

To facilitate the needed connection between your existing VMware Cloud on AWS host SDDC
in vCenter and a VMware Cloud on AWS cloud account in vRealize Automation, you must
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provide a network connection, and firewall rules, by using a VPN or similar networking means.
See Prepare your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud
accounts in vRealize Automation. If you are using an external HTTP Internet proxy, it must be
configured for IPv4.

m |f you do not have external Internet access, configure an Internet server proxy. See How do |
configure an Internet proxy server for vRealize Automation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts.
2 Click Add Cloud Account, select VMware Cloud on AWS, and enter values.

Sample values and supporting information are provided in the following table.
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Setting

VMC API Token

SDDC name

VMware, Inc.

Sample Value and Instruction

1  Click the /help icon at the end of
the VMC API token line and click API
Tokens page in the help text box to
open the API Tokens tab on your
organization's My Account page.

2 Click Generate Token to display the
Generate a New API Token options.

3 Enter a new token name, for example
myinitials mytoken.

4 Set the Token TTL to never expire.

If you create a token that is set

to expire, then the VMware Cloud
on AWS operations from vRealize
Automation will stop working when
the token expires and continue to
not work until you update the cloud
account with a new token.

5 In the Define Scopes section, select
All Roles.

Define Scopes

Scopes provide a way to implement granular access control.

8 airoes

Organization Roles Service Roles

6 Click Generate.

In the generated token page, click
Copy and click Continue.

8 Return to the New Cloud Account
page, paste the copied token into the
VMC API token row, and click Apply
API token.

New Cloud Account

VMware Cloud on AWS Server Credentials

VMC Al token * . ©

For this example, select
Datacenter:Datacenter-abz.

The valid SDDC name auto-populates the
vCenter and NSX-T FQDN entries. If a
cloud proxy was already deployed to the
SDDC, the cloud proxy value also auto-
populates.

Description

You can create a new token or use an existing
token for your organization on the linked API
Tokens page.

In the Define Scopes section, the minimum
required roles for the API token are:

m  Organizational Roles
m  Organization Member
m  Organization Owner
m  Service Roles - VMware Cloud on AWS
®  Administrator
m  NSX Cloud Administrator
m  NSX Cloud Auditor

Note Copy, download, or print the generated
token. Once you leave this page you cannot
retrieve the generated token.

Apply the generated or supplied token to
connect to the available SDDC environment
in your organization's VMware Cloud on AWS
subscription and populate the list of SDDC
names.

If the vRealize Automation and VMware Cloud
on AWS services are in different organizations,
you should switch to the VMware Cloud on
AWS organization and then generate the
token.

For more information about API tokens, see
Generate API Tokens.

Select from the list of available SDDCs from
your VMware Cloud on AWS subscription. The
list of SDDCs is based on the VMware Cloud on
AWS API token.

NSX-V SDDCs are not supported with vRealize
Automation and do not appear in the list of
available SDDCs.
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Setting

vCenter IP address/
FQDN

NSX Manager IP
address/FQDN

vCenter user name
and password

Validate

Name and
Description

Allow provisioning
to these data
centers

Create a cloud zone

Capability tags

VMware, Inc.

Sample Value and Instruction

The address auto-populates based on
your SDDC selection.

The address auto-populates based on
your SDDC selection.

The user name auto-populates as
cloudadmin@vmec.local.

Click Validate.

If you receive an Error updating
endpoint <Name>: Endpoint already
exists, a cloud account has already been

associated to that SDDC.

Enter ourCo-vMC for the cloud account
name.

Enter Sample deployment for VMC for
the cloud account description.

This information is read-only.

De-select the check-box. For this
example, you will create a cloud zone later
in the workflow.

Leave this empty. This workflow does not
use capability tags.

Description

Enter the IP address or FQDN of the vCenter
Server in the specified SDDC.

The IP address defaults to the private IP
address. Based on the type of network
connectivity used to access your SDDC, the
default address might be different than the
IP address of the NSX Manager Server in the
specified SDDC.

Specifies the IP address or FQDN of the NSX
Manager in the specified SDDC.

The IP address defaults to the private IP
address. Based on the type of network
connectivity used to access your SDDC, the
default address might be different than the
IP address of the NSX Manager Server in the
specified SDDC.

VMware Cloud on AWS cloud accounts
support NSX-T.

Enter your vCenter user name for the specified
SDDC if it's different than the default.

The specified user requires CloudAdmin
credentials. The user does not require
CloudGlobalAdmin credentials.

Enter the user password.

The validate action confirms your access rights
to the specified vCenter and checks that the
vCenter is running.

Lists available data centers in your specified
VMware Cloud on AWS SDDC environment.

See Learn more about Cloud Assembly cloud
zones.

Use tags according to your organization's tag
strategy. See How do | use tags to manage
Cloud Assembly resources and deployments
and Creating a tagging strategy.
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As with VMs deployed to vSphere, you can configure machine tags for a VM to be deployed
on VMware Cloud on AWS. You can also update the machine tag after initial deployment.
These machine tags allow vRealize Automation to dynamically assign a VM to an appropriate
NSX-T security group during deployment. For related information, see More about security
group and tag resources in vRealize Automation cloud templates.

3 Click Add.

Results

Resources such as machines and volumes are data-collected from the VMware Cloud on AWS
SDDC data center and listed in the Resources section of the vRealize Automation Infrastructure
tab.

What to do next

Create a cloud zone for VMware Cloud on AWS deployments in vRealize Automation.
Create a cloud zone for VMware Cloud on AWS deployments in vRealize
Automation

In this step, you create a cloud zone to specify a compute resource that the CloudAdmin user can
access when working with VMware Cloud on AWS in vRealize Automation.

In VMware Cloud on AWS, the two primary administrator credentials are CloudGlobalAdmin and
CloudAdmin. Cloud Assembly is designed to support the CloudAdmin user. Deploy to resources
that are available to a VMware Cloud on AWS CloudAdmin user. Do not deploy to resources that
require VMware Cloud on AWS CloudGlobalAdmin credentials.

Cloud zones identify the compute resources onto which a project cloud template deploys
machines, networks, and storage. See Learn more about Cloud Assembly cloud zones.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

m  Complete the Create a VMware Cloud on AWS cloud account in vRealize Automation within a
sample workflow procedure.

m  This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See
Credentials required for working with cloud accounts in vRealize Automation.

m  This procedure assumes that you have the cloud administrator user role. See What are the
VRealize Automation user roles.

Procedure

1 Select Infrastructure > Configure > Cloud Zones.
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2 Click New Cloud Zone, and enter values for the VMware Cloud on AWS environment.

Setting Sample Value

Account / region OurCo-VMC / Datacenter:Datacenter-abz
This is the cloud account and associated region that you
defined in the previous step, Create a VMware Cloud
on AWS cloud account in vRealize Automation within a
sample workflow.

Name VMC_cloud_zone-1

Description VMware Cloud on AWS resources only

Placement policy Default

Capability tags Leave this empty. This workflow does not use capability
tags.

3 Click the Compute tab.

4 Asshown in area 1 below, find and select a compute resource that is available to the
CloudAdmin user. For this example, use the resource named Cluster 1/ Compute-

ResourcePool.
Cluster 1/ Compute-ResourcePool isthe default compute resource for VMware Cloud on
AWS.

Summary m Projects

All compute resources listed apply to this cloud zo

Filter tags Enter tags to fil

© TAGS

-

Cluster-1/ Compute-RescurcePool

5 Asshown in area 2 above, add the tag name vmc _placements abz.

Tags

1 object(s) selected

Add tags vme_placements_abz X

Enter a new tag

Remove tags no tags @

6 Filter the compute resources that are used in this cloud zone by entering vmc_placements abz
in the Filter tags section.

VMware, Inc. 106



Using and Managing vRealize Automation Cloud Assembly

7 Click Save.
|:\ Name Account / regien Type Tags
[0 Custer & Cluster
Cluster-1/ Compute-ResourcePool iy OurCo-VMC / SDDC_test1_abz ResourcePool vme placements abz
[J  Cluster-1/ Mgmt-ResourcePool ResourcePool

Tm

For this example, only the compute resource named Cluster 1/ Compute-ResourcePool is
available to the CloudAdmin user.
What to do next

Configure network and storage profiles for VMware Cloud on AWS deployments in vRealize
Automation.

Configure network and storage profiles for VMware Cloud on AWS deployments
in vRealize Automation

In this step, you configure a network profile and a storage profile to specify resources that are
available to a VMware Cloud on AWS CloudAdmin user in vRealize Automation.

While an image and a flavor value are also needed, there is nothing unique about them specific to
VMware Cloud on AWS user credentials. For this example, you'll use a flavor value of small and
an image value of ubuntu-16 when you define the cloud template.

For general information about mappings and profiles, see Chapter 4 Building your Cloud
Assembly resource infrastructure.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

m Create a cloud zone. See Create a cloud zone for VMware Cloud on AWS deployments in
vRealize Automation.

m  This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See
Credentials required for working with cloud accounts in vRealize Automation.

m  This procedure assumes that you have the cloud administrator user role. See What are the
vRealize Automation user roles.
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Procedure
1 Define a network profile for VMware Cloud on AWS deployments.

a Select Infrastructure > Configure > Network Profiles and click New Network Profile.

Setting Sample value
Account / region OurCo-VMC / Datacenter:Datacenter-abz

Note Select the VMware Cloud on AWS cloud account, and its
matched SDDC data center, that you created in Create a VMware
Cloud on AWS cloud account in vRealize Automation within a
sample workflow.

Name vmc-networkl

Description Contains networks that can be accessed by cloud template
administrators who have VMware Cloud on AWS CloudAdmin
credentials.

b Click the Network tab and click Add Network.
¢ Select a network that a VMware Cloud on AWS user with CloudAdmin credentials can

deploy to, for example sddc-cgw-network-1.

Add Network

(] Name Zone Network Domain
3 sddc-cgw-network-1 cgw

[ RS + resreEOIEA 90 ARM wnnat_

2 Save the network profile.
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3 Define a storage profile for VMware Cloud on AWS deployments.

Configure a storage profile that targets a datastore/cluster that is accessible to the
CloudAdmin user.

Select Infrastructure > Configure > Storage Profiles and click new New Storage Profile.

Setting Sample Value

Account / region OurCo-VMC / Datacenter:Datacenter-abz

Select the VMware Cloud on AWS cloud account, and its matched
SDDC data center, that you created in Create a VMware Cloud on
AWS cloud account in vRealize Automation within a sample workflow.

Name vmc-storagel

Description Contains the datastore cluster that can be deployed to by
cloud template administrators who have VMware Cloud on AWS
CloudAdmin credentials.

From the Datastore / Cluster drop-down menu, select the WorkloadDatastore datastore.

Storage policy Datastore default ®

Datastore / Cluster Q Leave blank to provision to any datastore / cluste

Provisioning type vsanDat:astore 8.9 TB free ®

Datastore -

Shares

Limit IOPS

Showing 2 of 2 results. Show all

Disk mode Dependent

For VMware Cloud on AWS in Cloud Assembly, the storage policy must use the
WorkloadDatastore datastore to support VMware Cloud on AWS deployment.

4 Save the storage profile.

What to do next

Create a project to support VMware Cloud on AWS deployments in vRealize Automation.

Create a project to support VMware Cloud on AWS deployments in vRealize
Automation

In this step, you define a vRealize Automation project that can be used to control which resources
are available for VMware Cloud on AWS deployments.

For information about projects, see How do Cloud Assembly projects work at deployment time.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

Complete the Configure network and storage profiles for VMware Cloud on AWS deployments
in vRealize Automation procedure.
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m  This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See
Credentials required for working with cloud accounts in vRealize Automation.

m  This procedure assumes that you have the cloud administrator user role. See What are the
vRealize Automation user roles.

Procedure

1 Select Infrastructure > Administration > Projects.

2 Click New Project and enter the project name VMC _proj-1 abz.
3 Click Users and click Add Users.

The users need CloudAdmin credentials to their organization's VMware Cloud on AWS
subscription.

m chris.gray@ourco.com, Administrator
m  Kkerry.white@ourco.com, Member
4 Click Provisioning and then click Add Cloud Zone.

5 Add the cloud zone that you configured in the earlier step.

Setting Sample Value

Cloud zone VMC_cloud_zone-1

You created this cloud zone in the earlier step, Create a
cloud zone for VMware Cloud on AWS deployments in
vRealize Automation.

Provisioning priority 1

Instances limit 3

6 For this example, ignore the other options.

What to do next

Create a cloud template to deploy in your VMware Cloud on AWS environment. See Define
a vCenter machine resource in a cloud template design to support VMware Cloud on AWS
deployment in vRealize Automation.

Define a vCenter machine resource in a cloud template design to support
VMware Cloud on AWS deployment in vRealize Automation

In this step, you drag a vCenter machine resource onto the design canvas and add settings for a
VMware Cloud on AWS deployment in vRealize Automation.

Create a cloud template design that you can deploy to available VMware Cloud on AWS
resources.
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Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

This procedure assumes that you have cloud template designer credentials. See What are the
vRealize Automation user roles.

This procedure assumes that you have VMware Cloud on AWS CloudAdmin credentials for
the target SDDC in vCenter (Datacenter:Datacenter-abz). See Credentials required for working
with cloud accounts in vRealize Automation.

Configure the resource infrastructure and project as described in the preceding sections.

Procedure

1

Click the Design tab and then click New.

Setting Sample Value
Name vmc-bp_abz
Description 1

Project VMC_proj-1_abz

This is the project that you created earlier, which
supports the cloud zone that you also created earlier.
The project is now associated with the cloud zone, which
in turn is associated with the VMware Cloud on AWS
cloud account/region that you created earlier.

2 Slide a vSphere machine resource onto the canvas.

3 Edit the following (bold) cloud template resource code in the machine resource.

formatVersion: 1
inputs: {}
resources:

Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:

image: ubuntu-1604
cpuCount: 1
totalMemoryMB: 1024
folderName: Workloads

The image can be any value that is appropriate to your deployment needs.

You must add the folderName: Workloads Statement to the cloud template design code to
support VMware Cloud on AWS deployment. The folderName: Workloads setting supports the
CloudAdmin credentials in the VMware Cloud on AWS SDDC environment and is required.
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Note: While the folderName: Workloads setting shown in the above code sample is required,
you can add it directly in the cloud template code as shown above or you can add it in the
associated cloud zone or project. If the setting is specified in more than one of these three
places, the precedence is as follows:

m  The project setting overrides the cloud template setting and the cloud zone setting.
m  The cloud template setting overrides the cloud zone setting.

Note: You can optionally replace the cpuCount and totalMemoryMB settings with a flavor
(sizing) entry, as shown below:

formatVersion: 1
inputs: {}
resources:

Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:

image: ubuntu-1604
flavor: small
folderName: Workloads

If the cloud zone has the folder value set to Workloads, you do not need to set the folderName
property in the cloud template, unless you want to override the cloud zone folder value.

What to do next

Expand on this basic VMware Cloud on AWS workflow by adding network isolation. See Configure
an isolated network in VMware Cloud on AWS workflow in vRealize Automation.

Configure an isolated network in VMware Cloud on AWS workflow in
vRealize Automation

In this procedure, you add an isolated network for your VMware Cloud on AWS deployment in
vRealize Automation.

When you define your VMware Cloud on AWS cloud account, NSX-T settings configured in your
VMware Cloud on AWS service are available. For information about configuring NSX-T settings in
your VMware Cloud on AWS service, see VMware Cloud on AWS product documentation.

VRealize Automation supports VMware Cloud on AWS with NSX-T. It does not support VMware
Cloud on AWS with NSX-V.

vRealize Automation supports network isolation for VMware Cloud on AWS deployments. It does
not support other network methods for VMware Cloud on AWS.

This extension of the basic VMware Cloud on AWS workflow describes the following methods of
creating an isolated network for use in your cloud template:

m  Configure on-demand network-based isolation.

m  Configure on-demand security group-based isolation.
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Prerequisites

This procedure expands on the basic VMware Cloud on AWS workflow. It uses the same cloud
account and region, cloud zone, project, and network profile that you configured in the Tutorial:
Configuring VMware Cloud on AWS for vRealize Automation workflow.

Procedure

1 Define an isolated network for a VMware Cloud on AWS deployment in vRealize Automation
You can configure network isolation for a VMware Cloud on AWS deployment by using either
of the following procedures:

2 Define a network component in a cloud template to support network isolation for VMware
Cloud on AWS in vRealize Automation

In this step, you drag a network machine component onto a vRealize Automation cloud
template canvas and add settings for an isolated network deployment to your target VMware
Cloud on AWS environment.

Define an isolated network for a VMware Cloud on AWS deployment in vRealize
Automation

You can configure network isolation for a VMware Cloud on AWS deployment by using either of
the following procedures:

m  Configure on-demand network-based isolation in vRealize Automation

m  Configure on-demand security group-based isolation in vRealize Automation

Configure on-demand network-based isolation in vRealize Automation

You can configure network isolation for your VMware Cloud on AWS deployment needs by
specifying and using on-demand network settings in a network profile.

You can specify an isolated network by using a security group or by using on-demand network
settings. In this example, you configure network isolation by specifying on-demand network
settings in the network profile. Later, you access the network in a cloud template and use the
cloud template in a VMware Cloud on AWS deployment.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

m  Complete the Configure a basic VMware Cloud on AWS workflow in vRealize Automation
workflow.

m  Review Configure an isolated network in VMware Cloud on AWS workflow in vRealize
Automation.

m  This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See
Credentials required for working with cloud accounts in vRealize Automation.
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m  This procedure assumes that you have the cloud administrator user role. See What are the
vRealize Automation user roles.

Procedure

1 Open the network profile that you used in the basic VMware Cloud on AWS workflow, for
example vmc-networkl. See Configure network and storage profiles for VMware Cloud on
AWS deployments in vRealize Automation.

2 You do not need to make any selections on the Networks tab.
3 Click the Network Policies tab.

4 Select the Create an on-demand network option and select the default cgw network domain.
Specify an appropriate CIDR and subnet size.

5 Click Save.

When you use this network profile, machines are deployed to a network in the default network
domain. The network is isolated from other networks by using private or outbound network
access.

What to do next
Configure a network component in your cloud template. See Define a network component in a
cloud template to support network isolation for VMware Cloud on AWS in vRealize Automation

Configure on-demand security group-based isolation in vRealize Automation

You can configure network isolation for your VMware Cloud on AWS deployment needs by
specifying and using an on-demand security group in a network profile.

You can specify an isolated network by using a security group or by using on-demand network
settings. In this example, you configure network isolation by specifying an on-demand security
group in the network profile. Later, you specify the network in a cloud template and use the cloud
template in a VMware Cloud on AWS deployment.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.

Prerequisites

m  Complete the Configure a basic VMware Cloud on AWS workflow in vRealize Automation
workflow.

m  Review Configure an isolated network in VMware Cloud on AWS workflow in vRealize
Automation.

m  This procedure assumes that you have the required administrator credentials, including
VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter. See
Credentials required for working with cloud accounts in vRealize Automation.

m  This procedure assumes that you have the cloud administrator user role. See What are the
vRealize Automation user roles.
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Procedure

1 Open the network profile that you used in the basic VMware Cloud on AWS workflow, for
example vmc-networkl. See Configure network and storage profiles for VMware Cloud on
AWS deployments in vRealize Automation .

2 Select the existing network that you used in the basic VMware Cloud on AWS workflow,
for example sddc-cgw-network-1. See Configure network and storage profiles for VMware
Cloud on AWS deployments in vRealize Automation.

3 Click the Network Policies tab.
4 Select the Create an on-demand security group option.

Summary MNetworks MNetwork Policies Load Balancers Security

Use these settings when creating outbound and private networks. @

) Do not create on-demand network or on-d X
On-Demand Security Group
() Create an on-demand network (D)

© Create an on-demand security grou- Traffic rules for the deployment are defined
» by a security group. This method may be

more efficient for large networks, but uses

Network Resources
more IP addresses.

External network DONT-DELETE-D

5 Click Save.

When you use this network profile, machines are deployed to the selected network and are
isolated by a new security group policy. The new security policy allows private or outbound
network access.

What to do next

Configure a network component in your cloud template. See Define a network component in a
cloud template to support network isolation for VMware Cloud on AWS in vRealize Automation

Define a network component in a cloud template to support network isolation for
VMware Cloud on AWS in vRealize Automation

In this step, you drag a network machine component onto a vRealize Automation cloud template
canvas and add settings for an isolated network deployment to your target VMware Cloud on
AWS environment.

Add network isolation to the cloud template that you created earlier. The cloud template is already
associated with a project and cloud zone that support deployment to your VMware Cloud on AWS
environment, as well as the network profile and network that you configured for isolation.

Unless otherwise indicated, the step values that you enter in this procedure are for this example
workflow only.
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Prerequisites

Complete the Configure on-demand security group-based isolation in vRealize Automation or
Configure on-demand network-based isolation in vRealize Automation procedure.

This procedure assumes that you have cloud template designer credentials. See What are the
vRealize Automation user roles.

This procedure assumes that you have VMware Cloud on AWS CloudAdmin credentials for the
target SDDC in vCenter. See Credentials required for working with cloud accounts in vRealize
Automation.

Procedure

1

Open the cloud template that you created in the previous workflow. See Define a vCenter
machine resource in a cloud template design to support VMware Cloud on AWS deployment
in vRealize Automation.

From the components on the left of the cloud template design page, drag a network
component onto the canvas.

Edit the network component YAML code to specify a network type of either private or
outbound, as shown in bold.

resources: Cloud Network 1:
type: Cloud.Network
properties:

name: vmc_ isolated

networkType: private

OR

resources: Cloud Network 1:
type: Cloud.Network
properties:

name: vmc_isolated

networkType: outbound

What to do next

You are ready to deploy or close the cloud template.

Tutorial: Configuring a provider-specific external IPAM
integration for vRealize Automation

You can use an external IPAM provider to manage IP address assignments for your cloud template
deployments. This tutorial describes how to configure external IPAM integration in vRealize
Automation using Infoblox as the external IPAM provider.
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In this procedure, you use an existing IPAM provider package, in this case an Infoblox package,

and an existing running environment to build a provider-specific IPAM integration point. You

configure an existing network and create a network profile to support IP address allocation from
the external IPAM provider. Finally, you create a cloud template that is matched to the network
and network profile and deploy networked machines using IP values obtained from the external

IPAM provider.

Information about how to obtain and configure the IPAM provider package, and how to configure

a running environment that accesses a cloud extensibility proxy to support the IPAM provider
integration, is included as reference.

The values you see in this sample workflow are example values. You won't be able to use them
verbatim in your environment. Think about where you would make your own substitutions to fit

your organization's needs.

To reference a similar vRealize Automation scenario that illustrates an Infoblox IPAM
integration workflow in video form, see Infoblox IPAM Plug-in Integration with vRealize
Automation / vRealize Automation Cloud.

Procedure

1 Add required extensible attributes in the Infoblox application for integration with vRealize
Automation
Before you can download and deploy the Infoblox provider package (infoblox.zip) for
integration with vRealize Automation from either the Infoblox website or from the VMware
Marketplace, you must add required extensibility attributes in Infoblox.

2 Download and deploy an external IPAM provider package for use in vRealize Automation

Before you can define an external IPAM integration point in vRealize Automation, you need a

configured IPAM provider package.

3 Create a running environment for an IPAM integration point in vRealize Automation

Before you can define a external IPAM integration point in vRealize Automation, you need to

create or access an existing running environment to serve as an intermediary between the

IPAM provider and vRealize Automation. The running environment is commonly an Amazon

Web Services or Microsoft Azure cloud account or an on-premises actions-based extensibility

integration point that is associated to a cloud extensibility proxy.

4 Add an external IPAM integration for Infoblox in vRealize Automation

VRealize Automation supports integration with an external IPAM provider. This example uses

Infoblox as the external IPAM provider.

5 Configure a network and network profile to use external IPAM for an existing network in
VRealize Automation

You can define an existing network to use |IP address values that are obtained from, and
managed by, an external IPAM provider rather than internally from vRealize Automation.

VMware, Inc.

n7


https://vmwarelab.org/2020/05/11/infoblox-ipam-plug-in-1-1-integration-with-vrealize-automation-8-1-vrealize-automation-cloud/
https://vmwarelab.org/2020/05/11/infoblox-ipam-plug-in-1-1-integration-with-vrealize-automation-8-1-vrealize-automation-cloud/

Using and Managing vRealize Automation Cloud Assembly

6 Define and deploy a cloud template that uses an external IPAM provider range assignment in
VRealize Automation

You can define a cloud template to obtain and manage IP address assignments from your
external IPAM provider. This example uses Infoblox as the external IPAM provider.

7 Using Infloblox-specific properties and extensible attributes for IPAM integrations in vRealize
Automation cloud templates
You can use Infloblox-specific properties for vRealize Automation projects that contain
external IPAM integrations for Infoblox.

8 Control network data collection by using Infoblox filters in vRealize Automation

For Infloblox, you can limit the number of data collected networks to only those networks that
are needed for vRealize Automation operations. This reduces the amount of transferred data
and enhances system performance.

Add required extensible attributes in the Infoblox application for
integration with vRealize Automation

Before you can download and deploy the Infoblox provider package (infoblox.zip) for
integration with vRealize Automation from either the Infoblox website or from the VMware
Marketplace, you must add required extensibility attributes in Infoblox.

This procedure is applicable if you are creating an external IPAM integration point for Infoblox
integration with Cloud Assembly.

Before you can use the infoblox.zip download, you must log in to your Infoblox account,
using your organization account administrator credentials, and pre-create the following Infoblox
extensible attributes:

B VMware NIC index

m  VMware resource ID

Prerequisites

m  Verify that you have an account with Infoblox and that you have the correct access credentials
to your organization's Infoblox account.

m  Confirm that the Infoblox WAPI version is supported. IPAM integration with Infoblox depends
on Infoblox WAPI version v2.7. Infoblox appliances that support WAPI v2.7 are supported.

m  Review Using Infloblox-specific properties and extensible attributes for IPAM integrations in
VRealize Automation cloud templates.

Procedure
1 Loginto your Infoblox account using administrator credentials.

These are the same administrator user name and password credentials that you specify when
you create an external IPAM integration point in Cloud Assembly using the Infrastructure >
Connections > Integrations > menu sequence.
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2 Use the procedure described in the Infoblox documentation to create the following required
extensible attributes in your Infoblox application.

m VMware NIC index - type Integer
m VMware resource 1D -type String

The procedure is described in the Adding Extensible Attributes section of the Infoblox
documentation topic About Extensible Attributes. Also see Managing Extensible Attributes.

What to do next

After you add the required attributes, you can resume the process of downloading and deploying
the Infloblox package as described in Download and deploy an external IPAM provider package
for use in vRealize Automation.

Download and deploy an external IPAM provider package for use in
VRealize Automation

Before you can define an external IPAM integration point in vRealize Automation, you need a
configured IPAM provider package.
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You can download a provider-specific integration package from your IPAM provider's website or
the VMware Marketplace.

Note This example uses the VMware-supplied Infoblox package Infoblox.zip, wWhich is available
for download from VMware Marketplace as follows:

m Infoblox plug-in version 1.4 - Compatible with release vRealize Automation 8.3 - 8.7 and
providing all the functionality of previous versions. With this version, you can use the same
host name with a different DNS suffix for two NICs. See plug-in release notes for additional
details.

m Infoblox plug-in version 1.3 - Compatible with vRealize Automation 8.3.x and providing
additional network data collection filters. See Control network data collection by using Infoblox
filters in vRealize Automation. If you are using vRealize Automation 8.3.x you can instead use
Infoblox plug-in 1.4 to take advantage of additional capabilities.

The Infoblox v1.3 plug-in may be used with vRealize Automation 8.1 or 8.2, but only in select
situations and with caution as described in KB article Infoblox 1.3 Compatibility with vRealize
Automation 8.x (82142).

m  VRA Cloud Infoblox plugin version 1.2 - Compatible with vRealize Automation 8.1.x and 8.2.x
m  VRA Cloud Infoblox plugin version 1.1 - Compatible with vRealize Automation 8.1.x

m  VRA Cloud Infoblox plugin version 1.0 - Compatible with vRealize Automation 8.0.1.x with or
without an internet connection to the global network.

m  VRA Cloud Infoblox plugin version 0.4 - Compatible with vRealize Automation 8.0.0.x and
8.0.1.x when there is an internet connection with the global network.

IPAM integration with Infoblox depends on Infoblox WAPI version v2.7. All Infoblox appliances
that support WAPI v2.7 are supported.

For information about how to create an IPAM integration package for other IPAM providers, if one
does not already exist in the VMware Marketplace, see How do | use the IPAM SDK to create a
provider-specific external IPAM integration package for vRealize Automation.

The IPAM provider package contains scripts that are packaged with metadata and other
configurations. The scripts contain the source code used for the operations that vRealize
Automation performs in coordination with the external IPAM provider. Example operations include
Allocate an IP address for a virtual machine, Fetch a list of IP ranges from

the provider, and Update the MAC address of a host record in the provider.

Prerequisites

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.
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m  Verify that you have an account with the external IPAM provider, for example Infoblox or
Bluecat, and that you have the correct access credentials to your organization's account with
the IPAM provider.

m If you are using Infobox as your external IPAM provider, verify that you have added the
required extensible attributes to your Infoblox account before continuing. See Add required
extensible attributes in the Infoblox application for integration with vRealize Automation.

Note A certificate chain issue exists relative to how the Python element in the Infoblox plug-in
handles SSL handshakes. For information about the issue and required actions to resolve the
issue, see Knowledge Base Article VRA Cloud Infoblox Plugin throws a certificate chain error
during authentication process (88057).

Procedure

1 Navigate to the correct download page for the Infoblox plug. See above for links to a specific
Infoblox plug-in version.

See above for the Infoblox plugin options that are available in the VMware Marketplace.
2 Login and download the plug-in package.

3 If you have not already done so, add the required extensible attributes in Infoblox. See
Add required extensible attributes in the Infoblox application for integration with vRealize
Automation.

Results

The package is now available for you to deploy by using the Integrations > Add Integration >
IPAM > Manage Providers > Import package menu sequence as described in Add an external
IPAM integration for Infoblox in vRealize Automation .

Create a running environment for an IPAM integration point in
VRealize Automation

Before you can define a external IPAM integration point in vRealize Automation, you need to
create or access an existing running environment to serve as an intermediary between the
IPAM provider and vRealize Automation. The running environment is commonly an Amazon
Web Services or Microsoft Azure cloud account or an on-premises actions-based extensibility
integration point that is associated to a cloud extensibility proxy.

External IPAM integration requires a running environment. When you define the IPAM integration
point, you create a connection between Cloud Assembly and your IPAM provider by specifying an
available running environment.
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IPAM integration uses a set of downloaded provider-specific scripts or plug-ins in a running
environment that is facilitated by a Feature-as-a-Services (FaaS) provider such as Amazon Web
Services Lambda, Microsoft Azure Functions, or an actions-based extensibility (ABX) On-Prem
Embedded integration point. The running environment is used to connect to the external IPAM
provider, for example Infoblox.

Note An Infoblox IPAM integration point requires an actions-based extensibility (ABX) On-Prem
Embedded integration point.
Each type of runtime environment has advantages and disadvantages:
m  An actions-based extensibility (ABX) integration point:
m s free, no additional vendor usage costs.

m can connect to IPAM vendor appliances that reside in an on-premises data center behind a
NAT/firewall that is not publicly accessible, for example Infoblox.

m is slower with slightly less available performance than commercial cloud.
= Amazon Web Services
m has associated vendor FaaS connection/usage costs.

m  cannot connect to IPAM vendor appliances that reside in an on-premises data center
behind a NAT/firewall that is not publicly accessible.

= has fast and highly reliable performance.
m  Microsoft Azure
= has associated vendor FaaS connection/usage costs.

= cannot connect to IPAM vendor appliances that reside in an on-premises data center
behind a NAT/firewall that is not publicly accessible.

m  has fast and highly reliable performance.

Prerequisites

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have an account with the external IPAM provider, for example Infoblox or
Bluecat, and that you have the correct access credentials to your organization's account with
the IPAM provider.

m  Verify that you have access to a deployed integration package for your IPAM provider, such
as Infoblox or BlueCat. The deployed package is initially obtained as a .zip download from
your IPAM provider website or from the VMware Marketplace and then deployed in Cloud
Assembly.
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For information about how to deploy the provider package .zip file and make it available as
a Provider value on the IPAM Integration page, see Download and deploy an external IPAM
provider package for use in vRealize Automation.

Procedure

1 To create an On-Prem FaaS-based extensibility action to use as an IPAM integration running
environment, select Extensibility > Library > Actions.

2 Click New Action, enter an action name and description, and specify a project.
3 Inthe FaaS provider drop-down menu, select On Prem.
4 Complete the form to define the extensibility action.

For more information about creating extensibility actions, see Extending and automating
application life cycles with extensibility.

For related information about the running environment, see this Infoblox IPAM Plug-in
Integration blog video at approximately 24 minutes into the video.

Add an external IPAM integration for Infoblox in vRealize Automation

VvRealize Automation supports integration with an external IPAM provider. This example uses
Infoblox as the external IPAM provider.

You can use a provider-specific IPAM integration point to obtain and manage IP addresses and
related network characteristics for cloud template deployments.

In this example, you create an external IPAM integration point to support access to your
organization's account with an external IPAM provider. In this example workflow, the IPAM
provider is Infoblox and the provider-specific integration package already exists. While these
instructions are specific to an Infoblox integration, they can be used as reference if creating an
IPAM integration for a different external IPAM provider.

You can obtain a provider-specific integration package from your IPAM provider's website or the
VMware Marketplace.

This example uses the VMware-supplied Infoblox package Infoblox.zip, which is available for
download from the VMware Marketplace. For information about the latest Infloblox plug-in
versions that are available in the VMware Marketplace, see Download and deploy an external
IPAM provider package for use in vRealize Automation .

Prerequisites

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.
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m  Verify that you have an account with external IPAM provider and that you have the correct
access credentials to your organization's account with the IPAM provider.

m  Verify that you have access to a deployed integration package for your IPAM provider. The
deployed package is initially obtained as a .zip download from your IPAM provider website, or
from the VMware solutions exchange marketplace, and then deployed to vRealize Automation.

For information about how to download and deploy the provider package .zip file and make
it available as a Provider value on the IPAM Integration page, see Download and deploy an
external IPAM provider package for use in vRealize Automation.

m  Verify that you have access to a configured running environment for the IPAM provider. The
running environment is typically an actions-based extensibility (ABX) On-Prem Embedded
integration point.

For information about running environment characteristics, see Create a running environment
for an IPAM integration point in vRealize Automation.

m  Enable required extensible attributes in your Infoblox application. See Add required extensible
attributes in the Infoblox application for integration with vRealize Automation.

m If you do not have external Internet access, you can configure an Internet server proxy. See
How do | configure an Internet proxy server for vRealize Automation.

m  Verify that you have the required user credentials to access and use your Infoblox IPAM
product. For example, open the Administration tab in the Infoblox appliance and customize
administrator, groups, and roles entries. You must be a member of a group that has
administrator or superuser permissions or a custom group that has DHCP, DNS, IPAM, and
Grid permissions. These settings allow access to all the functionality that is available in the
Infoblox plug-in, enabling you to create an Infoblox IPAM integration and designers to use
that IPAM integration in cloud templates and deployments. For more information about user
permissions, see your Infoblox product documentation.

Procedure
1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Click IPAM.

3 Inthe Provider drop-down, select a configured IPAM provider package from the list, for
example /nfoblox_ hrg.

If the list is empty, click Import Provider Package, navigate to an existing provider
package .zip file, and select it. If you do not have the provider .zip file, you can obtain it from
your IPAM provider's web site or from the VMware Marketplace.

For information about how to deploy the provider package .zip file in vCenter and make it
available as a Provider value on the Integration page, see Download and deploy an external
IPAM provider package for use in vRealize Automation.
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For information about how to upgrade an existing IPAM integration to use a more recent
version of a vendor's IPAM integration package, see How to upgrade to a newer external
IPAM integration package in vRealize Automation .

4 Enter your administrator user name and password credentials for your account with the
external IPAM provider, along with all other (if any) mandatory fields, such as the host name of
your provider.

In this example, you obtain the host name of your Infoblox IPAM provider using the following
steps:

a In aseparate browser tab, log in to your IPAM provider account using your Infoblox
administrator credentials.

b Copy your host name URL.
c Paste your host name URL in the Hostname field on the IPAM Integration page.

5 Inthe Running Environment drop-down list, select an existing on-premises actions-based
extensibility integration point, for example /nfoblox_abx_intg.

The running environment supports communication between vRealize Automation and the
external IPAM provider.

Note If you use an Amazon Web Services or Microsoft Azure cloud account as the integration
running environment, be sure that the IPAM provider appliance is accessible from the Internet
and is not behind a NAT or firewall and that it has a publicly resolvable DNS name. If the IPAM
provider is not accessible, the Amazon Web Services Lambda or Microsoft Azure Functions
cannot connect to it and the integration will fail. For related information, see Create a running
environment for an IPAM integration point in vRealize Automation.

The IPAM framework only supports an actions-based extensibility (ABX) On-Prem Embedded
running environment.

Note An Infoblox IPAM integration point requires an actions-based extensibility (ABX) On-
Prem Embedded integration point.

The configured cloud account or integration point allows communication between vRealize
Automation and the IPAM provider, in this example Infoblox, through an associated cloud
extensibility proxy. You can select a provider that has already been created or you can create
one.

For information about how to create a running environment, see Create a running environment
for an IPAM integration point in vRealize Automation.

6 Click Validate.

Because this example uses the on-premises actions-based extensibility integration for the
running environment, you can view the validation action.

a Click the Extensibility tab.
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b Click Activity > Action Runs and select either All Runs or Integration runs from the filter to
note that an endpoint validation action is initiated and running.

7 When prompted to trust the self-signed certificate from the IPAM provider, click Accept.
After you accept the self-signed certificate, the validation action can continue to completion.

8 Enter a Name for this IPAM integration point, such as /nfloblox_ Integration, and a
Description, such as /nfoblox IPAM with ABX integration for team HRG.

9 Click Add to save the new external IPAM integration point.

A data collection action is imitated. Networks and IP ranges are data-collected from the IPAM
provider. You can view the data collection action as follows:

a Click the Extensibility tab.

b Click Activity > Action Runs and note that a data collection action is initiated and running.
You can open and view the action run content.

Results

The provider-specific external IPAM integration is now available for use with networks and
network profiles.

Configure a network and network profile to use external IPAM for an
existing network in vRealize Automation

You can define an existing network to use IP address values that are obtained from, and managed
by, an external IPAM provider rather than internally from vRealize Automation.

You can define a network to access existing IP settings that you have defined in your
organization's external IPAM provider account. This step expands on the Infoblox provider
integration that you created in the previous step.

In this example, you configure a network profile with existing networks that were data-collected
from vCenter. You then configure these networks to obtain IP information from an external IPAM
provider, in this case Infoblox. Virtual machines that you provision from vRealize Automation that
can be matched with this network profile obtain their IP and other TCP/IP related settings from the
external IPAM provider.

For more information about networks, see Network resources in vRealize Automation. For more
information about network profiles, see How to add network profiles in vRealize Automation and
Learn more about network profiles in vRealize Automation .

For related information, see How do | configure a network profile to support an on-demand
network for an external IPAM integration in vRealize Automation.
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Prerequisites

This sequence of steps is shown in the context of an IPAM provider integration workflow. See
Tutorial: Configuring a provider-specific external IPAM integration for vRealize Automation .

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have an account with the external IPAM provider, for example Infoblox or
Bluecat, and that you have the correct access credentials to your organization's account with
the IPAM provider. In this example workflow, the IPAM provider is Infoblox.

m  Verify that you have an IPAM integration point for the IPAM provider. See Add an external
IPAM integration for Infoblox in vRealize Automation .

Procedure
1 To configure a network, click Infrastructure > Resources > Networks.

2 Onthe Networks tab, select an existing network to use with the IPAM provider integration
point. In this example, the network name is net.23.717-only-1PAM.

Listed networks have been data-collected by vRealize Automation from a vCenter in your
organization.

3 To obtain values from the external IPAM provider, verify that except for the Account/region,
Name, and Network domain, all other network settings are empty, including the following:

m Domain (See Note in step 8)
m CIDR
m  Default gateway
m  DNS servers
m  DNS search domains
4 Click the IP Ranges tab and click Add IPAM IP Range.

5 From the Network menu, select the network that you just configured, for example net.23.717-
only-1PAM.

6 From the Provider menu, select the /nfloblox_ Integration IPAM integration point that you
created earlier in the workflow

7 From the now-visible Address Space drop-down menu, select one of the listed network views.

An address space in Infoblox is referred to as a network view.

VMware, Inc. 127


https://www.infoblox.com
https://www.bluecatnetworks.com

Using and Managing vRealize Automation Cloud Assembly

10

1

12

13

The network views are obtained from your IPAM provider account. This example uses

the network subnet that you just configured, for example net.23.717-only-IPAM, the

Infloblox_ Integration integration point that you created earlier in the workflow, and an address
space named default.

Listed address space values are obtained from the external IPAM provider.

From the list of displayed networks that are available for the selected address space, select
one or more networks, for example select 10.23.117.0/24.

For this example, the Domains and DNS Servers column values for the selected network

contain values from Infoblox.

Note If you select a network in Step 3 that had a Domain specified for vRealize Automation,
and then select a network from the external IPAM provider address space that contains a
Domain value, the Domain value in the external IPAM provider network takes precedence
over the Domain specified in vRealize Automation. If the IPAM IP range setting doesn't have
a Domain value, specified in either Cloud Assembly or in the external IPAM provider as
described above, provisioning fails.

For Infoblox, you can use the blueprint property Infoblox.IPAM.Network.dnsSuffix at the
machine level to overwrite the Domain value. For related information, see Using Infloblox-
specific properties and extensible attributes for IPAM integrations in vRealize Automation
cloud templates.

Click Add to save the IPAM IP range for the network.
The range is visible in the IP Ranges table.
Click the IP Addresses tab.

After you provision a machine by using the new address range from the external IPAM
provider, a new record will be visible in the IP Addresses table.

To configure a network profile to use the network, click Infrastructure > Configure > Network
Profiles.

Name the network profile, for example /nfoblox-NP, and add the following sample settings.
= Summary tab

m  Specify a vSphere cloud account/region.

m  Add a capability tag for the network profile, for example named /infoblox_ abx.

Make note of the capability tag, as you must also use it as a cloud template constraint
tag to make the provisioning association in the cloud template.

m  Networks tab
= Add the network that you created earlier, for example net.23.717-only-IPAM.

Click Save to save the network profile with these settings.
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Results

The network and network profile setting are now configured for an existing network type to be
used for the Infoblox IPAM integration in a cloud template.

Define and deploy a cloud template that uses an external IPAM
provider range assignment in vRealize Automation

You can define a cloud template to obtain and manage IP address assignments from your external
IPAM provider. This example uses Infoblox as the external IPAM provider.

In this final step in the external IPAM integration workflow, you define and deploy a cloud template
that connects your previously defined network and network profile to your organization's Infoblox
account to obtain and manage |IP address assignments for deployed VMs from the external IPAM
provider rather than from vRealize Automation.

This workflow uses Infoblox as the external IPAM provider and in some steps, the example values
are unique to Infoblox, although the intent is that the procedure can be applied to other external
IPAM integrations.

C:l The Automate IPAM and DNS for VMs using VMware vRealize Automation and Infoblox DDI
Infoblox blog provides related information.

After you deploy the cloud template and the VM is started, the |IP address used for each VM in the
deployment appears as a network entry in the Resources > Networks page, as a new host record
in the IPAM provider network in your IPAM provider's account, and in the vSphere Web Client
record for each deployed VM in the host vCenter.

Prerequisites

This sequence of steps is shown in the context of an external IPAM provider integration workflow.
See Tutorial: Configuring a provider-specific external IPAM integration for vRealize Automation .

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have an account with the external IPAM provider, for example Infoblox or
BlueCat, and that you have the correct access credentials to your organization's account with
the IPAM provider.

m  Verify that you have administrator access to the host account and any role requirements
needed to display status records in the vSphere web client record for your deployed VMs in
the host vCenter.

m  Verify that you have an IPAM integration point for the external IPAM provider. See Add an
external IPAM integration for Infoblox in vRealize Automation .
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Verify that you have configured a vRealize Automation network and network profile that
support external IPAM integration for your intended IPAM integration point. See Configure
a network and network profile to use external IPAM for an existing network in vRealize
Automation .

Verify that your project and cloud zone are tagged to match tags in the IPAM integration point
and network or network profile. Optionally configure the project to support custom resource
naming.

For more information than provided about the role of a project and cloud zone, as well as

the role of other infrastructure elements in your cloud template, see Tutorial: Setting up and
testing multi-cloud infrastructure and deployments in Cloud Assembly. For more information
about tagging, see How do | use tags to manage Cloud Assembly resources and deployments.

For information about custom naming VMs by using settings in your project, see Custom
naming for deployed resources in Cloud Assembly.

Procedure

1

Click Cloud templates > New, enter the following information in the New cloud template
page, and click Create.

= Name = ipam-bpa
m  Description = Cloud template that uses Infoblox IPAM integration
m  Project = 123VC

For this example, add a cloud agnostic machine component and a cloud agnostic network
component to the cloud template canvas and connect the two components.

Edit the cloud template code to add a constraint tag to the network component that matches
the capability tag that you added to the network profile. For this example, that tag value is
infoblox_ abx.

Edit the cloud template code to specify that the network assignment type is static.
When using an external IPAM provider, the assignment: static setting is required.

For this example, the specified IP address 10.23.117.4 is known to be currently available in

the external IPAM address space that we selected for the network in the associated network
profile. While the assignment: static setting is required, the address: valuesetting is not.
You can choose to begin external IP address selection at a particular address value, but doing
so is not required. If you do not specify an address: value setting, the external IPAM provider
selects the next available address in the external IPAM network.

Verify the cloud template code against the following example.

formatVersion: 1
inputs: {}
resources:
Cloud Network 1:
type: Cloud.Network

VMware, Inc. 130



Using and Managing vRealize Automation Cloud Assembly

10

1

properties:
networkType: existing
name: ipam
constraints:
- tag: infoblox abx
Cloud Machine 1:
type: Cloud.Machine
properties:
image: ubuntu
flavor: small
networks:
- network: '${resource.Cloud_Network_l.id}'
assignment: static
address: 10.23.117.4

name: '${resource.Cloud_Network_l.name}'

For examples of Infoblox properties that are available for specifying DNS and DHCP settings
in cloud templates, see Using Infloblox-specific properties and extensible attributes for IPAM
integrations in vRealize Automation cloud templates.

Click Deploy on the cloud template page, name the deployment /nfoblox-1, and click Deploy
on the Deployment Type page.

As the cloud template is being deployed, click the Extensibility tab and select Activity >
Action Runs to see the /nfoblox_ AllocatelP_ n extensibility action running.

After the extensibility action is completed and the machine is provisioned, the
Infloblox_ Update_ n action propagates the MAC address to Infoblox.

You can log in to and open your Infoblox account to see the new host record for the IPAM
address in the associated 10.23.117.0/24 network. You can also open the DNS tab in Infoblox to
see the new DNS host record.

To verify that the VM is being provisioned, log in to your host vCenter and vSphere Web Client
to locate the provisioned machine and view the DNS name and IP address.

After the provisioned VM is started, the MAC address is propagated to Infoblox by an
Infoblox_ AllocatelP extensibility action.

To view the new network record in vRealize Automation, select Infrastructure > Resources >
Networks and click to open the IP Addresses tab.

If you delete the deployment, the IPAM address of VMs in the deployment are released and
the IP addresses are again available to the external IPAM provider for other allocations. The
extensibility action for this event in vRealize Automation is /nfoblox_ Deallocate.

Using Infloblox-specific properties and extensible attributes for IPAM
integrations in vRealize Automation cloud templates

You can use Infloblox-specific properties for vRealize Automation projects that contain external
IPAM integrations for Infoblox.
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The following Infloblox properties are available for use with your Infoblox IPAM integrations in
cloud template designs and deployments. You can use them in vRealize Automation to further
control IP address allocation during cloud template deployment. Use of these properties is
optional.

Note If you are using the Infoblox plug-in 1.4 or earlier, a global Infoblox property overrides a
local Infoblox property for dnssuffix, dnsView, enableDns, and enableDhcp properties. A global
property applies to all NICs.

The following properties are available and included in the most recent version Infoblox plug-in
for vRealize Automation. For information about Infoblox plug-in versions and where to obtain the
most recent version of the Infoblox plug-in for your IPAM integration in vRealize Automation, see
Download and deploy an external IPAM provider package for use in vRealize Automation.

m Infoblox.IPAM.createFixedAddress

This property enables you to create a fixed address record inside Infoblox. Possible values are
True and False. By default, a host record is created. The default value is False.

m Infoblox.IPAM.Network.dnsView
This property enables you to use a DNS view when creating a host record inside Infoblox.
m Infoblox.IPAM.Network.enableDns

When allocating an IP in Infoblox, this property enables you to also create a DNS record.
Possible values are True and False. The default value is True.

m Infoblox.IPAM.Network.enableDhcp

This property enables you to set the DHCP configuration for the host address. Possible values
are True and False. The default value is True.

m Infoblox.IPAM.Network.dnsSuffix

This property enables you to overwrite the domain DHCP option of an Infoblox network with
a new one. This capability is useful if the Infoblox network does not have the domain DHCP
option set or if the domain DHCP option must be overwritten. The default value is null (empty
string).

When using an external IPAM provider such as Infoblox, you must specify a DNS suffix when
provisioning a machine. While the DNS suffix is required, you can specify it in any of the
following ways:

m  Specify the DNS suffix on the vSphere network subnet in vRealize Automation.

m  Specify the Infoblox.IPAM.Network.dnsSuffix property in the machine resource code
in the vRealize Automation cloud template.

An example is shown below in the Infoblox.IPAM.Network.hostnameNicSuffix section.

Infoblox.IPAM.Network.dnsSuffix is only applicable if
Infoblox.IPAM.Network.enableDns is set to True.
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m Infoblox.IPAM.Network.hostnameNicSuffix
You can use this property to specify a NIC index suffix when generating a host name.

This allows you to provision a machine with more than one NIC such that the host names for
each NIC are distinguished by a custom-defined suffix. As seen in the following example, you
can provision a machine, for example my-machine, that has 2 NICs so that the host name suffix
for the first NIC is -nic1 and the other is -nic2.

You can also specify a DNS suffix as shown in the example. The
Infoblox.IPAM.Network.dnsSuffix property is used with a value of test.local to
result in the first NIC being named my-machine-nicl.test.local and the other my-machine-

nic2.test.local.

formatVersion: 1
inputs: {}
resources:
Cloud Machine 1:
type: Cloud.Machine
properties:
Infoblox.IPAM.Network.dnsSuffix: test.local
Infoblox.IPAM.NetworkO.hostnameNicSuffix: -nicl
Infoblox.IPAM.Networkl.hostnameNicSuffix: -nic2
image: ubuntu
flavor: small
networks:
- network: '${resource.Cloud_Network_l.id}'
deviceIndex: 0
- network: 'S{resource.Cloud Network 2.id}"'
deviceIndex: 1
Cloud Network 1:
type: Cloud.Network
properties:
networkType: existing
Cloud Network 2:
type: Cloud.Network
properties:

networkType: existing
This property was introduced with Infloblox plug-in version 1.3. See Download and deploy an
external IPAM provider package for use in vRealize Automation.
m  You can also specify properties by using an extensibility subscription.

For related information about Infoblox extensible attributes relative to this use case, see
Add required extensible attributes in the Infoblox application for integration with vRealize
Automation.
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Using Infoblox properties on different machine NICs in a cloud template

The following Infoblox properties can support a different value for each machine NIC in the cloud
template:

m Infoblox.IPAM.Network.enableDhcp

m Infoblox.IPAM.Network.dnsView

m Infoblox.IPAM.Network.enableDns

m Infoblox.IPAM.Network.hostnameNicSuffix

For example, to use a different Infoblox.IPAM.Network.dnsView vValue for each NIC, use a
Infoblox.IPAM.Network<nicIndex>.dnsView entry for each NIC. The following sample shows
different values Infoblox.IPAM.Network.dnsView for two NICs.

formatVersion: 1
inputs: {}
resources:
Cloud_Machine 1:
type: Cloud.Machine
properties:
Infoblox.IPAM.Network0.dnsView: default
Infoblox.IPAM.Networkl.dnsView: my-net
image: ubuntu
flavor: small
networks:
- network: 'S${resource.Cloud Network 1.id}'
deviceIndex: 0
- network: 'S${resource.Cloud Network 2.id}'
deviceIndex: 1
Cloud_Network 1:
type: Cloud.Network
properties:
networkType: existing
Cloud_Network 2:
type: Cloud.Network
properties:
networkType: existing

By default, the Infoblox integration creates a DNS host record in the defau/t DNS view in Infoblox.
If your Infoblox administrator has created custorm DNS views, you can overwrite the default
integration behavior and specify a named view by using the Infoblox.IPAM.Network.dnsView
property in the machine component. For example, you can add the following property to the
Cloud Machine 1 component to specify a named DNS view in Infoblox.

Cloud_Machine 1:
type: Cloud.Machine
properties:
image: ubuntu
flavor: small
Infoblox.IPAM.Network.dnsView:<dns-view-name>
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For information about configuring and using DNS views, see DNS Views in Infoblox product
documentation. For examples in the Infoblox integration workflow, see Define and deploy a cloud
template that uses an external IPAM provider range assignment in vRealize Automation.

How to specify Infoblox properties
You can specify an Infoblox property using one of the following methods in Cloud Assembly:

m  You can specify properties in a project by using the Custom Properties section on your
Infrastructure > Administration > Projects page. Using this method, the specified properties
are applied to all machines that are provisioned in the scope of this project.

m  You can specify properties on each machine component in a cloud template. Sample cloud
template code illustrating use of the Infoblox.IPAM.Network.dnsView property is shown

below:

formatVersion: 1
inputs: {}
resources:
Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
Infoblox.IPAM.Network.dnsView: default
image: ubuntu
cpuCount: 1
totalMemoryMB: 1024
networks:
- network: '${resource.Cloud_Network_l.id}'
Cloud Network 1:
type: Cloud.Network
properties:
networkType: existing
constraints:

- tag: mk-ipam-demo

Control network data collection by using Infoblox filters in vRealize
Automation

For Infloblox, you can limit the number of data collected networks to only those networks that
are needed for vRealize Automation operations. This reduces the amount of transferred data and
enhances system performance.

vRealize Automation collects data every 10 minutes from the external IPAM system. For Infloblox,
you can filter in several ways to discover and data-collect only a subset of networks that are used
by vVRealize Automation operations.

To filter data collection for networks that use Infoblox-generated IP addresses, use the following
properties on the IPAM integration tab. The filter properties are available as you create or edit the
external IPAM integration point for Infoblox.
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These filters are only available with vRealize Automation 8.3 and later and with the Infoblox plug-in
version 1.3 and later (for example Infoblox plugin version 1.4).

Note The Infoblox plug-in version 1.3 can be used with vRealize Automation 8.1 or 8.2, but only in
select situations and with caution as described in KB article Infoblox 1.3 Compatibility with vRealize
Automation 8.x (82142).
m Infoblox.IPAM.NetworkContainerFilter

Filters on network containers.
m Infoblox.IPAM.NetworkFilter

Filter on networks.
m Infoblox.IPAM.RangeFilter

Filter on IP address ranges.

Be cautious when applying these data collection filters to networks that have already been data-
collected. If you apply filters to prevent some networks from being data-collected, the networks
that are not collected are assumed to be unnecessary and are deleted from vRealize Automation.
The exception are networks that are associated to vRealize Automation subnets. Previously data-
collected networks that are not subsequently discovered and data-collected, for example because
they were filtered out of the data collection task, are deleted from the vRealize Automation
database. However, if the previously data-collected networks are in use in vRealize Automation,
they are not deleted.

These filters are applied as query parameters in the search requests for the different network
objects. You can use any search parameters that Infoblox supports. You filter by CIDR or
extensible attributes that are based on regular expressions or exact matches. The format uses
the Infoblox WAPI filtration format, as described in Infoblox WAPI documentation. Methods of
filtering by CIDR or extensible attributes are shown in the following examples:

m  Filter based on CIDR for networks and network containers. Examples:

m  Exact match - Infoblox.IPAM.NetworkFilter: network=192.168.0.0

m  Match by extensible attribute - Infoblox.IPAM.NetworkFilter: network~=192.168
m Filter based on CIDR for IP address range. Example:

Match by regular expression and network view name - Infoblox.IPAM.RangeFilter:

network~=192.168.&network view=my view
m  Filter based on extensible attributes for networks, IP ranges, and network containers.
Syntax uses the filter_name="*ext_attr=ext_attr_ value format. Examples:
m  Exact match - *Building=Data Center
m  Match by regular expression with '~' - *Building~=*Center

m  Case sensitive match with ':' - *Building:=data center
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m  Exclude match with 'l' - *Building!=Data Center

m  Match by regular expression (case sensitive and exclude can be combined): *Building!

~:=Data Cent / *Building~:=center

m  Filter based on CIDR and extensible attributes using syntax from the above methods of
filtering. Example:

network=192.168.&*Building=Data Center

For more information about using extensible attributes and regular expressions in these
properties, see Infoblox Supported Expressions for Search Parameters and Infoblox REST API
Reference Guide.
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Setting up Cloud Assembly for
your organization

As a Cloud Assembly administrator, you must understand the user roles and set up connections
with your cloud account vendor and integration applications.

When you configure the cloud accounts and integrations, you are configuring the communication
between Cloud Assembly and those target systems.

This chapter includes the following topics:

m  What are the vRealize Automation user roles

m  Adding cloud accounts to Cloud Assembly

m Integrating vRealize Automation with other applications
m  What are onboarding plans in Cloud Assembly

m  Advanced configuration for Cloud Assembly environment

What are the vRealize Automation user roles

vRealize Automation has several levels of user roles. These different level control access to the
organization, the services, the projects that produce or consume the cloud templates, catalog
items, and pipelines, and the ability for uses to use or see individual parts of the user interface.
These different levels give cloud administrators different tools to apply any level of granularity that
is required by their operational needs.

General role descriptions
The user roles are defined at different levels. The service level roles are defined for each service.

More details for the service roles is provided below this table.
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Role

Organization Owner

Organization Member

Service Administrator

Service User

Service Viewer

Executor ( Code Stream only)

VMware, Inc.

General permissions

Can access the console and add users
to organization.

The organization owner cannot access
a service unless they have a service
role.

More about the Organization User
Roles

Can access the console.

The organization member cannot
access a service unless they have a
service role.

More about the Organization User
Roles

Can access the console and has full
view, update, and delete privileges in
the service.

m  Cloud Assembly Service Roles
m  Service Broker Service Roles

m  Code Stream Service Roles
[

VRA Migration Assistant Service
Roles

m  Orchestrator Service Roles

m  SaltStack Config Service Role

Can access the console and the
service with limited permissions.

The service member has limited
user interface. What they can see
or do depends on their project
membership.

m  Cloud Assembly Service Roles
m  Service Broker Service Roles

m  Code Stream Service Roles

Can access the console and the
service in a view-only mode.

m  Cloud Assembly Service Roles
m  Service Broker Service Roles

m  Code Stream Service Roles
[

VRA Migration Assistant Service
Roles

m  Orchestrator Service Roles

Can access the console and manage
pipeline executions.

Code Stream Service Roles

Where the role is defined

Organization console

Organization console

Organization console

Organization console

Organization console

Organization console
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Role

Orchestrator Workflow Designer
(Orchestrator only)

Project roles

Custom roles

Infrastructure administrator built-in role

General permissions

Can create, run, edit, and delete

their own vRealize Orchestrator Client
content. Can add their own content
to their assigned group. Does not
have access to the administration

and troubleshooting features of the
vRealize Orchestrator Client.

Orchestrator Service Roles

Can view and manage project
resources depending on project role.

Project roles include administrator,
member, and viewer.

Organization and service user roles in
vRealize Automation

The permissions are defined by the
Cloud Assembly Administrator for all
the services.

The user must have at least a service
viewer role in the relevant services so
that they can access the service. The
custom roles take precedence over
the service roles.

Custom user roles in vRealize
Automation

Gives predefined permissions for
tasks in vRealize Automation .

How do | assign the Cloud Assembly
Infrastructure Administrator built-in
role to a user

Where the role is defined

Organization console

Cloud Assembly, Service Broker, and
Code Stream

Cloud Assembly and Service Broker

Using the API

Organization and service user roles in vRealize Automation

The organization and service user roles that you defined for the Cloud Assembly, Service Broker,
and Code Stream services determine what the user can see and do in each service.

Organization User Roles

User roles are defined for the organization in the vRealize Automation console by an organization
owner. There are two types of roles, organization roles and service roles.

The organization roles are global and apply to all services in the organization. The organization-
level roles are Organization owner or Organization Member role.

For more information about the organization roles, see Administering vRealize Automation

The Cloud Assembly service roles, which are service-specific permissions, are also assigned at the

organization level in the console.
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Service Roles

These service roles are assigned by the organization owner.
This article includes information about the following services.
m  Cloud Assembly Service Roles

m  Service Broker Service Roles

m  Code Stream Service Roles

m  VRA Migration Assistant Service Roles

m  Orchestrator Service Roles

m  SaltStack Config Service Role

Cloud Assembly Service Roles

The Cloud Assembly service roles determine what you can see and do in Cloud Assembly. These
service roles are defined in the console by an organization owner.

Table 3-1. Cloud Assembly Service Role Descriptions

Role Description

Cloud Assembly Administrator A user who has read and write access to the entire user
interface and API resources. This is the only user role that
can see and do everything, including add cloud accounts,
create new projects, and assign a project administrator.

Cloud Assembly User A user who does not have the Cloud Assembly
Administrator role.
In a Cloud Assembly project, the administrator adds users
to projects as project members, administrators, or viewers.
The administrator can also add a project administrator.

Cloud Assembly Viewer A user who has read access to see information but cannot
create, update, or delete values. This is a read-only role
across all projects.

Users with the viewer role can see all the information that
is available to the administrator. They cannot take any
action unless you make them a project administrator or

a project member. If the user is affiliated with a project,
they have the permissions related to the role. The project
viewer would not extend their permissions the way that the
administrator or member role does.

In addition to the service roles, Cloud Assembly has project roles. Any project is available in all of
the services.

The project roles are defined in Cloud Assembly and can vary between projects.

In the following tables, which tells you what the different service and project roles can see and do,
remember that the service administrators have full permission on all areas of the user interface.
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The descriptions of project roles will help you decide what permissions to give your users.

m  Project administrators leverage the infrastructure that is created by the service administrator
to ensure that their project members have the resources they need for their development

work.

m  Project members work within their projects to design and deploy cloud templates. Your
projects can include only resources that you own or resources that are shared with other

project members.

m  Project viewers are restricted to read-only access, except in a few cases where they can do
non-destructive things like download cloud templates.

m  Project supervisors are approvers in Service Broker for their projects where an approval policy
is defined with a project supervisor approver. To provide the supervisor with context for
approvals, consider also granting them the project member or viewer role.

Table 3-2. Cloud Assembly service roles and project roles

Ul Context

Access Cloud
Assembly

Console

Infrastructure

Configure -
Projects

VMware, Inc.

Task

In the vVRA
console, you can
see and open
Cloud Assembly

See and open the
Infrastructure tab

Create projects

Update, or delete
values from
project summary,
provisioning,
Kubernetes,
integrations, and
test project
configurations.

Add users and
groups, and
assign roles in
projects.

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to

see and do project-related tasks.

Project Project Project
Administrator Member Viewer
Yes Yes Yes
Yes Yes Yes

Yes. Your
projects.

Project
Supervisor

Yes

Yes
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Configure -
Cloud Zones

Configure -
Kubernetes
Zones

Configure -
Flavors

Configure -
Image
Mappings

Configure -
Network
Profiles

Configure -
Storage
Profiles

Configure -
Pricing Cards

VMware, Inc.

Task

View projects

Create, update,
or delete cloud
zones

View cloud zones

View cloud
zone Insights
dashboard

View cloud zones
alerts

Create, update,
or delete
Kubernetes
zones

View Kubernetes
zones

Create, update,
or delete flavors

View flavors

Create, update,
or delete image
mappings

View image
mappings

Create, update,
or delete
network profiles

View image
network profiles

Create, update,
or delete storage
profiles

View image
storage profiles

Create, update,
or delete pricing
cards

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project Project
Administrator Member
Yes. Your Yes.
projects Your
projects

Project
Viewer

Yes.
Your
projects

Project
Supervisor

Yes. Your
projects
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Cloud Cloud Cloud Assembly User
Assembly Assembly User must be a project administrator or member to
Ul Context Task Administrator Viewer see and do project-related tasks.
Project Project Project Project

Administrator Member Viewer Supervisor

View the pricing Yes Yes
cards

Configure - Create, update, Yes
Tags or delete tags

View tags Yes Yes

Resources - Add tags Yes
Compute to discovered

compute

resources

View discovered Yes Yes
compute
resources

Resources - Modify network Yes
Networks tags, IP ranges,
IP addresses

View discovered Yes Yes
network
resources

Resources - Add tags Yes

Security to discovered

security groups

View discovered Yes Yes
security groups

Resources - Add tags Yes
Storage to discovered
storage
View storage Yes Yes
Resources - Deploy or Yes
Kubernetes add Kubernetes

clusters, and
create or add

namespaces
View Kubernetes Yes Yes Yes. Your Yes. Yes.
clusters and projects Your Your
namespaces projects projects

Activity - Delete Yes

Requests deployment

request records
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Activity -
Event Logs

Connections -
Cloud
Accounts

Connections -
Integrations

Onboarding

Extensibility

Events

Subscriptions

Library -
Event topics

VMware, Inc.

Task

View deployment
request records

View event logs

Create, update,
or delete cloud
accounts

View cloud
accounts

Create, update,
or delete
integrations

View integrations

Create, update,
or delete
onboarding plans

View onboarding
plans

See and open the
Extensibility tab

View extensibility
events

Create, update,
or delete
extensibility
subscriptions

Deactivate
subscriptions

View
subscriptions

View event topics

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project Project
Administrator Member

Yes. Your Yes.
projects Your
projects
Yes. Your Yes.
projects Your
projects

Project Project
Viewer Supervisor

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Yes
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Library -
Actions

Library -
Workflows

Activity -
Action Runs

Activity -
Workflow
Runs

Design

Design

Cloud
Templates

VMware, Inc.

Task

Create, update,
or delete
extensibility
actions

View extensibility
actions

View extensibility
workflows

Cancel or delete
extensibility
action runs

View extensibility
action runs

View extensibility
workflow runs

Open the Design
tab

Create, update,
and delete cloud
templates

View cloud
templates

Download cloud
templates

Upload cloud
templates

Deploy cloud
templates

Version and
restore cloud
templates

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project

Administrator

Yes.

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Project

Member

Yes.

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Project
Viewer

Yes.
Your
projects

Yes.

Yes.
Your
projects

Yes.
Your
projects

Project

Supervisor

Yes
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Custom
Resources

Custom
Actions

Resources

Deployments

Resources -
All Resources

VMware, Inc.

Cloud
Assembly
Task Administrator

Release cloud Yes
templates to the
catalog

Create, update Yes
or delete custom
resources

View custom Yes Yes
resources

Create, update, Yes
or delete custom
actions

View custom Yes Yes
actions

See and open the Yes Yes
Resources tab

View Yes Yes
deployments
including
deployment
details,
deployment
history, price,
monitor, alerts,
optimize, and
troubleshooting
information

Manage alerts Yes

Run day 2 actions  Yes
on deployments
based on policies

View all Yes Yes
discovered
resources

Cloud
Assembly
Viewer

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project
Administrator

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Yes

Yes. Your
projects

Yes. Your
projects

Yes. Your
projects

Project
Member

Yes.
Your
projects

Yes.
Your
projects

Yes.
Your
projects

Yes

Yes.
Your
projects

Yes.
your
projects

Yes.
Your
projects

Project
Viewer

Project
Supervisor

Yes.
Your
projects

Yes.
Your
projects

Yes Yes

Yes.
Your
projects
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Resources -
All Resources

Resources -
Virtual
Machines

VMware, Inc.

Task

Run day 2 actions
on discovered
resources.

Actions available
only on machines
and limited to
power on and

off for all
machines, and
remote console
for vSphere
machines.

View deployed,
onboarded,
migrated
resources

Run Day

2 actions

on deployed,
onboarded,

and migrated
resources based
on policies

View discovered
machines

Run day 2 actions
on discovered
machines.

Actions are
limited to power
on and off, and
remote console
for vSphere
machines.

Create New VM

View deployed,
onboarded,
and migrated
resources.

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project Project Project Project
Administrator Member Viewer Supervisor

Yes. Your Yes. Yes.
projects. Your Your
projects.  projects.

Yes. Your Yes.
projects. Your
projects.
Yes. Your Yes. Yes.
projects. Your Your

projects.  projects.
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context

Resources -
Volumes

Resources -
Networkin
and Security

Alerts

VMware, Inc.

Task

Run day 2 actions
on deployed,
onboarded,

and migrated
resources based
on policies

View discovered
volumes

No day 2 actions
available

View deployed,
onboarded,
and migrated
volumes

Run day 2 actions
on deployed,
onboarded,

and migrated
volumes based
on policies

View discovered
networks, load
balancers, and
security groups

No day 2 actions
available

View deployed,
onboarded,
and migrated
networks, load
balancers, and
security groups

Run day 2 actions
on deployed,
onboarded,

and migrated
networks, load
balancers, and
security groups
based on policies

Cloud
Assembly
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Cloud
Assembly
Viewer

Yes

Yes

Yes

Yes

Cloud Assembly User

User must be a project administrator or member to
see and do project-related tasks.

Project
Administrator

Yes. Your
projects.

Yes. Your
projects.

Yes. Your
projects.

Yes. Your
projects.

Yes. Your
projects.

Project
Member

Yes.
Your
projects.

Yes.
Your
projects.

Yes.
Your
projects.

Yes.
Your
projects.

Yes.
Your
projects.

Project Project
Viewer Supervisor

Yes.
Your
projects.

Yes.
Your
projects.
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Table 3-2. Cloud Assembly service roles and project roles (continued)

Ul Context Task

See and open the
Alerts tab

Manage alerts

View alerts

Cloud
Assembly
Administrator

Yes

Yes

Yes

Service Broker Service Roles

Cloud Cloud Assembly User
Assembly User must be a project administrator or member to
Viewer see and do project-related tasks.

Project Project Project Project

Yes

Yes

Administrator Member Viewer Supervisor

Yes Yes Yes
Yes. Your Yes.
projects Your

projects
Yes. Your Yes. Yes.
projects Your Your

projects projects

The Service Broker service roles determine what you can see and do in Service Broker. These
service roles are defined in the console by an organization owner.

Table 3-3. Service Broker Service Role Descriptions

Role

Service Broker Administrator

Service Broker User

Service Broker Viewer

Description

Must have read and write access to the entire user
interface and API resources. This is the only user role that
can perform all tasks, including creating a new project and
assigning a project administrator.

Any user who does not have the Service Broker
Administrator role.

In a Service Broker project, the administrator adds users
to projects as project members, administrators, or viewers.
The administrator can also add a project administrator.

A user who has read access to see information but cannot
create, update, or delete values.

Users with the viewer role can see all the information that
is available to the administrator. They cannot take any
action unless you make them a project administrator or

a project member. If the user is affiliated with a project,
they have the permissions related to the role. The project
viewer would not extend their permissions the way that the
administrator or member role does.

In addition to the service roles, Service Broker has project roles. Any project is available in all of

the services.

The project roles are defined in Service Broker and can vary between projects.

In the following tables, which tells you what the different service and project roles can see and do,
remember that the service administrators have full permission on all areas of the user interface.
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Use the following descriptions of project roles will help you as you decide what permissions to give

your users.

m  Project administrators leverage the infrastructure that is created by the service administrator
to ensure that their project members have the resources they need for their development

work.

m  Project members work within their projects to design and deploy cloud templates. In the
following table, Your projects can include only resources that you own or resources that are
shared with other project members.

m  Project viewers are restricted to read-only access.

m  Project supervisors are approvers in Service Broker for their projects where an approval policy
is defined with a project supervisor approver. To provide the supervisor with context for
approvals, consider also granting them the project member or viewer role.

Table 3-4. Service Broker Service Roles and Project Roles

Ul Context

Access
Service
Broker

Console

Infrastructure

Configure -
Projects

VMware, Inc.

Task

In the console,
you can see

and open Service
Broker

See and open the
Infrastructure tab

Create projects

Update, or delete
values from
project summary,
provisioning,
Kubernetes,
integrations, and
test project
configurations.

Add users and
groups, and
assign roles in
projects.

Service
Broker
Administrator

Yes

Yes

Yes

Yes

Yes

Service
Broker
Viewer

Yes

Yes

Service Broker User

User must be a project administrator to see and do
project-related tasks.

Project Project Project Project
Administrator Member Viewer Supervisor
Yes Yes Yes Yes

Yes. Your

projects.
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Table 3-4. Service Broker Service Roles and Project Roles (continued)

Ul Context

Configure -
Cloud Zones

Configure -
Kubernetes
Zones

Connections -
Cloud
Accounts

Connections -
Integrations

Activity -
Requests

Activity -
Event Logs

Content and
Policies

Content
Sources

VMware, Inc.

Task

View projects

Create, update,
or delete cloud
zones

View cloud zones

Create, update,
or delete
Kubernetes zones

View Kubernetes
zones

Create, update,
or delete cloud
accounts

View cloud
accounts

Create, update,
or delete
integrations

View integrations

Delete
deployment
request records

View deployment
request records

View event logs

See and open
the Content and
Policies tab

Create, update,
or delete content
sources

View content
sources

Service
Broker
Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Service
Broker
Viewer

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Service Broker User

User must be a project administrator to see and do
project-related tasks.

Project Project Project Project
Administrator Member Viewer Supervisor
Yes. Your Yes. Your Yes.
projects projects Your

projects
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Table 3-4. Service Broker Service Roles and Project Roles (continued)

Ul Context

Content
Sharing

Content

Policies -
Definitions

Policies -
Enforcement

Notifications -
Email Server

Catalog

Resources

Deployments

VMware, Inc.

Task

Add or remove
shared content

View shared
content

Customize form
and configure
item

View content

Create, update,
or delete policy
definitions

View policy
definitions

View
enforcement log

Configure an
email server

See and open the
Catalog tab

View available
catalog items

Request a catalog
item

See and open the
Resources tab

View
deployments,
including
deployment
details,
deployment
history, price,
monitor, alerts,
optimize, and
troubleshooting
information

Service

Broker

Administrator

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Service
Broker
Viewer

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Service Broker User

User must be a project administrator to see and do
project-related tasks.

Project

Administrator

Yes

Yes. Your
projects

Yes. Your
projects

Yes.

Yes. Your
projects

Project
Member

Yes

Yes. Your
projects

Yes. Your
projects

Yes

Yes. Your
projects

Project
Viewer

Project
Supervisor

Yes Yes

Yes.
Your
projects

Yes Yes

Yes.
Your
projects
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Table 3-4. Service Broker Service Roles and Project Roles (continued)

Service Service Service Broker User
Broker Broker  User must be a project administrator to see and do
Ul Context Task Administrator Viewer project-related tasks.
Project Project Project Project
Administrator Member Viewer Supervisor
Manage alerts Yes Yes. Your Yes. Your
projects projects
Run day 2 actions  Yes Yes. Your Yes. Your
on deployments projects projects
based on policies
Resources - View all Yes Yes

All Resources discovered
resources

Run day 2 actions  Yes
on discovered
resources.

Actions available
only on machines
and limited to
power on and

off for all
machines, and
remote console
for vSphere

machines.

Resources - View deployed, Yes Yes Yes. Your Yes. Your Yes.

All Resources onboarded, projects. projects. Your
migrated projects.
resources
Run Day 2 actions  Yes Yes Yes. Your Yes. Your
on deployed, projects. projects.
onboarded,

and migrated
resources based

on policies
Resources - View discovered Yes Yes
Virtual machines

Machines

Run day 2 actions  Yes
on discovered
machines.

Actions are
limited to power
on and off, and
remote console
for vSphere
machines.
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Table 3-4. Service Broker Service Roles and Project Roles (continued)

Service Service Service Broker User
Broker Broker  User must be a project administrator to see and do
Ul Context Task Administrator Viewer project-related tasks.
Project Project Project Project
Administrator Member Viewer Supervisor

Create New VM Yes

View deployed, Yes Yes. Your Yes. Your Yes.
onboarded, projects. projects. Your
and migrated projects.
resources.

Run day 2 actions  Yes Yes. Your Yes. Your

on deployed, projects. projects.

onboarded,

and migrated
resources based

on policies
Resources - View discovered Yes Yes
Volumes volumes

No day 2 actions

available

View deployed, Yes Yes Yes. Your Yes. Your Yes.
onboarded, and projects. projects. Your
migrated volumes projects.
Run day 2 actions  Yes Yes. Your Yes. Your

on deployed, projects. projects.

onboarded, and
migrated volumes
based on policies

Resources - View discovered Yes Yes
Networking networks, load
and Security balancers, and

security groups

No day 2 actions

available

View deployed, Yes Yes Yes. Your Yes. Your Yes.
onboarded, projects. projects. Your
and migrated projects.

networks, load
balancers, and
security groups
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Table 3-4. Service Broker Service Roles and Project Roles (continued)

Ul Context

Approvals

Task

Run day 2 actions
on deployed,
onboarded,

and migrated
networks, load
balancers, and
security groups
based on policies

See and open the
Approvals tab

Respond to
approval requests

Service
Broker
Administrator

Yes

Yes

Yes

Code Stream Service Roles

Service
Broker
Viewer

Yes

Service Broker User

User must be a project administrator to see and do

project-related tasks.

Project Project
Administrator Member

Yes. Your Yes. Your
projects. projects.
Yes Yes

Yes. Your Only if
projects and you are a
the policy named
approver is approver
Project

Administrator

Project
Viewer

Yes

Only if
you are a
named
approver

Project
Supervisor

Yes

Yes. Your
projects
and the
policy
approver is
Project
Supervisor

The Code Stream service roles determine what you can see and do in Code Stream. These roles
are defined in the console by the organization owner. Any project is available in all of the services.

Table 3-5. Code Stream Service Role Descriptions

Role

Code Stream Administrator

Code Stream Developer

Code Stream Executor

VMware, Inc.

Description

A user who has read and write access to the entire user interface and API resources. This

is the only user role that can see and do everything, including create projects, integrate

endpoints, add triggers, create pipelines and custom dashboards, mark endpoints and

variables as restricted resources, run pipelines that use restricted resources, and request
that pipelines be published in Service Broker.

A user who can work with pipelines, but cannot work with restricted endpoints or

variables. If a pipeline includes a restricted endpoint or variable, this user must obtain

approval on the pipeline task that uses the restricted endpoint or variable.

resume, pause, and cancel pipeline executions, but cannot modify pipelines.

A user who can run pipelines and approve or reject user operation tasks. This user can
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Table 3-5. Code Stream Service Role Descriptions (continued)

Role Description

Code Stream User
Stream.

Code Stream Viewer

A user who can access Code Stream, but does not have any other privileges in Code

A user who has read access to see pipelines, endpoints, pipeline executions, and

dashboards, but cannot create, update, or delete them. A user who also has the Service
viewer role can see all the information that is available to the administrator. They cannot

take any action unless you make them a project administrator or a project member. If the

user is affiliated with a project, they have the permissions related to the role. The project

viewer would not extend their permissions the way that the administrator or member role

does.

In addition to the service roles, Code Stream has project roles. Any project is available in all the

services.

The project roles are defined in Code Stream and can vary between projects.

In the following tables, which tell you what the different service and project roles can see and do,
remember that the service administrators have full permission on all areas of the user interface.

Use the following descriptions of project roles to help you decide what permissions to give your

users.

m  Project administrators leverage the infrastructure that is created by the service administrator
to ensure that their project members have the resources they need for their development
work. The project administrator can add members.

m  Project members who have a service role can use services.

m  Project viewers can see projects but cannot create, update, or delete them.

All actions except restricted means this role has permission to perform create, read,

update, and delete actions on entities except for restricted variables and endpoints.

Table 3-6. Code Stream service role capabilities

Ul Context Capabilities

Pipelines

View pipelines

Create
pipelines

Run pipelines

Run pipelines
that include
restricted
endpoints or
variables

VMware, Inc.

Code Stream
Administrator
role

Yes

Yes

Yes

Yes

Code
Stream
Developer
role

Yes

Yes

Yes

Code Stream
Executor role

Yes

Yes

Code
Stream
Viewer
role

Yes

Code
Stream
User role
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Table 3-6. Code Stream service role capabilities (continued)

Ul Context

Pipeline Executions

Custom Integrations

Endpoints

Mark resources as
restricted

VMware, Inc.

Capabilities

Update
pipelines

Delete
pipelines

View pipeline
executions

Resume,
pause, and
cancel pipeline
executions

Resume
pipelines that
stop for
approval on
restricted
resources

Create custom
integrations

Read custom
integrations

Update custom
integrations

View
executions

Create
executions

Update
executions

Delete
executions

Mark an
endpoint or
variable as
restricted

Code Stream
Administrator
role

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Code
Stream
Developer
role

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Code Stream
Executor role

Yes

Yes

Yes

Yes

Code
Stream
Viewer
role

Yes

Yes

Yes

Code
Stream
User role
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Table 3-6. Code Stream service role capabilities (continued)

Ul Context Capabilities
Dashboards
View
dashboards

Create
dashboards

Update
dashboards

Delete
dashboards

Code Stream
Administrator
role

Yes

Yes

Yes

Yes

VRA Migration Assistant Service Roles

Code Code

Stream Stream Code
Developer Code Stream Viewer Stream
role Executor role role User role
Yes Yes Yes

Yes

Yes

Yes

The vVRA Migration Assistant service roles determine what you can see and do in vVRA Migration
Assistant and Cloud Assembly. These service roles are defined in the console by an organization

owner.

Table 3-7. vRealize Automation Migration Assistant Service Roles Descriptions

Role

Migration Assistant Administrator

Migration Assistant Viewer

Orchestrator Service Roles

Description

A user who has full view, update, and delete privileges in
the VRA Migration Assistant and Cloud Assembly.

This role must also have at least the Cloud Assembly
Viewer role.

A user who has read access to see information but cannot
create, update, or delete values in VRA Migration Assistant
or in Cloud Assembly.

This role must also have at least the Cloud Assembly
Viewer role.

The Orchestrator service roles determine what you can see and do in vRealize Orchestrator Client.
These service roles are defined in the console by an organization owner.

VMware, Inc.
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Table 3-8. vRealize Orchestrator Service Roles Descriptions

Role

Orchestrator Administrator

Orchestrator Viewer

Orchestrator Workflow Designer

SaltStack Config Service Role

Description

A user who has full view, update, and delete privileges
in vRealize Orchestrator. An administrator can also access
the content created by specific groups.

A user who has read access to see features and content,
including all groups and group content, but cannot create,
update, run, delete values, or export content.

A user who can create, run, edit, and delete their own
VRealize Orchestrator Client content. They can add their
own content to their assigned group. The workflow
designer does not have access to the administration

and troubleshooting features of the vRealize Orchestrator
Client.

The SaltStack Config service role determines what you can see and do in vRealize Automation.
This service role is defined in the console by an organization owner.

Table 3-9. vRealize Automation SaltStack Config Service Role Description

Role

SaltStack Config Administrator

Description

A user who can access the SaltStack Config tile on the
console when the integration with Cloud Assembly is
configured. To log in on the SaltStack Config instance, the
user must have SaltStack administrator permissions that
are defined in SaltStack Config.

The user must also have the Cloud Assembly
Administrator role.

Custom user roles in vRealize Automation

As a Cloud Assembly administrator, you can create custom roles that define what users can see
and do in vRealize Automation. You can then assign users to those roles.

Custom User Role Permissions

Using Cloud Assembly, you can define more granular user roles and then assign users to those
roles. The custom roles have two categories, view and manage.

= View. A user assigned to a role with this permission can see all the items for all projects in the
selected sections of the user interface. This role is useful for users who need to see accounts,

configurations, or assigned values.

m  Manage. A user assigned to a role with this permission can see all the items and has full add,
edit, and delete permissions for all projects in the selected sections of the user interface.
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These permissions extend the privileges that are granted by the other roles and are not restricted
by project membership. For example, you can expand a project administrator's permissions to
manage parts of the infrastructure or give a service viewer an ability to review and respond to

approvals requests.

To define the user roles and assign users, open Cloud Assembly or Service Broker as a service
administrator and select Infrastructure > Administration > Custom Roles. You cannot configure
the custom roles in Code Stream, however the roles apply to all the services.

Table 3-10. Custom Roles

User Interface

Infrastructure

Catalog

VMware, Inc.

Permission

View Cloud Accounts.

Manage Cloud Accounts

View Image Mappings

Manage Image Mappings

View Flavor Mappings

Manage Flavor Mappings

View Cloud Zones

Manage Cloud Zones

View Requests

Manage Requests

View Integrations

Manage Integrations

View Projects

Manage Projects

View Onboarding Plans

Manage Onboarding Plans

Description

View cloud accounts.

Create, update, or delete cloud
accounts.

View image mappings.

Create, update, or delete image
mappings.

View flavor mappings.

Create, update, or delete flavor
mappings.

View cloud zones, Insights, and alerts.

Create, update, or delete cloud zones.
Manage alerts.

View activity requests.

Delete requests from the list.

View integrations.

Create, update, or delete integrations.
View projects.

Create projects. Add users and
assign roles in projects. Update, or
delete values from project summary,
users, provisioning, Kubernetes,
integrations, and test project
configurations.

View onboarding plans

Create, update, run, or delete
onboarding plans
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Table 3-10. Custom Roles (continued)

User Interface

Policies

Deployments

Cloud Templates

Xaa$s

VMware, Inc.

Permission

View Content

Manage Content

View Policies

Manage Policies

View Deployments

Manage Deployments

View Cloud Templates

Manage Cloud Templates

Edit Cloud Templates

Deploy Cloud Templates

Deploy In-line Cloud Template
Content

View Custom Resources

Manage Custom Resources

Description

Add, update, delete content sources.
Share content.

Customize the content, including the
catalog icons and request forms.

View policy definitions.

Create, update, or delete policy
definitions.

View all deployments, including
deployment details, deployment
history, alerts, and troubleshooting
information.

View all deployments, respond to
alerts, and run all day 2 actions

that the day 2 policies allow an
administrator to run on deployments
and deployment components.

View cloud templates.

Create, update, test, delete, version,
share cloud templates, and release/
unrelease a cloud template version.

Create, update, test, version,

share cloud templates, and release/
unrelease a cloud template version.
The role does not have permission to
delete cloud templates.

Test and deploy any cloud template in
any project.

Deploy any cloud template in the
projects that the assignees are
associated with. The project roles can
be administrator, member, or viewer.

View custom resources.

Create, update or delete custom
resources.
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Table 3-10. Custom Roles (continued)

User Interface

Extensibility

Pipeline

VMware, Inc.

Permission

View Resource Actions

Manage Resource Actions

View Extensibility Resources

Manage Extensibility Resources

Manage Pipelines

Manage Restricted Pipelines

Manage Custom Integrations

Execute Pipelines

Execute Restricted Pipelines

Manage Executions

Description

View custom actions.

Create, update, or delete custom
actions

View events, subscriptions, event
topics, actions, workflows, action
runs, and workflow runs.

Create, update, delete, and deactivate
extensibility subscriptions.

Create, update, or delete extensibility
actions. Cancel or delete extensibility
action runs.

Create, edit, and delete pipeline,
endpoint, variable, and trigger
configurations.

Restricted models are excluded.

Create, edit, and delete pipeline,
endpoint, variable, and trigger
configurations.

Restricted models are included.

Add, edit, and delete custom
integrations.

Run pipeline model executions and
triggers, and pause, cancel, resume,
or re-run the executions and triggers.

Run pipeline model executions and
triggers, and pause, cancel, resume,
or re-run the executions and triggers.
Resolve restricted endpoints and
variables.

Run pipeline model executions and
triggers, and pause, cancel, resume,
or re-run the executions and triggers.

Resolve restricted endpoints and
variables.

Delete executions.
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Table 3-10. Custom Roles (continued)

User Interface Permission Description
Approval
Manage Approvals View the Approvals tab where you
can approve or reject approval
requests.

Approver with this role will not
receive an email notification about an
approval request unless they are an
approver in the policy.

Use cases: How can user roles help me control access in vRealize
Automation

As a cloud administrator, you want to control the tasks that your users can perform in

vRealize Automation. Depending on your management goals and application development team
responsibilities, there are different ways that you can configure the user roles to support those
goals.

The following Cloud Assembly and Service Broker examples are based on three use cases. These
examples provide only enough instruction to illustrate the application of users roles.

The target audience for these use cases is the cloud administrator, who is also considered the
cloud administrator, and the service administrators.

The use cases build on each other. If you are ready to go directly to use case 3, you might need to
review use cases 1 and 2 to better understand why you configure the roles in the ways specified.

The purpose of the use cases is to demonstrate user roles, not to provide detailed information
about configuring your infrastructure, managing projects, creating cloud templates, and working
with deployments.

Before you begin, you must understand the levels of user roles that are configured by a cloud
administrator in the vRealize Automation Console.

m  Organization Roles
The organization roles control who can access the console.

As an organization owner, you must ensure that all users of any of the services are assigned at
least an organization member role.

Role Description

Organization Owner An administrator can add users, change the role of users, and remove users from the
organization. The owner manages which services users have access to.

Organization Member A general user can log in to the organization console. To access the services, an
organization owner must assign the users service roles.

m  Service Roles
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The service roles control who can access their assigned services.
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As an organization owner, you must ensure that the users who need access to the services are
assigned the appropriate role. You use the roles to control how much the user can do in each
service.

Table 3-11. Cloud Assembly Service Role Descriptions

Role Description

Cloud Assembly Administrator A user who has read and write access to the entire user
interface and API resources. This is the only user role
that can see and do everything, including add cloud
accounts, create new projects, and assign a project
administrator.

Cloud Assembly User A user who does not have the Cloud Assembly
Administrator role.

In a Cloud Assembly project, the administrator adds
users to projects as project members, administrators,
or viewers. The administrator can also add a project
administrator.

Cloud Assembly Viewer A user who has read access to see information but
cannot create, update, or delete values. This is a read-
only role across all projects.

Users with the viewer role can see all the information
that is available to the administrator. They cannot take
any action unless you make them a project administrator
or a project member. If the user is affiliated with a
project, they have the permissions related to the role.
The project viewer would not extend their permissions
the way that the administrator or member role does.

Table 3-12. Service Broker Service Role Descriptions

Role Description

Service Broker Administrator Must have read and write access to the entire user
interface and API resources. This is the only user role
that can perform all tasks, including creating a new
project and assigning a project administrator.

Service Broker User Any user who does not have the Service Broker
Administrator role.
In a Service Broker project, the administrator adds
users to projects as project members, administrators,
or viewers. The administrator can also add a project
administrator.

Service Broker Viewer A user who has read access to see information but
cannot create, update, or delete values.
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Table 3-12. Service Broker Service Role Descriptions (continued)

Role Description

Users with the viewer role can see all the information
that is available to the administrator. They cannot take
any action unless you make them a project administrator
or a project member. If the user is affiliated with a
project, they have the permissions related to the role.
The project viewer would not extend their permissions
the way that the administrator or member role does.

Table 3-13. Code Stream Service Role Descriptions

Role Description

Code Stream Administrator A user who has read and write access to the entire user interface and API resources.
This is the only user role that can see and do everything, including create projects,
integrate endpoints, add triggers, create pipelines and custom dashboards, mark
endpoints and variables as restricted resources, run pipelines that use restricted
resources, and request that pipelines be published in Service Broker.

Code Stream Developer A user who can work with pipelines, but cannot work with restricted endpoints or
variables. If a pipeline includes a restricted endpoint or variable, this user must obtain
approval on the pipeline task that uses the restricted endpoint or variable.

Code Stream Executor A user who can run pipelines and approve or reject user operation tasks. This user
can resume, pause, and cancel pipeline executions, but cannot modify pipelines.

Code Stream User A user who can access Code Stream, but does not have any other privileges in Code
Stream.
Code Stream Viewer A user who has read access to see pipelines, endpoints, pipeline executions, and

dashboards, but cannot create, update, or delete them. A user who also has the
Service viewer role can see all the information that is available to the administrator.
They cannot take any action unless you make them a project administrator or a
project member. If the user is affiliated with a project, they have the permissions
related to the role. The project viewer would not extend their permissions the way
that the administrator or member role does.

m  Project membership roles

The project membership determines what infrastructure resources and cloud templates are
available.
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Project membership is defined in the service by a user with a service administrator role. The
service administrator must ensure that the users who need access to one or more projects are
assigned the appropriate project role in each project.

Table 3-14. Project Roles

Role Description

Project Administrator A project administrator can manage their own projects,
create and deploy cloud templates associated with
their projects, and manage project deployments for all
project members.

Project Member A project member can create and deploy cloud
templates associated with their projects, manage
their own deployments, and manage any shared
deployments.

Project Viewer A project viewer is a member of the project with read-
only access to their project resources, cloud templates,
and deployments.

m  Custom roles

The custom roles are created by the Cloud Assembly to refine the member and viewer roles.

The procedures provided in these use cases are meant to highlight the user roles. They are not
detailed or definitive procedures for setting up vRealize Automation.

As you configure roles, remember that users who are running API operations are subject to the
roles that you assign here.

Prerequisites

m  Verify that you have the Organization Owner role. You must see the Identity and Access
Management tab with you log in to the console. If not, contact the organization owner.

m  Verify that you have the service administrator role for the various services. If you are not
certain about your role, contact the organization owner.

m  Verify that your users are added to vRealize Automation.

When you install vRealize Automation, your Active Directory users are added as part of the
process.
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For a more detailed task and role list for various roles, see Organization and service user roles
in vRealize Automation.

Procedure

User role use case 1: Set up the vRealize Automation user roles to support a small application
development team

As a vRealize Automation cloud administrator, you are responsible for managing the access
and the budget for your infrastructure resources. You add yourself and two others as
administrators. This small team can create the infrastructure and develop the cloud templates
that match the business goals of the teams that consume the cloud templates. You and your
small team of administrators then deploy the cloud templates for your non-administrator
consumers. You don't allow non-administrators to access vRealize Automation.

User role use case 2: Set up vRealize Automation user roles to support larger development
teams and the catalog

As a vRealize Automation organization owner, you are responsible for managing the access
and the budget for your infrastructure resources. You have a team of cloud template
developers who iteratively create and deploy templates for different projects until they

are ready to deliver to their consumers. You then deliver the deployable resources to the
consumers in a catalog.

User role use case 3: Set up vRealize Automation custom user roles to refine system roles

As a vRealize Automation organization owner or service administrator, you manage user
access using the organization and service system roles. However, you also want to create
custom roles to that selected users and perform tasks or see content that is outside of their
system roles.

User role use case 1: Set up the vRealize Automation user roles to support a
small application development team

As a vRealize Automation cloud administrator, you are responsible for managing the access and
the budget for your infrastructure resources. You add yourself and two others as administrators.
This small team can create the infrastructure and develop the cloud templates that match the
business goals of the teams that consume the cloud templates. You and your small team of
administrators then deploy the cloud templates for your non-administrator consumers. You don't

allow non-administrators to access vRealize Automation.

In this use case, you are the organization owner and you have a small team where they all have the
service administrator role.

The following procedure follows one user all the way through the process. You can do each step
for multiple users.

Prerequisites

Verify that you meet all the prerequisites stipulated in the use case introduction. See Use
cases: How can user roles help me control access in vRealize Automation.
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Procedure

1 Assign organization roles. Click Identity and Access Management.

a

b

Log in to the vRealize Automation console.
Click Identity and Access Management.
Select the user name and click Edit Roles.

In the Assign Organization Roles drop-down menu, select Organization Member.

Services Identity & Access Management Branding

ldentity & Access Management

Active Users Enterprise Groups

Edit Roles

You are editing the roles of the user Sylvia Adams (sylvia@coke.sga-horizon.local)

Aszsign Organization Roles Crganization Member

Mone

Organization Member

Crganization Owner

Assign Service Roles (@)

+ ADD SERVICE ACCESS

o e e e e e e e e e e e e g e e e e e e e g e e e g g e P e S e g S P P e S S S S P S S g P S o e

The organization member role ensures that the user can access the console and any
services that you add them to. They cannot manage organization users.

Leave the Edit Role page open for this user and continue to the next step.
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2 Assign Cloud Assembly Administrator role to yourself and to the one or two other
administrators in this scenario.

The service administrator role has full privileges to add, edit, and delete infrastructure,
projects, cloud templates, and deployments. Defining an administrator role for one person
and the user role for a different person is covered in Scenario 2. This example uses Sylvia.

a

b

Click Add Service Access.

Configure the user with the following value.

Service Role
Cloud Assembly Cloud Assembly Administrator

Services Identity & Access Management Branding

ldentity & Access Management

Active Users Enterprise Groups

Edit Roles

You are editing the roles of the user Sylvia Adams (sylvia@coke.sqa-horizon.local)

Assign Organization Roles Crganization Member

Assign Service Roles (T)

Cloud Assembly v with roles Cloud Assembly Administrator v X

+ ADD SERVICE ACCESS

SAVE CANCEL

3 Create a project in Cloud Assembly that you use to group resources and manage resource
billing for different business groups.

a

b

In the console, click the Services tab, and then click Cloud Assembly.
Select Infrastructure > Projects > New Project.

This user role use case is focused on providing examples of how you can implement user
roles, not on creating the fully defined system.

For information about configuring the infrastructure, see Chapter 4 Building your Cloud
Assembly resource infrastructure. For more about projects, see Chapter 5 Adding and
managing Cloud Assembly projects.

Enter WebAppTeam as the project name.

Click Users, and then click Add Users.
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e Enter email addresses for the individuals who can help you build and manage the
infrastructure and cloud templates.

For example, tony@mycompany.com,syliva@mycompany.com.
f Inthe Assign role drop-down menu, select Administrator.

As Cloud Assembly administrators, these two users already have administrator access to
the cloud accounts, infrastructure, and all projects. This step helps you understand the
roles used in the later scenarios. In the later scenarios, you define project administrator
and project member roles, which have different permissions.

g Click the Provisioning tab and add one or more cloud zones.
Another reminder. This use case is about user roles.
4 Develop a simple cloud template so that you can test the WebAppTeam project.

This cloud template section is abbreviated. The focus is users and user roles as defined by
projects, not how to create a cloud template.

a Select Cloud Templates > New.
b For the new cloud template name, enter WebApp.

c For Project, select WebAppTeam.
New Cloud Template X

Name * WebApp

Description

Project * O, WebAppTeam

Cloud template sharing in @ share only with this project

Service Broker () Allow an administrator to share with

any project in this organization

CANCEL CREATE

d Select Share only with the project.

This setting ensures that the cloud template is only available to project members. When
you are ready to provide the cloud templates to other teams, you can select Allow an
administrator to share with any project in this organization. Sharing the cloud template
with other projects means that you do not have to maintain duplicate instances of the same
base templates. You can move cloud templates from development projects to production
projects so that catalog consumers can deploy to production infrastructure resources.

e Click Create.
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f Inthe cloud template designer, drag the Cloud Agnostic > Machine component to the
canvas.

For more about configuring cloud templates, see Chapter 6 Designing your Cloud
Assembly deployments.

g Click Deploy.

h Continue iterating on the cloud template until you are ready to provide it to your
consumers.

i Click Version and release and version the cloud template.

5 Send the users the log in information using your most common method.

Results

In this use case, you made your two colleagues organization members. You then made Sylvia
a Cloud Assembly administrator. You made Tony a WebApp project administrator. This user
role configuration only works for small teams where you deliver deployed applications to your
consumers rather than providing them with self-service access or a catalog.

User role use case 2: Set up vRealize Automation user roles to support larger
development teams and the catalog

As a vRealize Automation organization owner, you are responsible for managing the access and
the budget for your infrastructure resources. You have a team of cloud template developers who
iteratively create and deploy templates for different projects until they are ready to deliver to their
consumers. You then deliver the deployable resources to the consumers in a catalog.

This use case assumes that you understand that use case 1is an administrator-only use case. You
now want to expand your system to support more teams and larger goals.

m Let developers create and deploy their own application cloud templates during development.
You add yourself as administrator, then add additional users with both the service user and the
service viewer role. Next, you add the users a as project members. The project members can
develop and deploy their own cloud templates.

m  Publish cloud templates to a catalog where you make them available for non-developers
to deploy. Now you are assigning user roles for Service Broker. Service Broker provides a
catalog for the cloud template consumers. You can also use it to create policies, including
leases and entitlements, but that functionality is not part of this user role use case.

Prerequisites

m  Review first use case. See User role use case 1. Set up the vRealize Automation user roles to
support a small application development team.

m |dentify the following users based on what permissions you want them to have:
= cloud template developers who will be Cloud Assembly users and viewers

m A Service Broker administrator
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m Non-developer users who will be catalog consumers as Service Broker users

Procedure
1 Assign organization member roles to your cloud template developer users.

If you need instructions, see the User role use case 1: Set up the vRealize Automation user
roles to support a small application development team.

2 Assign the Cloud Assembly service member role to your cloud template developers.
a Click Add Service Access.

Services Identity & Access Management Branding

Identity & Access Management

Active Users Enterprise Groups

Edit Roles

You are editing the roles of the user Tony Anteater (tony@coke.sqa-horizon.local)

Assign Organization Roles Crganization Member -

Assign Service Roles (T)

Cloud Assembly v with roles Cloud Assembly User v X

t ADD SERVICE ACCESS

b Configure the user with the following value.

Service Role
Cloud Assembly Cloud Assembly User
Cloud Assembly Cloud Assembly Viewer

In this use case, your developers need to see the infrastructure to ensure that they are
building deployable cloud templates. As users that you will assign as project administrators
and project members in the next step, they cannot see the infrastructure. As service
viewers they can see how the infrastructure is configured, but cannot make any changes.
As the cloud administrator, you remain in control, but give them access to the information
they need to develop cloud templates.

3 Create projects in Cloud Assembly that you use to group resources users.

In this use case, you create two projects. The first project is PersonnelAppDev and the second
is PayrollAppDev.

a Inthe console, click the Services tab, and then click Cloud Assembly.

b Select Infrastructure > Projects > New Project.

VMware, Inc. 174



Using and Managing vRealize Automation Cloud Assembly

¢ Enter PersonnelAppDev as the name.

d Click Users, and then click Add Users.

e Add project members and assign a project administrator.

Project Role

Project User

Project Administrator

Description

A project member is the primary developer user role in
a project. Projects determine what cloud resources are
available when you are ready to test your development
work by deploying a cloud template.

A project administrator supports their developers by
adding and removing users for your projects. You can
also delete your projects. To create a project, you must
have service administrator privileges.

f  For the users that you are adding as project members, enter the email address of each
user, separated by a comma, and select User in the Assign role drop-down menu.

For example, tony@mycompany.com,sylvia@mycompany.com.

2 PersonnelAppDev

Integrations

Role

Administrator

Member

Summary Users Provisioning Kubernetes Provisioning
Deployment () Deployments are shared between all users in the project
sharing
User roles Specify the users and groups related to this project
ADD USERS ADD GROUPS
(C, Search users or groups

\:I Name Account

\:I & Sylvia Adams sylvia

\:l & Gloria Martinez gloria

[] & Tony Anteater tony

|
SAVE CANCEL

Member

g For the designated administrators, select Administrator in the Assign role drop-down
menu and provide the necessary email address.

h  Click the Provisioning tab and add one or more cloud zones.

When the cloud template developers who are part of this project deploy a template, it is
deployed to the resources available in the cloud zones. You must ensure that the cloud
zone resources match the needs of the project development team templates.

i Repeat the process to add the PayrollAppDev project with the necessary users and an

administrator.
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4 Provide the service user with the necessary login information and verify that the members of

each project can do the following tasks.

a
b
c
d

e

Open Cloud Assembly.

See the infrastructure across all projects.

Create a cloud template for the project that they are a member of.

Deploy the cloud template to the cloud zone resources defined in the project.

Manage their deployments.

5 Assign organization member roles to your cloud template developer users.

If you need instructions, see the User role use case 1: Set up the vRealize Automation user
roles to support a small application development team.

6 Assign roles to a catalog administrator, catalog consumers, and cloud template developers
based on their job.

a

b

Click Add Service Access.
Configure the catalog administrator with the following value.

This role might be you, the cloud administrator, or it might be someone else on your
application development team.

Service Role

Service Broker Service Broker Administrator
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¢ Configure the cloud template consumers with the following value.

Service Role

Service Broker Service Broker User

ldentity & Access Management

Active Users Enterprise Groups

Edit Roles

You are editing the roles of the user Gloria Martinez (gloria@coke.sqa-horizon.local)

Assign Organization Roles Organization Member

Assign Service Roles ()

Service Broker v with roles Service Broker User v X

= ADD SERVICE ACCESS

d Configure the cloud template developers with the following value.

Service Role
Cloud AssemblyCloud Assembly Cloud Assembly User
7 Create projects in Cloud Assembly that you use to group resources and users.

In this use case, you create two projects. The first project is PersonnelAppDev and the second
is PayrollAppDev.

If you need instructions, see the User role use case 2: Set up vRealize Automation user roles to
support larger development teams and the catalog.

8 Create and release cloud templates for each project team.

If you need instructions, see the User role use case 1: Set up the vRealize Automation user
roles to support a small application development team.

9 Import a Cloud Assembly cloud template into Service Broker.

You must log in as a user with the Service Broker Administrator role.

a Login as a user with the Service Broker Administrator role.

b In the console, click Service Broker.
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C

9
h

Select Content and Policies > Content Sources, and click New.

&
New Content Source

[lh Content Sources

& Content Sharing

Type * VMware Cloud Templates @
) Content
E policies o Name * PersonnelApplmport
Definitions Description
Enforcement P
I Notifications v

Get cloud templates from
Email Server

Source O, Personnel&ppDeyv
project *

VALIDATE

Deploy cloud templates to

Cloud templates will be deployed to cloud zones in projects they are shared with.

CREATE & IMPORT CANCEL

Select Cloud Assembly Cloud Template.

Enter PersonnelAppImport as the name.

In the Source project drop-down menu, select PersonnelAppDev and click Validate.
When the source is validated, click Create and Import.

Repeat for PayrollAppDev using PayrollApplmport as the content source name.

10 Share an imported cloud template with a project.

Although the cloud template is already associated with a project, you share it in Service Broker
to make it available in the catalog.

a

b

Continue as a user with the Service Broker administrator role.
In Service Broker, select Content and Policies > Content Sharing.

Select the PersonnelAppDev project, which includes the users who must be able to deploy
the cloud template from the catalog.

VMware, Inc. 178



Using and Managing vRealize Automation Cloud Assembly

d Click Add Items and then select the PersonnelApp cloud template to share with the project
members.

Share Iltems with PersonnelAppDev X

Select the templates to share with the project members. @

CONTENT SOURCES » Tl &

Items Shared with this Project Description

L @) PersonnelApplmport

4> WebApp for Personnel

1item(s)

CANCEL SAVE

e Click Save.

11 Verify that the cloud template is available in the Service Broker catalog to the project
members.

a Request that a project member log in and click the Catalog tab.

Catalog Items Cieen) v

<8<> WebApp for Perso...

VMware Cloud Templates

Projects: PersonnelAppDev

REQUEST

A A A NN NN NN AP

ﬁ

b Click Request on the PersonnelApp cloud template card.

¢ Complete the form and click Submit.
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12 Verify that the project member can monitor the deployment process.

a Request that the project member select Resources > Deployments and locate their
provisioning request.

Catalog Deployments
Dep|0ymeﬂt5 (2rems ) S7 O, Search deployments (@ | sort Created on (descending) - = &
@ Web App for Pers... 1Resource Created T minu..  Never expires ACTIONS v
1o - i Cloud_Machine_1-mc » On
Project PersonnelAp.

Requestor gloria@coke 5.

b When the cloud template is deployed, verify that the requesting user access the
application.

13 Repeat the process for the additional projects.

Results

In this use case, recognizing that need to delegate the cloud template development to the
developers, you add more organization members. You made them Cloud Assembly users. You
then made them members of relevant projects so that they can create and deploy cloud templates.
As project members, they cannot see or alter the infrastructure that you continue to manage, but
you gave them full service viewer permissions sot that they could understand the constraints of
infrastructure that they are designing for.

In this use case, you configure users with various roles, including the Service Broker administrator
and users. You then provide the non-developer users with the Service Broker catalog.

What to do next

To learn how to define and assign custom roles to user, see User role use case 3: Set up vRealize
Automation custom user roles to refine system roles.

User role use case 3: Set up vRealize Automation custom user roles to refine
system roles

As a vRealize Automation organization owner or service administrator, you manage user access
using the organization and service system roles. However, you also want to create custom roles to
that selected users and perform tasks or see content that is outside of their system roles.

This scenario assumes that you understand the service user and viewer, and the project member
and viewer roles that are defined in use case 2. You can see that they are more restrictive than the
service and project administrator roles used in use case 1. Now you have identified some local use
cases where you want some users to have full management permissions to on some features, view
permissions on others, and you do not want them to even view yet another set of features. You
use custom roles define those permission.
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This use case is based on three possible local use cases. This procedure shows you how to create
permissions for the following custom roles.

Restricted Infrastructure Administrator. You want some service users, who are not service

administrators, to have broader infrastructure permissions. As the administrator, you want
them to help set up cloud zones, images, and flavors. You also want them to be able

on on-board and manage discovered resources. Notice they cannot add cloud accounts or
integrations, they can only define the infrastructure for those endpoints.

Extensibility Developer. You want some service users to have full permissions to use the
extensibility actions and subscriptions as part of cloud template development for their project
team and for other projects. They will also develop custom resource types and custom actions
for multiple projects.

XaaS Developer. You want some service users to have full permissions to develop custom
resource types and custom actions for multiple projects.

Deployment Troubleshooter. You want your project administrators to have permissions they
need to troubleshoot and perform root cause analysis on failed deployments. You give them
manage permissions on non-destructive or less expensive categories such as image and flavor
mappings. You also want the project administrators to have permission to set approvals and
day 2 policies as part of the failed deployment troubleshooting role.

Prerequisites

Review the Cloud Assembly and Service Broker service roles and project roles tables in What
are the vRealize Automation user roles. You must understand what each service user role can
see and do in those services.

Review the Custom user roles in vRealize Automation descriptions so that you know more
about how you can refine the permissions for your users.

Review the first use case so that you understand organization roles and the service
administrator roles. See User role use case 1: Set up the vRealize Automation user roles to
support a small application development team.

Review the second use case so that you understand the service user and project member
roles. See User role use case 2: Set up vRealize Automation user roles to support larger
development teams and the catalog.

Familiarize yourself with Service Broker. See Adding content to the catalog.

Procedure

1

Assign organization member roles to your cloud template developer users.

If you need instructions, see the User role use case 1: Set up the vRealize Automation user
roles to support a small application development team.
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2 Assign Cloud Assembly and Service Broker service roles for your cloud template developers
and catalog consumers.

If you need instructions, see the User role use case 2: Set up vRealize Automation user roles to
support larger development teams and the catalog.

3 Create projects in Cloud Assembly that you use to group resources and users.

The steps below for the custom roles also includes project roles.
If you need instructions for creating projects, see the User role use case 2: Set up vRealize
Automation user roles to support larger development teams and the catalog.

4 Create and release cloud templates for each project team.

If you need instructions, see the User role use case 1: Set up the vRealize Automation user
roles to support a small application development team.

5 Log in to Cloud Assembly as a service administrator and select Infrastructure > Administration
> Custom Roles.

6 Create a Restricted Infrastructure Administrator role.

In this example, you have a user, Tony, who is expert at setting up the infrastructure for
various projects, but you don't want to give him full service permissions. Instead, Tony
builds the core infrastructure the supports the work of all the projects. You give him limited
infrastructure management permissions. Tony, or an outside contractor, might also have
similar permissions for onboarding discovered machines and bringing them under vRealize
Automation management.

a Add Tony to Cloud Assembly as a service user and viewer.

With his viewer permissions, he can see the underlying cloud accounts and integrations if
he needs to troubleshoot his work, but he cannot make changes.

b Create a project and add Tony as project member.

c To create the custom role, select Infrastructure > Administration > Custom Roles, and
click New Custom Role.

d Enter the name Restricted Infrastructure Administrator and select the following
permissions.

Select this permission ... So that the users can ...

Infrastructure > Manage Cloud Create, update, and delete cloud zones.
Zones

Infrastructure > Manage Flavor Create, update, and delete flavor mappings.
Mappings

Infrastructure > Manage Image Create, update, and delete image mappings.
Mappings

e Click Create.
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f  Onthe Custom Roles page, select the Restricted Infrastructure Administrator role and click
Assign.

g Enter Tony's email account and click Add.
For example, enter Tony@yourcompany.com.
You can also enter any defined Active Directory user groups.

h Have Tony verify that when he logs in, he can add, edit, and delete values in the areas
defined by the custom role.

7 Create an Extensibility Developer role.

In this example, you have several cloud template developers, Sylvia and Igor, who are
knowledgeable about how to use extensibility actions and subscriptions to manage daily
development tasks. They are also experienced with vRealize Orchestrator, so you task

them with providing custom resources and actions for various projects. You give them
additional permissions manage extensibility by managing custom resources and actions, and
by managing extensibility actions and subscriptions.

a Add Sylvia and Igor as Cloud Assembly users.
b Add them as members of the projects that they are contributing their extensibility skills to.

¢ Create a custom user role that you name Extensibility Developer and select the
following permissions.

Select this permission ... So that the users can ...
XaaS > Manage Custom Resources Create, update, or delete custom resources.
Xaa$S > Manage Resource Actions Create, update, or delete custom actions.

Extensibility > Manage Extensibility = Create, update, or delete extensibility actions and subscriptions. Disable
Resources subscriptions. Cancel and delete action runs.

d Click Create.
e Assign Sylvia and Igor to the Extensibility Developer role.

f  Verify that Sylvia and Igor can manage the custom resources and actions, and that they
can manage the various options on the Extensibility tab.

8 Create a Deployment Troubleshooter role.

In this example, you give your project administrators more manage permission so that they can
remedy deployment failures for their teams.

a Add your project administrators, Shauna, Pratap, and Wei, as Cloud Assembly and Service
Broker service users.

b Intheir projects, add them as project administrators.
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¢ Create a custom user role that you name Deployment Troubleshooter and select the
following permissions.

Select this permission ... So that the users can ...

Infrastructure > Manage Flavor Create, update, and delete flavor mappings.

Mappings

Infrastructure > Manage Image Create, update, and delete image mappings.

Mappings

Deployments > Manage View all deployments, across projects, and run all day 2 actions on
Deployments deployments and deployment components.

Policy > Manage Policies Create, update, or delete policy definitions.

d Click Create.
e Assign Shauna, Pratap, and Wei to the Deployment Troubleshooter role.

f  Verify that they can manage flavor mappings, image mappings, and policies in Service
Broker.

Results

In this use case, you configure different users with various roles, including custom roles that
expand their service and project roles.

What to do next

Create custom roles that address your local use cases.

How do | assign the Cloud Assembly Infrastructure Administrator
built-in role to a user

The infrastructure administrator role is a built-in role that you can assign to selected users. You
cannot assign the role in the user interface.

When should | assign this user role

You can duplicate the permissions using the custom user role options. However, you can give this
built-in role to users who are limited administrators.

Infrastructure administrator role permissions

The following table provides the list of management permissions and other permissions the an
infrastructure administrators needs. These permissions cannot be modified. If you want a user
to have more limited permissions, use the custom roles to create a user role that meets your
particular needs.
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Table 3-15. Provided permissions for the Infrastructure Administrator built-in role

Permission to create, edit, update, or delete Other permissions

m  Cloud accounts m  View and tag discovered resources
m  Integrations m  View compute resources

m  Cloud zones ®m  Mange IP addresses

m  Flavor mappings ®  View and tag load balancers

B |mage mappings m  View network domains

m Network profiles m  View security

m  Storage profiles m  View storage

m Tags m  View and remove requests

m  Onboarding

How do | assign the Infrastructure Administrator role

This built-in role is assigned using the RBAC API. You first get the role and then assign the role to
a user.

Before you begin:

Familiarize yourself with the API. See the vRealize Automation APl Programming Guide.
Familiarize yourself with the API. See the vRealize Automation 8.6 APl Programming Guide.

Get an API bearer token. See the Get Your Access Token article in vRealize Automation API
Programming Guide.

Get an APl bearer token. See See the Get Your Access Token article in vRealize Automation
8.6 APl Programming Guide

GO 10 $vra/project/api/swagger/swagger-ui.html?urls.primaryName=rba wWhere svra is the
base URL for your instance.

In the upper right corner of the page, in the Select a definition drop-down list, select rbac:
2020-08-10.

To retrieve the user role, open the Role section, run GET /rbac-service/api/roles.

The results should look similar to the following example.

"content": [
{
"description": "Infrastructure Administrator",
"hidden": false,
"id": "infrastructure administrator",
"name": "Infrastructure Administrator",
"orgId": "string",
"permissions": [

"string"
] ’
"projectScope": true
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4 To add a user to the role, open the Role Assignment section, open and edit the PUT /rbac-
service/api/role-assignments command with the user name included.

For example,

"orgId": "string",
"principalId": "Username@domain",
"principalType": "user",
"projectId": "string",
"rolesToAdd": [

"infrastructure administrator
1,

"rolesToRemove": [

"string"

5 Run the modified PUT command.

6 To verify the results, instruct the assigned user to log in and ensure that they have the
permissions defined above.

Adding cloud accounts to Cloud Assembly

Cloud accounts are the configured permissions that Cloud Assembly uses to collect data from the
regions or data centers, and to deploy cloud templates to those regions.

The collected data includes the regions that you later associate with cloud zones.

When you later configure cloud zones, mappings, and profiles, you select the cloud account to
which they are associated.

As a cloud administrator, you create cloud accounts for the projects in which team members
work. Resource information such as network and security, compute, storage, and tags content is
data-collected from your cloud accounts.

Note If the cloud account has associated machines that have already been deployed in the
region, you can bring those machines into Cloud Assembly management by using an onboarding
plan. See What are onboarding plans in Cloud Assembly.

If you remove a cloud account that is used in a deployment, resources that are part of that
deployment become unmanaged.

Credentials required for working with cloud accounts in vRealize
Automation

To configure and work with cloud accounts in vRealize Automation, verify that you have the
following credentials.
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Required cloud account credentials

To... You need...

Sign up for and A VMware ID.

log in to Cloud B Set up a My VMware account by using your corporate email address.
Assembly

Connect HTTPS port 443 open to outgoing traffic with access through the firewall to:
to vRealize B *.vmwareidentity.com

Automation

B gaz.csp-vidm-prod.com
H *.vmware.com

For more information about ports and protocols, see VMware Ports and
Protocols.

For more information about ports and protocols, see Port Requirementsin
the Reference Architecture help.

services
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To...

Add a vCenter
cloud account
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You need...

Privileges are required for the vSphere agent to manage the vCenter Server

instance. Provide an account with the following read and write privileges:

The permissions needed to manage VMware Cloud on AWS and vCenter

vCenter |P address or FQDN

cloud accounts are listed. Permissions must be enabled for all clusters in the
vCenter Server, not just clusters that host endpoints.

For all vCenter Server-based cloud accounts - including NSX-V, NSX-T,
vCenter, and VMware Cloud on AWS - the administrator must have vSphere

endpoint credentials, or the credentials under which the agent service runs
in vCenter, that provide administrative access to the host vCenter Server.

For more information about vSphere agent requirements, see VMware
vSphere product documentation.

Datastore

B Allocate space

B Browse datastore

B Low level file operations
Datastore Cluster

B Configure a datastore cluster
Folder

B Create folder

B Delete folder

Global

B Manage custom attributes

B Set custom attribute
Network

B Assign network

Permissions

B Modify permission

Resource

B Assign VM to Res Pool

B Migrate powered off virtual machine
B Migrate powered on virtual machine
Profile-driven storage

B Profile-driven storage view

To return a list of storage policies that can be mapped to a storage
profile, grant the StorageProfile.View privilege to all accounts that
connect vRealize Automation to vCenter Server.

Content Library

To assign a privilege on a content library, an administrator must grant the

privilege to the user as a global privilege. For related information, see

Hierarchical Inheritance of Permissions for Content Libraries in vSphere

Virtual Machine Administration at VMware vSphere Documentation.
B Add library item

B Create local library

B Create subscribed library

B Delete library item
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To...
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You need...

Delete local library

Delete subscribed library
Download files

Evict library item

Probe subscription information
Read storage

Sync library item

Sync subscribed library

Type introspection

Update configuration settings
Update files

Update library

Update library item

Update local library

Update subscribed library
View configuration settings

B vSphere Tagging

Assign or unassign vSphere tag

Assign or unassign vSphere tag on object
Create a vSphere tag

Create a vSphere tag category

Delete vSphere tag

Delete vSphere tag category

Edit vSphere tag

Edit vSphere tag category

Modify UsedBYy field or category

Modify UsedBy field for tag

H vApp

Import
VApp application configuration

The vApp.Import application configuration is required for OVF
templates and to provision VMs from the content library.

The vApp.vApp application configuration is required when using
cloud-init for cloud configuration scripting. This setting allows for
modification of a VApp's internal structure, such as its product
information and properties.

B Virtual Machine - Inventory

Create from existing
Create new

Move

Remove

B Virtual Machine - Interaction

Configure CD media
Console interaction
Device connection
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To...
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You need...

B Virtual Machine - Configuration

Power off
Power on
Reset
Suspend
Tools install

Add existing disk
Add new

Remove disk
Advanced

Change CPU count
Change resource
Extend virtual disk
Disk change tracking
Memory

Modify device settings
Rename

Set annotation
Settings

Swapfile placement

B Virtual Machine - Provisioning

Customize

Clone template

Clone virtual machine
Deploy template

Read customization specs

B Virtual Machine - State

Create snapshot
Remove snhapshot
Revert to snapshot
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To...

Add an Amazon
Web Services
(AWS) cloud
account
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You need...

Provide a power user account with read and write privileges. The user
account must be a member of the power access policy (PowerUserAccess) in
the AWS Identity and Access Management (IAM) system.

B 20-digit Access Key ID and corresponding Secret Access Key

If you are using an external HTTP Internet proxy, it must be configured for
IPv4.

vRealize Automation actions-based extensibility (ABX) and external IPAM
integration may require additional permissions.

The following AWS permissions are suggested to allow autoscaling
functions:

B Autoscaling actions:
autoscaling:DescribeAutoScalinglnstances
autoscaling:Attachlnstances
autoscaling:DeleteLaunchConfiguration
autoscaling:DescribeAutoScalingGroups
autoscaling:CreateAutoScalingGroup
autoscaling:UpdateAutoScalingGroup
autoscaling:DeleteAutoScalingGroup
autoscaling:DescribelLoadBalancers
B Autoscaling resources:

m

Provide all autoscaling resource permissions.

The following permissions are required to allow AWS Security Token Service
(AWS STS) functions to support temporary, limited-privilege credentials for
AWS identity and access:

B AWS STS resources:
m
Provide all STS resource permissions.
The following AWS permissions are required to allow EC2 functions:
B EC2 actions:

B ec2:AttachVolume
ec2:AuthorizeSecurityGrouplngress
ec2:DeleteSubnet
ec2:DeleteSnapshot
ec2:Describelnstances
ec2:DeleteTags
ec2:DescribeRegions
ec2:DescribeVolumesModifications
ec2:CreateVpc
ec2:DescribeSnapshots
ec2:DescribelnternetGateways
ec2:DeleteVolume
ec2:DescribeNetworklinterfaces
ec2:Startlnstances
ec2:DescribeAvailabilityZones
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To...
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You need...

ec2.CreatelnternetGateway
ec2:CreateSecurityGroup
ec2:DescribeVolumes
ec2:CreateSnapshot
ec2:ModifylnstanceAttribute
ec2:DescribeRouteTables
ec2:DescribelnstanceTypes
ec2:DescribelnstanceTypeOfferings
ec2:DescribelnstanceStatus
ec2:DetachVolume
ec2:Rebootinstances
ec2:AuthorizeSecurityGroupEgress
ec2:ModifyVolume
ec2:Terminatelnstances
ec2:DescribeSpotFleetRequestHistory
ec2:DescribeTags

ec2:CreateTags

ec2:Runlinstances
ec2:DescribeNatGateways
ec2:Stoplnstances
ec2:DescribeSecurityGroups
ec2:CreateVolume
ec2:DescribeSpotFleetRequests
ec2:Describelmages
ec2:DescribeVpcs
ec2:DeleteSecurityGroup
ec2:DeleteVpc

ec2:CreateSubnet
ec2:DescribeSubnets
ec2:RequestSpotFleet

Note The SpotFleet request permission is not required for

vRealize Automation actions-based extensibility (ABX) or external
IPAM integrations.

B EC2 resources:

*

Provide all EC2 resource permissions.

The following AWS permissions are required to allow elastic load balancing
functions:

B |Load balancer actions:

elasticloadbalancing:DeleteLoadBalancer
elasticloadbalancing:DescribelLoadBalancers
elasticloadbalancing:RemoveTags
elasticloadbalancing:CreatelLoadBalancer
elasticloadbalancing:DescribeTags
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To...
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You need...

B elasticloadbalancing:ConfigureHealthCheck
elasticloadbalancing:AddTags
elasticloadbalancing:CreateTargetGroup
elasticloadbalancing:DeletelL.oadBalancerListeners
elasticloadbalancing:DeregisterinstancesFromLoadBalancer
elasticloadbalancing:RegisterinstancesWithLoadBalancer
B elasticloadbalancing:CreateLoadBalancerListeners

Load balancer resources:

m

Provide all load balancer resource permissions.

The following AWS ldentity and Access Management (IAM) permissions can
be enabled, however they are not required:

iam:SimulateCustomPolicy
iam:GetUser
iam:ListUserPolicies
iam:GetUserPolicy
iam:ListAttachedUserPolicies
iam:GetPolicyVersion
iam:ListGroupsForUser
iam:ListGroupPolicies
iam:GetGroupPolicy
iam:ListAttachedGroupPolicies
iam:ListPolicyVersions
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To...

Add a Microsoft
Azure cloud
account
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You need...

Configure a Microsoft Azure instance and obtain a valid Microsoft Azure
subscription from which you can use the subscription ID.

Create an Active Directory application as described in How to: Use the portal
to create an Azure AD application and service principal that can access
resources in Microsoft Azure product documentation.

If you are using an external HTTP Internet proxy, it must be configured for
IPv4.

Make note of the following information:

Subscription ID

Allows you to access to your Microsoft Azure subscriptions.

Tenant ID

The authorization endpoint for the Active Directory applications you
create in your Microsoft Azure account.

Client application ID

Provides access to Microsoft Active Directory in your Microsoft Azure
individual account.

Client application secret key

The unique secret key generated to pair with your client application ID.

The following permissions are needed for creating and validating Microsoft
Azure cloud accounts:

Microsoft Compute

B Microsoft.Compute/virtualMachines/extensions/write
Microsoft.Compute/virtualMachines/extensions/read
Microsoft.Compute/virtualMachines/extensions/delete
Microsoft.Compute/virtualMachines/deallocate/action
Microsoft. Compute/virtualMachines/delete
Microsoft.Compute/virtualMachines/powerOff/action
Microsoft.Compute/virtualMachines/read
Microsoft.Compute/virtualMachines/restart/action
Microsoft.Compute/virtualMachines/start/action
Microsoft.Compute/virtualMachines/write
Microsoft.Compute/availabilitySets/write
Microsoft.Compute/availabilitySets/read
Microsoft.Compute/availabilitySets/delete
Microsoft.Compute/disks/delete
Microsoft.Compute/disks/read
Microsoft.Compute/disks/write

Microsoft Network
Microsoft.Network/loadBalancers/backendAddressPools/join/action
Microsoft.Network/loadBalancers/delete
Microsoft.Network/loadBalancers/read
Microsoft.Network/loadBalancers/write
Microsoft.Network/networkinterfaces/join/action
Microsoft.Network/networkinterfaces/read
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To...
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You need...

Microsoft.Network/networkinterfaces/write
Microsoft.Network/networkinterfaces/delete
Microsoft.Network/networkSecurityGroups/join/action
Microsoft.Network/networkSecurityGroups/read
Microsoft.Network/networkSecurityGroups/write
Microsoft.Network/networkSecurityGroups/delete
Microsoft.Network/publiclPAddresses/delete
Microsoft.Network/publiclPAddresses/join/action
Microsoft.Network/publiclPAddresses/read
Microsoft.Network/publiclPAddresses/write
Microsoft.Network/virtualNetworks/read
Microsoft.Network/virtualNetworks/subnets/delete
Microsoft.Network/virtualNetworks/subnets/join/action
Microsoft.Network/virtualNetworks/subnets/read
Microsoft.Network/virtualNetworks/subnets/write
Microsoft.Network/virtualNetworks/write
B Microsoft Resources

B Microsoft.Resources/subscriptions/resourcegroups/delete

B Microsoft.Resources/subscriptions/resourcegroups/read

B Microsoft.Resources/subscriptions/resourcegroups/write
B Microsoft Storage

B Microsoft.Storage/storageAccounts/delete

B Microsoft.Storage/storageAccounts/listKeys/action

B Microsoft.Storage/storageAccounts/read

B Microsoft.Storage/storageAccounts/write
B Microsoft Web
Microsoft.Web/sites/read
Microsoft.Web/sites/write
Microsoft.Web/sites/delete
Microsoft.Web/sites/config/read
Microsoft.Web/sites/config/write
Microsoft.Web/sites/config/list/action
Microsoft.Web/sites/publishxml/action
Microsoft.Web/serverfarms/write
Microsoft.Web/serverfarms/delete
Microsoft.Web/sites/hostruntime/functions/keys/read
Microsoft.Web/sites/hostruntime/host/read
B Microsoft.web/sites/functions/masterkey/read

If you are using Microsoft Azure with action-based extensibility, the following
permissions are required, in addition to the minimal permissions:

B Microsoft.Web/sites/read
Microsoft. Web/sites/write
Microsoft.Web/sites/delete
Microsoft.Web/sites/*/action
Microsoft.Web/sites/config/read
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To...

VMware, Inc.

You need...

Microsoft.Web/sites/config/write
Microsoft.Web/sites/config/list/action
Microsoft.Web/sites/publishxml/action
Microsoft.Web/serverfarms/write
Microsoft.Web/serverfarms/delete
Microsoft.Web/sites/hostruntime/functions/keys/read
Microsoft.Web/sites/hostruntime/host/read
Microsoft.Web/sites/functions/masterkey/read
Microsoft. Web/apimanagementaccounts/apis/read
Microsoft.Authorization/roleAssignments/read
Microsoft. Authorization/roleAssignments/write
Microsoft.Authorization/roleAssignments/delete
Microsoft.Insights/Components/Read
Microsoft.Insights/Components/Write
Microsoft.Insights/Components/Query/Read

If you are using Microsoft Azure with action-based extensibility with
extensions, the following permissions are also needed:

Microsoft. Compute/virtualMachines/extensions/write
Microsoft. Compute/virtualMachines/extensions/read
Microsoft.Compute/virtualMachines/extensions/delete

For related information about creating a Microsoft Azure cloud account, see
Configure Microsoft Azure.
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The Google Cloud Platform cloud account interacts with the Google Cloud
Platform compute engine.

The Project Admin and Owner credentials are required for creating and
validating Google Cloud Platform cloud accounts.

If you are using an external HTTP Internet proxy, it must be configured for
IPv4.

The compute engine service must be enabled. When creating the cloud
account in vRealize Automation, use the service account that was created
when the compute engine was initialized.

The following compute engine permissions are also needed, depending on
the actions that the user can take:

B roles/compute.admin

Provides full control of all compute engine resources.
B roles/iam.serviceAccountUser

Provides access to users who manage virtual machine instances that are
configured to run as a service account. Grant access to the following
resources and services:

compute.*
resourcemanager.projects.get
resourcemanager.projects.list
serviceusage.quotas.get
serviceusage.services.get
serviceusage.services.list

B roles/compute.imageUser

Provides permission to list and read images without having other
permissions on the image. Granting the compute.imageUser role at the
project level gives users the ability to list all images in the project. It also
allows users to create resources, such as instances and persistent disks,
based on images in the project.

B compute.images.get
compute.images.getFromFamily
compute.images.list
compute.images.useReadOnly
resourcemanager.projects.get
resourcemanager.projects.list
serviceusage.quotas.get
serviceusage.services.get
serviceusage.services.list

B roles/compute.instanceAdmin

Provides permissions to create, modify, and delete virtual machine
instances. This includes permissions to create, modify, and delete disks,
and also to configure shielded VMBETA settings.

For users that manage virtual machine instances (but not network or
security settings or instances that run as service accounts), grant this role
to the organization, folder, or project that contains the instances, or to
the individual instances.
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Users that manage virtual machine instances that are configured to run as

a service account also need the roles/iam.serviceAccountUser role.

compute.acceleratorTypes
compute.addresses.get
compute.addresses.list
compute.addresses.use
compute.autoscalers
compute.diskTypes
compute.disks.create
compute.disks.createSnapshot
compute.disks.delete
compute.disks.get
compute.disks.list
compute.disks.resize
compute.disks.setLabels
compute.disks.update
compute.disks.use
compute.disks.useReadOnly
compute.globalAddresses.get
compute.globalAddresses.list
compute.globalAddresses.use
compute.globalOperations.get
compute.globalOperations.list
compute.images.get
compute.images.getFromFamily
compute.images.list
compute.images.useReadOnly
compute.instanceGroupManagers
compute.instanceGroups
compute.instanceTemplates
compute.instances
compute.licenses.get
compute.licenses.list
compute.machineTypes
compute.networkEndpointGroups
compute.networks.get
compute.networks.list
compute.networks.use
compute.networks.useExternallp
compute.projects.get
compute.regionOperations.get
compute.regionOperations.list
compute.regions
compute.reservations.get
compute.reservations.list
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compute.subnetworks.get
compute.subnetworks.list
compute.subnetworks.use
compute.subnetworks.useExternallp
compute.targetPools.get
compute.targetPools.list
compute.zoneOperations.get
compute.zoneOperations.list
compute.zones
resourcemanager.projects.get
resourcemanager.projects.list
serviceusage.quotas.get
serviceusage.services.get
serviceusage.services.list

B roles/compute.instanceAdmin.v1

Provides full control of compute engine instances, instance groups, disks,

snapshots, and images. Also provides read access to all compute engine
networking resources.

Note If you grant a user this role at the instance level, that user cannot
create new instances.

compute.acceleratorTypes
compute.addresses.get
compute.addresses.list
compute.addresses.use
compute.autoscalers
compute.backendBuckets.get
compute.backendBuckets.list
compute.backendServices.get
compute.backendServices.list
compute.diskTypes
compute.disks
compute.firewalls.get
compute.firewalls.list
compute.forwardingRules.get
compute.forwardingRules.list
compute.globalAddresses.get
compute.globalAddresses.list
compute.globalAddresses.use
compute.globalForwardingRules.get
compute.globalForwardingRules.list
compute.globalOperations.get
compute.globalOperations.list
compute.healthChecks.get
compute.healthChecks.list

199



Using and Managing vRealize Automation Cloud Assembly

To...

VMware, Inc.

You need...

compute.httpHealthChecks.get
compute.httpHealthChecks.list
compute.httpsHealthChecks.get
compute.httpsHealthChecks.list
compute.images
compute.instanceGroupManagers
compute.instanceGroups
compute.instanceTemplates
compute.instances
compute.interconnectAttachments.get
compute.interconnectAttachments.list
compute.interconnectlLocations
compute.interconnects.get
compute.interconnects.list
compute.licenseCodes
compute.licenses
compute.machineTypes
compute.networkEndpointGroups
compute.networks.get
compute.networks.list
compute.networks.use
compute.networks.useExternallp
compute.projects.get
compute.projects.setCommoninstanceMetadata
compute.regionBackendServices.get
compute.regionBackendServices.list
compute.regionOperations.get
compute.regionOperations.list
compute.regions
compute.reservations.get
compute.reservations.list
compute.resourcePolicies
compute.routers.get
compute.routers.list
compute.routes.get
compute.routes.list
compute.snapshots
compute.ssiCertificates.get
compute.sslCertificates.list
compute.sslPolicies.get
compute.sslPolicies.list
compute.sslPolicies.listAvailableFeatures
compute.subnetworks.get
compute.subnetworks.list
compute.subnetworks.use
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compute.subnetworks.useExternallp
compute.targetHttpProxies.get
compute.targetHttpProxies.list
compute.targetHttpsProxies.get
compute.targetHttpsProxies.list
compute.targetinstances.get
compute.targetinstances.list
compute.targetPools.get
compute.targetPools.list
compute.targetSsIProxies.get
compute.targetSslIProxies.list
compute.targetTcpProxies.get
compute.targetTcpProxies.list
compute.targetVpnGateways.get
compute.targetVpnGateways.list
compute.urlMaps.get
compute.urlMaps.list
compute.vpnTunnels.get
compute.vpnTunnels.list
compute.zoneOperations.get
compute.zoneOperations.list
compute.zones
resourcemanager.projects.get
resourcemanager.projects.list
serviceusage.quotas.get
serviceusage.services.get
serviceusage.services.list

Provide an account with the following read and write privileges:
B NSX-T IP address or FQDN
B NSX-T Data Center - Enterprise Administrator role and access credentials

Administrators a/sorequire access to the vCenter Server as described in the
Add a vCenter cloud account section of this table.

Provide an account with the following read and write privileges:
B NSX-V Enterprise Administrator role and access credentials
B NSX-V IP address or FQDN

Administrators a/so require access to the vCenter Server as described in the
Add a vCenter cloud account section of this table.
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Add a VMware Provide an account with the following read and write privileges:
Cloud on AWS B The cloudadmin@vmc.local account or any user account in the
(VMC) cloud CloudAdmin group

account B NSX Enterprise Administrator role and access credentials

B NSX Cloud Admin access to your organization's VMware Cloud on AWS
SDDC environment

B Administrator access to your organization's VMware Cloud on AWS
SDDC environment

B The VMware Cloud on AWS API token for your VMware Cloud on AWS
environment in your organization's VMware Cloud on AWS service

B vCenter IP address or FQDN

Administrators a/so require access to the vCenter Server as described in the

Add a vCenter cloud account section of this table.

For more information about the permissions needed to create and use

VMware Cloud on AWS cloud accounts, see Managing the VMware Cloud

on AWS Data Centerin VMware Cloud on AWS product documentation.

Integrate Provide a local or non-local login account to vRealize Operations Manager
with vRealize with the following read privileges.

Operations B Adapter Instance vCenter Adapter > VC Adapter Instance for vCenter-
Manager FQDN

A non-local account might need to be imported first, before you can assign
its read-only role.

Configure Microsoft Azure for use with Cloud Assembly

You must gather some information and perform some configuration in order to create a Microsoft
Azure cloud account in Cloud Assembly.

Procedure
1 Locate and record your Microsoft Azure subscription and tenant IDs.

m  Subscription ID - Click the Subscriptions icon on the left toolbar in your Azure portal to
view the subscription ID.

m  Tenant ID - Click the Help icon and select Show Diagnostics in your Azure portal. Search
for tenant and record the ID when you have located it.

2 You can create a new storage account and a resource group to get started. Alternatively, you
can create these in blueprints later.

m  Storage Account - Use the following procedure to configure an account.

1 Inyour Azure portal, locate the Storage Accounts icon on the sidebar. Make sure the
correct subscription is selected and click Add. You can also, search for storage account
in the Azure search field.

2 Enter the required information for the storage account. You will need your subscription
ID.
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3 Select whether to use an existing resource group or create a new one. Make note of
your resource group name, as you will need it later.

Note Save the location of your storage account as you will need it later.

3 Create a virtual network. Alternatively, if you have a suitable existing network, you can select
that one.

If you are creating a network, you must select Use an Existing Resource Group and specify the
group that you created in the preceding step. Also, select the same location that you specified
previously. Microsoft Azure will not deploy virtual machines or other objects if the location
doesn't match between all applicable components that the object will consume.

a

9

Locate the Virtual Network icon on the left panel and click it or search for virtual network.
Make sure to select the correct subscription and click Add.

Enter a unique name for your new virtual network and record it for later.

Enter the appropriate IP address for your virtual network in the Address space field.
Ensure that the correct subscription is selected and click Add.

Enter the remaining basic configuration information.

You can modify the other options as necessary, but for most configurations, you can leave
the defaults.

Click Create.

4 Set up an Azure Active Directory application so that vRA can authenticate.

a

b

Locate the Active Directory icon on the Azure left menu and click it.

Click App Registrations and select Add.

Type a name for your application that complies with Azure name validation.
Leave Web app/API as the Application Type.

The Sign-on URL can be anything that is appropriate for your usage.

Click Create.

5 Create a secret key to authenticate the application in Cloud Assembly.

a

Click the name of your application in Azure.

Make note of your Application ID for later use.

Click All Settings in the next pane and select Keys from the settings list.
Enter a description for the new key and choose a duration.

Click Save and make sure to copy the key value to a safe location as you will be unable to
retrieve it later.

On the left menu, select APl Permissions for the application and click Add a Permission to
create a new permission.
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f  Select Azure Service Management on the Select an API page.
g Click Delegated Permissions.

h Under Select permissions select user_impersonation and then click Add Permissions.

6 Authorize your Active Directory application to connect to your Azure subscription so that you

can deploy and manage virtual machines.

a Inthe left menu, click the Subscriptions icon, and select your new subscription.
You may need to click on the text of the name to get the panel to slide over.

b Select the Access control (IAM) option to see the permissions to your subscription.

¢ Click Add under the Add a Role Assignment heading.

d Choose Contributor from the Role drop down.

e Leave the default selection in the Assign Access to drop down.

f  Type the name of your application in the Select box.

g Click Save.

h Add additional roles so that your new application has Owner, Contributor, and Reader
roles.

i Click the Save.

What to do next

You must install the Microsoft Azure command line interface tools. These tools are freely available
for both Windows and Mac operating systems. See the Microsoft documentation for more
information about downloading and installing these tools.

When you have the command line interface installed, you must authenticate to your new
subscription.

1

Open a terminal window and type your Microsoft Azure login. You will receive a URL and a
shortcode that will allow you to authenticate.

In a browser, enter the code that you received from the application on your device.
Enter your Auth Code and click Continue.
Select your Azure account and login.

If you have multiple subscriptions, ensure that the correct one is selected using the azure

account set <subscription-name>command.

Before you proceed, you must register the Microsoft.Compute provider to your new Azure
subscription using the azure provider register microsoft.compute command.

If the command times out and generates an error the first time your run it, run it again.
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When you have completed configuration, you can use the azure vm image list command to
retrieve available virtual machine image names. You can choose the desired image and record the
URN provided for it and later use it in blueprints.

Create a Microsoft Azure cloud account in vRealize Automation

As a cloud administrator, you can create a Microsoft Azure cloud account for account regions to
which your team will deploy vRealize Automation cloud templates.

To view an example use case of how Microsoft Azure cloud account works in vRealize Automation
see Tutorial: Setting up and testing multi-cloud infrastructure and deployments in Cloud Assembly.

Prerequisites

m  Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

m  Verify that you have the required user role. See What are the vRealize Automation user roles.

m  Configure a Microsoft Azure account for use with vRealize Automation. See Configure
Microsoft Azure for use with Cloud Assembly.

m |f you do not have external Internet access, configure an Internet server proxy. See How do |
configure an Internet proxy server for vRealize Automation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the Microsoft Azure account type and enter credentials and other values.
3 Click Validate.
The account regions associated with the account are collected.
4 Select the regions to which you want to provision this resource.
5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need to add tags to support a tagging strategy, enter capability tags. See How do | use
tags to manage Cloud Assembly resources and deployments and Creating a tagging strategy.

For more information about how capability tags and constraint tags help control
deployment placements, see the Constraint Tags and Placement video tutorial.

7 Click Save.

Results

The account is added to vRealize Automation, and the selected regions are available for the
specified cloud zone.
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What to do next
Create infrastructure resources for this cloud account.

When you add an Azure cloud account to a cloud template, you can choose to reuse
availability sets if you want. Subscriptions have a limit of 2000 availability sets and 25,000
virtual machines, so it makes sense to reuse availability sets when possible. There are two
YAML properties that you can use to control how deployments use availability sets. The
availabilitySetName property enables you to specify an availability set to use. The second
property is doNotAttachAvailabilitySet which is set to false by default. If this property is set
to true, vRealize Automation will create the deployment with no availability set.

You cannot create a deployment without an availability set if you use a load balancer attached to
the virtual machine.

The following table describes how vRealize Automation behaves depending on whether a
resource group and an availability set are specified in the cloud template.

An availability set cannot exist without being part of a resource group. The availability sets in a
given resource group must have unique names. Availability sets can have the same name only if
they are part of different resource groups.

If you do not specify a resource group name, then vRealize Automation will create a new resource
group, which means that a new availability set must also be created even if a name is passed. The
new set will use the name that is passed.

Table 3-16.

Resource Group Specified Availability Set Specified Result

No No vRealize Automation creates a new resource group
and a new availability set for the virtual machine.

Yes No VvRealize Automation reuses the existing resource
group and creates a new availability set for the virtual
machine.

No Yes vRealize Automation creates a new resource group
and a new availability set with the specified name.

Yes Yes vRealize Automation reuses the existing resource

group. If an availability set with the specified name
already exists in that group, it will also be reused. If
there is no availability set with the specified name in
the group, a new one is created with that name.

Cloud Assembly supports Azure disk snapshots for deployed virtual machines. See Working with
snapshots for Microsoft Azure virtual machine disks in vRealize Operations Manager for more
information.

Cloud Assembly supports several boot diagnostics options for Azure deployments. Boot
diagnostics supports debugging of Azure virtual machines and includes collection of log
information and relevant screenshots. See Using boot diagnostics and log analytics with a
Microsoft Azure virtual machine for more information.
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Using boot diagnostics and log analytics with a Microsoft Azure virtual machine

You can invoke and configure Microsoft Azure boot diagnostics from an Azure instance in a cloud
template. In addition you can also configure log analytics for an Azure virtual machine instance.
Boot diagnostics is a debugging feature for Azure virtual machines that facilitates diagnostics for
virtual machine boot failures. Using boot diagnostics, a user can monitor the state of a virtual
machine as it is booting up by collecting serial log information and screenshots.

Boot Diagnostics

Boot diagnostics captures serial log information and screenshots and these needs to be saved to
the disk. The disk can be of two types, Azure Managed Disk or Unmanaged Disk.

The bootDiagnostics YAML property is supported in Azure cloud templates. When this property is
set to true, boot diagnostics are enabled on the applicable Azure virtual machine deployment.

The following YAML snippet shows an example of how the bootDiagnostics property is used.

formatVersion: 1
inputs: {}
resources:

Cloud Azure Machine 1:
type: Cloud.Azure.Machine
metadata:

layoutPosition:
-0
-0
properties:
image: ubuntu
flavor: small

bootDiagnostics: true

Boot diagnostics can also be invoked on a deployed Azure virtual machine as a day 2 operation.
Navigate to the Deployments page in Cloud Assembly and select the Azure deployment. The
Actions menu on this page enables you to toggle between Enable Boot Diagnostics and Disable
Boot Diagnostics.

After you have deployed a cloud template with boot diagnostics enabled, the Cloud Assembly
Deployments page for the deployment will indicate that boot diagnostics are enabled. If you want
to disable boot diagnostics, click the Actions menu on the Deployments page and select Disable
Boot Diagnostics.

Log Analytics

Log Analytics enables you to edit and run log queries on data collected by Azure Monitor Logs,
and then interactively analyze the results. You can use Log Analytics queries to retrieve records
that match specific criteria to help identify trends and patterns and provide a variety of data
insights. By enabling Log Analytics on a Azure virtual machine, that machine will act as a data
source.
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Before you can configure log analytics in a Cloud Assembly cloud template, you must create and
configure an Azure Log Analytics workspace. You can do this using the Virtual Machines option in
the Azure Monitor menu. See the Microsoft Azure documentation for more information.

To configure log analytics, you must have the Azure Workspace ID and Workspace Key. You can
find these on the Agent Management tab in Azure under the Log Analytics Workspace.

The following cloud template example shows how log analytics can be configured using
extensions.

formatVersion: 1
inputs: {}
resources:

Cloud Azure Machine 1:
type: Cloud.Azure.Machine
properties:

image: ubuntu
flavor: small
extensions:

- autoUpgradeMinorVersion: true
name: test-loga
protectedSettings:

workspaceKey: XXXXXXXXX
publisher: Microsoft.EnterpriseCloud.Monitoring
settings:
workspaceId: aaaaaaaaa
type: OmsAgentForLinux
typeHandlerVersion: '1.0'

After you have deployed a cloud template with Log Analytics enabled, you can enable or disable it
using the Actions menu options on the Cloud Assembly Deployments page for the deployment.

Working with snapshots for Microsoft Azure virtual machine disks in vRealize
Operations Manager
You can create full or incremental snapshots of Microsoft Azure managed disks.

The Cloud Assembly Deployments page for an Azure deployment contains an Actions menu

that provides several options for creating and deleting snapshots from Azure deployments on
virtual machine managed disks and on independent managed disks. The following list outlines the
specific snapshot functionality that is supported.

m  Create a disk snapshot - Supported for both external and compute disks. You can also create
snapshots for a disk in a different resource group.

m  Delete a disk snapshot - Supported for external disks only
m  Encrypt snapshots using an Azure disk encryption set.
m  You can provide key-value pairs as tags during snapshot creation.

Snapshots on unmanaged disks are currently not supported.
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If you use encryption, the current snapshot implementation supports platform-managed key
encryption. By default, the network policy allows access from everywhere, so restricting access
to snapshots by using the network policy is not possible.

For more information about using the Cloud Assembly Actions and the Deployments page, see
What actions can | run on Cloud Assembly deployments.

For more information about Microsoft Azure snapshot support, see Create a snapshot of a virtual
hard disk in Microsoft product documentation.

Create an Amazon Web Services cloud account in vRealize
Automation

As a cloud administrator, you can create an Amazon Web Services (AWS) cloud account for
account regions to which your team will deploy vRealize Automation cloud templates.

The following procedure describes how to configure an AWS cloud account.

Prerequisites

m  Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

m  Verify that you have the required user role. See What are the vRealize Automation user roles.
m  Verify that you have required AWS administrator credentials.

m |f you do not have external Internet access, configure an Internet server proxy. See How do |
configure an Internet proxy server for vRealize Automation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the AWS account type, and enter credentials and other values.
3 Click Validate.
The account regions associated with the account are collected.
4 Select the regions to which you want to provision this resource.
5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need to add tags to support a tagging strategy, enter capability tags. See How do | use
tags to manage Cloud Assembly resources and deployments and Creating a tagging strategy.

For more information about how capability tags and constraint tags help control

deployment placements, see the Constraint Tags and Placement video tutorial.

7 Click Add.
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Results

The account is added to vRealize Automation, and the selected regions are available for the
specified cloud zone.

What to do next

Configure infrastructure resources for this cloud account.

Create a Google Cloud Platform cloud account in vRealize
Automation

As a cloud administrator, you can create a Google Cloud Platform (GCP) cloud account for account
regions to which your team will deploy vRealize Automation cloud templates.

Prerequisites

Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

Verify that you have the required user role. See What are the vRealize Automation user roles.
Verify that you have access to the Google Cloud Platform JSON security key.

Verify that you have required security information for your Google Cloud Platform instance.
You can obtain most of this information from your instance or from the Google documentation.

If you do not have external Internet access, configure an Internet server proxy. See How do |
configure an Internet proxy server for vRealize Automation.

Procedure

1

In Cloud Assembly, select Infrastructure > Connections > Cloud Accounts and click Add
Cloud Account.

Select the Google Cloud Platform account type and enter the appropriate credentials and
related information. Use the service account that was created when the source GCP account
compute engine was initialized.

As noted in the Prerequisites section above, credential requirements are available at
Credentials required for working with cloud accounts in vRealize Automation. To successfully
create the cloud account in vRealize Automation, the source GCP account must have the
compute engine service enabled.

In vRealize Automation, the project ID is part of the Google Cloud Platform endpoint. You
specify it when you create the cloud account. During data collection of project-specific private
images, the vRealize Automation GCP adapter queries the Google Cloud Platform API.

Click Validate.

The account regions associated with the account are collected.

4 Select the regions to which you want to provision this resource.
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5 For efficiency, click Create a Cloud zone for the selected regions.

6 If you need tags to support a tagging strategy, enter capability tags. See How do | use tags to
manage Cloud Assembly resources and deployments and Creating a tagging strategy.

For more information about how capability tags and constraint tags help control
deployment placements, see the Constraint Tags and Placement video tutorial.

7 Click Add.

Results

The account is added to vRealize Automation, and the selected regions are available for the
specified cloud zone.

What to do next
Create infrastructure resources for this cloud account.

The following paragraphs provide some information on deploying a Google Cloud Platform virtual
machine from Cloud Assembly.

When you add a Google Cloud Platform cloud account to a Cloud Assembly cloud template, you
can use the usesoleTenant YAML property to indicate that you want to deploy a virtual machine to
a sole tenant node. This configuration enables you to isolate virtual machines for security, privacy
or others issues.

To facilitate this functionality, Google Cloud Platform node affinity labels are converted to tags in
Cloud Assembly, and these tags are applied on relevant vRealize Automation availability zones
where node groups reside. When the usesoleTenant property is set to true, constraint tags must
be one of the node affinity labels. Also, to deploy a machine in sole tenant mode, you must include
the usesoleTenant property in the cloud template as well as the constraint tags.

Before using this feature, you must create the appropriate node template and node affinity labels
inGoogle Cloud Platform and then create a node group.

The following YAML example shows how the useSoleTenant property can be used in Cloud
Assembly cloud templates. The constraint tags are the node affinity labels that were auto-collected
from your Google Cloud Platform server.

resources:
Cloud GCP Machine 1:
type: Cloud.GCP.Machine
properties:
image: ubuntu
flavor: c2-family
name: demo-vm
useSoleTenant: true
constraints:
-tag: 'env:prod'
-tag: 'region:asia-eastl'
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Create a vCenter cloud account in vRealize Automation

You can add a vCenter cloud account for the account regions to which you want to deploy
VRealize Automation cloud templates.

For network and security purposes, you can associate a vCenter cloud account with an NSX-T or
NSX-V cloud account.

An NSX-T cloud account can be associated to one or more vCenter cloud accounts. However, an
NSX-V cloud account can only be associated to one vCenter cloud account.

Prerequisites

Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

Verify that you have properly configured your ports and protocols to support the cloud
account. See the Ports and Protocols for vRealize Automation topic in /nstalling vRealize
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure

Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
Select the vCenter account type and enter the vCenter Server host IP address.
Enter your vCenter Server administrator credentials and click Validate.

All data centers that are associated with the account are data-collected. The following
elements are data-collected, as are all vSphere tags for the following elements:

= Machines

m  Clusters and hosts
m  Port groups

m Data stores

Select at least one of the available data centers on the specified vCenter Server to allow
provisioning for this cloud account.

For efficiency, create a cloud zone for provisioning to the selected data centers.

You can also create cloud zones as a separate step according to your organization's cloud
strategy.

For information about cloud zones, see Learn more about Cloud Assembly cloud zones.
Select an existing NSX cloud account.

You can select the NSX account now, or later when you edit the cloud account.
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For information about NSX-V cloud accounts, see Create an NSX-V cloud account in vRealize
Automation.

For information about NSX-T cloud accounts, see Create an NSX-T cloud account in vRealize
Automation.

For information about making association changes after you have deployed a cloud template,
see What happens if | remove an NSX cloud account association in vRealize Automation.

7 If you want to add tags to support a tagging strategy, enter capability tags.

You can add tags now, or later when you edit the cloud account. For information about
tagging, see How do | use tags to manage Cloud Assembly resources and deployments.

For more information about how capability tags and constraint tags help control
deployment placements, see the Constraint Tags and Placement video tutorial.

8 Click Save.

Results

The cloud account is added and the selected data centers are available for the specified cloud
zone. Collected data such as machines, networks, storage, and volumes is listed in the Resources
section of the Infrastructure tab.

What to do next

Configure remaining infrastructure resources for this cloud account. See Chapter 4 Building your
Cloud Assembly resource infrastructure.

Create an NSX-V cloud account in vRealize Automation

For network and security purposes, you can create and associate an NSX-V cloud account with a
vCenter cloud account.

An NSX-V cloud account can only be associated to one vCenter cloud account.

The association between NSX-V and a vCenter cloud account must be configured outside of
VRealize Automation, specifically in your NSX application. vRealize Automation doesn't create the
association between NSX and vCenter. In vRealize Automation, you specify an association that
already exists in NSX.

Prerequisites

m  Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have a vCenter cloud account to use with this NSX cloud account. See Create a
vCenter cloud account in vRealize Automation.
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m  Verify that you have properly configured your ports and protocols to support the cloud
account. See the Ports and Protocols for vRealize Automation topic in /nstalling vRealize
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the NSX-V account type and enter the NSX-V host IP address.
3 Enter your NSX administrator credentials and click Validate.
The assets associated with the account are collected.
If the NSX host IP address is not available, validation fails.

4 If available, select the vCenter endpoint that represents the vCenter cloud account that you are
associating with this NSX-V account.

Only vCenter cloud accounts that are not currently associated to an NSX-T or NSX-V cloud
account are available for selection.

For information about making association changes after you have deployed a cloud template,
see What happens if | remove an NSX cloud account association in vRealize Automation.

5 If you want to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do | use tags to manage Cloud
Assembly resources and deployments.

For information about how capability tags and constraint tags help control deployment
placements, see the Constraint Tags and Placement video tutorial.

6 Click Save.

What to do next

You can create or edit a vCenter cloud account to associate with this NSX cloud account. See
Create a vCenter cloud account in vRealize Automation.

Create and configure one or more cloud zones for use with the data centers that are used by this
cloud account. See Learn more about Cloud Assembly cloud zones.

Configure infrastructure resources for this cloud account. See Chapter 4 Building your Cloud
Assembly resource infrastructure.

Create an NSX-T cloud account in vRealize Automation

For network and security purposes, you can create an NSX-T cloud account and associate it with
one or more vCenter cloud accounts.

An NSX-T cloud account can be associated to one or more vCenter cloud accounts. However, an
NSX-V cloud account can only be associated to one vCenter cloud account.
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The association between NSX-T and one or more vCenter cloud accounts must be configured
outside of vRealize Automation, specifically in your NSX application. vRealize Automation doesn't
create the association between NSX and vCenter. In vRealize Automation, you specify one or more
configuration associations that already exists in NSX.

When you create an NSX-T cloud account in vRealize Automation, you specify a manager type and
an NSX mode. These selections cannot be changed after you create the cloud account.

You can connect to an NSX-T Global Manager and configure an association between an NSX-T
Global Manager and local managers in the context of the NSX-T federation.

For related information about NSX-T options and capabilities in general, see NSX-T Data Center
product documentation.

To facilitate fault tolerance and high availability in deployments, each NSX-T data center endpoint
represents a cluster of three NSX Managers.

m  VRealize Automation can point to one of the NSX Managers. Using this option, one NSX
Manager receives the API calls from vRealize Automation.

m  VRealize Automation can point to the Virtual IP of the cluster. Using this option, one NSX
Manager assumes control of the VIP. That NSX Manager receives the API calls from vRealize
Automation. In case of failure, another node in the cluster assumes control of the VIP and
receives the API calls from vRealize Automation.

For more information about VIP configuration for NSX, see Configure a Virtual IP (VIP)
Address for a Clusterin the NSX-T Data Center Installation Guide at VMware NSX-T Data
Center Documentation.

m  VvRealize Automation can point to a load balancer VIP to load-balance the calls to the three
NSX Managers. Using this option, all three NSX Managers receive API calls from vRealize
Automation.

You can configure the VIP on a third-party load balancer or on an NSX-T load balancer.

For large scale environments, consider using this option to split the vRealize Automation API
calls among the three NSX Managers.

For a detailed look at using NSX-T 3.2 with vRealize Automation, see VMware blog post VMware
Network Automation with NSX-T 3.2 and vRealize Automation.

Prerequisites

m  Verify that you have the required administrator credentials and have enabled HTTPS access on
port 443. See Credentials required for working with cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have a vCenter cloud account to use with this NSX cloud account. See Create a
vCenter cloud account in vRealize Automation.
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m  Verify that you have properly configured your ports and protocols to support the cloud
account. See the Ports and Protocols for vRealize Automation topic in /nstalling vRealize
Automation with vRealize Easy Installer and the Port Requirements topic in vRealize
Automation Reference Architecture Guide in the vRealize Automation product documentation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the NSX-T account type and specify a cloud account name and description.

3 Enter the host IP address for the NSX-T Manager instance or VIP (see above for information
about the expected behavior that pertains to the NSX Manager and VIP options).

4 Enter your NSX user name and password administrator credentials.
5 For Manager type, select either Global or Local (default).
m  Global Manager

The Global Manager setting is only available for use with the Policy NSX mode setting. It is
not available when using the Manager NSX mode setting.

The Global setting refers to the NSX-T federation capabilities, including global network
segments. Only NSX-T cloud accounts with the Global setting support NSX-T federation.

When using the Global Manager setting, you are prompted to identify a Local Manager
NSX-T cloud account and an associated vCenter Server cloud account.

You cannot associate a Global Manger NSX-T cloud account with vCenter cloud account,
as you can with an Local Manager NSX-T cloud account. Similar to how a Local Manager
NSX-T cloud account can be associated to multiple vCenter cloud accounts, a Global
Manager NSX-T cloud account can be associated to multiple Local Manager NSX-T cloud
accounts.

m  Local Manager

Use the Local setting to define a traditional NSX-T cloud account, which can be associated
to one or more vSphere cloud accounts. You can associate a Global manager NSX-T cloud
account with a Local NSX-T cloud accounts. Note that this is also the setting to use if you
are creating a new and empty target NSX-T cloud account for the purposes of NSX-V to
NSX-T migration.

You cannot change the Manager type setting after you create the cloud account.
6 For NSX mode, select either Policy or Manager.
m  Policy mode (default)

The Policy mode is available for NSX-T 3.0 and NSX-T 3.1 forward. This option enables
VRealize Automation to use the additional capabilities available in the NSX-T Policy API.

If you are using NSX-T with a VMware Cloud on AWS cloud account in a cloud template,
the NSX-T cloud account must use the Policy NSX mode.
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The Policy setting refers to the NSX-T Policy API form of NSX-T.
= Manager mode

Existing NSX-T endpoints or cloud accounts that are upgraded from an earlier version of
VRealize Automation that did not provide a Policy option are treated as Manager mode
NSX-T cloud accounts.

The Manager mode is supported for NSX-T 2.4, NSX-T 3.0, and NSX-T 3.1 forward.

If you specify Manager mode, use the Manager mode option for other NSX-T cloud
accounts until vRealize Automation introduces a Manager mode to Policy mode migration
path.

Some vRealize Automation options for NSX-T require NSX-T 3.0 or greater, including
adding tags to virtual machine NIC components in the cloud template.

The Manager setting refers to the NSX-T Manager API form of NSX-T.

If you have existing NSX-T cloud accounts that were created prior to the introduction

of the Policy mode in vRealize Automation 8.2, they use the Manager API method. It is
recommended that you wait until the Manager API to Policy APl migration tool is made
available in vRealize Automation. If you prefer not to wait, you should replace your existing
NSX-T cloud accounts with new NSX-T cloud accounts that specify the Policy APl method.

You cannot change the NSX mode value after you create the cloud account.

7 Click Validate to confirm the credentials in relation to the selected NSX Manager type and NSX
mode.

The assets associated with the account are collected.
If the NSX host IP address is not available, validation fails.

8 In Associations, add one or more vCenter cloud accounts to associate with this NSX-T cloud
account. You can also remove existing vCenter cloud account associations.

Only vCenter cloud accounts that are not currently associated in vRealize Automation to an
NSX-T or NSX-V cloud account are available for selection.

See What can | do with NSX-T mapping to multiple vCenters in vRealize Automation.

For information about making association changes after you have deployed a cloud template,
or about deleting the cloud account after you have deployed a cloud template, see What
happens if | remove an NSX cloud account association in vRealize Automation.

9 If you want to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do | use tags to manage Cloud
Assembly resources and deployments.

For more information about how capability tags and constraint tags help control
deployment placements, see the Constraint Tags and Placement video tutorial.
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10 Click Save.

What to do next

You can create or edit a vCenter cloud account to associate with this NSX cloud account. See
Create a vCenter cloud account in vRealize Automation.

Create and configure one or more cloud zones for use with the data centers that are used by this

cloud account. See Learn more about Cloud Assembly cloud zones.

Configure infrastructure resources for this cloud account. See Chapter 4 Building your Cloud
Assembly resource infrastructure.

For samples of using NSX-T options in vRealize Automation cloud templates, see Networks,

security resources, and load balancers in vRealize Automation .

Create a VMware Cloud on AWS cloud account in vRealize
Automation

As a cloud administrator, you can create a VMware Cloud on AWS cloud account for account
regions to which your team will deploy vRealize Automation cloud templates.

VMware Cloud on AWS requires some unique configuration procedures in vRealize Automation.

To properly configure vRealize Automation for VMware Cloud on AWS, including setting an API
token values for the cloud account and setting gateway firewall rules for its cloud proxy, see the
Tutorial: Configuring VMware Cloud on AWS for vRealize Automation workflow.

Prerequisites

m  Verify that you have the required VMware Cloud on AWS administrator credentials, including

VMware Cloud on AWS CloudAdmin credentials for the target SDDC in vCenter and that you

have enabled HTTPS access on port 443. See Credentials required for working with cloud
accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation

user roles.

m |f you do not have external Internet access, configure an Internet server proxy. See How do |

configure an Internet proxy server for vRealize Automation.

m  Verify that you have configured needed access and firewall rules in the SDDC. See Prepare

your VMware Cloud on AWS SDDC to connect with VMware Cloud on AWS cloud accounts in

vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Cloud Accounts, click Add Cloud Account and select

the VMware Cloud on AWS account type.
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8

Add the VMC API token for your organization to access the available SDDCs.

You can create a new token or use an existing token for your organization on the linked API
Tokens page. For details, see Create a VMware Cloud on AWS cloud account in vRealize
Automation within a sample workflow.

Select the SDDC to be available for deployments.
NSX-V SDDCs are not supported and do not appear in the list.

The vCenter and NSX-T Manager IP address/FQDN values are automatically populated based
on the SDDC.

Enter your vCenter user name and password for the specified SDDC if other than the default
value of cloudadmin@vmc.local.

Click Validate to confirm your access rights to the specified vCenter and check that the
vCenter is running.

The data centers associated with the account are collected.
For efficiency, create a cloud zone for provisioning to the selected SDDC.

You can also create cloud zones as a separate step according to your organization's cloud
strategy.

If you want to add tags to support a tagging strategy, enter capability tags.

You can add or remove capability tags later. See How do | use tags to manage Cloud
Assembly resources and deployments.

For more information about how capability tags and constraint tags help control
deployment placements, see the Constraint Tags and Placement video tutorial.

As with VMs deployed to vSphere, you can configure machine tags for a VM to be deployed
on VMware Cloud on AWS. You can also update the machine tag after initial deployment.
These machine tags allow vRealize Automation to dynamically assign a VM to an appropriate
NSX-T security group during deployment. For related information, see More about security
group and tag resources in vRealize Automation cloud templates.

Click Save.

Results

The cloud account is added and the selected SDDC is available for the specified cloud zone.

What to do next

To properly configure vRealize Automation for VMware Cloud on AWS, see Tutorial: Configuring
VMware Cloud on AWS for vRealize Automation.

For related information about VMware Cloud on AWS outside of vRealize Automation, see
VMware Cloud on AWS documentation.
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Create a VMware Cloud Foundation cloud account

You can configure a VMware Cloud Foundation (VCF) as a cloud account within Cloud Assembly
to use workload domains.

A VCF cloud account enables you to incorporate a VCF workload into Cloud Assembly to

facilitate a comprehensive hybrid cloud management solution. Cloud Assembly offers several entry
points from which you can activate the VCF cloud account configuration page. If you access this
page using the Add Cloud Account button on the SDDC integration Workload Domain tab, the
workload is pre-selected, including the basic information for the vCenter and NSX manager.

Prerequisites

You must have an instance of VMware SDDC Manager 4.1 or higher configured as a Cloud
Assembly integration for use with this cloud account. For more information, see Configure a
VMware SDDC Manager integration.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the VCF Cloud Account type, and enter a Name and Description.

3 Enter the FQDN and credentials for the SDDC manager instance that you are using with this
cloud account.

You can skip this step if you have already configured the SDDC manager instance that you will
use with this account.

4 Select one or more workload domains that you want to use with this VCF cloud account.

5 If you want to have Cloud Assembly use Cloud Foundation managed service credentials
for vCenter and NSX, select Automatically create service credentials. Later, if you want to
change these credentials, you must use the VCF mechanism for password management.

If you select this option, you can skip steps 7 and 8.
6 Enter the credentials required to access the vCenter associated with this cloud account.

7 Under the NSX Manager heading, enter NSX credentials if you want to manually enter
credentials for the VCF cloud account, or click Create and Validate Service Credentials if you
want Cloud Assembly to create and validate NSX credentials.

8 Enter the credentials required to access the NSX-T network associated with this cloud account.
9 If applicable, select the NSX mode.
10 Click Validate to confirm a connection to the SDDC manager.

11 If applicable, select the data centers that you want to provision to under the Configuration
heading. Click the check box if you want to create a cloud zone for the selected data centers.

12 If you use tags to support a tagging strategy, enter capability tags. See How do | use tags to
manage Cloud Assembly resources and deployments and Creating a tagging strategy.
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13 Click Save.

Results

This cloud account brings the selected workload domain associated with the specified SDDC
manager into Cloud Assembly for use.

If you want to manage additional workload domains using vRealize Automation, you must repeat
this processs for each domain.
What to do next

After you configure the VCF cloud account, you can select the account on the main cloud account
page and click Setup Cloud to initiate the VMware Cloud Foundation Quickstart wizard that will
configure your cloud.

For more information about the Quick Start wizard, see How do | get started with vRealize
Automation using the VMware Cloud Foundation Quickstart in Getting Started.

Create a VMware Cloud Director cloud account in vRealize
Automation

You can create a VMware Cloud Director cloud account in vRealize Automation to deploy

Cloud Director virtual machines using cloud agnostic objects. Cloud Director supports flexible
provisioning of network, storage and compute resources, and provides a portal-based experience
to manage vCenters and their NSX-T and NSX-V network appliances and associated virtual data
centers via a catalog.

The VMware Cloud Director cloud account supports creation of standalone Cloud Director virtual
machines with no vApp. Three scenarios for provisioning Cloud Director virtual machines by using
Cloud Assembly cloud templates are supported:

= Virtual machines
m  Virtual machines attached networks
= Virtual machines with additional disk/s

For more information about working with VMware Cloud Director, including information about
setting up multiple servers for high availability, see the official documentation at https://
docs.vmware.com/en/VMware-Cloud-Director/index.html.

The VMware Cloud Director cloud account supports up to 1000 virtual machines with vRealize
Automation in sustain mode.

The following procedure describes how to set up a VMware Cloud Director cloud account within
VRealize Automation Cloud Assembly.

Prerequisites

m  Set up a VMware Cloud Director 10.2.0, 10.2.1, 10.2.2 ,10.3 or 10.3.1 deployment with one or
more appropriate organizations.
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m  Users specified for this integration must have Organization Administrator privileges to read
applicable templates and to create virtual machines as well as to view other resources such
as compute policies, disks, virtual data centers, etc. The VCD cloud account for vRealize
Automation works within a tenant context in Cloud Director, so you connect to an individual
organization in Cloud Director with your tenant credentials. For more information about
required credentials, see Credentials required for working with cloud accounts in vRealize
Automation.

m  You must configure the appropriate storage, network, image, and flavors, or sizing policy,

within your VMware Cloud Director instance and map these objects into vRealize Automation

Cloud Assembly either before or after you configure your integration. The following list

explains how VMware Cloud Director virtual objects should be mapped to vRealize Automation

objects in Cloud Assembly.

m  VMware Cloud Director organization networks (isolated, direct, routed) - map to vRealize

Automation networks. No static IP pool can be set for the network adapter.

= VMware Cloud Director virtual machine sizing policies - map to vRealize Automation
flavors.

m  VMware Cloud Director storage policies - map to vRealize Automation storage profiles.

= VMware Cloud Director images (OVF, ISO boot media) - map to vRealize Automation
images. Images can be vApp template or media such as ISO files. If you use ISO then an
"empty" virtual machine is created and media is attached as boot media.

= VMware Cloud Director virtual machines - map to vRealize Automation computes.

m  VMware Cloud Director virtual machines disks - map to vRealize Automation cloud
volumes.

You map these VMware Cloud Director objects to vRealize Automation objects using the
options under the Infrastructure > Configure > pages in Cloud Assembly. See the relevant
topics under Chapter 4 Building your Cloud Assembly resource infrastructure for detailed
information about mapping objects in vRealize Automation.

Procedure
1 Select Infrastructure > Connections > Cloud Accounts and click Add Cloud Account.
2 Select the VMware Cloud Director cloud account type, and enter a Name and Description.

3 Enter the appropriate account information required to access the VMware Cloud Director
server.

4 Enter the base URL to use to connect with the VMware Cloud Director server.

5 Enter an appropriate Username and Password for a valid account that can access the
specified Cloud Director instance.
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6 Enter the desired Organization name to use with this integration.

In vCloud Director, an organization contains users, the vApps that they create, and the
resources the vApps use.

7 Click Validate.

During validation, you might be asked to accept a certificate. When the connection is
validated, you can select additional settings.

8 If you use tags to support a tagging strategy, enter capability tags. See How do | use tags to
manage Cloud Assembly resources and deployments and Creating a tagging strategy.

9 After you validate, the page displays a list of Cloud Director virtual data centers from which
you can select. Select the appropriate data center. This selection determines the Director
regions to which you can deploy.

10 Click Add to add the VMware Cloud Director cloud account to vRealize Automation.

Results

The VMware Cloud Director cloud account is available for configuration in vRealize Automation.
The networks associated with the Cloud Director instance are available for configuration on the
Cloud Assembly Resources > Networks page. You can set up the appropriate storage profiles and
then use the cloud account to create deployments in cloud templates. In addition, ensure that an
appropriate project is configured in Cloud Assembly for use with the Cloud Director instance.

What to do next
The VMware Cloud Director cloud account is ready for use in Cloud Assembly cloud templates.

The following is an example cloud template for a basic VMware Cloud Director deployment.

formatVersion: 1
inputs: {}
resources:
Cloud Network 1:
type: Cloud.Network
properties:
networkType: existing
constraints:
- tag: netl:isolated
Cloud Volume 1:
type: Cloud.Volume
properties:
capacityGb: 2
Cloud Machine 1:
type: Cloud.Machine
properties:
image: imagel
flavor: small
storage:
constraints:
- tag: storage:development
attachedDisks:

VMware, Inc. 223



Using and Managing vRealize Automation Cloud Assembly

- source: '${resource.Cloud_Volume_l.id}'
networks:
- network: '${resource.Cloud_Network_l.id}'

The following day 2 actions are supported on deployed VMware Cloud Director virtual machines:
= Poweron

s Power off

m  Suspend

m  Create snapshot

m  Revert to snapshot

m Remove shapshot

= Add disk

m  Remove disk

m  Resize disk (note: only increasing disk size is supported)
m  Resize boot disk

After a blueprint is deployed, users can apply tags on newly provisioned machines in vRealize
Automation. These vRealize Automation tags are mapped to VMware Cloud Director metadata
which can be retrieved using the VMware Cloud Director API. Users can also tag other vRealize
Automation resources, but only machines on the VMware Cloud Director side are updated as it's
the only supported type of resource of this feature.

After a blueprint is deployed, users can resize a virtual machine's boot disk. Also regular disks
are supported; in this case, customers only need to attach a disk resource to a machine resource.
When everything is deployed, you can use the option to "update boot disk" or "update disk" to
increase, but not decrease, the size of the desired disk.

After a blueprint is deployed, users can change a virtual machine sizing policy using the resize
option using the vRealize Automation flavor configuration Resize option. Once selected, the
VMware Cloud Director virtual machine will use the provided sizing policy.

This feature requires that the Default Rights Bundle assigned to the Organization

Administrator role contains the "Change compute policies" right, for which internal code

is VAPP_EDIT VM COMPUTE POLICY. Then, this right must be activated for the Organization
Administrator. Otherwise, the resize operation will fail with an error 403: Either you need some
or all of the following rights [VAPP EDIT VM COMPUTE POLICY] to perform operations

You can resize the boot disk of a VMware Cloud Director virtual machine as a day 2 operation,
by selecting the virtual machine on the Deployments page. However, you must disable Fast
provisioning before attempting to resize the boot disk or the following error may occur:

Request timed out after 120 minutes. Please configure project request timeout

parameter for long running resource requests.
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Note that this requirement applies only to virtual machines created from vApp Template disks. It
does not apply to virtual machines created from ISO files.

The following procedure describes how to disable fast provisioning.

1 Log into VMware Cloud Director as a system administrator: https://ved url/provider

with the system user
2 Click on Organization VDCs.
3 Select the target organization.
4 Click on Storage (under Policies).
5 Disable Fast Provisioning.
Using logs and other resources to troubleshoot VMware Cloud Director cloud
accounts in vRealize Automation
If you encounter issues when configuring or using a VMware Cloud Director cloud account in
VRealize Automation you can consult logs and other resources as described below.
Troubleshooting VMware Cloud Director cloud account connection issues

If the VMware Cloud Director adapter is not listed on the cloud account creation screen or is not
responding, you can use the following command to verify the status by logging in to the vRealize
Automation kubernetes host and checking the adapter pod status:

root@host [ ~ ]# kubectl -n prelude get pods | grep adapter-host-service-app
adapter-host-service-app-65£5c945bb-p6hpn 1/1 Running 0 4d1lh

If the VMware Cloud Director adapter cannot communicate with the Cloud Director physical
machine, an error is displayed in the cloud account screen with statements about connection and
processing exceptions. The error also appears in the logs.

Working with VMware Cloud Director logs

The VMware Cloud Director adapter main log file resides under the local (pod) dir /var/log/
adapter-host-service-app.log and in the case of the adapter running inside the vRealize
Automation appliance host, this log is also copied to /services-logs/prelude/adapter-host-
service-app/file-logs/. By default most of the logging is restricted to DEBUG or INFO levels.
You can alter the configuration for the following loggers to enable more verbose logging for
debugging purposes:

m  org.apache.cxf.services=INFO - this logger provides verbose info for communication
between the adapter and VMware Cloud Director.

m  com.vmware.vra.vcloud.director.adapter=TRACE - this logger provides verbose info for
communication between the adapter and vRealize Automation.
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There are three ways you can access the logs:

m access log by login to the adapter pod
root@host [ ~ ]# kubectl -n prelude exec -ti adapter-host-service-app-65f£5c945bb-pbhpn --

bash
root [ / ]# less /var/log/adapter-host-service-app.log

m  access log using kubectl

root@host [ ~ ]# kubectl -n prelude get logs adapter-host-service-app-65f5c945bb-p6hpn

m  access log using the adapter kubernetes host local copy

root@host [ ~ 1# 1less /services-logs/prelude/adapter-host-service-app/file-logs/adapter—

host-service-app.log
You can query or change the loggers configuration via /actuator/loggers REST API endpoint.
m  Example of enabling VMware Cloud Director client communication tracing via curl :

curl -i -X POST -H 'Content-Type: application/json' -d '{"configuredLevel”: "INFO"}'
http://{adapter-url}/actuator/loggers/org.apache.cxf.services

m  Example of disabling VMware Cloud Director client communication tracing via curl :

curl -i -X POST -H 'Content-Type: application/json' -d '{"configuredLevel": "OFF"}'

http://{adapter-url}/actuator/loggers/org.apache.cxf.services

m  Example of obtaining current configuration for VMware Cloud Director client communication
via curl :

curl http://{adapter-url}/actuator/loggers/org.apache.cxf.services
{"configuredLevel":"OFF", "effectivelLevel":"INFO"}

There are other parameters that can be adjusted to alter performance of VMware Cloud Director.

m  vcd.max.thread.count - this parameter determines the maximum degree of parallelism when
performing VMware Cloud Director API calls. The default is 128.

Note Decreasing the value for this parameter will reduce the stress on the VMware
Cloud Director backend when performing enumeration but may decrease the enumeration
performance.

m  VCD ADAPTER PAGINATION SIZE IMAGES - this parameter determines the page size when
performing image enumeration. The default is 50.

Note Decrease this parameter if adapter timeout errors occur during image enumeration.
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Integrating vRealize Automation with other applications

Integrations enable you to add external systems to vRealize Automation.

Integrations include vRealize Orchestrator, configuration management and other external systems
such as GitHub, Ansible, Puppet, and external IPAM providers such as Infoblox.

Note If you do not have external Internet access and your integration requires it, you can
configure an Internet server proxy. See How do | configure an Internet proxy server for vRealize
Automation.

How do | use Git integration in Cloud Assembly

Cloud Assembly supports integration with various flavors of Git repositories so that you can
manage VMware cloud templates and action scripts under source control. This functionality
facilitates auditing and accountability of processes around deployment.

Cloud Assembly supports different flavors of Git integration as described in the following list. Each
of these options is a separate integration.

m  GitHub cloud, GitHub Enterprise on-premises
m  GitLab cloud GitLab Enterprise on-premises
m  BitBucket on-premises

You must have an appropriate local Git repository configured with access for all designated users
in order to set up Git integration with Cloud Assembly. Also, you must save your cloud templates
in a specific structure in order for them to be detected by Git. To create an integration with GitLab
or GitHub, select Infrastructure > Connections > Integrations in Cloud Assembly and then make
the appropriate selection. You will need the url and token for the target repository.

When Git integration is configured with an existing repository, all cloud templates associated
with selected projects become available to qualified users. You can use these templates with an
existing deployment or as the basis of a new deployment. When you add a project, you must
select some properties regarding where and how it is stored in Git.

You can save actions to a Git repository directly from Cloud Assembly. You can version action
scripts either directly to Git, or you can create versions in Cloud Assembly. If you create a version
of an action in Cloud Assembly, then it is automatically saved to Git as a version. Cloud templates
are a bit more complicated, because you cannot directly add them to a Git integration from Cloud
Assembly. You must save them directly to a Git instance, and then you can retrieve them from Git
when working with the cloud template management page in Cloud Assembly.
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Before you Begin

You must create and save your cloud templates in a specific structure in order for them to be
detected by GitLab or GitHub.

m  Configure and store cloud templates to be integrated with GitLab correctly. Only valid
templates are imported into GitLab.

m  Create one or more designated folders for the cloud templates.
m  All cloud templates must be stored within blueprint.yaml files.
m  Ensure that the top of your templates include the name: and version: properties.

m  Extract an API key for the applicable repository. In your Git account, select your login in the
upper right corner, and navigate to the Settings menu. Select Access Tokens, then name your
token, set an expiration date. Then, select APl and create the token. Copy the resulting value
and save it.

The following guidelines must be observed for all cloud templates used with Git integration.
m  Each cloud template must reside in a separate folder.

m  All cloud templates must be named blueprint.yaml.

m  All cloud template YAML files must use name and version fields.

m  Only valid cloud templates are imported.

m |f you update a draft cloud template imported from Git, and its content differs from that in the
top version, the draft will not be updated in subsequent syncs and a new version is created. If
you want to update a template and also allow further sync's from Git, then you must create a
new version after final changes.

m  Configure GitLab cloud template integration in Cloud Assembly

This procedure demonstrates configuring GitLab integration in Cloud Assembly so that you
can work with cloud templates in the repository and automatically download saved templates
that are associated with designated projects. To use cloud templates with GitLab, you must
create a connection to an appropriate GitLab instance, and then save the desired templates
to that instance.

m  Configure GitHub integration in Cloud Assembly

You can integrate the GitHub cloud-based repository hosting service in Cloud Assembly

m  Configure Bitbucket integration in Cloud Assembly

Cloud Assembly supports integration with Bitbucket for use as a Git-based repository for ABX
action scripts and VMware cloud templates.
Configure GitLab cloud template integration in Cloud Assembly

This procedure demonstrates configuring GitLab integration in Cloud Assembly so that you can
work with cloud templates in the repository and automatically download saved templates that
are associated with designated projects. To use cloud templates with GitLab, you must create
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a connection to an appropriate GitLab instance, and then save the desired templates to that
instance.

When GitLab integration is configured with an existing repository, all cloud templates associated
with selected projects become available to qualified users. You can use these templates with an
existing deployment or as the basis of a new deployment. When you add a project, you must
select some properties regarding where and how it is stored in GitLab.

Note You cannot push new or updated cloud templates to the Git repository from Cloud
Assembly. Also, you cannot push new templates to the repository from Cloud Assembly. To add
cloud templates to a repository, developers must use the Git interface.

If you update a draft cloud template imported from Git, and its content differs from that in the top
version, the draft will not be updated in subsequent syncs and a new version is created. If you
want to update a cloud template and also allow further sync's from Git, then you must create a
new version after final changes.

After you set up your cloud templates for use with GitLab and collect required information,
you must set up integration with your GitLab instance. Then, you can import the designated
cloud templates into GitLab. You can view a video demonstration of this procedure at https://
www.youtube.com/watch?v=hOvqo63Sdgg.

Prerequisites

m  Extract an API key for the applicable repository. In your GitLab account, select your login in
the upper right corner, and navigate to the Settings menu. Select Access Tokens, then name
your token, set an expiration date. Then, select APl and create the token. Copy the resulting
value and save it.

You must have an appropriate local Git repository configured with access for all designated users
in order to set up Git integration with Cloud Assembly. Also, you must create and save your cloud
templates in a specific structure in order for them to be detected by GitLab.

m  Configure and store cloud templates to be integrated with GitLab correctly. Only valid
templates are imported into GitLab. See How do | use Git integration in Cloud Assembly.

Procedure
1 Set up integration with your GitLab environment in Cloud Assembly.
a Select Infrastructure > Integrations > Add New and choose GitLab.

b Enter the URL for your GitLab instance. For a software as a service GitLab instance, in
most cases, it will be gitlab.com.

c Enter the Token, also known as an API key, for the specified GitLab instance. See the
prerequisites above for information about extracting the token from your GitLab instance.

d Add an appropriate Name and Description.

e Click Validate to verify the connection.
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f  Add capability tags if desired. See Using capability tags in Cloud Assembly for more
information.

g Click Add.

2 Configure the GitLab connection to accept cloud templates in an appropriate repository.
a Select Infrastructure > Integrations and choose the appropriate GitLab integration.
b Select Projects.
c Select New Project and create a name for the project.

d Enter the Repository path within GitLab. Typically, this is the user name of the main
account appended to the repository name.

e Enter the appropriate GitLab Branch that you want to use.
f If applicable, enter a Folder name. If left blank, all folders are available.

g Enter an appropriate Type. If applicable, enter a folder name. If left blank, all folders are
available.

h  Click Next to finish adding the repository.

When you click Next, an automated synchronization task is initiated that imports cloud
templates into the platform.

When the synchronization tasks are complete, a message indicates that the cloud
templates have been imported.

Results

You can now retrieve cloud templates from GitLab.

Configure GitHub integration in Cloud Assembly
You can integrate the GitHub cloud-based repository hosting service in Cloud Assembly

You need a valid GitHub token to configure GitHub integration in Cloud Assembly See the GitHub
documentation for information about creating and locating your token.

Prerequisites
= You must have access to GitHub.

m  Configure and store cloud templates to be integrated with GitHub correctly. Only valid cloud
templates are imported into GitHub. See How do | use Git integration in Cloud Assembly.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Select GitHub.

3 Enter the required information on the GitHub configuration page.

4

Click Validate to check the integration.
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5 If you need to add tags to support a tagging strategy, enter capability tags. See How do | use
tags to manage Cloud Assembly resources and deployments and Creating a tagging strategy.

6 Click Add.

7 Configure the GitHub connection to accept cloud templates in an appropriate repository.
a Select Infrastructure > Integrations and choose the appropriate GitHub integration.
b Select Projects.
c Select New Project and create a name for the project.

d Enter the Repository path within GitHub. Typically, this is the user name of the main
account appended to the repository name.

e Enter the appropriate GitHub Branch that you want to use.

f If applicable, enter a Folder name. If left blank, all folders are available.
g Enter an appropriate Type.

h  Click Next to finish adding the repository.

An automated synchronization task is initiated that imports cloud templates into the
platform.

When the synchronization tasks are complete, a message indicates that the cloud
templates have been imported.

Results

GitHub is available for use in Cloud Assembly blueprints.

What to do next

You can now retrieve cloud templates from GitHub.

Configure Bitbucket integration in Cloud Assembly

Cloud Assembly supports integration with Bitbucket for use as a Git-based repository for ABX
action scripts and VMware cloud templates.

In Cloud Assembly, you can work with two types of repository items using Bitbucket integration:
VMware cloud templates or ABX action scripts. You must synch projects that you want to work
with before using a Bitbucket integration. ABX actions support write back to the Bitbucket
repository, but you cannot write back cloud templates from the integration. If you want to create
new versions of cloud template files, you must do so manually.

Prerequisites

m  Set up an on premises Bitbucket Server deployment with one or more ABX or cloud template-
based projects that you want to use with your deployments. Bitbucket Cloud is currently not
supported.

m  Create or designate Cloud Assembly project to associate your Bitbucket integration.
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m  Cloud template files to be synched to a Bitbucket integration must be named
blueprint.yaml.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select Bitbucket.

3 Enter the Summary information and Bitbucket credentials on the Bitbucket new integration
Summary page.

4 To check the integration, click Validate.

5 If you use add tags to support a tagging strategy, enter capability tags. See How do | use tags
to manage Cloud Assembly resources and deployments and Creating a tagging strategy.

6 Click Add.

7 Select the Projects tab on the main page for the Bitbucket integration to associate a project
with this Bitbucket integration.

8 Select the Project to associate with this Bitbucket integration.

9 Click Next to add a Repository to Bitbucket project and indicate the type of repository you are
adding and then specify the Repository name and Branch, as well as the Folder.

10 Click Add.

If you want to add one or more repositories to a project, click Add Repository.

Results

Bitbucket integration is configured with the specified repository configuration, and you can view
and work with ABX actions and cloud templates contained in configured repositories. When you
add a project to a Bitbucket integration, a synch operation runs to pull the latest versions of ABX
action scripts and cloud template files from the designated repository. The History tab on the
Bitbucket integration page shows records of all synch operations for the integration. By default,
files are automatically synched every 15 minutes,but you can manually synch a file by selecting it
and clicking SYNCH at any time.

What to do next

You can work with ABX actions on the Cloud Assembly Extensibility page, and you can work
with cloud templates on the Design page. If you save a changed version of an ABX action on the
Extensibility area of Cloud Assembly, the new version of the script is created and written back to
the repository.

How to configure an external IPAM integration in vRealize
Automation

You can create a provider-specific external IPAM integration point to manage the IP addresses
used in your cloud template deployments. When using an external IPAM integration point, IP
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addresses are obtained from and managed by the designated IPAM provider rather than from
vRealize Automation.

You can create a provider-specific IPAM integration point to manage IP addresses and DNS
settings for cloud template deployments and VMs in vRealize Automation.

For information about how to configure the prerequisites, and an example of how to create a
provider-specific external IPAM integration point within the context of a sample workflow, see Add
an external IPAM integration for Infoblox in vRealize Automation . Note that this workflow is for an
Infoblox IPAM integration but can be used as reference for any external IPAM vendor.

For information about how to create the needed assets to enable external IPAM partners and
vendors to integrate their IPAM solution with vRealize Automation, see How do | use the IPAM
SDK to create a provider-specific external IPAM integration package for vRealize Automation.

Prerequisites

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have an account with the external IPAM provider, for example Infoblox or
Bluecat, and that you have the correct access credentials to your organization's account with
the IPAM provider.

m  Verify that you have access to a deployed integration package for the IPAM provider, such as
Infoblox or BlueCat. The deployed package is initially obtained as a .zip download from your
IPAM provider or the VMware Marketplace and then deployed to vRealize Automation.

m  Verify that you have access to a configured running environment for the IPAM provider.

m |f you are using an actions-based extensibility (ABX) On-Prem Embedded running
environment, verify that you have an HTTP proxy server in the vRealize Automation
network that is able to pass outgoing traffic to external sites such as gcr.io and
storage.googleapis.com. For details, see Pulling Docker images behind proxy in vRealize
Automation 8.x (75180).

m  Verify that you have the required user credentials to access and use the IPAM vendor product.
See your integration vendor's product documentation for information about required user
permissions.

Procedure
1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Click IPAM.

VMware, Inc. 233


https://www.infoblox.com
https://www.bluecatnetworks.com
https://marketplace.cloud.vmware.com/
http://kb.vmware.com/s/article/75180
http://kb.vmware.com/s/article/75180

Using and Managing vRealize Automation Cloud Assembly

3 Inthe Provider drop-down, select a configured IPAM provider package from the list.

If the list is empty, click Import Provider Package, navigate to an existing provider
package .zip file, and select it. If you do not have the .zip file, you can obtain it from the
VMware Marketplace.

4 Enter your administrator user name and password credentials for your account with the
external IPAM provider, along with all other (if any) mandatory fields, such as the host name of
your provider.

5 In the Running Environment drop-down list, select an existing running environment, such as
on-premises actions-based extensibility integration point.

The running environment supports communication between vRealize Automation and the
IPAM provider.

The IPAM framework only supports an actions-based extensibility (ABX) On-Prem Embedded
running environment.

Note If you use an Amazon Web Services or Microsoft Azure cloud account as the integration
running environment, be sure that the IPAM provider appliance is accessible from the Internet
and is not behind a NAT or firewall and that it has a publicly resolvable DNS name. If the IPAM
provider is not accessible, the Amazon Web Services Lambda or Microsoft Azure Functions
cannot connect to it and the integration will fail.

6 Click Validate.

7 When prompted to trust the self-signed certificate from the external IPAM provider, click
Accept.

After you accept the self-signed certificate, the validation action can continue to completion.

8 Enter a name for this IPAM integration point and click Add to save the new IPAM integration
point.

A data collection action is imitated. Networks and |IP addresses are data-collected from the
external IPAM provider.

How to upgrade to a newer external IPAM integration package in
VvRealize Automation

You can upgrade an existing external IPAM integration point to source a more recent version of
the vendor-specific IPAM integration package.

An external IPAM provider or VMware may upgrade a source IPAM integration package for a
particular vendor. For example, the external IPAM integration package for Infoblox has been
upgraded several times. To preserve any existingvRealize Automation infrastructure settings that
use a named IPAM integration point, you can edit an IPAM integration point to source the updated
IPAM integration package, rather than create a new IPAM integration point.
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Prerequisites

This procedure assumes that you have already created an external IPAM integration point and
want to upgrade that integration point to use a more recent version of the vendor's IPAM
integration package.

For information about how to create an external IPAM integration point, see Add an external IPAM
integration for Infoblox in vRealize Automation .

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Verify that you have the cloud administrator user role. See What are the vRealize Automation
user roles.

m  Verify that you have an account with the external IPAM provider and that you have the correct
access credentials to your organization's account with that IPAM provider.

m  Verify that you have access to a deployed integration package for your IPAM provider. The
deployed package is initially obtained as a .zip download from your IPAM provider website or
from the VMware Marketplace and then deployed to vRealize Automation.

For information about how to download and deploy the provider package .zip file and make
it available as a Provider value on the IPAM Integration page, see Download and deploy an
external IPAM provider package for use in vRealize Automation.

m  Verify that you have access to a configured running environment for the IPAM provider. The
running environment is typically an actions-based extensibility (ABX) On-Prem Embedded
integration point.

For information about running environment characteristics, see Create a running environment
for an IPAM integration point in vRealize Automation.

Procedure

1 Select Infrastructure > Connections > Integrations IPAM and open the existing IPAM
integration point.

2 Click Manage Providers.
3 Navigate to and import the updated IPAM integration package.

4 Click Validate and click Save.

Configure MyVMware integration in Cloud Assembly

You can integrate MyVMware with Cloud Assembly to support VMware related actions and
capabilities associated with downloadable components that require an account.

You can create only one My VMware integration for each organization.
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Prerequisites
You must have a user account with the appropriate permissions for MyVMware.
m  For information about inviting a user to a MyVMware account, see KB 2070555.

m  For information about assigning user permissions in a My VMware account, see KB 2006977.

Procedure

—

Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select My VMware.

3 Enter the required information on the MyVMware configuration page.

4 If you require tags to support a tagging strategy, enter capability tags. See How do | use tags
to manage Cloud Assembly resources and deployments and Creating a tagging strategy.

5 Click Add.

Results

My VMware is available for use.

What to do next

Access My VMware components as needed.

Configure a vRealize Orchestrator integration in Cloud Assembly

You can configure one or more vRealize Orchestrator integrations, so that you can use workflows
as part of extensibility and cloud templates.

VRealize Automation includes a preconfigured embedded vRealize Orchestrator instance. You can
access the client of the embedded vRealize Orchestrator from the vRealize Automation Cloud
Services Console.

Note You can access the Control Center of the embedded vRealize Orchestrator by navigating to
https://your_ vRA_ FQDN/vco-controlcenter and logging in as root.

You can also integrate an external vRealize Orchestrator instance for use in your vRealize
Automation extensibility subscriptions and XaaS (Anything as a Service) operations used for cloud
templates.

Prerequisites

m  Verify that you have cloud administrator credentials. See Credentials required for working with
cloud accounts in vRealize Automation.

m  Upgrade or migrate to vRealize Orchestrator 8.3. See Upgrading and Migrating VMware
vRealize Orchestrator.
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Procedure

—

o v A W N

10

1

Select Infrastructure > Connections > Integrations.

Click Add integration.

Select vRealize Orchestrator.

Enter a name for the vRealize Orchestrator integration.

(Optional) Enter a description for the vRealize Orchestrator integration.

Under vRealize Orchestrator URL, enter the fully qualified domain name (FQDN) of your
external vRealize Orchestrator instance.

For example, https://my_vRO_ FQDN.com:443.

To validate the integration, click Validate.

(Optional) If prompted to do so, review the certificate information, and click Accept.
(Optional) Add capability tags. For more information on capability tags, see Using capability

tags in Cloud Assembly.

Note Capability tags can be used to manage multiple vRealize Orchestrator integrations. See
Managing multiple vRealize Orchestrator integrations with project constraints.

Click Add.
The vRealize Orchestrator integration is saved.

To verify that the integration is configured and that the workflows are added, select
Extensibility > Library > Workflows.

What to do next

Access the integrated external vRealize Orchestrator Client:

1
2
3

Navigate to the vRealize Automation Cloud Services Console.
Select Orchestrator.

Select the tab that corresponds to the integrated vRealize Orchestrator instance.

Note Cloud Assembly users without cloud administrator credentials cannot see the tab of the
integrated vRealize Orchestrator instance.

Disable or enable vRealize Orchestrator integrations

You can manually disable or enable your vRealize Orchestrator integration so you can perform
maintenance while the integration is still running.
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You can disable your vRealize Orchestrator integration to perform maintenance. While disabled,
your VRealize Orchestrator integration is still in a RUNNING state so you can continue to perform
tasks such as resource monitoring and data collection.

Note In addition to manual disabling, the vRealize Orchestrator Gateway service performs
periodic health status checks to verify if your vRealize Orchestrator integrations are active or
not. Any inactive vRealize Orchestrator integrations are disabled automatically and are set to the
DISCONNECTED state. You will be unable to perform tasks such as data collection or resource
monitoring on disconnected integrations.

After disabling a vRealize Orchestrator integration, or having the integration be disconnected by
the health status checker, workflows will only run on remaining integrations that are enabled.

If your environment includes multiple enabled vRealize Orchestrator integrations which are

not managed through project constraints or capability tags, a random vRealize Orchestrator
integration will be selected to run your workflow.

Note Since the vRealize Orchestrator integration is selected randomly, you must ensure that
information required to run a given operation is available on all integrations. For content entities
such as workflows, this means that they should be synchronized across all integrations. For
inventory objects there is no guarantee that they will have the same object identifier on all
integrations, so trying to run a workflow that includes such an inventory object as a input
parameter might fail.

For information on managing multiple vRealize Orchestrator integrations with project constraints
and capability tags, see Managing multiple vRealize Orchestrator integrations with project
constraints and Managing multiple vRealize Orchestrator integrations with cloud account capability
tags.

Prerequisites

Configure one or more vVRealize Orchestrator integrations in Cloud Assembly. See Configure a
VvRealize Orchestrator integration in Cloud Assembly.

Procedure
1 Disable your vRealize Orchestrator integration.
a Navigate to Infrastructure > Connections > Integrations.
b Select the vRealize Orchestrator integration you want to disable.
¢ Under vRealize Orchestrator Server Credentials, toggle off the Enable endpoint option.
d Click Validate.
e After successful validation, click Save.

2 Perform the necessary maintenance tasks on the disabled vRealize Orchestrator integration.
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3 Enable your vRealize Orchestrator integration.
a Navigate to Infrastructure > Connections > Integrations.
b Select the previously disabled vRealize Orchestrator integration.
¢ Under vRealize Orchestrator Server Credentials, toggle on the Enable endpoint option.
d Click Validate.

e After successful validation, click Save.

Managing multiple vRealize Orchestrator integrations with project constraints

You can use project constraints to manage what vRealize Orchestrator integrations are used in
workflow subscriptions.

Cloud Assembly supports the integration of multiple vRealize Orchestrator servers that can be
used in workflow subscriptions. You can manage what vRealize Orchestrator integrations are used
in cloud templates provisioned by your project with soft or hard project constraints. For more
information on project constraints, see Using Cloud Assembly project tags and custom properties .

Prerequisites

m  Verify that you have cloud administrator credentials. See What are the vRealize Automation
user roles.

m  Configure two or more vRealize Orchestrator integrations in Cloud Assembly. See Configure a
VRealize Orchestrator integration in Cloud Assembly.

m  Add capability tags to your vRealize Orchestrator integrations. See Using capability tags in
Cloud Assembly.

Procedure
1 Navigate to Infrastructure > Administration > Projects and select your project.
2 Select the Provisioning tab.

3 Enter the capability tags of your vRealize Orchestrator integrations in the Extensibility
constraints text box and set them as soft or hard project constraints.

4 Click Save.

Results

When you deploy a cloud template, Cloud Assembly uses the project constraints to manage what
vRealize Orchestrator integrations are used in workflow subscriptions.

What to do next

Alternatively, you can use capability tags to manage multiple vRealize Orchestrator integrations
on a cloud account level. For more information, see Managing multiple vRealize Orchestrator
integrations with cloud account capability tags.
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Managing multiple vRealize Orchestrator integrations with cloud account
capability tags

You can use capability tags to manage what vRealize Orchestrator integrations are used in
workflow subscriptions.

Cloud Assembly supports the integration of multiple vRealize Orchestrator servers that can be
used in workflow subscriptions. You can manage what vRealize Orchestrator integrations are used
in workflow subscriptions by adding capability tags to your cloud account.

Prerequisites

m  Verify that you have cloud administrator credentials. See What are the vRealize Automation
user roles.

m  Configure two or more vRealize Orchestrator integrations in Cloud Assembly. For more
information, see Configure a vRealize Orchestrator integration in Cloud Assembly.

m  Add capability tags to your vRealize Orchestrator integrations. See Using capability tags in
Cloud Assembly.

Procedure

1 Navigate to Infrastructure > Connections > Cloud Accounts.

2 Select your cloud account.

3 Enter the capability tags of the vRealize Orchestrator integrations you want to use.

The capability tags are automatically converted into soft constraints. To use hard constraints
in managing your integrations, you must use project constraints. For more information, see
Managing multiple vRealize Orchestrator integrations with project constraints.

4 Click Save.

Results

When you deploy a cloud template, Cloud Assembly uses the tagging in the associated cloud
account to manage what vRealize Orchestrator integrations are used in workflow subscriptions.
Data collection for vRealize Orchestrator integrations

VvRealize Automation performs periodic data collection for your vRealize Orchestrator integrations.

Data collection events for vRealize Orchestrator integrations are triggered every 10 minutes.
The data collection gathers data about the workflows included in the library of each vRealize
Orchestrator integration.

Important Verify that you version up a workflow when you are finished editing it. Changes to
non-versioned up workflows are not picked up by the data collector.

You can find information about the last data collection performed on a vRealize Orchestrator
integration by navigating Infrastructure > Connections > Integrations and selecting the specific
integration. You can also trigger a manual data collection event by clicking Start Data Collection.
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For more information on vRealize Automation data collection, see How does data collection work
in vRealize Automation.

How do | work with Kubernetes in Cloud Assembly

Cloud Assembly offers several options for configuring, managing and deploying Kubernetes virtual
workloads.

There are two options for working with Tanzu Kubernetes resources in Cloud Assembly. You can
create a vSphere with Tanzu Kubernetes configuration, which requires only a suitable vCenter
cloud account and a cluster plan to access the native vSphere Tanzu Kubernetes capabilities. With
this option, you can leverage a vCenter cloud account to access supervisor namespaces to deploy
vSphere Kubernetes-based workloads. You can also integrate external Kubernetes resources in
Cloud Assembly.

Alternatively, you can integrate VMware Tanzu Kubernetes Grid Integrated Edition (TKGI),
formerly PKS. This type of Kubernetes implementation requires a PKS integration in Cloud
Assembly. It does not require a Cloud Assembly cluster plan.

Finally, you can also create a Red Hat OpenShift integration with Cloud Assembly to configure,
manage and deploy Kubernetes resources.

Working with vSphere with Tanzu Kubernetes Clusters

vSphere 7.x contains significant enhancements that enable you to work with Kubernetes natively to
manage both virtual machines and containers from one interface. Cloud Assembly enables users
to leverage the vSphere with Tanzu Kubernetes capabilities embedded within vSphere. You can
access vSphere with Tanzu Kubernetes functionality via a vCenter cloud account with a vSphere
implementation that contains supervisor clusters. This implementation enables you to manage
both conventional virtual machines and Kubernetes clusters from vCenter.

For Tanzu Kubernetes supervisor namespaces, users must have access to an applicable vSphere
SSO so that they can log in to a provided link to the supervisor namespace details. Then, they
can download a customized Kubectl with vSphere authentication so they can use their supervisor
namespace.

To use this functionality, you must have a vCenter with vSphere cloud account that has supervisor
namespaces configured. After a users has logged in they can begin working with applicable
namespaces.

Working with VMware Tanzu Kubernetes Grid Integrated Edition (TKGI) or
Openshift Integrations

For TKGI, external clusters, or Openshift configurations, Cloud Assembly provides access to a
Kubeconfig that enables users to access applicable Kubernetes clusters.
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After you create a TKGI or OpenShift integration, applicable Kubernetes clusters become available
in Cloud Assembly and you can add and create Kubernetes components to Cloud Assembly to
support management of cluster and container applications. These applications form the basis of
self-service deployments that are available from the Service Broker catalog.

m  Configure VMware Tanzu Kubernetes Grid Integrated Edition Integration in Cloud Assembly

You can configure a VMware Tanzu Kubernetes Grid Integrated Edition (TKGi), formerly PKS,
resource connection on premises and in the cloud to support Kubernetes integration and
management capabilities in Cloud Assembly.

m  Provision a vSphere with Tanzu Kubernetes deployment in vRealize Automation

vRealize Automation enables you to provision a vSphere with Tanzu Kubernetes deployment
from Cloud Assembly to leverage the vSphere 7.x native capabilities to deploy and manage
Tanzu Kubernetes clusters, providing an infrastructure-agnostic layer for provisioning and
management of virtual infrastructure.

m  Configure Red Hat OpenShift Integration in Cloud Assembly

You can configure a Red Hat OpenShift resource connection on premises and in the cloud
to support enterprise-level Kubernetes integration and management capabilities in Cloud
Assembly.

m  Configure a Kubernetes Zone in Cloud Assembly

Kubernetes zones enable cloud administrators to define policy-based placement of
Kubernetes clusters and namespaces and supervisor namespaces used in Cloud Assembly
deployments. An administrator can use this page to specify what clusters are available for
provisioning of Kubernetes namespaces and what properties are acceptable for clusters.

m Create a cluster plan in vRealize Automation Cloud Assembly for use with a vSphere with
Tanzu Kubernetes deployment

You must create a cluster plan for use with vSphere with Tanzu Kubernetes deployments in
vRealize Automation. A cluster plan functions as a configuration template for provisioning
Tanzu Kubernetes cluster instances on a particular vSphere cloud account instance.

m  Use Tanzu supervisor clusters and namespaces in Cloud Assembly

Administrators can make supervisor namespacess on a Tanzu-enabled vSphere integration
available to users so they can add those namespaces to Kubernetes deployments via cloud
templates or to request them from the Service Broker catalog.

m  Working with Kubernetes clusters and namespaces in Cloud Assembly
Cloud administrators can add, view, and manage the configuration of deployed Kubernetes
clusters and namespaces, both generic and Pacific-based, in Cloud Assembly.

m  Adding Kubernetes components to cloud templates in Cloud Assembly

When adding Kubernetes components to a Cloud Assembly cloud template, you can choose
to add clusters or enable users to create namespaces in various configurations. Typically,
this choice depends on your access control requirements, how you have configured your
Kubernetes components, and your deployment requirements.
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m  Using Cloud Assembly extensibility with Kubernetes

Cloud Assembly provides a set of event topics that correspond to typical actions related

to Kubernetes cluster and namespace deployment. Users can subscribe to these topics as
desired, and they will run at the appropriate time. Users receive notification when the event
related to the subscribed topic occurs. You can also configure VRO workflows to run based on
event notifications.

Configure VMware Tanzu Kubernetes Grid Integrated Edition Integration in
Cloud Assembly

You can configure a VMware Tanzu Kubernetes Grid Integrated Edition (TKGi), formerly PKS,
resource connection on premises and in the cloud to support Kubernetes integration and
management capabilities in Cloud Assembly.

TKGI integrations enable you to manage TKGI instances on premises and in the cloud and
Kubernetes clusters provisioned on TKGI and external clusters. You must create a Kubernetes
profile and associate it with a project to support policy-based placement of resources.

Prerequisites
m  You must have an appropriately configured TKGI server set up with UAA authentication.

m  Verify that you have cloud administrator credentials. For more information, see What are the
VRealize Automation user roles.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.

2 Select VMware Tanzu Kubernetes Grid Integrated Edition.

3 Enter the IP address or FQDN, and TKGI address for the TKGI cloud account you are creating.
m  The IP address is the FQDN or IP address of the TKGI user authentication server.
m  The TKGI address is the FQDN or IP address for the main TKGI server.

4 Select whether this TKGI server is local or located in the public cloud or on a private cloud.

5 Enter an appropriate Username and Password for the TKGI server and other related
information..

6 If you use tags to support a tagging strategy, enter capability tags. See How do | use tags to
manage Cloud Assembly resources and deployments and Creating a tagging strategy.

7 Click Add.

Results

You can create Kubernetes zones and assign them to a project, or you can discover external
Kubernetes clusters and assign those clusters to projects. In addition, you can add or create
Kubernetes namespaces that facilitate management of clusters among large groups and
organizations.
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What to do next

Create or select the appropriate Kubernetes zones, then select one or more clusters or
namespaces, and assign them to a project. After that, you can create and publish cloud templates
to enable users to generate self-service deployments that use Kubernetes.

Provision a vSphere with Tanzu Kubernetes deployment in vRealize Automation

vRealize Automation enables you to provision a vSphere with Tanzu Kubernetes deployment from
Cloud Assembly to leverage the vSphere 7.x native capabilities to deploy and manage Tanzu
Kubernetes clusters, providing an infrastructure-agnostic layer for provisioning and management
of virtual infrastructure.

The Tanzu with vSphere Kubernetes functionality leverages the native Kubernetes capability of
vSphere 7.x. It does not require a vRealize Automation PKS integration to function.

Prerequisites

m  To provision a vSphere with Tanzu Kubernetes deployment with Cloud Assembly, you must
have access to vSphere 7.x. In vRealize Automation, vSphere is available as part of a Cloud
Assembly vCenter cloud account. See Create a vCenter cloud account in vRealize Automation.

m  Tanzu must be enabled on the vSphere cloud account, and it must contain appropriate
supervisor namespaces.

m  You must have an appropriate cluster plan to use with the integration. See Create a cluster
plan in vRealize Automation Cloud Assembly for use with a vSphere with Tanzu Kubernetes
deployment .

Procedure
1 If a suitable vCenter cloud account does not already exist in Cloud Assembly, create one.
See Create a vCenter cloud account in vRealize Automation.

2 Select Infrastructure > Configure > Kubernetes Zone to create or select a Kubernetes zone in
VRealize Automation Cloud Assembly.

You can use an existing Kubernetes zone if you have an appropriate one already configured,
but an administrator must add one or more supervisor namespaces to the zone. These
namespaces serve as the compute resources on which provisioned Tanzu Kubernetes clusters
are created within the zone. See Configure a Kubernetes Zone in Cloud Assembly for more
information about Kubernetes zones.

3 Navigate to the Kubernetes Provisioning tab on the Infrastructure > Administration > Projects
page in Cloud Assembly and associate the Kubernetes Zone with the appropriate project.

4 Create or select a cluster plan for an appropriate vSphere 7.x cloud account.

See Create a cluster plan in vRealize Automation Cloud Assembly for use with a vSphere with
Tanzu Kubernetes deployment for more information.
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Select Design > Cloud Templates and create a cloud template for a project which has
access to an appropriate Kubernetes zone. Then, drag a K8s Cluster component on the cloud
template scheme and specify its name and cluster plan.

You have the option of also specifying the number of worker nodes.

Run the cloud template and then, when it completes, find the address of the provisioned Tanzu
cluster on the deployment on the Cloud Assembly Deployments page resource properties.

Find and explore the Tanzu cluster on the Cloud Assembly Infrastructure > Configure >
Kubernetes page.

Results

The Tanzu Kubernetes cluster is provisioned as specified in the cloud template.

What to do next

After you deploy the Tanzu cluster, you have several option for working with it.

Navigate to the Resources > Deployments page in Cloud Assembly, and locate and download
the related Kubeconfig file to access the provisioned Tanzu cluster. You can use the
Kubeconfig file to manage the deployed Tanzu Kubernetes cluster as any other compliant
Kubernetes cluster.

You can find and explore the Tanzu cluster on the Cloud Assembly Infrastructure > Resources
> Kubernetes page.

To create a new namespace, navigate to the Namespaces tab on the Cloud Assembly
Infrastructure > Resources > Kubernetes page and click New Namespace to create a
namespace on the applicable Tanzu cluster. You can verify that the namespace was created by
verifying that it is listed on the Namespaces tab on the Kubernetes page.

Configure Red Hat OpenShift Integration in Cloud Assembly

You can configure a Red Hat OpenShift resource connection on premises and in the cloud to
support enterprise-level Kubernetes integration and management capabilities in Cloud Assembly.

Cloud Assembly supports integration with OpenShift versions 3.x.

Prerequisites

You must have an appropriately configured Red Hat OpenShift implementation.

Verify that you have cloud administrator credentials. For more information, see What are the
VRealize Automation user roles.

VMware supplies resources you can use to create an OpenShift cluster with a cloud template
at the following location: https://flings.vmware.com/enterprise-openshift-as-a-service-on-
cloud-automation-services. You can use clusters created with these resources as global
clusters in the Kubernetes zones to create self-service namespaces.
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Procedure

—

Select Infrastructure > Connections > Integrations and click Add Integration.
Select Red Hat OpenShift.

Enter the Address and Location for the OpenShift server.

A W N

Select the appropriate Credential Type and enter the approriate credentials.

OpenShift integration supports either OAuth username/password, public key, or bearer token
authentication.

5 Enter an appropriate Name and Description for the OpenShift integration.

6 If you use tags to support a tagging strategy, enter the appropriate capability tags. See How
do | use tags to manage Cloud Assembly resources and deployments and Creating a tagging
strategy.

7 Click Add.

Results

When an integration is created, new Kubernetes clusters appear in the relevant section of the
Kubernetes page. You can create Kubernetes zones and assign them to a project. In addition, you
can configure Kubernetes namespaces that facilitate management of clusters among large groups
and organizations.

What to do next

Create or select the appropriate Kubernetes zones, then select one or more clusters or
namespaces, and assign them to a project. After that, you can create and publish cloud templates
to enable users to generate self-service deployments that use Kubernetes.

Configure a Kubernetes Zone in Cloud Assembly

Kubernetes zones enable cloud administrators to define policy-based placement of Kubernetes
clusters and namespaces and supervisor namespaces used in Cloud Assembly deployments.
An administrator can use this page to specify what clusters are available for provisioning of
Kubernetes namespaces and what properties are acceptable for clusters.

Cloud administrators can associate Kubernetes zones with TKGI cloud accounts configured for
Cloud Assembly or with external Kubernetes clusters that are not associated with a project.

When you create a Kubernetes zone, you can assign multiple provider-specific resources to the
zone, and these resources will dictate what properties can be set for the newly provisioned
clusters in terms of the number of workers, masters, available CPU, memory, and other
configuration settings. For TKGI providers, these correspond to TKGI plans. An administrator
can also assign multiple clusters to a Kubernetes zone that will be used for placement of newly
provisioned Kubernetes namespaces. The administrator can only assign clusters that are not
onboarded, or not managed by CMX, and are provisioned via the preselected cluster provider.
The administrator can assign multiple Kubernetes zones to a single project, thus making them all
available for placement operations that happen within this project.
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A cloud administrator can assign priorities on multiple levels.

m  Kubernetes zone priority within a project.

m  Resource priority within a Kubernetes zone.

m  Cluster priority within a Kubernetes zone.

The cloud administrator can also assign tags on multiple levels:
m  Capability tags per Kubernetes zone.

m Tags per resource assignment.

m Tags per cluster assignment.

You can create Kubernetes zones with supervisor namespaces on vSphere in the same way that
you work with generic Kubernetes namespaces. To add a supervisor namespace to a Kubernetes
zone, you must associate the zone with a vSphere 7 endpoint that contains the desired Pacific
namespace resources.

Service Broker contains a version of the Kubernetes Zone page to enable Service Broker
administrators to access existing Kubernetes zones so they can create placement policies for
Kubernetes namespaces and clusters provisioned from the catalog.

Prerequisites

Configure integration with a suitable VMware Tanzu Kubernetes Grid Integrated Edition (TKGI)
deployment. See Configure VMware Tanzu Kubernetes Grid Integrated Edition Integration in
Cloud Assembly

Procedure
1 Select Infrastructure > Configure > Kubernetes Zone and click New Kubernetes Zone.
2 Enter the TKGI integration Account name to which you want this zone to apply.

This defines the cloud account or endpoint that is associated with the zone. You can assign
only one endpoint to each zone. If you are working with Supervisor Namespace on vSphere,
you can only select vSphere instances here that contain Supervisor namespaces.

3 Add a Name and Description for the Kubernetes Zone.

4 Add capability tags if appropriate. See Using capability tags in Cloud Assembly for more
information.

5 Click Save.

6 Click the On-demand tab and add TKGI plans as appropriate for the zone to use for cluster
provisioning.

You can select one or more plans and assign priorities to them. Lower numbers equal higher
priority. Priority assignments are secondary to tag based selection.
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7 Click the Cluster tab and then click the Add Compute button to add Kubernetes or supervisor
clusters to the zone. If you are working with an external cluster, it is automatically onboarded
to Cloud Assembly when you select it.

You can add Kubernetes namespaces to the cluster on the Kubernetes Clusters page in Cloud
Assembly.

Results

Kubernetes zones are configured for use with Cloud Assembly deployments.

What to do next
Assign the Kubernetes zone to a project.

1 Select Infrastructure > Administration > Projects and then select the project that you want to
associate with your Kubernetes zone.

2 Click the Kubernetes Provisioning tab on the Project page.

3 Click Add Kubernetes Zone and add the zone that you just created. You can multiple zones if
applicable, and you also set the priority on the zones.

4 Click Save.

The Kubernetes Provisioning tab of the Cloud Assembly Project page enables you to set limits

on the type and number of namespaces users can provision to a kubernetes zone. You can also
select the type of namespaces that can be provisioned to a zone, either regular namespaces or
supervisor namespaces. The Kubernetes Zones table on the Kubernetes Provisioning tab contains
columns that show the current limit settings. To set limits, click the applicable zone on the table to
open a dialog that enables you to choose namespace and supervisor namespace limits.

Click within the Supports column on the Kubernetes Zones table to select what type of namespace
can be provisioned to the zone.

After you assign a Kubernetes zone to a project, you can use the Cloud Templates page under the
Cloud Assembly Design tab to provision a deployment based on the Kubernetes zone and project
configuration. This Cloud Templates page includes options to add a K8S Cluster, K8S Namespace
and Supervisor Namespace. Select the appropriate option for the Kubernetes resource you are
working with.

Create a cluster plan in vRealize Automation Cloud Assembly for use with a
vSphere with Tanzu Kubernetes deployment

You must create a cluster plan for use with vSphere with Tanzu Kubernetes deployments in
VRealize Automation. A cluster plan functions as a configuration template for provisioning Tanzu
Kubernetes cluster instances on a particular vSphere cloud account instance.

A cluster plan defines a configuration mapping, similar to a flavor-mapping, for a set of vSphere
cloud account instances. Generally, the cluster plan encodes a meaningful set of configuration
properties, such as virtual machine classes, storage classes, etc, that are used when provisioning
Tanzu kubernetes clusters on a particular vSphere server cloud account.
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Note that a single cluster plan might have a particular configuration property mapping in one
vSphere cloud account and another configuration mapping in another vSphere instance. For
example, if you have two eligible vSphere cloud accounts, one with high resource and another
with limited resources, the 1arge cluster plan might specify guaranteed-xlarge for the high-profile
vSphere server and best-effort-medium for the limited vSphere instance. In general, the l1arge
specification maps a different configuration property set to each eligible vSphere server instance.

After a cluster plan is created for one or more vSphere instance, all eligible supervisor
namespaces, that an administrator assigns to host a Tanzu Kubernetes cluster using a Kubernetes
zone assignment, should be aligned with respect to the configuration defined in the cluster plan
specification. For example, the storage policy specified in the cluster plan should be added as a
storage class to all vSphere supervisor namespaces dedicated for provisioning of Tanzu clusters.

Prerequisites

m  To create a vSphere with Tanzu Kubernetes deployment in Cloud Assembly, you must have
access to vSphere 7.x which is available as part of a vCenter cloud account. See Create a
vCenter cloud account in vRealize Automation.

m  Tanzu must be enabled on the vSphere cloud account with one or more supervisor
namespaces.

m  All supervisor clusters on the registered vSphere cloud account that are eligible for
provisioning of Tanzu Clusters must be added as managed entities on the Cloud Assembly
Infrastructure > Kubernetes > Supervisor Clusters page using the Add Supervisor Cluster
option.

Procedure

1 Select Infrastructure > Configure > Cluster Plan and click New Cluster Plan.

2 Enter an Account, Name, and Description for the cluster plan. The account defines the cloud
account to which this cluster plan applies.

3 Enter cluster information details including Kubernetes versions and Control plane. This
information includes allocations for nodes, machine class and storage class.

m  Enter the version of Kubernetes that is applicable to this cluster plan. This is the
Kubernetes version of the provisioned Tanzu Kubernetes clusters: for example, 1.19 or 1.20.

m  The control plane count defines the specification for Kubernetes API server nodes.

m A virtual machine class is a request for reservations on the virtual machine for processing
power. There are numerous predefined machine classes, which represent different levels
of compute power. See Virtual Machine Classes for Tanzu Kubernetes Clusters for more
information.

m  Workers specify the Tanzu Kubernetes worker nodes to be deployed with this plan.
4 Enter and select Additional Settings for the cluster plan.

m  Enter the Default PVC storage class to use with this cluster.
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m  Use the radio buttons to indicate behavior in regards to usage of storage classes and
network settings.

5 Click Create.

Results

The cluster plan is created and is available for use within Cloud Assembly cloud templates.

What to do next

After you create a cluster plan, you can use it to create a vSphere with Tanzu Kubernetes
deployment in Cloud Assembly. See Provision a vSphere with Tanzu Kubernetes deployment in
vRealize Automation.

Use Tanzu supervisor clusters and namespaces in Cloud Assembly

Administrators can make supervisor namespacess on a Tanzu-enabled vSphere integration
available to users so they can add those namespaces to Kubernetes deployments via cloud
templates or to request them from the Service Broker catalog.

This task describes how to add Tanzu supervisor clusters with Cloud Assembly for use in
deployments and how to create or add namespaces that define what Cloud Assembly projects and
users can access particular Kubernetes resources. This functionality relies on a suitable vSphere
cloud account rather than an integration such as VMware Tanzu Kubernetes Grid Integrated
Edition (TKGI) or Openshift. Supervisor clusters are customized Kubernetes clusters associated
with vSphere. They expose Kubernetes APIs to end users, and they use ESXI as a platform for
worker nodes rather than Linux. Supervisor namespaces facilitate access control to Kubernetes
resources, because it is typically easier to apply policies to namespaces than to individual virtual
machines. You can create multiple namespaces for each supervisor cluster.

Tanzu enabled deployments can also use vSphere generated guest clusters. A guest cluster is a
kubernetes cluster that runs inside virtual machines on the supervisor cluster. A guest cluster is
fully upstream compliant Kubernetes, so it’s guaranteed to work with all Kubernetes applications.
Guest clusters in vSphere use the open source Cluster API project to lifecycle manage Kubernetes
clusters, which in turn uses the VM operator to manage the virtual machines that make up a guest.

When used with Tanzu enabled vSphere instances, Kubernetes zones define which supervisor
clusters are available for provisioning of a supervisor namespace. Supervisor namespaces are
specific to Tanzu enabled vSphere instances. You cannot provision a generic Kubernetes resource
to a Tanzu enabled vSphere instance.

Cloud Assembly users designated as project viewers have view only access to namespaces, while
project members can edit them.

You can configure the supervisor clusters associated with namespaces if desired.
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Prerequisites

To use supervisor clusters and namespaces with Cloud Assembly, you must have a vSphere 7.x
endpoint configured. In vRealize Automation, vSphere is installed as part of a vCenter cloud
account. See Create a vCenter cloud account in vRealize Automation.

Tanzu must be enabled on the vSphere cloud account, and it must contain appropriate
supervisor namespaces.

Both your vCenter and your vRealize Automation deployment should use the same Active
Directory for users to be synched. Though provisioning will still function if this is not the case,
vRealize Automation users will not get automatic access to the namespace.

Procedure

1

10

1

12

13

Select Infrastructure > Configure > Kubernetes Zone in Cloud Assembly.

This page shows managed clusters that are available for use, and enables you to add
additional clusters. You can click on any of the clusters to view their details.

Select New Kubernetes Zone.
Specify the Account details for the target vSphere cloud account.

Click the Search icon in the text box to either view all vSphere accounts or search for an
account by name.

Type a Name and Description for the new zone.

Add capability tags if appropriate. See Using capability tags in Cloud Assembly for more
information.

Click the Provisioning tab to select the supervisor cluster that will be associated with the
namespaces.

Click Add Compute to view and select the available supervisor clusters.
Click Add.

Select Infrastructure > Administration > Projects and then select the project that you want to
associate with your Kubernetes zone.

Click the Kubernetes Provisioning tab on the Project page.

Click Add Kubernetes Zone and add the zone that you just created. You can multiple zones if
applicable, and you also set the priority on the zones.

Click Save.
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What to do next

After a namespace is configured, the Infrastructure > Resources > Kubernetes page in Cloud
Assembly for applicable users displays the namespace. Users can click the Address link on the
Summary tab to open the vSphere Kubernetes CLI Tools to manage the namespace. Users must
be a cloud administrator or a member of the namespace for the designated project to access a link
to the Supervisor namespace details. Also users can download a customized Kubectl to use the
Supervisor namespace. Users can log in to the supervisor namespace and use it as they would any
other namespace, and then create cloud templates and deploy applications.

To add the namespace to a cloud template select Design > Cloud Template and select an existing
cloud template or create a new one. Then you can select the Supervisor namespace item on the
left menu and drag it to the canvas.

You can assign storage policies to a supervisor namespace using tags. You can add tags, such as
location:local to specify the kubernetes zone you want to use with the deployment and other
tags on your storage profiles such as speed: fast and speed:slow.

formatVersion: 1
resources:
Cloud SV Namespace 1:
type: Cloud.SV.Namespace
properties:
name: 'a'
storage:
-profile:
constraints:
- tag: 'speed:fast'
-profile:
1iimitMB:1000
constraints:

-tag: 'speed:slow'

This cloud template requests a supervisor namespace with no constrains, and specifies two
storage profiles with it.

After you deploy cloud templates containing a supervisor namespace, users can also request
supervisor namespaces from the Service Broker catalog. Also, you can click on the Deployments
page in Cloud Assembly to view information about the deployment and access a link that contains
the command to run the kubectl for the namespace on vSphere.
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You can specify virtual machine classes for supervisor namespaces in a cloud template using the
vmclasses property that enables you to specify a class name. See the following cloud template
example.

resources:

Cloud SV _Namespace 1:
type: Cloud.SV.Namespace
properties:

name: demo-vmclassl
vmclasses:

- name: vmclassl

Working with Kubernetes clusters and namespaces in Cloud Assembly

Cloud administrators can add, view, and manage the configuration of deployed Kubernetes
clusters and namespaces, both generic and Pacific-based, in Cloud Assembly.

Users with cloud administrator privileges can view, add, and manage Kubernetes clusters and
namespaces to which you are entitled access on the Infrastructure > Resources > Kubernetes
page. This page contains tabs for Clusters, Namespaces, Supervisor Clusters and Supervisor
Namespaces. You can select one of these tabs to view and manage the analogous resources.
Most typically, this page facilitates management of deployed clusters and namespaces.

m  Cluster: A cluster is a group of Kubernetes nodes distributed across one or more physical
machines. This page shows provisioned and undeployed clusters that have been configured
for use on your Cloud Assembly instance. You can click on a cluster to view information about
its current status. When you deploy a cluster, it includes a link to a Kubconfig file that is
accessible only for cloud administrators. This file grants full admin privileges over the cluster
including a list of namespaces.

Supervisor clusters are unique to vSphere instances and use ESXI as their worker nodes
instead of Linux.

m Namespaces: Namespaces are virtual clusters that provide administrators with a way to group
or separate cluster resources. They facilitate management of resources among large groups
of users and organizations. As a form of role-based access control, a cloud administrator
can allow users to add namespaces to a project when they request a deployment and then
later manage those namespaces from the Kubernetes Clusters page. When you deploy a
namespace, it includes a link to a kubeconfig file that allows valid users, such as developers, to
view and manage some aspects of that namespace.

Supervisor clusters and supervisor namespaces exist only on vSphere instances and provide
Kubernetes-like access to vSphere objects.
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A cloud administrator can change the project associated with a Kubernetes namespace or cluster
on this page so that the administrator can provision Kubernetes resources from cloud templates
and Service Broker and then assign them to specific projects for consumption. The administrator
can change the scope of a cluster to make it global or project specific. Global clusters appear
Clusters tab for all Kubernetes zones and are available for selection and provisioning. If a cluster
is global, it can be added to a Kubernetes zone and then used to provision namespaces from the
catalog.

If you are configuring new or existing cluster, you must select whether to connect with a primary
IP address or a primary hostname.

Working with generic Kubernetes Clusters in Cloud Assembly

You can add new, existing, or external clusters to Cloud Assembly using the options on this page.
1 Select Infrastructure > Resources > Kubernetes and confirm that the Clusters tab is active.

If there are any clusters currently configured for your Cloud Assembly instance, they appear on
this page.

2 If you are adding a new or existing cluster, or deploying a cluster, select the appropriate
option according to the following table.

Option Description Details

Deploy Add new clusters to Cloud Assembly You must specify the TKGI cloud account that
to which this cluster will be deployed as well as
the desired plan and the number of nodes.

Add Existing Configure an existing cluster to work with your project. You must specify the TKGI cloud account, the
cluster to use, and the appropriate project
for the targeted developer. Also, you need to
specify the sharing scope. If you want to share
globally, you must configure your Kubernetes
zones and namespaces appropriately.

Add External Add a vanilla Kubernetes cluster, that might not be You must designate a project to which the
associated with TKGI, to Cloud Assembly. cluster is associated, enter the IP address for
the desired cluster and select a cloud proxy anc
certificate information required to connect to
this cluster.

3 Click Add to make the cluster available within Cloud Assembly.

Working with Kubernetes Namespaces in Cloud Assembly

If you are a cloud administrator, namespaces help you group and manage Kubernetes cluster
resources. If you are a user, namespaces are the area in Kubernetes clusters for your
deployments. Administrators and users can access namespaces using the Namespaces tab located
on the Infrastructure > Resources > Kubernetes page.

There are several ways to add Kubernetes namespaces to resources in Cloud Assembly. The
following procedure outlines one typical method.

1  Select Infrastructure > Resources > Kubernetes and click the Namespaces tab.
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2 To add a new namespace, click New Namespace. To add an existing namespace click Add
Namespace.

3 Enter a Name and Description for the namespace.

At this point you have added a namespace for use with Kubernetes resources, but it is not
associated with anything in particular.

4  Specify the Cluster that you want to associate with this namespace.
5 Click Create to add the namespace to Cloud Assembly.

You can add custom properties on Kubernetes namespaces to support extensibility in several
different ways. You add custom properties when you provision a namespace by creating a Cloud
Assembly cloud template. When you specify a Kubernetes namespace in a cloud template you can
add properties to the namespace. First, you can right click on the properties in the template to
access the default properties that are part of the cloud template schema. As a second option, you
can add user-defined properties in the properties section of the namespace in the cloud template.

After deployment, these custom properties appear on the Deployments page in Cloud Assembly
for the applicable deployment.

Finally, you can also add custom properties to a namespace using actions configured on the
Extensibility > Actions page in Cloud Assembly.

Working with Supervisor clusters and Supervisor namespaces

Cloud administrators can view and change the configuration of supervisor clusters and
namespaces on the Kubernetes page in Cloud Assembly.

1  Select Infrastructure > Resources > Kubernetes in Cloud Assembly.
2 Select Add Supervisor Cluster.

3 Specify the Account details for the target vSphere cloud account.

4

Click the Search icon in the Supervisor cluster text box to either view all supervisor clusters or
search for a cluster by name.

ul

Select the desired cluster and click Add.

6 Select the Supervisor Namespaces tab and click the New Supervisor Namespace button to
add a new namespace.

7 Select the Supervisor Namespaces tab and click the New Supervisor Namespace button to
add a new namespace.

a If you are creating a new namespace, add a Name and Description.
b Select the appropriate cloud Account to associate with the namespace.
c Select the Supervisor cluster to associate with this namespace.

d Select the Project to associate with the namespace.
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e Use the Available storage policies selection to add storage policies for use with the
namespace.

You can add all available storage policies or select specific policies for use with the
supervisor namespace. Also, you can optionally set a limit on the storage size available
with each available storage policy.

f  Click Create.

8 Review the relevant details for the new namespace. You can change the storage policy
configuration if needed.

Users and groups that currently have access to the namespace in vSphere are listed on the
Users tab. If new users or groups are added to the project, click the Update Users button on
this tab to update the list. The list is not updated automatically, so you must use the button to
update.

Note Synchronization of users makes sense only if Cloud Assembly and vCenter are
configured with a common Active Directory/LDAP service.

After a cluster or namespace is configured, the Infrastructure > Resources > Kubernetes page

in Cloud Assembly displays the clusters and namespaces available to the user. You can click an
individual namespace or cluster to open a page that contains a number of tabs that show statistics
and other information for the resource, and allows you to configure various options.

The Summary tab for clusters on the Kubernetes page allows administrators to view and, in some
cases, update configuration of a cluster including changing the scope. The Sharing radio buttons
allow you to select either Global (shareable within the Kubernetes Zone) or Project (access limited
to a single project). If you select Project, you must also specify the applicable project in the
following Project selection.

Note Changing the sharing configuration can affect the namespaces that are available on the
cluster.

Users can click the Address link on the Summary tab to open the vSphere Kubernetes CLI Tools to
manage the namespace. Users must be a cloud administrator or a member of the namespace

for the designated project to access a link to the Supervisor namespace details. Also users

can download a customized Kubectl to use the Supervisor namespace. Users can log in to the
supervisor namespace and use it as they would any other namespace, and then create cloud
templates and deploy applications.

Adding Kubernetes components to cloud templates in Cloud Assembly

When adding Kubernetes components to a Cloud Assembly cloud template, you can choose

to add clusters or enable users to create namespaces in various configurations. Typically, this
choice depends on your access control requirements, how you have configured your Kubernetes
components, and your deployment requirements.
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To add a Kubernetes component to a cloud template in Cloud Assembly, select Design > Cloud
Templates , click New, and then locate and expand the Kubernetes option on the left menu. Then,
make the desired selection, either Cluster or KBS Namespace by dragging it to the canvas.

Adding a Kubernetes cluster that is associated with a project to a cloud template is the most
straightforward method of making Kubernetes resources available to valid users. You can use
tags on clusters to control where they are deployed just as you do with other Cloud Assembly
resources. You can use tags to select a zone and a VMware Tanzu Kubernetes Grid Integrated
Edition (TKGI) plan during the allocation phase of cluster deployment.

Once you add a cluster in this way, it is automatically available to all valid users.

Cloud template examples

The first cloud template example shows a template for a simple Kubernetes deployment that is
controlled by tagging. A Kubernetes zone was created with two deployment plans, configured on
the New Kubernetes Zone page. In this case, a tag called placement :tag was added as a capability
on the zone, and it was used to match the analogous constraint on the cloud template. If there
were more than one zone configured with the tag, the one with the lowest priority number would
be selected.

formatVersion: 1
inputs: {}
resources:
Cluster_provisioned from tag:
type: Cloud.K8S.Cluster
properties:
hostname: 109.129.209.125
constraints:
-tag: 'placement tag'
port: 7003
workers: 1

connectBy: hostname

The second cloud template examples shows how to set up a template with a variable called
$(input.hostname) so that users can input the desired cluster hostname when requesting a
deployment. Tags can also be used to select a zone and a TKGI plan durring the resource
allocation phase of cluster deployment.

formatVersion: 1
inputs:
hostname:
type: string
title: Cluster hostname
resources:
Cloud K8S Cluster 1:
type: Cloud.K8S.Cluster

properties:
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hostname: ${input.hostname}
port: 8443
connectBy: hostname

workers: 1

If you want to use namespaces to mange cluster usage, you can set up a variable in the

cloud template called name: ${input.name}to substitute for the namespace name which a user

enters when requesting a deployment. For this sort of deployment, you would create a template

something like the following example:

1 formatVersion: 1

2 inputs:

3 name:

4 type: string

5 title: "Namespace name"

6 resources:

7 Cloud KBS Namespace 1:

8 type: Cloud.K8S.Namespace
9 properties:

10 name: ${input.name}

Users can manage deployed clusters via kubeconfig files that are accessible from the
Infrastructure > Resources > Kubernetes Clusters page. Locate the card on the page for the
desired cluster and click Kubeconfig.

Supervisor Namespaces in VMware Cloud Templates

The following is the schema for a basic Supervisor namespace in a Cloud Assembly cloud
template.

"title": "Supervisor namespace schema",
"description": "Request schema for provisioning of Supervisor namespace resource",
"type": "object",
"properties": {
"name": {
"title": "Name",
"description": "Alphabetic (a-z and 0-9) string with maximum length of 63 characters.

The character ‘-’ is allowed anywhere except the first or last position of the identifier.",

"type": "string",
"pattern”: "AUFNNS\\{.F\\}.*S[A((?!-) [a-z0-9-1{1,63} (°<!-))S",
"ignoreOnUpdate": true

}I

"description": {

"title": "Description",
"description": "An optional description of this Supervisor namespace.",
"type": "string",

"ignoreOnUpdate": true
}I

"content": {
"title": "Content",
"description": "Kubernetes Yaml Content",
"type": "string",
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"maxLength": 65000
by

"constraints": {
"title": "Constraints",
"description": "To target the correct resources, blueprint constraints are matched

against infrastructure capability tags. Constraints must include the key name. Options
include value, negative [!], and hard or soft requirement.",
"type": "array",
"recreateOnUpdate": true,
"items": {
"type": "object",
"properties": {
"tag": {
"title": "Tag",
"description”: "Constraint definition in syntax °"[!]tag key[:tag value]
[thard|:soft]" \nExamples:\n " "\n!location:eu:hard\n location:us:soft\n!pci\n """,
"type": "string",

"recreateOnUpdate": true

by
"limits": {
"title": "Limits",
"description": "Defines namespace resource limits such as pods, services, etc.",
"type": "object",
"properties": {
"stateful set count": {
"title": "stateful set count",
"description": "This represents the new value for 'statefulSetCount' option which
is the maximum number of StatefulSets in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"deployment count": {
"title": "deployment count",
"description": "This represents the new value for 'deploymentCount' option which is
the maximum number of deployments in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"cpu limit default": {
"title": "cpu_ limit default",
"description": "This represents the new value for the default CPU limit (in Mhz)
for containers in the pod. If specified, this limit should be at least 10 MHz.",
"type": "integer",
"recreateOnUpdate": false
by
"config map count": {
"title": "config map_count",
"description": "This represents the new value for 'configMapCount' option which is
the maximum number of ConfigMaps in the namespace.",
"type": "integer",
"recreateOnUpdate": false

by
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"pod_count": {

"title": "pod count",
"description": "This represents the new value for 'podCount' option which is the
maximum number of pods in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"job count": {
"title": "job_count",
"description": "This represents the new value for 'jobCount' option which is the
maximum number of jobs in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"secret count": {
"title": "secret count",
"description": "This represents the new value for 'secretCount' option which is the
maximum number of secrets in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"cpu limit": {
"title": "cpu limit",
"description": "This represents the new value for 'limits.cpu' option which is
equivalent to the maximum CPU limit (in MHz) across all pods in the namespace.",
"type": "integer",
"recreateOnUpdate": false

by
"cpu_request default": {
"title": "cpu_ request default",
"description": "This represents the new value for the default CPU request (in Mhz)
for containers in the pod. If specified, this field should be at least 10 MHz.",
"type": "integer",
"recreateOnUpdate": false
by
"memory limit default": ({
"title": "memory limit default",
"description": "This represents the new value for the default memory limit (in
mebibytes) for containers in the pod.",
"type": "integer",
"recreateOnUpdate": false
by
"memory limit": {
"title": "memory limit",
"description": "This represents the new value for 'limits.memory' option which is
equivalent to the maximum memory limit (in mebibytes) across all pods in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"memory request default": {
"title": "memory request default",
"description": "This represents the new value for the default memory request (in
mebibytes) for containers in the pod.",
"type": "integer",

"recreateOnUpdate": false
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by

"service count": {
"title": "service count",
"description": "This represents the new value for 'serviceCount' option which is

the maximum number of services in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"replica_set count": {
"title": "replica set count",
"description": "This represents the new value for 'replicaSetCount' option which is

the maximum number of ReplicaSets in the namespace.",

"type": "integer",
"recreateOnUpdate": false
by
"replication controller count": {
"title": "replication controller count",
"description": "This represents the new value for 'replicationControllerCount'

option which is the maximum number of ReplicationControllers in the namespace.",
"type": "integer",
"recreateOnUpdate": false
by
"storage request limit": {

"title": "storage request limit",

"description": "This represents the new value for 'requests.storage' which is the
limit on storage requests (in mebibytes) across all persistent volume claims from pods in the
namespace.",

"type": "integer",

"recreateOnUpdate": false

by
"persistent volume claim count": {

"title": "persistent volume claim count",

"description": "This represents the new value for 'persistentVolumeClaimCount'
option which is the maximum number of PersistentVolumeClaims in the namespace.",

"type": "integer",

"recreateOnUpdate": false

by
"daemon_set count": {

"title": "daemon set count",

"description": "This represents the new value for 'daemonSetCount' option which is
the maximum number of DaemonSets in the namespace.",

"type": "integer",

"recreateOnUpdate": false

by
"additionalProperties
by
"vm_classes": {

"title": "VM classes",

false

"description": "Defines set of Virtual Machine classes to be assigned to the namespace",
"type": "array",
"recreateOnUpdate": false,
"items": {
"type": "object",

"properties": {
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"name": {
"title": "Name",
"description": "Name of the Virtual Machine class.",
"type": "string",

"recreateOnUpdate": false

by
"storage": {
"title": "Storage policies",
"description": "Defines set of storage profiles to be used to assign storage policies
to the namespace.",
"type": "array",
"recreateOnUpdate": false,
"items": {
"type": "object",
"properties": {

"profile": {

"type": "object",
"title": "Storage profile",
"description": "Defines storage policies to be assigned to the namespace",
"recreateOnUpdate": false,
"properties": {
"constraints": {
"title": "Constraints",
"description": "To target the correct storage profiles, blueprint constraints

are matched against storage profile capability tags.",

"type": "array",
"recreateOnUpdate": false,
"items": {
"type": "object",
"properties": {
"tag": {
"title": "Tag",
"description”: "Constraint definition in syntax "[!]tag key[:tag value]
[thard|:soft]  \nExamples:\n ' \nlocation:eu:hard\n location:us:soft\n” """,
"type": "string",
"recreateOnUpdate": false

by
"minItems":1
by
"limitMb": {
"title": "Limit",
"description": "The maximum amount of storage (in mebibytes) which can be

utilized by the namespace for this storage policy. Optional. If unset, no limits are placed.",

"type": "integer"
}
by
"required": [
"constraints"
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}
}I
"required": [

"name"

VMware cloud templates support the use of limits with supervisor namespaces. Limits enable you
to control resource usage for CPUs and memory as well as the maximum number of pods allowed
in the namespace by deployed machines.

formatVersion: 1
inputs: {}
resources:
Cloud SV Namespace 1:
type: Cloud.SV.Namespace
properties:
name: '${env.deploymentName}'
limits:
- cpu_limit: 1000
cpu_request default: 800
memory_ limit: 2000
memory_ limit default: 1500
pod count: 200

The following example shows how you could specify a storage policy using tags.

formatVersion: 1
inputs: {}
resources:
Cloud SV _Namespace 1:
type: Cloud.SV.Namespace
properties:
name: 'ns-with-storage-policy'
description: 'sample'
storage:
- profile:
limitMb: 1000
constraints:
- tag: 'storage:fast'
- profile:
constraints:

- tag: 'storage:cheap'

Using arbitrary YAMLs with self-service namespace or cluster VCTs

As part of a cluster or namespace creation, users often want to execute additional customizations.
For example, you may want to add users (role/role binding) or create a pod security policy or
install agents. By using the YAML content property, users can define customized packages that
they want to provision on that cluster/namespace/supervisor namespace.
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Each YAML content package associated with the content property must be separated with a triple
dash (---). Also the content information must be a multi-line string. Refer to the following YAML
example to see how content packages can be configured.

formatVersion: 1
inputs: {}
resources:
Cloud Tanzu_Cluster_1:
type: Cloud.Tanzu.Cluster
properties:
name: ddonchev-tkc
plan: small
content: |-
apiVersion: rbac.authorization.k8s.io/v1l
kind: ClusterRoleBinding
metadata:
name: psp:authenticated-from-yaml
subjects:
- apiGroup: rbac.authorization.k8s.io
kind: Group
name: system:authenticated
roleRef:
apiGroup: rbac.authorization.k8s.io
kind: ClusterRole
name: psp:vmware-system-privileged
apiVersion: apiextensions.k8s.io/vl
kind: CustomResourceDefinition
metadata:
# name must match the spec fields below, and be in the form: <plural>.<group>
name: crontabs.stable.example.com
spec:
# group name to use for REST API: /apis/<group>/<version>
group: stable.example.com
# list of versions supported by this CustomResourceDefinition
versions:
- name: vl
# Each version can be enabled/disabled by Served flag.
served: true
# One and only one version must be marked as the storage version.
storage: true
schema:
openAPIV3Schema:
type: object
properties:
spec:
type: object
properties:
cronSpec:
type: string
image:
type: string
replicas:

type: integer
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# either Namespaced or Cluster

scope: Namespaced

names:
# plural name to be used in the URL: /apis/<group>/<version>/<plural>
plural: crontabs
# singular name to be used as an alias on the CLI and for display
singular: crontab
# kind is normally the CamelCased singular type. Your resource manifests use this.
kind: CronTab
# shortNames allow shorter string to match your resource on the CLI
shortNames:
- ct

The YAML defined in the content property also appears on the Properties tab for the deployment.

Cloud Assembly can only create content resources in the scope of the resource being deployed.
For example: if you provision a kubernetes namespace,Cloud Assembly cannot create a
deployment inside a different namespace. Users have the same rights as if they were using the
kubeconfig with kubectl.

After the virtual machine is provisioned, an installation of the kubernetes objects inside the
content property will begin. If one of the resources referenced in the YAML content property

fails to provision, Cloud Assembly will roll back and delete all the previous kubernetes objects from
the resource and the deployment will have a Failed status. The resource will still be provisioned
and visible. Also, you can still use day2 actions, including trying to apply the content again.

You can enhance the content property with inputs from the cloud template as shown in the
following example.

formatVersion: 1
inputs: {}
resources:
Cloud SV Namespace 1:
type: Cloud.SV.Namespace
properties:
name: sv-namespace-with-vm-classes
vm_classes:
- name: best-effort-2xlarge
- name: best-effort-4xlarge
- name: best-effort-8xlarge

In addition, you can provision custom resources such as the TanzuKubernetesCluster. This would
fail as a day 1 operation, because the supervisor namespace will not contain the required virtual
machine classes and storage classes. When the virtual machine classes and storage classes are
bound to the supervisor namespace you can create the TanzuKubernetesCluster (Or another
resource) using the day 2 action.

Note: You can provision a resource without content, and you will still be able to add kubernetes
objects as YAML with the day 2 action.

The content that appears in the YAML property defines what is provisioned on the resource. When
you edit this content, the following table shows the possible results:
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Action Result

If you add a kubernetes object and submit. The specified object is created on the resource.

If you remove a kubernetes object and submit. The specified object is deleted from the resource.
If you modify a kubernetes object and submit. The specified object is patched on the resource.

It is important to clarify what actions are considered as a modification to the current object. For
example: if you modify the namespace field of an object, then a new object is created instead of
the old one being patched.

The unigueness of a resource is defined by the following fields: apiversion, kind, metadata.name,
metadata.namespace
Using Cloud Assembly extensibility with Kubernetes

Cloud Assembly provides a set of event topics that correspond to typical actions related to
Kubernetes cluster and namespace deployment. Users can subscribe to these topics as desired,
and they will run at the appropriate time. Users receive notification when the event related

to the subscribed topic occurs. You can also configure vRO workflows to run based on event
notifications.

The following topics are available for subscription on the Extensibility > Library > Event Topics
page in Cloud Assembly. To view these topics, search for Kubernetes in the Event Topics Search
text box.

m  Kubernetes cluster allocation

m  Kubernetes cluster post provision

m  Kubernetes cluster post removal

m  Kubernetes cluster provision

m  Kubernetes cluster removal

m  Kubernetes namespace allocation

m  Kubernetes namespace post provision

m  Kubernetes namespace post removal

m  Kubernetes namespace removal

m  Kubernetes namespace allocation

m  Kubernetes supervisor namespace allocation

m  Kubernetes supervisor namespace post provision
m  Kubernetes supervisor namespace post removal
m  Kubernetes supervisor namespace removal

m  Kubernetes supervisor namespace allocation
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Click one of the topics to view the schema for that topic which shows all the information that

is collected and transmitted. There are namespace topics for both Kubernetes namespaces and
supervisor namespaces. You can use any of this schema information to set up various notifications
and management and reporting tasks.

You can set up action scripts for CMX-related actions on the Extensibility > Library > Actions
page. Action scripts can be used for various purposes: for example, to create a DNS record of
Kubernetes cluster provisioning. If you are creating a DNS record, you can use the masternodeips
field from the Kubernetes cluster post provision topic with a REST command in an Action script to
create a DNS record.

The Subscriptions page defines the relationship between the event topics and action scripts. You
can view and manage these components on the Subscriptions page in Cloud Assembly

See the Cloud Assembly extensibility documentation at Extending and automating application life
cycles with extensibility for more information.

What Is configuration management in Cloud Assembly

Cloud Assembly supports integration with Puppet Enterprise, Ansible Open Source, and Ansible
Tower so that you can manage deployments for configuration and drift.

Puppet Integration

To integrate Puppet-based configuration management, you must have a valid instance of Puppet
Enterprise installed on a public or private cloud with a vSphere workload. You must establish

a connection between this external system and your Cloud Assembly instance. Then you can
make Puppet configuration management available to Cloud Assembly by adding it to appropriate
blueprints.

The Cloud Assembly blueprint service Puppet provider installs, configures, and runs the Puppet
agent on a deployed compute resource. The Puppet provider supports both SSH and WinRM
connections with the following prerequisites:

m  SSH connections:

m  The user name must be either a super user or a user with sudo permissions to run
commands with NOPASSWD.

m  Deactivate requiretty for the given user.
= cURL must be available on the deployment compute resource.
= WIinRM connections:
m  PowerShell 2.0 must be available on the deployment compute resource.

m  Configure the Windows template as described in the vRealize Orchestrator documentation.
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The DevOps administrator is responsible for managing the connections to a Puppet master
and for applying Puppets roles, or configuration rules, to specific deployments. Following
deployment, virtual machines configured to support configuration management are registered
with the designated Puppet Master.

When virtual machines are deployed, users can add or delete a Puppet Master as an
external system or update projects assigned to the Puppet Master. Finally, appropriate users
can de-register deployed virtual machines from the Puppet Master when the machines are
decommissioned.

Ansible Open Source Integration

When setting up an Ansible integration, install Ansible Open Source in accordance with the
Ansible installation instructions. See the Ansible documentation for more information about
installation.

Ansible enables host key checking by default. If a host is reinstalled with a different key in the
known_hosts file, an error message appear. If a host is not listed in the known hosts file, you
must supply the key on start-up. You can deactivate host key checking with the following setting in
the /etc/ansible/ansible.cfgor ~/.ansible.cfq file:

[defaults]
host key checking = False

localhost _warning = False

[paramiko connection]

record host keys = False

[ssh_connection]
#ssh_args = -C -o ControlMaster=auto -o ControlPersist=60s

ssh_args = -o UserKnownHostsFile=/dev/null

To avoid the host key checking errors, set host key checking and record host keys to False
including adding an extra option UserKnownHostsFile=/dev/null Setin ssh_args.In addition, if the
inventory is empty initially, Ansible warns that the host list is empty. This causes the playbook
syntax check to fail.

Ansible vault enables you to store sensitive information, such as passwords or keys, in encrypted
files rather than as plain text. Vault is encrypted with a password. In Cloud Assembly, Ansible uses
Vault to encrypt data such as ssh passwords for host machines. It assumes that the path to the
Vault password has been set.

You can modify the ansible.cfg file to specify the location of the password file using the
following format.

vault password file = /path to/file.txt

You can also set the ANSIBLE VAULT PASSWORD FILE environment variable
so that Ansible automatically searches for the password. For example,
ANSIBLE VAULT PASSWORD FILE=~/.vault pass.txt
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Cloud Assembly manages the Ansible inventory file, so you must ensure that the Cloud Assembly
user has rwx access on the inventory file.

cat ~/var/tmp/vmware/provider/user defined script/$(ls -t ~/var/tmp/vmware/provider/

user defined script/ | head -1)/log.txt

If you want to use a non-root user with Cloud Assembly open-source integration, the users require
a set of permissions to run the commands used by the Cloud Assembly open-source provider. The
following commands must be set in the user's sudoers file.

Defaults:myuser !requiretty

If the user is not part of an admin group that has no askpass application specified, set the following
command in the user's sudoers file.

myuser ALL=(ALL) NOPASSWD: ALL

If you encounter errors or other problems when setting up Ansible integration, refer

tothe log. txt file at 'cat~/var/tmp/vmware/provider/user defined script/$(ls -t
~/var/tmp/vmware/provider/user defined script/ | head -1)/' onthe Ansible Control
Machine.

Ansible Tower Integration
Supported Operating System Types

m  Red Hat Enterprise Linux 8.0 or later 64-bit (x86), supports only Ansible Tower 3.5 and
greater.

m  Red Hat Enterprise Linux 7.4 or later 64-bit (x86).
m  CentOS 7.4 or later 64-bit (x86).

The following is a sample inventory file, which is generated during an Ansible Tower installation.
You may need to modify it for Cloud Assembly integration uses.

[root@cava-env8-dev-001359 ansible-tower-setup-bundle-3.5.2-1.el18]# pwd
/root/ansible-tower-install/ansible-tower-setup-bundle-3.5.2-1.el8
[root@cava-env8-dev-001359 ansible-tower-setup-bundle-3.5.2-1.el18]# cat inventory
[tower]

localhost ansible connection=local

[database]
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[all:vars]

admin password='VMwarel!'

pg_host=""

pg_port=""

pg_database='awx'
pg_username="'awx'

pg_password='VMwarel!'

rabbitmg port=5672

rabbitmg vhost=tower
rabbitmg username=tower
rabbitmg password='VMwarel!'

rabbitmg cookie=cookiemonster

# Needs to be true for fgdns and ip addresses

rabbitmg use long name=false

# Isolated Tower nodes automatically generate an RSA key for authentication;
# To deactivate this behavior, set this value to false

# isolated_key generation=true

Configure Puppet Enterprise integration in Cloud Assembly

Cloud Assembly supports integration with Puppet Enterprise configuration management.
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When you add Puppet Enterprise to Cloud Assembly as an external system, by default it is
available on all projects. You can restrict it to specific projects.

To add a Puppet Enterprise integration, you must have the Puppet master name and the
hostname or IP address of the master.

You can find Puppet logs at the following location in case you need to check them for errors or
information purposes.

Description Log Location

Log for create and Logs are on the deployed machine at '~/var/tmp/vmware/provider/

install related events user defined script/$(ls -t ~/var/tmp/vmware/provider/user defined script/
| head -1)/".

Refer to the log.txt file for full logs. For detailed Puppet agent logs, refer to https://
puppet.com/docs/puppet/4.8/services_agent_unix.html#logging

Log for Puppet delete Logs are onthe PE at " ~/var/tmp/vmware/provider/user defined script/$(ls -t
and run related tasks ~/var/tmp/vmware/provider/user defined script/ | head -1)/. Refertothe
log.txt file for full logs.

Procedure

1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Select Puppet.

3 Enter the required information on the Puppet configuration page.

For Puppet integration to work properly, the provided credentials must be valid for both the
SSH and the API account. Also, the specified OS and application user accounts must have the
same username and password.

4 Click Validate to check the integration.
5 Click Add.

Results

Puppet is available for use with cloud templates.

What to do next
Add Puppet components to the desired cloud templates.

1 Under Cloud Templates in Cloud Assembly, select Puppet under the Content Management
heading on the cloud template menu and drag the Puppet component to the canvas.

2 Enter Puppet Properties on the pane to the right.
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Property Description

Master Enter the name of the Puppet primary machine used
with this cloud template.

Environment Select the environment for the Puppet primary machine.

Role Select the Puppet role to be used with this cloud
template.

Agent Run Interval The frequency at which you want the Puppet agent

to poll the Puppet primary machine for configuration
details to be applied to deployed virtual machines
related to this cloud template.

3 Click the Code tab on the right pane to view the YAML code for the Puppet configuration
properties.

When you add a Puppet component to a cloud template, you can add the installMaster property
to the YAML file to point to a Puppet install master, also known as a compile master. The value

of this property can be the IP address or the hostname of the Puppet compile master. Using this
property provides access to enhanced capabilities for deployed Puppet virtual machines and also
supports additional day two actions.

Puppet_ Agent:

type: Cloud.Puppet

properties:
account: PEIntegrationAccount
environment: production
role: 'role::linux webserver'
host: '${CentOS-Puppet.*}"'
username: root
password: passwordl23!
installMaster: my-pe-compile-master.example.com
agentConfiguration:

certName: '${CentOS-Puppet.address}'

osType: linux

count: 1

Note Though the user defined here is root, the cloud template can be configured with any user
that is included in the sudoers list.

In some cases, vRealize Automation passes some machine related information to Puppet virtual
machines as facts by default. Custom facts are not supported for Windows machines. On Linux
machines some information is passed by default, and users can pass additional information using
custom properties.

There are some limitations on what is passed to Puppet machines under Linux. Custom properties
on host resources and on the Puppet agent are passed to Puppet virtual machines. Custom
properties on network resources are not passed to the virtual machine. Items passed include
simple properties, boolean properties as well as custom named and complex types such as nested
maps with arrays.
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The following example shows how various custom resources can be called on host resources:

resources:
Puppet-Host:
type: Cloud.AWS.EC2.Instance
properties:
customer specified property on ec2 resource: "property"

customer specified property on network resource that should also be a fact and is boolean:
true
CustomerNameStuff: "zone A"
try map:
key: value
keytwo: value
nested array:
- one
- two
- true
try array:
- one
- two
-three:

inner_key: value

If a Puppet purge command results in errors, in most cases, vRealize Automation will ignore purge
errors for nodes and proceed with deletion of the node. Even if a certificate is not found for

a specific node, vRealize Automation will proceed with deletion. If vRealize Automation cannot
proceed with the node deletion for some reason, you can click Delete on the Deployments page
Actions menu to open a dialog that will enable you to proceed with the node deletion. A similar
workflow is executed when you remove a Puppet integration from a cloud template and then
apply the template to the deployment. This workflow triggers a node purge operation that is
handled as described above.

Integration with Puppet Enterprise requires a public IP address. If there is no public IP address
configured for the Puppet Enterprise machine, the IP address of the first NIC is used.

If the NIC of a Puppet provisioned machine running on a vSphere machine has multiple IP
addresses, you can use the primaryAddress YAML property in cloud templates to specify which
IP address to use for connections. When the primaryAddress property is assigned to a NIC, then
the IP address of this NIC is used by Puppet. Only one NIC can be designated as primary. See the
following YAML snippet for an example of how the primaryaAddress property is used.

BaseVM:

type: Cloud.vSphere.Machine

properties:
image: photon
count: 2
customizationSpec: Linux
cpuCount: 1
totalMemoryMB: 1024
networks:

- network: 'S${resource.dev.id}"'
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deviceIndex: 0

primaryAddress: true
assignment: static

- network: 'S${resource.prod.id}"
deviceIndex: 1

assignment: static

If the primaryAddress property is not set for any virtual machine NIC, the cloud template logic will
default to the current behavior for IP address selection.

Configure Ansible Open Source integration in Cloud Assembly

Cloud Assembly supports integration with Ansible Open Source configuration management. After
configuring integration, you can add Ansible components to new or existing deployments.

When you integrate Ansible Open Source with Cloud Assembly, you can configure it to run one
or more Ansible playbooks in a given order when a new machine is provisioned to automate
configuration management. You specify the desired playbooks in the cloud template for a
deployment.

When setting up an Ansible integration, you must specify the Ansible Open Source host machine
as well as the inventory file path that defines information for managing resources. In addition, you
must provide a name and password to access the Ansible Open Source instance. Later, when you
add an Ansible component to a deployment, you can update the connection to use key-based
authentication.

By default, Ansible uses ssh to connect to the physical machines. If you are using Windows
machines as specified in the cloud template with the osType Windows property, the
connection type variable is automatically set to winrm.

Initially, Ansible integration uses the user/password or user/key credentials provided in the
integration to connect to the Ansible Control Machine. Once the connection is successful, the
provided playbooks in the cloud template are validated for syntax.

If the validation is successful, then an execution folder is created on the Ansible Control
Machine at ~/var/tmp/vmware/provider/user defined script/. Thisis the location from
which scripts run to add the host to the inventory, create the host vars files including setting

up the authentication mode to connect to the host, and finally run the playbooks. At this point,
the credentials provided in the cloud template are used to connect to the host from the Ansible
Control Machine.

Ansible integration supports physical machines that do not use an IP address. For machines
provisioned on public clouds such as AWS, Azure, and GCP, the address property in the created
resource is populated with the machine's public IP address only when the machine is connected
to a public network. For machines not connected to a public network, the Ansible integration
looks for the IP address from the network attached to the machine. If there are multiple networks
attached, Ansible integration looks for the network with the least devicelndex; that is, the index
of the Network Interface Card (NIC) attached to the machine. If the devicelndex property is not
specified in the blueprint, the integration uses the first network attached.
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See What Is configuration management in Cloud Assembly for more details on configuring Ansible
Open Source for integration in Cloud Assembly.

Prerequisites

The Ansible control machine must use an Ansible version. See the vRealize Automation
Support Matrix for information about supported versions.

Ansible log verbosity must be set to default of zero.

The user must have read/write access to the directory where the Ansible inventory file is
located. In addition, the user must have read/write access to the inventory file, if it exists
already.

If you are using a non-root user with the sudo option, ensure that the following is set in the
sudoers file:

Defaults:user name !requiretty
and
username ALL=(ALL) NOPASSWD: ALL

Ensure that host key checking is deactivated by setting host key checking = False at /etc/
ansible/ansible.cfgor ~/.ansible.cfqg.

Ensure that the vault password is set by adding the following line to the /etc/ansible/
ansible.cfgor ~/.ansible.cfqg file:

vault password file = /path/to/password file

The vault password file contains the password in plain text and is used only when cloud
templates or deployments provide the username and password combination to use between
ACM and the node as show in the following example.

echo 'myStrOng9@88wOrd' > ~/.ansible vault password.txt

echo 'ANSIBLE VAULT PASSWORD FILE=~/.ansible vault password.txt' > ~/.profile

# Instead of this way, you can also set it setting

'vault password file=~/.ansible vault password.txt' in either /etc/ansible/ansible.cfg or
~/.ansible.cfg

To avoid host key failures while trying to run playbooks, it is recommended that you include
the following settings in /etc/ansible/ansible config.

[paramiko connection]

record host keys = False

[ssh_connection]
#ssh_args = -C -o ControlMaster=auto -o ControlPersist=60s
ssh_args = -o UserKnownHostsFile=/dev/null # If you already have any

options set for ssh args, just add the additional option shown here at the end.
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Procedure
1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Click Ansible.

The Ansible configuration page appears.

3 Enter the Hostname, Inventory File Path and other required information for the Ansible Open
Source instance.

4 Click Validate to check the integration.
5 Click Add.

Results

Ansible is available for use with cloud templates.

What to do next
Add Ansible components to the desired cloud templates.

1 On the cloud template canvas page, select Ansible under the Configuration Management
heading on the cloud template options menu and drag the Ansible component to the canvas.

2 Use the panel on the right to configure the appropriate Ansible properties such as specifying
the playbooks to run.

In Ansible, users can assign a variable to a single host, and then use it later in playbooks.
Ansible Open Source integration enables you to specify these host variable in cloud templates.
The hostvariables property must be in proper YAML format, as expected by the Ansible control
machine, and this content will be placed at the following location:

parent directory of inventory file/host vars/host ip address/vra user host vars.yml

The default location of the Ansible inventory file is defined in the Ansible account as added on the
Integrations page in Cloud Assembly. The Ansible integration will not validate the hostvariable
YAML syntax in the cloud template, but the Ansible Control Machine will throw an error when you
run a playbook in the case of incorrect format or syntax.

The following cloud template YAML snippet shows an example useage of the hostvariables
property.

Cloud Ansible 1:

type: Cloud.Ansible

properties:
host: 'S${resource.AnsibleLinuxVM.*}'
osType: linux
account: ansible-CAVA
username: ${input.username}
password: ${input.password}
maxConnectionRetries: 20
groups:

- linux vms
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playbooks:
provision:
- /root/ansible-playbooks/install web server.yml
hostVariables: |
message: Hello ${env.requestedBy}

project: ${env.projectName}

Ansible integrations expect authentication credentials to be present in a cloud template in one of
the following ways:

m  User name and password in the Ansible resource.
m  User name and privateKeyFile in the Ansible resource.

= Username in Ansible resource and privatekey in the compute resource by specifying
remoteAccess to generatedPublicPrivateKey.

When you create an Ansible Open Source integration, you must provide login information for the
integration user to connect with the Ansible control machine using SSH. To run playbooks with an
integration, you can specify a different user in the integration YAML code. The username property
is mandatory and required to connect to the virtual machine where Ansible will make changes.
The playbookRunUsername property is optional and can be provided to execute the playbook on
the Ansible node. The default value of playbookRunUsername is the Ansible endpoint integration
username.

If you specify a different user, that user should have write access to the Ansible hosts file and
should have permission to create private key files.

When you add an Ansible Open Source tile to a cloud template, vRealize Automation creates

the host entry for the attached virtual machine. By default, vRealize Automation will use the
virtual machine’s resource name to create the host entry, but you can specify any name using the
hostName property in the blueprint YAML. In order to communicate with the machine, vRealize
Automation will create the host variable ansible host: IP Address for the host entry. You

can override the default behaviour to configure communication using FQDN, by specifying the
keyword ansible host under hostvariables and providing FQDN as its value. The following
YAML code snippet shows an example of how hostname and FQDN communication can be
configured:

Cloud Ansible:
type: Cloud Ansible
properties:
osType: linux
username: ubuntu
groups:
- sample
hostName: resource name
host: name of host
account: name of account
hostVariables:
ansible host:Host FQDN
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In this example you override the default ansible host value by providing the FQDN. This may be
useful for users who want Ansible Open Souce to connect to the host machine using the FQDN.

The default value of hostvariables in the YAML will be ansible host:IP address and the IP
address is used to communicate with the server.

If the YAML count property is more than 1 for Ansible Open Source, the hostname could be
mapped to any of the respective virtual machine's properties.The following example shows
mapping for a virtual machine resource named Ubuntu-VM if we want its address property to
be mapped to the hostname.

hostname: '${resource.Ubuntu-VM.address[count.index]}"

In cloud templates, ensure that the path to the Ansible playbook is accessible to the user specified
in the integration account. You can use an absolute path to specify the playbook location, but it

is not necessary. An absolute path to the user's home folder is recommended so that the path
remains valid even if the Ansible integration credentials change over time.

Configure Ansible Tower Integration in Cloud Assembly

You can integrate Ansible Tower with Cloud Assembly to support configuration management of
deployed resources. After configuring integration, you can add Ansible Tower virtual components
to new or existing deployments from the cloud template editor.

Prerequisites

m  Grant non-administrator users the appropriate permissions to access Ansible Tower. There are
two options that work for most configurations. Choose the one that is most appropriate for
your configuration.

m  Grant users Inventory Administrator and Job Template Administrator roles at the
organization level.

m  Grant users Administrator permission for a particular inventory and the Execute role for all
job templates used for provisioning.

m  You must configure the appropriate credentials and templates in Ansible Tower for use with
your deployments. Templates can be job templates or workflow templates. Job templates
define the inventory and playbook for use with a deployment. There is a 1:1 mapping between
a job template and a playbook. Playbooks use a YAML-like syntax to define tasks that are
associated with the template. For most typical deployments, use machine credentials for
authentication.

Workflow templates enable users to create sequences consisting of any combination of job
templates, project syncs, and inventory syncs that are linked together so that you can execute
them as a single unit. The Ansible Tower Workflow Visualizer helps users to design workflow
templates. For most typical deployments, you can use machine credentials for authentication.

a Loginto Ansible Tower and navigate to the Templates section.
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b Select Adding a new job template.

m  Select the credential that you already created. These are the credentials of the machine
to be managed by Ansible Tower. For each job template, there can be one credential
object.

m  For the Limit selection, select Prompt on Launch. This ensures that the job template
runs against the node being provisioned or de-provisioned from Cloud Assembly. If
this option is not selected, a Limit is not set error will appear when the blueprint that
contains the job template is deployed.

c Select Adding a new workflow template.

m  Select the credentials that you already created and then define the inventory. Using
Workflow Visualizer, design the workflow template.

For the Limit box of workflow or job templates, generally you can select Prompt on
Launch. This selection ensures that the job or workflow template runs against the node
being provisioned or de-provisioned from Cloud Assembly.

m  You can view the execution of the Job templates or workflow templates invoked from Cloud
Assembly on the Ansible Tower Jobs tab .

Procedure
1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Click Ansible Tower.

The Ansible configuration page appears.

3 Enter the Hosthame, which can be an IP address, and other required information for the
Ansible Tower instance.

4 Enter the Ul-based authentication Username and Password for the applicable Ansible Tower
instance.

5 Click Validate to verify the integration.
6 Type an appropriate Name and Description for the integration.

7 Click Add.

Results

Ansible Tower is available for use in cloud templates.

What to do next

Add Ansible Tower components to the desired cloud templates. You must specify the applicable
job template with execute permission for the user specified in the integration account.

1 Onthe cloud template canvas page, select Ansible under the Configuration Management
heading on the blueprint options menu and drag the Ansible Tower component to the canvas.
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2 Use the panel on the right to configure the appropriate Ansible Tower properties such as job
templates.

When you add an Ansible Tower tile to a cloud template, vRealize Automation creates the host
entry for the attached virtual machine in the Ansible Tower. By default, vRealize Automation

will use the virtual machine’s resource name to create the host entry, but you can specify any
name using the hostName property in the blueprint YAML. In order to communicate with the
machine, vRealize Automation will create the host variable ansible host: IP Address for the
host entry. You can override the default behaviour to configure communication using FQDN, by
specifying the keyword ansible host under hostvariables and providing FQDN as its value. The
following YAML code snippet shows an example of how hostname and FQDN communication can
be configured:

Cloud_Ansible Tower_ 1:

type: Cloud Ansible Tower

properties:
host: name of host
account: name of account
hostName: resource name
hostVariables:

ansible host:Host FQDN

In this example you override the default ansible host value by providing the FQDN. This may be
useful for users who want Ansible Tower to connect to the host machine using the FQDN.

The default value of hostvariables in the YAML will be ansible host:IP _address and the IP
address is used to communicate with the server.

If the YAML count property is more than 1 for Ansible Tower, the hostname could be mapped

to any of the respective virtual machine's properties.The following example shows mapping for a
virtual machine resource named Ubuntu-VM if we want its address property to be mapped to the
hostname.

hostname: 'S${resource.Ubuntu-VM.address[count.index]}"'

When you add an Ansible Tower component to a cloud template, and you can specify the job
template to call in the cloud template YAML. You can also specify workflow templates or a
combination of job templates and workflow templates. If you don't specify the template type,
by default vRealize Automation assumes that you are calling a job template.

The following YAML snippet shows an example of how a combination of job and workflow
templates can be called in an Ansible Tower cloud template.

Cloud Ansible 1:
type: Cloud.Ansible.Tower
properties:
host: ‘${resource.CentOS Machine.*}’
account:
maxConnectionRetries: 2

maxJobRetries: 2
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templates:
provision:
- name: My workflow
type: workflow
- name: My job template

We added the maxConnectionsRetries and maxJobRetries to handle Ansible related failures. The
cloud templates accepts the custom value and, in case no value is provided, it uses the default
value. For maxConnectionRetries, the default value is 10, and for maxJobRetries the default value
is 3.

Note Earlier versions of vRealize Automation supported the execution of job templates only
using the jobTemplate schema in the cloud template. jobTemplate is now deprecated and might
be removed in future releases. For now, using the jobTemplate property will continue to work as
expected. To run workflow templates and use additional features, it is recommended to use the
templates schema.

Cloud Assembly cloud templates for Ansible Tower integrations include the usebefaultLimit
property with a true or false value to define where Ansible templates are executed. Ansible
templates can be job templates or workflow templates. If this value is set to true, the specified
templates are run against the machine specified in the Limit box on the Ansible Templates page.
If the value is set to false, the templates are run against the provisioned machine, but users
should check the Prompt on Launch checkbox on the Ansible Tower Templates page. By default,
the value of this property is false. The following YAML example shows how the useDefaultLimit
property appears in cloud templates.

templates:
provision:
- name: ping aws_credentials
type: job
useDefaultLimit: false

extraVars: '{"rubiconSurveyJob" : "checkSurvey"}'

In addition, as the preceding example shows, you can use the extravars property to specify extra
variables or survey variables. This capability can be useful for running templates that require input.
If a user has maintained the survey variable, then you must pass the variable in the extravars
section of the cloud template to avoid errors.

Create a SaltStack Config integration in vRealize Automation

You can create a SaltStack Config integration to access the SaltStack Config service and use
SaltStack Config objects and actions in vRealize Automation.

With vRealize Automation SaltStack Config, you can provision, configure, and deploy software
to your virtual machines at any scale using event-driven automation. You can also use SaltStack
Config to define and enforce optimal, compliant software states across your entire environment.
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Installation

Before integrating SaltStack Config with vRealize Automation, you must first install it in your
environment. See Installing and Configuring SaltStack Config for more information.
Considerations

Integrated vRealize Automation SaltStack Config is available for vRealize Automation with the
following conditions:

m  The SaltStack Config integration is associated to a specific host during install.
= VRealize Automation does not support multi-tenancy for SaltStack Config currently.

m  The vRealize Automation tenant can support one SaltStack Config integration and one Salt
master. The Salt master can support multiple minions.

m Before you can delete a SaltStack Config integration in vRealize Automation, you must delete
any existing deployments that use the SaltStack Config integration.
Prerequisites

m  Verify that you have vRealize Automation administrator credentials and SaltStack Config
administrator credentials (root level access).

You need vRealize Automation administrator credentials and SaltStack Config administrator
credentials (root level access) to create a SaltStack Config integration.

You also need SaltStack Config administrator credentials to open and work in the SaltStack
Config service itself.

You use vRealize Automation credentials to access vRealize Automation and SaltStack Config
credentials to access SaltStack Config.

For information about SaltStack Config administrator credentials, see the Installing and
Configuring SaltStack Config guide.

m  Verify that the SaltStack Config service is installed.

m  Verify that the Salt master to be used in the SaltStack Config integration contains the Master
Plugin.

m  Verify that you have the SaltStack Config service administrator role in vRealize Automation.
See What are the vRealize Automation user roles.

m  Verify that you have the Cloud Assembly service administrator role in vRealize Automation.

See Organization and service user roles in vRealize Automation.

Configure a SaltStack Config integration in vRealize Automation

After you install SaltStack Config for vRealize Automation, you can configure the integration in
Cloud Assembly.

1 In Cloud Assembly, select Infrastructure > Connections > Integrations, and click Add
Integration.
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2 Select the SaltStack Config integration type.

Fritz Arbeiter
&, CAVA-216-121-242

vmw vRealize Automation - Cloud Assembly

Resources Design Infrastructure Extensibility Tenant Management Migration J 6L

«
Integration Types

& Administration v Select an integration type.
Projects

Users and Groups

= G b " | () v

Custom Names Active Directory Ansible Ansible Tower Bitbucket GitHub GitLab
Secrets
& Configure v
Cloud Zones
Virtual Private Zones N
puppet S N & v
1PAM Puppet Red Hat Openshift saltstack SDDC Manager Terraform Runtime

Flavor Mappings
Image Mappings

Network Profiles

3  Complete the form.

vmw VRealize Automation - Cloud Assembly

Resources Design Infrastructure Extensibility Tenant Management Migration

«
Terraform Versions o G:) NeW |I’1teg I’ation

Tags Name *
® Onboarding
Description
@ Resources v 4
Compute .
SaltStack Integration
Networks
Hostname *
Security
Storage Running environment Q,_ Search for running environment
Kubernetes .
Username
Activity v
Password *
Requests
Events Log
& Connections v

Cloud Accounts CANCEL

Integrations

a Enter a name for the integration.

(o}

(Optional) Provide a description for the integration.

c Enter the hostname for the SaltStack Config server.

o

Specify the running environment for the SaltStack Config integration.

If you're using the saltConfiguration property to deploy minions and apply state files on
your virtual machines, you don't need to configure a running environment. However, it is
recommended that you update your cloud templates to use the SaltStack Config resource.
The saltConfiguration property will be deprecated in a future release.
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If you are using the SaltStack Config resource to deploy minions and apply state files on
your virtual machines, select the embedded-ABX-onprem running environment.

e Enter the SaltStack Config administrator user name and password used to access the
specified host.

f  Click Validate to confirm your administrator access to the SaltStack Config integration
host.

If validation fails, make sure you entered the correct hostname, user name, and password.

g Click Save.

Access your SaltStack Config integration

After you save the SaltStack Config integration point, you can open the SaltStack Config
integration service.

1

If you deployed SaltStack Config through vRealize Suite Lifecycle Manager, you can click on
the service tile from the vRealize Automation Service Console to open the integration and
access the host.

vmw vRealize Automation - Cloud Services Console

BB Services PY
Get up and running fast. Quickstart will help you set up your on-prem SDDC [ &

& Identity & Access Management v for provisioning with vRealize Automation, populate the self-service catalog

and deploy your first cloud template.

« For vRealize Automation 8 @ .
—
—

Active Users

Enterprise Groups Time to complete: Approx. 10 minutes

Branding 0 of 5 steps completed
My Services
(80 Cloud Assembly O}> Code Stream
@)o Orchestrator [}, SaltStack Config
8 Service Broker ® VRA Migration Assistant

If you did a stand-alone install of SaltStack Config, you can access the service using your
SaltStack Config hostname.

When prompted to log in to SaltStack Config, enter your SaltStack Config administrator user
name and password.

If you need to make any changes to the integration, select Infrastructure > Connections >
Integrations, select the available SaltStack Config integration tile, and click Open.
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vmw vRealize Automation - Cloud Assembly

Resources  Design  Infrastructure  Extensibility — TenantManagement  Migration

«

Flavor Mappings - |ﬂt69raﬂons

Network Profiles
Storage Profiles r/\{:,/w embedded-VRO @ SaltStack Config
Cluster Plans
Identifier hitps /fcava-216-122-87.eng vmwa Identifier cava-6-242-211.eng vmware com
Pricing Cards

Terraform Versions

Tags

@

® Onboarding

Resources v

Compute OPEN OPEN

Networks

Security

The hostname cannot be changed after you configure the integration. You can only edit the name,
description, running environment, and credentials for the integration.

vmw VRealize Automation - Cloud Assembly

Resources Design Infrastructure Extensibility Tenant Management Migration
L
Terraform Versions - G: Sa|t5taCk COI"IfIg DELETE
s Name * SaltStack Config

® Onboarding

Description
@ Resources v 4
Compute .
SaltStack Integration
Networks
Hostname *
Security
Storage Running environment Q_ & embedded-ABX-onprem
= Username * root
Activity v
Password *
Requests
Events Log @ Validate credentials before making X
changes.
& Connections v

Cloud Accounts
CANCEL

Integrations

Learn how to use SaltStack Config

SaltStack Config is a stand-alone product that you can integrate with and use in vRealize
Automation.

= Learn how to add the SaltStack Config resource to install minions on virtual machines in your
Cloud Assembly deployments.

m  Learn how to deploy minions using the API (RaaS) in a Linux or Windows environment.
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How do | create an Active Directory integration in Cloud Assembly

Cloud Assembly supports integration with Active Directory servers to provide out of the box
creation of computer accounts in a specified Organizational Unit (OU) within an Active Directory
server prior to provisioning a virtual machine. Active Directory supports an LDAP connection to
the Active Directory server.

An Active Directory policy that is associated with a project is applied to all virtual machines
provisioned within the scope of that project. Users can specify one or more tags to selectively
apply the policy to virtual machines that are provisioned to the cloud zones with matching
capability tags.

For on-premises deployments, Active Directory integration enables you to set up a health check
feature that shows the status of the integration and the underlying ABX integration on which

it relies, including the required extensibility cloud proxy. Prior to applying an Active Directory
policy, Cloud Assembly checks the status of the underlying integrations. If the integration is
healthy, Cloud Assembly creates the deployed computer objects in the specified Active Directory.
If the integration is unhealthy, the deploy operation skips the Active Directory phase during
provisioning.

Prerequisites

m Active Directory integration requires an LDAP connection to the Active Directory server.

m |f you are configuring an Active Directory integration with vCenter on-premises, you must
configure an ABX integration with an extensibility cloud proxy. Select Extensibility > Activity >
Integrations and choose Extensibility Actions On Prem.

m [f you are configuring an integration with Active Directory in the cloud, you must have a
Microsoft Azure or Amazon Web Services account.

m  You must have a project configured with appropriate cloud zones, and image and flavor
mappings to use with the Active Directory integration.

m  The desired OU on your Active Directory must be pre-created before you associated your
Active Directory integration with a project.

Procedure

1 Select Infrastructure > Connections > Integrations and then New Integration.

2 Click Active Directory.

3 Onthe Summary tab, enter the appropriate LDAP host and environment names.

The specified LDAP host is used to validate the Active Directory integration, and it is also used
for subsequent deployments if no alternative hosts are specified and invoked due to errors or
unavailability.

4 Enter the name and password for the LDAP server.
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Enter the appropriate Base DN that specifies the root for the desired Active Directory
resources.

Note You can specify only one DN per Active Directory integration.

Click Validate to ensure that the integration is functional.

Enter a Name and Description of this integration.

Click Save.

Click the Project tab to add a project to the Active Directory integration.

On the Add Projects dialog, you must select a project name and a relative DN, which is a DN
that exists within the Base DN specified on the Summary tab.

Under the Extended Options selection, provide a comma separated list of Alternate Hosts that
will be used if the initially selected server is unavailable during deployment. The primary server
is always used for initial validation of the integration.

Note If the format of the primary host is LDAP, LDAPS is not supported for alternative hosts.

Enter the time in seconds to wait for the initial server to respond before trying an alternate
server in the Connection Timeout box.

Click Save.

Results

You can now associate the project with Active Directory integration to a cloud template. When a
machine is provisioned using this cloud template, it is pre-staged in the specified Active Directory
and Organizational Unit.

Initially, Active Directory integrations are deployed to a default OU with little user restrictions.
The OU is set by default when you map an Active Directory integration to a project. You can
add a property called FinalRelativeDN to blueprints to change the OU for Active Directory

deployments. This property enables you to specify the OU to use with an Active Directory
deployment.

formatVersion: 1

inputs: {}

resources:

Cloud vSphere Machine 1:
type: Cloud.vSphere.Machine
properties:
image: CenOS8
flavor: tiny
activeDirectory:
finalRelativeDN: ou=test

securityGroup: TestSecurityGroup
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As shown in the preceding YAML example, users can add a property to an Active Directory
integration deployment that adds a computer account to the security group so that appropriate
permissions are assigned to access the shared resource over a network. The Active Directory
virtual machine is initially deployed to a fixed OU but when the machine is ready to release, it is
moved to a different OU with the appropriate policy as applicable for users.

If a computer acount is moved to a different OU after deployment, Cloud Assembly attemts to
delete the accounts on the initial OU. Deletion of computer accounts succeeds only in the case of
virtual machines moved to a different OU within the same domain.

You can also implement a tag-based health check for on-premises Active Directory integrations as
follows.

1 Create an Active Directory integration as described in the preceding steps.
2 Click the Project tab to add a project to the Active Directory integration.

3 Select a project name and a relative DN on the Add Projects dialog. The relative DN must exist
within the specified base DN.

There are two switches on this dialog that enable you to control Active Directory configuration
from cloud templates. Both switches are off by default.

m  Override - This switch enables you to override Active Directory properties, specifically the
relative DN in cloud templates. When switched on, you can change the OU specified in
the relativeDN property in the cloud template. When provisioned the machine will be
added to the OU specified in the relativeDN property in the cloud template. The following
example shows the cloud template hierarchy in which this property appears.

activeDirectory:

relativeDN: OU=ad integration machine override

= |gnore - This switch enables you to ignore the Active Directory configuration for
the project. When switched on, it adds a property to the cloud template called
ignoreActiveDirectory for the associated virtual machine. When this property is set to
true means that the machine is not added to the Active Directory when deployed.

4 Add appropriate tags. These tags are applicable to the cloud zone to which the Active
Directory policy may apply.

5 Click Save.

The Status of the Active Directory integration is displayed for each integration on the
Infrastructure > Connections > Integrations page in Cloud Assembly.

You can associate the project with Active Directory integration with a cloud template. When a
machine is provisioned using this template, it is pre-staged in the specified Active Directory and
Ou.
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Configure a VMware SDDC Manager integration

You can add a VMware SDDC Manager integration to vRealize Automation to facilitate using
workload domains as part of VMware Cloud Foundation (VCF) cloud accounts within vRealize
Automation.

Prerequisites

m  VRealize Automation supports integration only with VMware SDDC manager 4.1 and newer.

Procedure
1 Select Infrastructure > Connections > Integrations and click Add Integration.
2 Select SDDC Manager.
The SDDC Manager integration configuration page appears.
3 Inthe Summary section, enter a Name and Description for the integration.

4 Inthe SDDC Manager Credentials section, enter the SDDC Mgr IP address/FQDN for the
SDDC Manager server machine.

5 Enter the Username and Password for the admin account to be used to initially connect to the
SDDC Manager. As a best practice, avoid using the administrator account to connect. Use a
different account that has admin privileges in SDDC Manager to create service roles.

These credentials are used to initially set up the connection to the SDDC Manager, and then
service credentials are created to use when connecting from a VCF cloud account.

6 Click Validate to verify the connection to the SDDC Manager.
7 Click Add.

Results

After the integration is created, you can view workloads associated with the SDDC on the
Workload Domain tab that appears on the completed integration page. Also, you can view and
select workloads associated with the integration and then click the Add Cloud Account button to
open a page for creating a VCF cloud account that will use the selected workload.

What to do next

After you configure the VCF cloud account, a Setup Cloud button appears at the top of the page.
Click this button to initiate the VCF cloud setup wizard.

Integrating with vRealize Operations Manager

vRealize Automation can work with vRealize Operations Manager to perform advanced workload
placement, provide deployment health and virtual machine metrics, and display pricing.
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Number and type of integrations

Integration between the two products must be on-premises to on-premises, not a mix of on-
premises and cloud.

You can integrate one vRealize Automation instance with multiple vRealize Operations Manager
instances, but a vRealize Operations Manager instance can only be connected to one vRealize
Automation instance.

You cannot connect an aggregated vRealize Operations Manager cluster to vRealize Automation.

Basic requirements for integration

To integrate with vRealize Operations Manager, go to Infrastructure > Connections >
Integrations. To add the integration, you need the vRealize Operations Manager URL and
credentials for the login account described in the next section. In addition, vRealize Automation
and vRealize Operations Manager need to manage the same vSphere endpoint.

Login account for integration

In vRealize Operations Manager, you need a local or non-local vRealize Operations Manager
login account for the integration to use. The account requires read-only privileges to

the vCenter adapter instance for the vSphere endpoint. Note that a non-local account

might need to be imported in vRealize Operations Manager and have its read-only

role assigned. For the integration, the username format for non-local account login

is username@ domain@ authenticated-source, such as jdoe@company.com@workspaceone.
Authenticated sources are defined during vRealize Operations Manager server initial setup.

See the following sections for details. For pricing information, see How to use Pricing Cards in
vRealize Automation.

Advanced workload placement using vRealize Operations Manager

VRealize Automation and vRealize Operations Manager can work together to optimally place
deployment workloads.

You enable workload placement at the vSphere based cloud zone level. Only Distributed Resource
Scheduler (DRS) enabled clusters of a cloud zone are eligible for advanced placement using
vRealize Operations Manager.

m  VRealize Automation placement—The vRealize Automation placement engine is application
intent based. It considers tag-based constraints, project membership and the associated cloud
zones, and affinity filters related to network, storage, and compute. Resource placement
depends on all of these factors plus the presence of other, related target resources in the
same deployment.

m  VRealize Operations Manager placement—vRealize Operations Manager considers operational
intent for optimal placement. Operational intent can take past workloads and future, what-if
predictions into account.
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When using advanced workload placement, you must apply vRealize Automation tagging
in order to implement business intent decisions, instead of using the vRealize Operations
Manager business intent options.

When integrating with vRealize Operations Manager, vRealize Automation continues to follow
its application intent model and its related constraints to filter for target placement. Then, from
within those results, it uses the vRealize Operations Manager recommendation to further refine

placement.

In the absence of a recommendation

If you enable advanced workload placement, and vRealize Operations Manager analysis returns no
recommendations, you may configure vRealize Automation to fall back to its default, application
intent placement.

Limitations on workload placement

Certain limitations apply when using vRealize Operations Manager to place workloads.

VRealize Operations Manager does not support workload placement on resource pools in
vCenter Server.

If vRealize Operations Manager is down, the timeout used for workload placement to call
vRealize Operations Manager might expire.

Placement doesn't cross multiple cloud zones. vRealize Automation sends one cloud zone to
vRealize Operations Manager for placement recommendations within that single cloud zone.

How to enable workload placement

To enable workload placement, there are steps to take for vSphere, vRealize Operations Manager,
and vRealize Automation.

1

In Cloud Assembly, connect to your vCenter Server cloud account.

The options are under Infrastructure > Connections > Cloud Accounts.

In vCenter Server, verify that DRS enabled clusters exist and are set to fully automated.
In vRealize Operations Manager, verify that the same vCenter Server is being managed.
You need vRealize Operations Manager 8 or later.

In Cloud Assembly, add the vRealize Operations Manager integration.

The options are under Infrastructure > Connections > Integrations.

To add the integration, you need the vRealize Operations Manager primary node URL below,
plus the login username and password.

https://operations-manager-I/P-address-or-FQDN/suite-api
After entering the values, click VALIDATE.

Synchronize the integration to the vCenter Server by clicking SYNC.
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Also synchronize any time that Cloud Assembly and vRealize Operations Manager begin
managing a new vCenter Server.

6 In Cloud Assembly, create a cloud zone for the vCenter Server account.
The options are under Infrastructure > Configure > Cloud Zones.
7 Under the cloud zone Summary tab, set the Placement Policy to ADVANCED.
8 Under the Placement Policy, select whether to have vRealize Automation fall back to its default

placement if vRealize Operations Manager returns no recommendations.

Troubleshooting workload placement

If vRealize Operations Manager isn't recommending workload placements the way that you
expect, review the deployment request details in Cloud Assembly or vRealize Automation Service
Broker.

1 Go to Infrastructure > Activity > Requests, and click the request.
2 In Request Details, look at the allocation phases.

Look for targets that were successfully or unsuccessfully identified.
3 In Request Details, at the upper right, enable Dev Mode.
4 Follow the request path to locate filter blocks.

5 Click a filter block, and review the following section.

filterName: ComputePlacementPolicyAffinityHostFilter
VvV computeLinksBefore
VvV computeLinksAfter

Vv filteredOutHostsReasons

Entry Description

computelinksBefore List of potential placement hosts based on vRealize Automation algorithms.
computelLinksAfter Selected placement host.

filteredOutHostsReasons Messages describing why a host was selected or rejected.

When vRealize Operations Manager selects the host, the following message appears.

advance policy filter: Filtered hosts based on recommendation from vROPS.

Learn more about workload placement

To find the best infrastructure on which to place a deployment, vRealize Automation makes several
filtering decisions. vRealize Automation integration with vRealize Operations Manager may further
refine the placement decision.

vRealize Operations Manager can help to optimally place workloads provided that you have
enabled the Advanced placement policy option in your vSphere based cloud zones.
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In addition, the vSphere cloud accounts for the cloud zones must be monitored by vRealize
Operations Manager.

Phase 1: Reservation

Note Although the name is the same, reservation isn't related to the vRealize Automation 7
reservation feature.

The vRealize Automation reservation phase is the same whether or not you enable Advanced
placement with vRealize Operations Manager.
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1 Reservation starts with a cloud template linked to a project. That project is in turn linked to
cloud zones.

2 The cloud zones consist of compute resource hosts, pools, and clusters, and attached storage.
Initially, any cloud zone in the project may be a potential placement target.

3 vRealize Automation filters out cloud zones that don't have enough healthy resources for the
deployment.

For example, if too many resources are powered off or in maintenance, that cloud zone is
filtered out.

4 vRealize Automation filters out cloud zones that can't meet business requirements.
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For example, the deployment might exceed a pricing or budget limit for the zone.

5 vRealize Automation filters out cloud zones that can't meet cluster requirements.

For example, the cloud zone resources might have CPU or memory usage limits that are too

low for the deployment.

6 VRealize Automation filters out cloud zones that have no affinity with application constraints.

Affinity requires that cloud template or project-level constraint tags match capability tags
found somewhere in the cloud zone resources.

For example, if the cloud template or project includes a storage constraint to use storage

tagged pci, a cloud zone where none of the storage resources have that capability tag would

be filtered out.
7 VRealize Automation selects cloud zones with the best provisioning priority.

8 If the project-level placement policy is something other than Default, vRealize Automation
selects a cloud zone that supports the non-default placement policy.

In this release, Spread is the only non-default. Spread distributes the load by selecting the

cloud zone with the lower ratio of virtual machines to hosts. Default simply deploys to the first

available zone.

The project placement policy is only a factor during the cloud zone reservation phase. It has no

effect on, nor relation to, the cloud zone placement policy in the allocation phase.

When finished, the reservation phase selects one cloud zone and its resources. vRealize
Automation reserves the first available zone that remains qualified after passing the preceding
filters.

Phase 2: Allocation

VRealize Automation inspects the reserved cloud zone compute resources and linked storage.
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Reserved Cloud Zone Resources
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Recommended DRS
Allocated enabled cluster and
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and Storage .

Within the cloud zone, vRealize Automation filters out resources that are in a maintenance or
powered-off state.

Note that there are still enough healthy resources for the deployment. Otherwise, the entire
cloud zone would have been filtered out during the reservation phase.

vRealize Automation filters out resources that don't match cluster-level constraints found in
the cloud template or project.

For example, a resource in the cloud zone might be tagged test under Infrastructure >
Resources > Compute.

If the cloud template or project includes a constraint tag to use a dev resource, the test
resource is filtered out.

In addition, storage or network profiles in the cloud zone might be tagged in ways that don't
match cluster-level storage or network constraints in the cloud template or project.

vRealize Automation filters out resources based on affinity settings that are defined in vCenter.

For example, there might be a rule in vCenter where the presence of a virtual machine in one
cluster might block another cluster from being used.

VRealize Automation filters out resources that don't match any remaining custom constraints
found in the cloud template or project.

For example, if the cloud template includes a constraint to use a ubuntu tagged image, a cloud
zone where none of the image mappings are tagged ubuntu would be filtered out.
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5 vRealize Automation looks for the best possible compute and storage according to the cloud
zone placement policy.

vRealize Automation engages vRealize Operations Manager only when the following two
conditions are true:

m  The cloud zone placement policy is set to Advanced.

m  After filtering through step 4, at least one DRS enabled cluster and the storage linked to it
remain qualified.

Otherwise, vRealize Automation proceeds with its own placement algorithm without input from
vRealize Operations Manager.

vRealize Operations Manager placement recommendation

If qualified for input from vRealize Operations Manager, vRealize Automation contacts vRealize
Operations Manager for a recommendation of the best possible compute and storage for the
deployment. vRealize Automation sends the following data to vRealize Operations Manager:

m  The qualified target DRS enabled clusters and their attached datastores or datastore cluster
m  The resource count or cluster size of the deployment

s CPU and memory requirements for the virtual machines in the deployment

m  Disk requirements for the virtual machines in the deployment

From the qualified targets, if vRealize Operations Manager can return an optimal placement for
each of the virtual machines, vRealize Automation allocates compute and storage according to the
vRealize Operations Manager recommendation.

For more about how vRealize Operations Manager handles workloads, see the vRealize
Operations documentation.

If vRealize Operations Manager couldn't find a recommendation, or vRealize Automation couldn't
find any DRS enabled cluster and storage, vRealize Automation checks the fallback setting of the
cloud zone:

= With Fallback

VRealize Automation allocates compute and storage that remains qualified even without a
vRealize Operations Manager recommendation.

= Without Fallback
vRealize Automation cancels the request and does not proceed with provisioning.
Phase 3: Provisioning

VRealize Automation deploys the requested virtual machines, storage, and network through the
adapter for the placement target selected at the end of the allocation phase.

The placement target consists of compute hosts, clusters, or resource pools, and attached storage
datastore or datastore cluster.
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Continuous optimization using vRealize Operations Manager

When you add the vRealize Automation adapter in vRealize Operations Manager, vRealize
Operations Manager automatically creates a new custom datacenter (CDC) for vRealize
Automation based workloads.

With continuous optimization, you take advantage of workload rebalancing and relocation, and
use vRealize Automation with vRealize Operations Manager beyond initial workload placement.
As virtualization resources move or come under heavier or lighter load, vRealize Automation
provisioned workloads can move as needed.

= Continuous optimization automatically creates a new CDC in vRealize Operations Manager.
There is one new CDC for each vRealize Automation vSphere cloud zone.
m  The newly created CDC contains every vRealize Automation managed cluster associated with

the cloud zone.

Note Do not manually create a mixed CDC of vRealize Automation and non-vRealize
Automation clusters.

m  You use VRealize Operations Manager to run continuous optimization for the newly created
VvRealize Automation based CDC.

m  Workloads can only be rebalanced or relocated within the same cloud zone or CDC.

m  Optimization never creates a new vRealize Automation or vRealize Operations Manager
placement violation.

m |f you have existing placement violations, optimization can fix vRealize Operations Manager
operational intent issues.

m |If you have existing placement violations, optimization cannot fix vRealize Operations
Manager business intent issues.

For example, if you used vRealize Operations Manager to manually move a virtual machine
to a cluster that doesn't support your constraints, vRealize Operations Manager doesn't
detect a violation nor try to resolve it.

m  This release obeys operational intent at the CDC level. All member vRealize Automation
clusters are optimized to the same settings.

To set a different operational intent for clusters, you must configure them in separate vRealize
Automation CDCs, associated with separate vSphere cloud zones. Having different test and
production clusters might be one example situation.

m  VRealize Automation application intent and the constraints defined in vRealize Automation are
honored during any optimization rebalance or relocation operations.

m  VRealize Operations Manager placement tags cannot be applied to vRealize Automation
provisioned workloads.
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In addition, scheduled optimization involving multiple machines is supported. Regularly scheduled
optimizations are not all-or-nothing processes. If conditions interrupt machine movement,
successfully relocated machines stay relocated, and the next vRealize Operations Manager cycle
attempts to relocate the remainder as is usual for vRealize Operations Manager. Such a partially
completed optimization causes no negative effect in vRealize Automation.

How to enable continuous optimization

When you add the vRealize Automation adapter in vRealize Operations Manager, vRealize

Operations Manager automatically creates a new, dedicated datacenter for vRealize Automation
based workloads.

Other than adding the integration within Cloud Assembly, there are no separate installation steps
for continuous optimization. You may begin configuring and using vRealize Operations Manager
for workload relocation in the new datacenter. See the Continuous optimization example .
Continuous optimization example

The following example shows a rebalancing workflow for vRealize Automation continuous
optimization with vRealize Operations Manager.

1 From the vRealize Operations Manager home page, click Workload Optimization.
2 Select the automatically created vRealize Automation datacenter.
3 Under Operational Intent, click Edit, and select Balance.

You cannot select or edit Business Intent, which is disabled when the datacenter is for vRealize
Automation optimization.

£ 10.160.148.47-Custom DataCenter &

Operational Intent Business Intent

Utilization Objective: Salan Intent Not Set

(@ @

=

4 Under Optimization Recommendation, click Optimize Now.

vRealize Operations Manager displays a before-and-after diagram of the proposed operation.
5 Click Next.
6 Click Begin Action.

7 In vRealize Automation, monitor the operation in progress by clicking Resources >
Deployments and looking at event status.
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When rebalancing finishes, vRealize Automation refreshes. The Compute Resources page shows
that machines have moved.

In vRealize Operations Manager, the next data collection refreshes the display to show that
optimization is complete.
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In vRealize Operations Manager, you can review the operation by clicking Administration >
History > Recent Tasks.

Locate vRealize Automation managed datacenters

You can use VRealize Operations Manager to display only the vRealize Automation managed
datacenters.

Procedure
1 From the vRealize Operations Manager home page, click Workload Optimization.

2 Near the top right, click the View drop-down.
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3 Select only the vRealize Automation managed datacenters.
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Deployment monitoring based on vRealize Operations Manager
VRealize Automation can show vRealize Operations Manager data about your deployments.

Reviewing the filtered set of metrics directly in vRealize Automation saves you the task of
accessing or searching vRealize Operations Manager. Although you cannot launch in context
to vRealize Operations Manager, you are of course free to log in and use vRealize Operations
Manager for additional data as needed.

Enable vRealize Operations Manager data

For vRealize Automation to show vRealize Operations Manager data, specific integrations must
be present. The integrations require you to supply the address and login credentials for vRealize
Automation, vRealize Operations Manager, and vCenter.

Procedure

1 In vRealize Operations Manager, go to Data Sources > Integrations, and verify or add your
vCenter account integration.

2 In Cloud Assembly, go to Infrastructure > Connections > Cloud Accounts, and verify or add
your vCenter account.

VRealize Operations Manager and vRealize Automation must be connected to the same
vCenter.

3 In vRealize Operations Manager, go to Data Sources > Integrations, and add the vRealize
Automation 8.x adapter account integration.

4 In Cloud Assembly, go to Infrastructure > Connections > Integrations, and add the vRealize
Operations Manager integration.

Enter the vRealize Operations Manager address in the following form:
https://operations-manager-1P-address-or-FQDN/suite-api

For additional background, see Integrating with vRealize Operations Manager.

What to do next

In Cloud Assembly, click Resources > Deployments, select a deployment on your vCenter, and
verify that the Monitor tab appears.
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Health and alerts provided by vRealize Operations Manager

When monitoring is enabled, vRealize Automation retrieves vRealize Operations Manager Health
and associated alerts about your deployments.

To access monitoring, click a deployment and select the Monitor tab. If the tab is missing, see
Enable vRealize Operations Manager data.

To see alerts, highlight the deployment name at the top of the component tree in the left panel.

m  You can review the severity and text of the alerts.

m  To focus on areas of concern, filter and sort on data in the columns.

= Only Health badges and Health alerts appear. Other alert types such as Efficiency or Risk are
not supported.

Metrics provided by vRealize Operations Manager

When monitoring is enabled, vRealize Automation retrieves vRealize Operations Manager metrics
about your deployments.

To access monitoring, click a deployment and select the Monitor tab. If the tab is missing, see
Enable vRealize Operations Manager data.

To see metrics, expand the component tree on the left, and highlight a virtual machine.

m  Metrics are not cached. They come directly from vRealize Operations Manager and might take
a few moments to load.

= Only virtual machine metrics appear. Metrics from other components such as vCloud Director,
Software, or XaaS are not supported.

m  Only vSphere virtual machine metrics appear. Other cloud providers such as AWS or Azure are
not supported.

Metrics appear as timeline graphs that show highs and lows for the following measures.
= CPU

= Memory

m  Storage IOPS

s Network MBPS

To reveal the specific metric name, click the blue information icon at the upper left corner of the
timeline.
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Acting on data provided by vRealize Operations Manager

When metrics provided by vRealize Operations Manager expose a problem, you can identify
trouble areas directly in vRealize Automation.

To see metrics provided by vRealize Operations Manager, click a deployment and select the
Monitor tab. If the tab is missing, see Enable vRealize Operations Manager data.

Metrics for the past day, week, or month are available. To zoom in on an area of concern, select a
small area in the lower, shaded part under any metric timeline:
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Resource management and deployment optimization using vRealize Operations
Manager metrics in vRealize Automation

In an integrated vRealize Automation and vRealize Operations Manager environment, you can
access insights and alerts for vRealize Automation objects that are monitored by vRealize
Operations Manager.

The Insights dashboard and Alerts tab pages provide the real-time capacity and related
awareness information that you need to make management decisions in vRealize Automation
without needing to open vRealize Operations Manager. The information is supplied by the
associated vRealize Operations Manager application.
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Working with the insights dashboard and with resource alerts

The Insights dashboard conveys information about capacity consumption across all computes
within the cloud zone and grouped by projects. It can also show project deployments that are in
need of optimization.

The Alerts pages displays potential capacity and performance concerns for objects such as cloud
zones, projects, deployments, and virtual machines. They also contain information for project
owners as to which of their deployments can be optimized. Each deployment link opens the
Optimize tab in the deployment, where specific guidance is provided.

The following diagram illustrates the relationship between vRealize Automation resources and
deployments, and the data that the associated vRealize Operations Manager application provides
in vRealize Automation.
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Working with the insights dashboard

The Insights dashboard, which is available on each cloud zone page, provides the following
VRealize Operations Manager metrics:

s CPU, memory, and storage utilization usage as a percentage of capacity
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m  Capability consumption summary
s CPU and memory demand and usage history

m  Consumption across projects

m  Reclaimable resource capacity, with cost savings, for deployments and projects in a cloud zone

Deployments  Design [ Infrastructure | Extensioilty  Marketplace  Alerts DoubEp sETUP € DARK
«
A ———— Insights Summary Compute Projects Alerts
Projects
e CcPU >1 year Memory >1 year Storage >1 year
sy . ilzation (GHz) Utiization (G8) Jtilzation (T8)
Secrets
@ Configure v
8.6 274 6.7
Kubernetes Zones
Flavor Mappings
Mpsablapgings Capacity Consumption Duration 30 days Projects ( @items ) CONTACT OWNERS
Network Profiles x
CPU (Demand) Memory (Demand) CPU (vCPUs) Memory (GB) Storage (TB)
Storage Profiles —— e
Alocation Uits

Pricing Cards — o B

-Contact-Own = —_
Terraform Versions 15

Project-With-Price-.

Tags o 10,000,000
Configuration Properties HCMP1 = Erolect wh o 10,000

© Onboarding GJ-Project

Utilization (GH2)

& Resources v
HCMp 3 - HCMP Use.

It also provides an option to alert project owners of deployments that can be optimized.

The Insights dashboard is available for vSphere and VMware Cloud on AWS cloud zones,
provided that the cloud accounts are configured in both vRealize Automation and vRealize
Operations Manager and are being monitored in vRealize Operations Manager.

For details, see: How to use the Insights dashboard to monitor resource capacity and notify
project owners in vRealize Automation .

Working with alerts

The Alerts pages provide the following filtering categories. Filtering categories are supplied by the

associated vRealize Operations Manager application.

m  Severity

m  Status

= Impact
m Type

= Subtype

m  Resource

Each filter can be further refined using quick filters. For example, the resource filter can be further

refined by its quick filter types of cloud zone, virtual machine, deployment, and project resource.

You use combinations of filters and quick filters to control which alerts are available for display.
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Marketplace

Alerts

| CStatus: Active X ) C Resource Type: Virtual Machine, Project, Cloud Zone X ) C Impact: Health X ) |

Deployments Design Infrastructure Extensibility
'¥ Resource Typev (O Quick filters
Today Cloud Zone
Virtual Machine
C C] Deployment
4 Project oDAY
Yesterday

A Virtual machine is powered off for more than 5 days

Virtual Machine » Cloud_vSphere_Machine_1-
mcm222450-155465769232

Virtual machine is powered off for more than 5 days

A Virtual machine is powered off for more than 5 days

Virtual Machine » Cloud_vSphere_Machine_2-
mcm222451-155465774235

Virtual machine is powered off for more than 5 days

o AlertDefinition_20571bc0-a68c-477¢-bb93-118da83...

Cloud Zone » sga-vc65 / Datacenter

o AlertDefinition_6b5667f5-eb02-4b2e-bcf9-40cbb2...

Cloud Zone » sga-vc67.sga.local / Datacenter

o AlertDefinition_bf5e68e4-28f1-4992-af8d-94ea214ff...

Cloud Zone » sga-vc67.sga.local / Datacenter

L 4

4:40 PM

4:40 PM

1.26 PM

1:26 PM

1:26 PM

= !
T 177

A

/\ Virtual machine is powered off for more than 5 d:
Created: Dec 13, 2020, 4:40:46 PM | Updated: Dec 14, 2020, 7:04:47 PM
Virtual Machine » Cloud_vSphere_Machine_1-mcm222450-155465769232

Virtual machine is powered off for more than 5 days

Severity: Warning Status: Active Impact: Health Type: Infrastri

Suggestions @ REVIEW DEPLOYMENT

e Delete powered off machines

¢ Manually power on the virtual machine.

Notes

Leave a note...

Some Alerts provide information about, and a link to, deployments that can be optimized.
An individual alert can provide the option to contact the project owner, examine an Insights

dashboard, or take possible actions.
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Deployments Design Infrastructure Extensibility Marketplace [J GUIDED
¥ Severity v Q_ Quick filters (" status: Active X ) (" Severity: Critical X )
A . . Rl
Today © The project has some deployments that contain optimizable resour

0 The project has some deployments t... m

Project » vc65 project

contain optimizable resources.

@ Cloud Zone has less than 60 days r... 1:46 AM
Cloud Zone » sga-vc67.sqa.local / Datacenter
The time remaining on cloud zone is less than
60 days until capacity demand runs out.

Created: Dec 14, 2020, 6:17:44 PM | Updated: Dec 14, 2020, 6:17:44 PM

Project » vc65 project

The project has some deployments that \ The project has some deployments that contain optimizable resources.

Severity: Critical Status: Active Impact: Efficiency Type: Application Subtype: Perfor

Suggestions @ REVIEW PROJECT

o |f the project is experiencing increased provisioning, you can review the project to undel

deployments and poweroff/delete the ones that are no longer in use.

Yesterday

@ Cloud Zone has less than 60 days re..  135PM
Cloud Zone » jlif;Zone-glin
The time remaining on cloud zone is less than
60 days until capacity demand runs out.

@ Cloud Zone has less than 60 days re..  135PM

Deployments to review

Name / ¥ Owner

contact-owner-test-dep-2

Items per page 10 N

Cloud Zone » vmc staging-vsphere / SDDC-
Datacenter

The time remaining on cloud zone is less than
60 days until capacity demand runs out.

o AlertDefinition_ff4d3d96-fa4f-4022-... 1:26 PM v

1176 > >l

Notes

Investigating|

ADD NOTE

Alerts are available for vSphere and VMware Cloud on AWS resource objects.

For details about how to configure and use integrated alerts, see How to use Alerts to manage
resource capacity, performance, and availability in vRealize Automation and How to use Alerts to

optimize deployments in vRealize Automation.

What are onboarding plans in Cloud Assembly

You use a workload onboarding plan to identify machines that have been data-collected from a
cloud account type in a target region or data center but that are not yet managed by a Cloud

Assembly project.

When you add a cloud account that contains machines that were deployed outside of Cloud
Assembly, the machines are not managed by Cloud Assembly until you onboard them. Use an
onboarding plan to bring unmanaged machines into Cloud Assembly management. You create

a plan, populate it with machines, and then run the plan to import the machines. Using the
onboarding plan, you can create a cloud template and can also create one or many deployments.

You can onboard one or many unmanaged machines in a single plan by selecting machines

manually.

m  You can onboard up to 3,500 unmanaged machines within a single onboarding plan per hour.
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m  You can onboard up to 17,000 unmanaged machines concurrently within multiple onboarding
plans per hour.

Machines that are available for workload onboarding are listed on the Resources > Resource >
Virtual Machines labeled as Discovered in the Origin column. Only machines that have been
data-collected are listed. After you onboard the machines, they appear in the Origin column as

Deployed. You can filter for discovered or deployed machines by clicking the filter icon.
vmw Cloud Assembly
Resources Design Infrastructure Extensibility
& L4
Virtual Machines r
& Deployments CLEAR ALL
@0 Resources v > Projects
All Resources » Cloud Types Name Depl
Virtual Machines > Cloud Accounts b2 f# popove-vSphere Server..
Volumes > Resource Tags
Metworking & Security v Resource Origin
Deployed (25)
Discovered (1442) b : B aws-vm-mcmE02-1866..
b : [ dboiklisv-vRealizeOrch...

The person who runs the workload onboarding plan is automatically assigned as the machine
owner.

Onboarding also supports onboarding custom properties, attached disks, changing deployment
owners, and vSphere networks.

m  Custom properties - you can set custom properties at the plan and at the individual machine
levels. A custom property set at the machine level overrides the same property on the plan
level.

m Attached disks - If a machine has any non-bootable disks, they are automatically onboarded
with the parent machine. To view non-bootable disks, click the machine name in the plan, and
then navigate to the Storage tab.

= Deployment ownership - Onboarding allows you to change the default deployment owner. To
change the owner, select a deployment from the Deployment tab, click Actions > Change
Owner, and select the desired user associated with the project.

Onboarding examples

For examples of onboarding techniques, see Example: Onboard selected machines as a single
deployment in Cloud Assembly .
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Onboarding event subscriptions

A Deployment Onboarded event is created when you run the plan. Using Extensibility tab
options, you can subscribe to these deployment events and perform actions on them.

After onboarding, you can update a project as a day 2 action for onboarded deployments. To use
the change project action, the target project must use the same clound zone resources as the
deployment. You cannot run the change project action on any onboarded deployments where you
made changes after onboarding.

Example: Onboard selected machines as a single deployment in
Cloud Assembly

In this example, you onboard two unmanaged machines as a single Cloud Assembly deployment
and create a single cloud template for all machines in the plan.

When you create a cloud account, all machines that are associated to it are data-collected and
then displayed on the Resources > Resources > Virtual Machines page. If the cloud account has
machines that were deployed outside of Cloud Assembly, you can use an onboarding plan to allow
Cloud Assembly to manage the machine deployments.

Note You can only rename deployments before they are onboarded. After onboarding, the
Rename option is disabled.

Prerequisites

m  Verify that you have the required user role. See What are the vRealize Automation user roles.
m  Review What are onboarding plans in Cloud Assembly.

m Create and prepare a Cloud Assembly project.

This procedure involves some of the steps from the basic Wordpress use case. See Tutorial:
Setting up and testing multi-cloud infrastructure and deployments in Cloud Assembly.

m Create a project, add users, and assign user roles in the project. See Part 2: Create the
example Cloud Assembly project.

m  Create an Amazon Web Services cloud account for the project. See the cloud account
section of the Part 1: Configure the example Cloud Assembly infrastructure.

The Amazon Web Services cloud account in this procedure contains machines that were
deployed before the cloud account was added to Cloud Assembly and by an application
other than Cloud Assembly.

m  Verify that the Resources > Resources > Virtual Machines page contains machines to
onboard. See Managing resources in Cloud Assembly for more information.

Procedure

1 Go to Infrastructure > Onboarding.
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2 Click New Onboarding Plan and enter sample values.

Setting Sample Value
Plan name VC-sqa-deployments
Description Sample onboarding plan for AWS machine for OurCo-

AWS cloud account

Cloud account OurCo-AWS

Default project WordPress

3 Click Create.

4 Onthe plan's Deployments tab, click Select Machines, choose one or more machines, and
click OK.

Select Machines

I

] Mame State

|
Amazon_EC2_Machine_1-mcm77038-89914732588 [=On

Amazon_EC2_Machine_1-mcm77060-89%18191050 > On

5 Select Create one deployment that contains all the machines and click Create.
6 Click the check box next to the new deployment name and click Cloud template....
7 Click Create Cloud Template in Cloud Assembly format and enter a Cloud Template name, or

click Assign an existing Cloud Template and select the desired Cloud Template to assign.

Note Mapping Cloud Templates to onboarded deployments is only for visual parity for end
consumers. Onboarded deployments are not compatible with Cloud Templates.
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8 Click Save.

Cloud Template Configuration

Iz:l Mapping of Claud Templates ta onboarded depleymants i only far vigual parity for and consumers. Onbaarded
deployments are nat compatible with Cloud Templates

Deployment: Demo

Mane (use nantime snapshat)

Create Cloud Template in Ooud Assambly format

n‘ Assign an existing Cloud Template

Blaima Praject Last Updated

@ Demo QnDoaErdng Qct 21, 2021, 1236115 PM

onboarding Jun 10, 2021, 82155 AM
onboarding May 25, 2021, 9224:07 AM

onboarding Do 7, 2020, 2:03:53 PW

| k

Note When your onboarding plan uses a vSphere machine, you must edit the cloud template
after the onboarding process is complete. The onboarding process cannot link the source
vSphere machine and its machine template, and the resultant cloud template will contain
the imageRef: "no image available" entry in the cloud template code. The cloud template
cannot be deployed until you specify the correct template name in the imageref: field.

To make it easier to locate and update the cloud template after the onboarding process

is complete, use the Cloud template name option on the deployment's Cloud template
configuration page. Record the auto-generated cloud template name or enter and record
a cloud template name of your choice. When onboarding is complete, locate and open the
cloud template and replace the "no image available" entry in the imageref: field with the
correct template name.

9 Click the deployment name check box, click Run, and then click Run again on the Run plan
page.

The selected machines are onboarded as a single deployment, with an accompanying cloud
template.

10 Open and examine the cloud template by clicking the Design > Cloud templates page and
then clicking the cloud template name.
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11 Open and examine the deployment by clicking the Resources > Deployments page and then
clicking the deployment name.

Advanced configuration for Cloud Assembly environment

You can configure your Cloud Assembly environment to further support project configuration,
integration, and deployment.

For related and additional information about administration methods, such as using working with
users and logs, and joining or leaving the Customer Experience program, see the Administering
VRealize Automation help.

How do | configure an Internet proxy server for vRealize Automation

For vRealize Automation installations on isolated networks with no direct Internet access, you can
use an Internet proxy server to allow Internet by proxy functionality. The Internet proxy server
supports HTTP and HTTPS.

To configure and use public cloud providers such as Amazon Web Services (AWS), Microsoft
Azure, and Google Cloud Platform (GCP) as well as external integration points such as IPAM,
Ansible, and Puppet, with vRealize Automation, you must configure an Internet proxy server to
access the internal vRealize Automation Internet proxy server.

VRealize Automation contains an internal proxy server that communicates with your Internet
proxy server. This server communicates with your proxy server if it has been configured with

the vracli proxy set ... command. If you have not configured an Internet proxy server for your
organization, then the vRealize Automation internal proxy server attempts to connect directly to
the Internet.

You can set up vRealize Automation to use an Internet proxy server by using the supplied vracli
command line utility. Information about how to use the vracli API is available by using the
--help argument in the vracli command line, for examplevracli proxy --help.

Access to the Internet proxy server requires use of the actions-based extensibility (ABX) On-Prem

Embedded controls that are built into vRealize Automation.

Note Access to Workspace ONE Access (previously named VMware Identity Manager) is not
supported by way of the Internet proxy. You cannot use the vracli set vidm command to access
Workspace ONE Access through the Internet proxy server.

The internal proxy server requires IPv4 as its default IP format. It doesn't require Internet protocol
restrictions, authentication or man-in-the-middle actions on TLS (HTTPS) certificate traffic.

Prerequisites

m  Verify that you have an existing HTTP or HTTPS server, that you can use as the Internet proxy
server, in the vRealize Automation network that is able to pass outgoing traffic to external
sites. The connection must be configured for IPv4.
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Verify that the target Internet proxy server is configured to support IPv4 as its default IP
format and not IPv6.

If the Internet proxy server uses TLS and requires an HTTPS connection with its clients, you

must import the server certificate by using one of the following commands, prior to setting the

proxy configuration.
B  vracli certificate proxy --set path to proxy certificate.pem
m  vracli certificate proxy --set stdin

Use the stdin parameter for interactive input.

Procedure

Create a proxy configuration for the pods or containers that are used by Kubernetes. In this

example, the proxy server is accessed by using the HTTP scheme.
vracli proxy set —--host http://proxy.vmware.com:3128

Show the proxy configuration.

vracli proxy show

The result will be similar to:

"enabled": true,

"host": "10.244.4.51",

"java-proxy-exclude": "*.locall|*.localdomain|localhost|10.244.*|
192.168.%|172.16.* | kubernetes|sc2-rdops-vm06-dhcp-198-120.eng.vmware.com|10.192.204.9]|
*.eng.vmware.com|sc2-rdops-vm06-dhcp-204-9.eng.vmware.com|10.192.213.146|sc2-rdops-vm06—
dhcp-213-146.eng.vmware.com|10.192.213.151|sc2-rdops-vm06-dhcp-213-151.eng.vmware.com",

"java-user": null,

"password": null,

"port": 3128,

"proxy-
exclude": ".local, .localdomain,localhost,10.244.,192.168.,172.16., kubernetes,sc2-
rdops-vm06-dhcp-198-120.eng.vmware.com,10.192.204.9, .eng.vmware.com, Sc2-
rdops-vm06-dhcp-204-9.eng.vmware.com,10.192.213.146, sc2-rdops-vm06—
dhcp-213-146.eng.vmware.com,10.192.213.151, sc2-rdops-vm06-dhcp-213-151.eng.vmware.com",

"scheme": "http",

"upstream proxy host": null,

"upstream proxy password encoded": "",
"upstream proxy port": null,
"upstream proxy user encoded": "",

"user": null,

"internal.proxy.config": "dns v4 first on \nhttp port
0.0.0.0:3128\nlogformat squid %ts.%03tu %6tr %>a %$Ss/%$03>Hs
$<st %rm %ru %$[un %Sh/%<a %mt\naccess log stdio:/tmp/logger squid\ncoredump dir /\ncache
deny all \nappend domain .prelude.svc.cluster.locall\nacl mylan src 10.0.0.0/8\nacl mylan
src 127.0.0.0/8\nacl mylan src 192.168.3.0/24\nacl proxy-exclude dstdomain .local\nacl
proxy-exclude dstdomain .localdomain\nacl proxy-exclude dstdomain localhost\nacl
proxy-exclude dstdomain 10.244.\nacl proxy-exclude dstdomain 192.168.\nacl proxy-exclude
dstdomain 172.16.\nacl proxy-exclude dstdomain kubernetes\nacl proxy-exclude dstdomain
10.192.204.9\nacl proxy-exclude dstdomain .eng.vmware.com\nacl proxy-exclude dstdomain
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10.192.213.146\nacl proxy-exclude dstdomain 10.192.213.151\nalways direct allow proxy-
exclude\nhttp access allow mylan\nhttp access deny all\n# End autogen configuration\n",

"internal.proxy.config.type": "default"

Note If you have configured an Internet proxy server for your organization, then
"internal.proxy.config.type": "non-default" appears in the above example instead of
'default'. For security, the password is not shown.

Note If you use the -proxy-exclude parameter, you must edit the default values. For
example, if you want to add acme. com as a domain that cannot be accessed by using the
Internet proxy server, use the following steps:

a Enter vracli proxy default-no-proxy to obtain the default proxy-exclude settings. This is
a list of automatically generated domains and networks.

b Edit the value to add .acme.comn.
¢ Enter vracli proxy set .... --proxy-exclude ... to update the configuration settings.

d Runthe /opt/scripts/deploy.sh command to redeploy the environment.

3 (Optional) Exclude DNS domains, FQDNSs, and IP addresses from being accessed by the
Internet proxy server.

Always modify the default values of the proxy-exclude variable using parameter --proxy-
exclude. TO add the domain exclude.vmware. com, first use the vrali proxy show command,
then copy the proxy-exclude variable, and add the domain value using the vracli proxy
set ... command as below:

vracli proxy set --host http://
proxy.vmware.com:3128 --proxy-exclude "exclude.vmware.com,docker-
registry.prelude.svc.cluster.local,localhost, .local, .cluster.local,10.244.,192.,172.16.,sc—

rdops-vmll-dhcp-75-38.eng.vmware.com,10.161.75.38, .eng.vmware.com"

Note Add elements to proxy-exclude instead of replacing values. If you delete proxy-
exclude default values, vRealize Automation does not function properly. If this happens,
delete the proxy configuration and start over.

4 After you set the Internet proxy server with vracli proxy set ... command, you can use the
vracli proxy apply command to update the Internet proxy server configuration and make the
latest proxy settings active.

5 If you have not already done so, activate the script changes by running the following
command:

/opt/scripts/deploy.sh
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6 (Optional) If needed, configure the proxy server to support external access on port 22.

To support integrations such as Puppet and Ansible, the proxy server must allow port 22 to
access the relevant hosts.

Example: Sample Squid configuration

Relative to step 1, if you are setting up a Squid proxy, you can tune your configurationin /etc/
squid/squid.conf by adapting it to the following sample:

acl localnet src 192.168.11.0/24
acl SSL ports port 443

acl Safe ports port 80 # http

acl Safe ports port 21 # ftp

acl Safe ports port 443 # https

acl Safe ports port 70 # gopher

acl Safe ports port 210 # wais

acl Safe ports port 1025-65535 # unregistered ports
acl Safe ports port 280 # http-mgmt

acl Safe ports port 488 # gss-http

acl Safe ports port 591 # filemaker

acl Safe ports port 777 # multiling http
acl CONNECT method CONNECT

http_access allow !Safe ports
http_access allow CONNECT !SSL ports

http_access allow localnet
http port 0.0.0.0:3128

maximum object size 5 GB

cache dir ufs /var/spool/squid 20000 16 256

coredump dir /var/spool/squid

refresh pattern ~ftp: 1440 20% 10080

refresh pattern “gopher: 1440 0% 1440

refresh pattern -i (/cgi-bin/|\?) 0 0% 0

refresh pattern (Release|Packages(.gz)*)$ 0 20% 2880
refresh pattern . 0 20% 4320

client persistent connections on

server persistent connections on

What can | do with NSX-T mapping to multiple vCenters in vRealize
Automation

You can associate an NSX-T cloud account to one or more vCenter cloud accounts to support
various deployment objectives.
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You can associate the same existing NSX-T network to network profiles for different vCenters and
provision a deployment in either vCenter based on constraints. Several examples are listed below:

m  Cloud templates that contain a single machine with multiple NICs that use the same network
profile, where that network profile contains an NSX-T network that spans multiple vCenters.

m  Cloud templates that contain a machine on a private network that uses a network profile with
subnet-based isolation and that uses an NSX-T existing network that spans multiple vCenters.

m  Cloud templates that contain a single machine on a private network that uses a network profile
with security group-based isolation and that uses an NSX-T network that spans vCenters.

m  Cloud templates that contain a single machine on a routed network that uses a network profile
that contains an NSX-T network that spans multiple vCenters.

m  Cloud templates that contain an on-demand load balancer that is defined in a network profile
where the load balancer is applied to all the vCenter machines on the network.

m  Cloud templates that contain an on-demand network that is defined in a network profile where
the on-demand network is used by all the vCenters that use the network profile.

m  Cloud templates that contain an on-demand security group that optionally contains firewall
rules and where the security group is associated to all the vCenters on the network.

You can configure vRealize Automation internal or external IPAM on the NSX-T network and share
the same IP address for machines that are provisioned in different vCenters.

If no network profile is defined in your system, you can provision a cloud template that contains
multiple machines on different vCenters that share a single existing NSX-T network.

What happens if | remove an NSX cloud account association in
VRealize Automation

If you remove an association between an NSX cloud account and a vCenter cloud account, you
also need to update the related network profiles to remove the associated NSX objects.

If you remove an association between an NSX cloud account and a vCenter cloud account, the
infrastructure elements are not updated automatically by vRealize Automation. You must update
your existing network profiles to remove the associated NSX objects.

The user interface provides information to help highlight the impacted network profile elements as
follows:

m [f the network profile has an NSX existing network selected:

m  The object is marked as /nvalid and the message Some network objects are missing or
/nvalid. is displayed.

m  The objects are removed when you save the network profile.

m |f the network profile has app isolation configured, you must update the Isolation policy
settings before the network profile can be saved.
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m |f the network profile has security groups or load balancers selected, the objects are removed
when you save the network profile.

Existing deployments continue to work as designed for existing components, but will fail when
creating new components, for example in a scale-out operation.

If you re-establish the association, the network profile is repopulated and existing deployments
work as designed.

If you remove the NSX cloud account, the above behavior is the same, but network objects are
marked as missing rather than invalid.

How do | use the IPAM SDK to create a provider-specific external
IPAM integration package for vRealize Automation

External IPAM vendors and partners can download and use the IPAM SDK to create an IPAM
integration package that enables vRealize Automation to support their provider-specific IPAM
solution.

The process for building and deploying a custom IPAM integration package for vRealize
Automation by using the supplied IPAM SDK is described in the Creating and Deploying a
Provider-specific IPAM Integration Package for VMware Cloud Assembly document. As described
in the document, you can download the most recent VMware vRealize Automation Third-Party
IPAM SDK from the VMware code site. The following IPAM SDK packages are available:

m  VMware vRealize Automation Third-Party IPAM SDK 1.1.0

m  VMware vRealize Automation Third-Party IPAM SDK 1.0.0

On-
Prem

AWS/Azure may not have

AWS Lambda / v
Azure F